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InfiniiVision 4000 X-Series Oscilloscopes—At a Glance

Table 1 4000 X-Series Model Numbers, Bandwidths, Sample Rates

Bandwidth 200 MHz 350 MHz 500 MHz 1 GHz 1.5 GHz

Sample Rate 
(interleaved, 
non-interleaved)

5 GSa/s, 
2.5 GSa/s

5 GSa/s, 
2.5 GSa/s

5 GSa/s, 
2.5 GSa/s

5 GSa/s, 
2.5 GSa/s

5 GSa/s, 
2.5 GSa/s

2-Channel + 16 Logic 
Channels MSO

MSO-X 4022A MSO-X 4032A MSO-X 4052A

4-Channel + 16 Logic 
Channels MSO

MSO-X 4024A MSO-X 4034A MSO-X 4054A MSO-X 4104A MSO-X 4154A

2-Channel DSO DSO-X 4022A DSO-X 4032A DSO-X 4052A

4-Channel DSO DSO-X 4024A DSO-X 4034A DSO-X 4054A DSO-X 4104A DSO-X 4154A
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The Agilent InfiniiVision 4000 X- Series oscilloscopes deliver these features:

• 200 MHz, 350 MHz, 500 MHz, 1 GHz, and 1.5 GHz bandwidth models.

• 2-  and 4- channel digital storage oscilloscope (DSO) models.

• 2+16- channel and 4+16- channel mixed- signal oscilloscope (MSO) 
models.

An MSO lets you debug your mixed- signal designs using analog signals 
and tightly correlated digital signals simultaneously. The 16 digital 
channels have a 1.25 GSa/s sample rate, with a 250 MHz toggle rate.

• 12.1 inch SVGA touchscreen display. The touchscreen makes the 
oscilloscope easier to use:

• You can "touch" inside alpha- numeric keypad dialogs to enter file, 
label, network, and printer names, etc., instead of using softkeys and 

the  Entry knob.

• You can drag a finger across the screen to draw rectangular boxes 
for zooming in on waveforms or setting up Zone triggers.

• You can touch the blue menu icon in the sidebar to display 
information or control dialogs. You can drag (undock) these dialogs 
out of the sidebar, for example, to view cursor values and 
measurements at the same time.

• You can touch other areas of the screen as substitutes for using 
front panel keys, softkeys, and knobs.

• Interleaved 4 Mpts or non- interleaved 2 Mpts MegaZoom IV memory 
for the fastest waveform update rates, uncompromised.

• All knobs are pushable for making quick selections.

• Trigger types: edge, edge then edge, pulse width, pattern, OR, rise/fall 
time, Nth edge burst, runt, setup & hold, video, and zone.

• Serial decode/trigger options for: CAN/LIN, FlexRay, I2C/SPI, I2S, 
UART/RS232, MIL- STD- 1553/ARINC 429, and USB. There is a Lister 
for displaying serial decode packets.

• Math waveforms: add, subtract, multiply, divide, FFT, d/dt, integrate, 
square root, Ax+B, square, absolute value, common logarithm, natural 
logarithm, exponential, base 10 exponential, low pass filter, high pass 
filter, averaged value, magnify, measurement trend, chart logic bus 
timing, and chart logic bus state.
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• Reference waveform locations (4) for comparing with other channel or 
math waveforms.

• Many built- in measurements and a measurement statistics display.

• Built- in, license- enabled 2- channel waveform generator with: arbitrary, 
sine, square, ramp, pulse, DC, noise, sine cardinal, exponential rise, 
exponential fall, cardiac, and Gaussian pulse. Modulated waveforms on 
WaveGen1 except for arbitrary, pulse, DC, and noise waveforms.

• USB and LAN ports make printing, saving, and sharing data easy.

• VGA port for displaying the screen on a different monitor.

• A Quick Help system is built into the oscilloscope. Press and hold any 
key to display Quick Help. Complete instructions for using the quick 
help system are given in “Access the Built- In Quick Help" on page 62.

For more information about InfiniiVision oscilloscopes, see: 
"www.agilent.com/find/scope"

http://www.agilent.com/find/scope
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In This Guide
This guide shows how to use the InfiniiVision 4000 X- Series oscilloscopes.

When unpacking and using the 
oscilloscope for the first time, see:

• Chapter 1, “Getting Started,” starting on page 27

When displaying waveforms and 
acquired data, see:

• Chapter 2, “Horizontal Controls,” starting on page 65
• Chapter 3, “Vertical Controls,” starting on page 81
• Chapter 4, “Math Waveforms,” starting on page 91
• Chapter 5, “Reference Waveforms,” starting on page 

121
• Chapter 6, “Digital Channels,” starting on page 125
• Chapter 7, “Serial Decode,” starting on page 145
• Chapter 8, “Display Settings,” starting on page 151
• Chapter 9, “Labels,” starting on page 159

When setting up triggers or changing 
how data is acquired, see:

• Chapter 10, “Triggers,” starting on page 167
• Chapter 11, “Trigger Mode/Coupling,” starting on 

page 205
• Chapter 12, “Acquisition Control,” starting on page 213

Making measurements and analyzing 
data:

• Chapter 13, “Cursors,” starting on page 231
• Chapter 14, “Measurements,” starting on page 241
• Chapter 15, “Mask Testing,” starting on page 271
• Chapter 16, “Digital Voltmeter,” starting on page 283

When using the built-in license 
enabled waveform generator, see:

• Chapter 17, “Waveform Generator,” starting on page 
287

When saving, recalling, or printing, 
see:

• Chapter 18, “Save/Email/Recall (Setups, Screens, 
Data),” starting on page 309

• Chapter 19, “Print (Screens),” starting on page 323

When using the oscilloscope's utility 
functions or web interface, see:

• Chapter 20, “Utility Settings,” starting on page 329
• Chapter 21, “Web Interface,” starting on page 349
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For reference information, see: • Chapter 22, “Reference,” starting on page 367

When using licensed serial bus 
triggering and decode features, see:

• Chapter 23, “CAN/LIN Triggering and Serial Decode,” 
starting on page 387

• Chapter 24, “FlexRay Triggering and Serial Decode,” 
starting on page 405

• Chapter 25, “I2C/SPI Triggering and Serial Decode,” 
starting on page 415

• Chapter 26, “I2S Triggering and Serial Decode,” 
starting on page 435

• Chapter 27, “MIL-STD-1553/ARINC 429 Triggering and 
Serial Decode,” starting on page 445

• Chapter 28, “UART/RS232 Triggering and Serial 
Decode,” starting on page 461

• Chapter 29, “USB 2.0 Triggering and Serial Decode,” 
starting on page 471

TIP Abbreviated instructions for pressing a series of keys and softkeys

Instructions for pressing a series of keys are written in an abbreviated manner. Instructions 
for pressing [Key1], then pressing Softkey2, then pressing Softkey3 are abbreviated as 
follows:

Press [Key1] > Softkey2 > Softkey3.

The keys may be a front panel [Key] or a Softkey. Softkeys are the six keys located directly 
below the oscilloscope display.



8 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

 



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 9

Contents

InfiniiVision 4000 X-Series Oscilloscopes—At a Glance 3

In This Guide 6

1 Getting Started

Inspect the Package Contents 27

Attaching the Accessory Pouch 30

Tilt the Oscilloscope for Easy Viewing 31

Power-On the Oscilloscope 32

Connect Probes to the Oscilloscope 33

 Maximum input voltage at analog inputs 34

 Do not float the oscilloscope chassis 34

Input a Waveform 34

Recall the Default Oscilloscope Setup 35

Use Auto Scale 35

Compensate Passive Probes 37

Learn the Front Panel Controls and Connectors 38

Front Panel Overlays for Different Languages 45

Learn the Touchscreen Controls 47

Draw Rectangles for Waveform Zoom or Zone Trigger Set 
Up 47

Drag Waveforms Left and Right to Change the Horizontal 
Position 48



10 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

Select Sidebar Information or Controls 49
Undock Sidebar Dialogs by Dragging 50
Select Dialog Menus and Close Dialogs 51
Drag Cursors 51
Touch Softkeys and Menus On the Screen 51
Enter Names Using Alpha-Numeric Keypad Dialogs 52
Change Waveform Offsets By Dragging Ground Reference 

Icons 53
Access Controls and Menus Via the Spark Icon 54
Turn Channels On/Off and Open Scale/Offset Dialogs 56
Access the Horizontal Menu and Open the Scale/Delay 

Dialog 56
Access the Trigger Menu, Change the Trigger Mode, and Open 

the Trigger Level Dialog 57
Use a USB Mouse and/or Keyboard for Touchscreen 

Controls 58

Learn the Rear Panel Connectors 58

Learn the Oscilloscope Display 60

Access the Built-In Quick Help 62

2 Horizontal Controls

To adjust the horizontal (time/div) scale 67

To adjust the horizontal delay (position) 67

Panning and Zooming Single or Stopped Acquisitions 68

To change the horizontal time mode (Normal, XY, or Roll) 69

XY Time Mode 70

To display the zoomed time base 73

To change the horizontal scale knob's coarse/fine adjustment 
setting 75

To position the time reference (left, center, right) 75



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 11

Searching for Events 76

To set up searches 76
To copy search setups 77

Navigating the Time Base 77

To navigate time 78
To navigate search events 78
To navigate segments 79

3 Vertical Controls

To turn waveforms on or off (channel or math) 82

To adjust the vertical scale 83

To adjust the vertical position 83

To specify channel coupling 84

To specify channel input impedance 85

To specify bandwidth limiting 85

To change the vertical scale knob's coarse/fine adjustment 
setting 86

To invert a waveform 86

Setting Analog Channel Probe Options 87

To specify the channel units 87
To specify the probe attenuation 88
To specify the probe skew 88
To calibrate a probe 89

4 Math Waveforms

To display math waveforms 91

To adjust the math waveform scale and offset 93

Units for Math Waveforms 93

Math Operators 94



12 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

Add or Subtract 94
Multiply or Divide 95

Math Transforms 96

Differentiate 97
Integrate 98
FFT Measurement 100
Square Root 108
Ax + B 108
Square 109
Absolute Value 110
Common Logarithm 110
Natural Logarithm 111
Exponential 111
Base 10 Exponential 112

Math Filters 112

High Pass and Low Pass Filter 113
Averaged Value 114

Math Visualizations 114

Magnify 114
Measurement Trend 115
Chart Logic Bus Timing 117
Chart Logic Bus State 118

5 Reference Waveforms

To save a waveform to a reference waveform location 121

To display a reference waveform 122

To scale and position reference waveforms 123

To adjust reference waveform skew 124

To display reference waveform information 124



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 13

To save/recall reference waveform files to/from a USB storage 
device 124

6 Digital Channels

To connect the digital probes to the device under test 125

 Probe cable for digital channels 126

Acquiring waveforms using the digital channels 129

To display digital channels using AutoScale 129

Interpreting the digital waveform display 131

To change the displayed size of the digital channels 132

To switch a single channel on or off 132

To switch all digital channels on or off 132

To switch groups of channels on or off 132

To change the logic threshold for digital channels 133

To reposition a digital channel 133

To display digital channels as a bus 134

Digital channel signal fidelity: Probe impedance and 
grounding 137

Input Impedance 138
Probe Grounding 140
Best Probing Practices 142

To replace digital probe leads 142

7 Serial Decode

Serial Decode Options 145

Lister 146

Searching Lister Data 148



14 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

8 Display Settings

To adjust waveform intensity 151

To set or clear persistence 153

To clear the display 155

To select the grid type 155

To adjust the grid intensity 155

To display waveforms as vectors or dots 156

To freeze the display 157

9 Labels

To turn the label display on or off 159

To assign a predefined label to a channel 160

To define a new label 161

To load a list of labels from a text file you create 162

To reset the label library to the factory default 163

To add an annotation 164

10 Triggers

Adjusting the Trigger Level 169

Forcing a Trigger 169

Edge Trigger 170

Edge then Edge Trigger 172

Pulse Width Trigger 174

Pattern Trigger 177

Hex Bus Pattern Trigger 179

OR Trigger 180



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 15

Rise/Fall Time Trigger 182

Nth Edge Burst Trigger 184

Runt Trigger 185

Setup and Hold Trigger 187

Video Trigger 188

To set up Generic video triggers 193
To trigger on a specific line of video 194
To trigger on all sync pulses 195
To trigger on a specific field of the video signal 196
To trigger on all fields of the video signal 197
To trigger on odd or even fields 198

Serial Trigger 201

Zone Qualified Trigger 202

11 Trigger Mode/Coupling

To select the Auto or Normal trigger mode 206

To select the trigger coupling 208

To enable or disable trigger noise rejection 209

To enable or disable trigger HF Reject 209

To set the trigger holdoff 210

External Trigger Input 210

 Maximum voltage at oscilloscope external trigger input 211

12 Acquisition Control

Running, Stopping, and Making Single Acquisitions (Run 
Control) 213

Overview of Sampling 215



16 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

Sampling Theory 215
Aliasing 215
Oscilloscope Bandwidth and Sample Rate 216
Oscilloscope Rise Time 217
Oscilloscope Bandwidth Required 218
Memory Depth and Sample Rate 219

Selecting the Acquisition Mode 219

Normal Acquisition Mode 220
Peak Detect Acquisition Mode 220
Averaging Acquisition Mode 223
High Resolution Acquisition Mode 225

Realtime Sampling Option 226

Realtime Sampling and Oscilloscope Bandwidth 227

Acquiring to Segmented Memory 228

Navigating Segments 229
Measurements, Statistics, and Infinite Persistence with 

Segmented Memory 229
Segmented Memory Re-Arm Time 230
Saving Data from Segmented Memory 230

13 Cursors

To make cursor measurements 232

Cursor Examples 235

14 Measurements

To make automatic measurements 242

Measurements Summary 244

Snapshot All 247

Voltage Measurements 248

Peak-Peak 249
Maximum 249



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 17

Minimum 249
Amplitude 249
Top 250
Base 251
Overshoot 251
Preshoot 252
Average 253
DC RMS 253
AC RMS 254
Ratio 256

Time Measurements 256

Period 257
Frequency 257
Counter 258
+ Width 259
– Width 259
Burst Width 259
Duty Cycle 259
Rise Time 260
Fall Time 260
Delay 260
Phase 261
X at Min Y 263
X at Max Y 263

Count Measurements 264

Positive Pulse Count 264
Negative Pulse Count 264
Rising Edge Count 265
Falling Edges Count 265

Mixed Measurements 265

Area 265



18 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

Measurement Thresholds 266

Measurement Window 268

Measurement Statistics 268

15 Mask Testing

To create a mask from a "golden" waveform (Automask) 271

Mask Test Setup Options 274

Mask Statistics 276

To manually modify a mask file 277

Building a Mask File 280

How is mask testing done? 282

16 Digital Voltmeter

17 Waveform Generator

To select generated waveform types and settings 287

To edit arbitrary waveforms 291

Creating New Arbitrary Waveforms 293
Editing Existing Arbitrary Waveforms 294
Capturing Other Waveforms to the Arbitrary Waveform 299

To output the waveform generator sync pulse 299

To specify the expected output load 300

To use waveform generator logic presets 300

To add noise to the waveform generator output 301

To add modulation to the waveform generator output 302

To set up Amplitude Modulation (AM) 303
To set up Frequency Modulation (FM) 304
To set up Frequency-Shift Keying Modulation (FSK) 306



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 19

To restore waveform generator defaults 307

To set up dual channel tracking 307

18 Save/Email/Recall (Setups, Screens, Data)

Saving Setups, Screen Images, or Data 309

To save setup files 311
To save BMP or PNG image files 312
To save CSV, ASCII XY, or BIN data files 312
Length Control 314
To save Lister data files 315
To save reference waveform files to a USB storage device 316
To save masks 316
To save arbitrary waveforms 317
To navigate storage locations 317
To enter file names 317

Emailing Setups, Screen Images, or Data 318

Recalling Setups, Masks, or Data 319

To recall setup files 320
To recall mask files 320
To recall reference waveform files from a USB storage 

device 320
To recall arbitrary waveforms 321

Recalling Default Setups 322

Performing a Secure Erase 322

19 Print (Screens)

To print the oscilloscope's display 323

To set up network printer connections 325

To specify the print options 326

To specify the palette option 327



20 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

20 Utility Settings

I/O Interface Settings 329

Setting up the Oscilloscope's LAN Connection 330

To establish a LAN connection 331
Stand-alone (Point-to-Point) Connection to a PC 332

File Explorer 333

Setting Oscilloscope Preferences 335

To choose "expand about" center or ground 335
To disable/enable transparent backgrounds 336
To load the default label library 336
To set up the screen saver 336
To set AutoScale preferences 337

Setting the Oscilloscope's Clock 338

Setting the Rear Panel TRIG OUT Source 339

Setting the Reference Signal Mode 339

To supply a sample clock to the oscilloscope 340

 Maximum input voltage at 10 MHz REF connector 340
To synchronize the timebase of two or more instruments 341

Performing Service Tasks 342

To perform user calibration 342
To perform hardware self test 344
To perform front panel self test 345
To display oscilloscope information 345
To display the user calibration status 345
To clean the oscilloscope 345
To check warranty and extended services status 346
To contact Agilent 346
To return the instrument 346

Configuring the [Quick Action] Key 347



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 21

21 Web Interface

Accessing the Web Interface 350

Browser Web Control 351

Real Scope Remote Front Panel 352
Simple Remote Front Panel 353
Browser-Based Remote Front Panel 354
Remote Programming via the Web Interface 355
Remote Programming with Agilent IO Libraries 356

Save/Recall 357

Saving Files via the Web Interface 357
Recalling Files via the Web Interface 358

Get Image 359

Identification Function 360

Instrument Utilities 360

Setting a Password 363

22 Reference

Specifications and Characteristics 367

Measurement Category 367

Oscilloscope Measurement Category 368
Measurement Category Definitions 368
Transient Withstand Capability 369

 Maximum input voltage at analog inputs 369

 Maximum input voltage at digital channels 369

Environmental Conditions 369

Probes and Accessories 370

Passive Probes 371



22 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

Single-Ended Active Probes 371
Differential Probes 372
Current Probes 373
Accessories Available 373

Loading Licenses and Displaying License Information 374

Licensed Options Available 375
Other Options Available 376
Upgrading to an MSO 376

Software and Firmware Updates 377

Binary Data (.bin) Format 377

Binary Data in MATLAB 378
Binary Header Format 378
Example Program for Reading Binary Data 381
Examples of Binary Files 381

CSV and ASCII XY files 384

CSV and ASCII XY file structure 385
Minimum and Maximum Values in CSV Files 385

Acknowledgements 386

23 CAN/LIN Triggering and Serial Decode

Setup for CAN Signals 387

Loading and Displaying CAN Symbolic Data 389

CAN Triggering 390

CAN Serial Decode 392

Interpreting CAN Decode 393
CAN Totalizer 394
Interpreting CAN Lister Data 395
Searching for CAN Data in the Lister 396

Setup for LIN Signals 397



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 23

LIN Triggering 398

LIN Serial Decode 400

Interpreting LIN Decode 402
Interpreting LIN Lister Data 403
Searching for LIN Data in the Lister 404

24 FlexRay Triggering and Serial Decode

Setup for FlexRay Signals 405

FlexRay Triggering 406

Triggering on FlexRay Frames 407
Triggering on FlexRay Errors 408
Triggering on FlexRay Events 408

FlexRay Serial Decode 409

Interpreting FlexRay Decode 410
FlexRay Totalizer 411
Interpreting FlexRay Lister Data 412
Searching for FlexRay Data in the Lister 413

25 I2C/SPI Triggering and Serial Decode

Setup for I2C Signals 415

I2C Triggering 416

I2C Serial Decode 420

Interpreting I2C Decode 421
Interpreting I2C Lister Data 423
Searching for I2C Data in the Lister 423

Setup for SPI Signals 424

SPI Triggering 428

SPI Serial Decode 430

Interpreting SPI Decode 432
Interpreting SPI Lister Data 433



24 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

Searching for SPI Data in the Lister 433

26 I2S Triggering and Serial Decode

Setup for I2S Signals 435

I2S Triggering 438

I2S Serial Decode 441

Interpreting I2S Decode 442
Interpreting I2S Lister Data 443
Searching for I2S Data in the Lister 444

27 MIL-STD-1553/ARINC 429 Triggering and Serial Decode

Setup for MIL-STD-1553 Signals 445

MIL-STD-1553 Triggering 447

MIL-STD-1553 Serial Decode 448

Interpreting MIL-STD-1553 Decode 449
Interpreting MIL-STD-1553 Lister Data 450
Searching for MIL-STD-1553 Data in the Lister 451

Setup for ARINC 429 Signals 452

ARINC 429 Triggering 454

ARINC 429 Serial Decode 455

Interpreting ARINC 429 Decode 457
ARINC 429 Totalizer 458
Interpreting ARINC 429 Lister Data 459
Searching for ARINC 429 Data in the Lister 460

28 UART/RS232 Triggering and Serial Decode

Setup for UART/RS232 Signals 461

UART/RS232 Triggering 463

UART/RS232 Serial Decode 465



Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 25

Interpreting UART/RS232 Decode 467
UART/RS232 Totalizer 468
Interpreting UART/RS232 Lister Data 469
Searching for UART/RS232 Data in the Lister 469

29 USB 2.0 Triggering and Serial Decode

Setup for USB 2.0 Signals 471

USB 2.0 Triggering 473

USB 2.0 Serial Decode 475

Interpreting USB 2.0 Decode 476
Interpreting USB 2.0 Lister Data 478
Searching for USB 2.0 Data in the Lister 479

Index



26 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide



27

Agilent InfiniiVision 4000 X-Series Oscilloscopes 
User's Guide

 

s1

1
Getting Started

Inspect the Package Contents 27

Attaching the Accessory Pouch 30

Tilt the Oscilloscope for Easy Viewing 31

Power-On the Oscilloscope 32

Connect Probes to the Oscilloscope 33

Input a Waveform 34

Recall the Default Oscilloscope Setup 35

Use Auto Scale 35

Compensate Passive Probes 37

Learn the Front Panel Controls and Connectors 38

Learn the Touchscreen Controls 47

Learn the Rear Panel Connectors 58

Learn the Oscilloscope Display 60

Access the Built-In Quick Help 62

This chapter describes the steps you take when using the oscilloscope for 
the first time.

Inspect the Package Contents

• Inspect the shipping container for damage.

If your shipping container appears to be damaged, keep the shipping 
container or cushioning material until you have inspected the contents 
of the shipment for completeness and have checked the oscilloscope 
mechanically and electrically.
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1 Getting Started
 

• Verify that you received the following items and any optional 
accessories you may have ordered:

• InfiniiVision 4000 X- Series oscilloscope.

• Power cord (country of origin determines specific type).

• Oscilloscope probes:

• Two probes for 2- channel models.

• Four probes for 4- channel models.

• Digital probe kit (MSO models only).

• Documentation CD- ROM.

• Accessory pouch (not shown).
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See Also • “Accessories Available" on page 373

InfiniiVision 4000 X-Series oscilloscope

Power cord
(Based on country
of origin)

Documentation CD

Digital Probe Kit*
(MSO models only) 

*N6450-60001 Digital Probe Kit contains:
     54620-61601  16-channel cable (qyt 1)
     01650-82103   2-inch probe ground leads (qyt 5)
     5090-4832       Grabber (qyt 20)

Digital probe replacement parts are listed in the
"Digital Channels" chapter.

N2894A probes
(Qty 2 or 4)
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Attaching the Accessory Pouch

Included with the oscillosope is an accessory pouch that can be attached 
to the rear panel. You can use it to store oscilloscope probes and other 
accessories. To attach the pouch:

1 Remove these two screws.

2 Secure the accessory pouch to the rear panel using the removed screws.
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Tilt the Oscilloscope for Easy Viewing

The oscilloscope can be tilted up for easier viewing.

1 Tilt the oscilloscope forward. Rotate the foot down and toward the rear 
of the oscilloscope. The foot will lock into place.
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2 Repeat for the other foot.

3 Rock the oscilloscope back so that it rests securely on its feet.

To retract the feet:

1 Tilt the oscilloscope forward. Press the foot release button and rotate 
the foot up and toward the front of the oscilloscope.

2 Repeat for the other foot.

Power-On the Oscilloscope

Power
Requirements

Line voltage, frequency, and power:

• ~Line 100- 120 Vac, 50/60/400 Hz

• 100- 240 Vac, 50/60 Hz

• 120 W max

Ventilation
Requirements

The air intake and exhaust areas must be free from obstructions. 
Unrestricted air flow is required for proper cooling. Always ensure that 
the air intake and exhaust areas are free from obstructions.

The fan draws air in from the left side and bottom of the oscilloscope and 
pushes it out behind the oscilloscope.
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When using the oscilloscope in a bench- top setting, provide at least 2" 
clearance at the sides and 4" (100 mm) clearance above and behind the 
oscilloscope for proper cooling.

To power-on the
oscilloscope

1 Connect the power cord to the rear of the oscilloscope, then to a 
suitable AC voltage source. Route the power cord so the oscilloscope's 
feet and legs do not pinch the cord.

2 The oscilloscope automatically adjusts for input line voltages in the 
range 100 to 240 VAC. The line cord provided is matched to the country 
of origin.

3 Press the power switch.

The power switch is located on the lower left corner of the front panel. 
The oscilloscope will perform a self- test and will be operational in a few 
seconds.

Connect Probes to the Oscilloscope

1 Connect the oscilloscope probe to an oscilloscope channel BNC 
connector.

2 Connect the probe's retractable hook tip to the point of interest on the 
circuit or device under test. Be sure to connect the probe ground lead 
to a ground point on the circuit.

WARNING Always use a grounded power cord. Do not defeat the power cord ground.
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Input a Waveform

The first signal to input to the oscilloscope is the Demo 2, Probe Comp 
signal. This signal is used for compensating probes.

1 Connect an oscilloscope probe from channel 1 to the Demo 2 (Probe 
Comp) terminal on the front panel.

2 Connect the probe's ground lead to the ground terminal (next to the 
Demo 2 terminal).

CAUTION  Maximum input voltage at analog inputs

CAT I 300 Vrms, 400 Vpk; transient overvoltage 1.6 kVpk

50Ω input: 5 Vrms Input protection is enabled in 50 Ω mode and the 50 Ω load will 
disconnect if greater than 5 Vrms is detected. However the inputs could still be 
damaged, depending on the time constant of the signal. The 50 Ω input protection only 
functions when the oscilloscope is powered on.

With 10073C 10:1 probe: CAT I 500 Vpk

With N2871A, N2872A, N2873A 10:1 probe: CAT I 400 Vpk, transient overvoltage 
1.25 kVpk

CAUTION  Do not float the oscilloscope chassis

Defeating the ground connection and "floating" the oscilloscope chassis will probably 
result in inaccurate measurements and may also cause equipment damage. The probe 
ground lead is connected to the oscilloscope chassis and the ground wire in the power 
cord. If you need to measure between two live points, use a differential probe with 
sufficient dynamic range.

WARNING Do not negate the protective action of the ground connection to the oscilloscope. The 
oscilloscope must remain grounded through its power cord. Defeating the ground 
creates an electric shock hazard.
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Recall the Default Oscilloscope Setup

To recall the default oscilloscope setup:

1 Press [Default Setup].

The default setup restores the oscilloscope's default settings. This places 
the oscilloscope in a known operating condition. The major default settings 
are:

In the Save/Recall Menu, there are also options for restoring the complete 
factory settings (see “Recalling Default Setups" on page 322) or performing 
a secure erase (see “Performing a Secure Erase" on page 322).

Use Auto Scale

Use [Auto Scale] to automatically configure the oscilloscope to best display 
the input signals.

1 Press [Auto Scale].

You should see a waveform on the oscilloscope's display similar to this:

Table 2 Default Configuration Settings

Horizontal Normal mode, 100 µs/div scale, 0 s delay, center time reference.

Vertical (Analog) Channel 1 on, 5 V/div scale, DC coupling, 0 V position, 1 MΩ impedance.

Trigger Edge trigger, Auto trigger mode, 0 V level, channel 1 source, DC coupling, 
rising edge slope, 40 ns holdoff time.

Display Persistence off, 20% grid intensity, 50% waveform intensity.

Other Acquire mode normal, [Run/Stop] to Run, cursors and measurements off.

Labels All custom labels that you have created in the Label Library are preserved (not 
erased), but all channel labels will be set to their original names.
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2 If you want to return to the oscilloscope settings that existed before, 
press Undo AutoScale.

3 If you want to enable "fast debug" autoscaling, change the channels 
autoscaled, or preserve the acquisition mode during autoscale, press 
Fast Debug, Channels, or Acq Mode.

These are the same softkeys that appear in the AutoScale Preferences 
Menu. See “To set AutoScale preferences" on page 337.

If you see the waveform, but the square wave is not shaped correctly as 
shown above, perform the procedure “Compensate Passive Probes" on 
page 37.

If you do not see the waveform, make sure the probe is connected 
securely to the front panel channel input BNC and to the left side, 
Demo 2, Probe Comp terminal.

How AutoScale
Works

Auto Scale analyzes any waveforms present at each channel and at the 
external trigger input. This includes the digital channels, if connected.
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Auto Scale finds, turns on, and scales any channel with a repetitive 
waveform that has a frequency of at least 25 Hz, a duty cycle greater than 
0.5%, and an amplitude of at least 10 mV peak- to- peak. Any channels 
where no signal is found are turned off.

The trigger source is selected by looking for the first valid waveform 
starting with external trigger, then continuing with the lowest number 
analog channel up to the highest number analog channel, and finally (if 
digital probes are connected) the highest number digital channel.

During Auto Scale, the delay is set to 0.0 seconds, the horizontal time/div 
(sweep speed) setting is a function of the input signal (about 2 periods of 
the triggered signal on the screen), and the triggering mode is set to Edge.

Compensate Passive Probes

Each oscilloscope passive probe must be compensated to match the input 
characteristics of the oscilloscope channel to which it is connected. A 
poorly compensated probe can introduce significant measurement errors.

1 Input the Probe Comp signal (see “Input a Waveform" on page 34).

2 Press [Default Setup] to recall the default oscilloscope setup (see “Recall 
the Default Oscilloscope Setup" on page 35).

3 Press [Auto Scale] to automatically configure the oscilloscope for the 
Probe Comp signal (see “Use Auto Scale" on page 35).

4 Press the channel key to which the probe is connected ([1], [2], etc.).

5 In the Channel Menu, press Probe.

6 In the Channel Probe Menu, press Probe Check; then, follow the 
instructions on- screen.

If necessary, use a nonmetallic tool (supplied with the probe) to adjust 
the trimmer capacitor on the probe for the flattest pulse possible.

On the N2862/63/90 probes, the trimmer capacitor is the yellow 
adjustment on the probe tip. On other probes, the trimmer capacitor is 
located on the probe BNC connector.



38 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

1 Getting Started
 

7 Connect probes to all other oscilloscope channels (channel 2 of a 
2- channel oscilloscope, or channels 2, 3, and 4 of a 4- channel 
oscilloscope).

8 Repeat the procedure for each channel.

Learn the Front Panel Controls and Connectors

On the front panel, key refers to any key (button) you can press.

Softkey specifically refers to the six keys that are directly below the 
display. The legend for these keys is directly above them, on the display. 
Their functions change as you navigate through the oscilloscope's menus.

For the following figure, refer to the numbered descriptions in the table 
that follows.

Perfectly compensated 

Over compensated 

Under compensated
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14. Tools keys

1. Power switch

2. Softkeys

3. [Intensity] key

4. Entry knob

6. Trigger controls5. Waveform keys

18. Demo 2, Ground,
and Demo 1

terminals

17. Analog
channel
inputs

19. USB
Host
ports

15. [Help] key

13. File keys

8. Run Control keys

12. Measure controls

11. Additional
waveform controls

7. Horizontal controls

10. [Auto Scale] key

9. [Default Setup] key

16. Vertical controls

21. Waveform
generator
outputs

20. EXT TRIG IN
connector

1. Power switch Press once to switch power on; press again to switch power off. See 
“Power-On the Oscilloscope" on page 32.

2. Softkeys The functions of these keys change based upon the menus shown on the 
display directly above the keys.

The Back/Up key moves up in the softkey menu hierarchy. At the 

top of the hierarchy, the Back/Up key turns the menus off, and 
oscilloscope information is shown instead.

3. [Intensity] key Press the key to illuminate it. When illuminated, turn the Entry knob to 
adjust waveform intensity.
You can vary the intensity control to bring out signal detail, much like an 
analog oscilloscope.
Digital channel waveform intensity is not adjustable.
More details about using the Intensity control to view signal detail are on 
“To adjust waveform intensity" on page 151.

Back

Back
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4. Entry knob The Entry knob is used to select items from menus and to change values. 
The function of the Entry knob changes based upon the current menu 
and softkey selections.

Note that the curved arrow symbol above the entry knob 
illuminates whenever the entry knob can be used to select a value. Also, 

note that when the Entry knob symbol appears on a softkey, you 
can use the Entry knob, to select values.
Often, rotating the Entry knob is enough to make a selection. Sometimes, 
you can push the Entry knob to enable or disable a selection. Pushing the 
Entry knob also makes popup menus disappear.

5. Waveform keys [Analyze] key — Press this key to access analysis features like:
• Trigger level setting.
• Measurement threshold setting.
• Video trigger automatic set up and display.
• The DSOX4USBSQ USB 2.0 signal quality analysis application.
• Mask testing (see Chapter 15, “Mask Testing,” starting on page 271).
• The DSOX4PWR power measurement and analysis application.
• Digital voltmeter (DVM) (see Chapter 16, “Digital Voltmeter,” starting 

on page 283).
The [Acquire] key lets you select Normal, Peak Detect, Averaging, or 
High Resolution acquisition modes (see “Selecting the Acquisition 
Mode" on page 219) and use segmented memory (see “Acquiring to 
Segmented Memory" on page 228).
The [Display] key lets you access the menu where you can enable 
persistence (see “To set or clear persistence" on page 153), clear the 
display, and adjust the display grid (graticule) intensity (see “To adjust 
the grid intensity" on page 155).
[Touch] key — Press this key to disable/enable the touchscreen.

6. Trigger controls These controls determine how the oscilloscope triggers to capture data. 
See Chapter 10, “Triggers,” starting on page 167 and Chapter 11, “Trigger 
Mode/Coupling,” starting on page 205.
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7. Horizontal 
controls

The Horizontal controls consist of:
• Horizontal scale knob — Turn the knob in the Horizontal section that 

is marked  to adjust the time/div (sweep speed) setting. 
The symbols under the knob indicate that this control has the effect of 
spreading out or zooming in on the waveform using the horizontal 
scale.

• Horizontal position knob — Turn the knob marked  to pan through 
the waveform data horizontally. You can see the captured waveform 
before the trigger (turn the knob clockwise) or after the trigger (turn 
the knob counterclockwise). If you pan through the waveform when 
the oscilloscope is stopped (not in Run mode) then you are looking at 
the waveform data from the last acquisition taken.

• [Horiz] key — Press this key to open the Horizontal Menu where you 
can select XY and Roll modes, enable or disable Zoom, enable or 
disable horizontal time/division fine adjustment, and select the 
trigger time reference point.

• Zoom  key — Press the  zoom key to split the oscilloscope 
display into Normal and Zoom sections without opening the 
Horizontal Menu.

• [Search] key — Lets you search for events in the acquired data.
• [Navigate] keys — Press these keys to navigate through captured 

data via time, search events, or segmented memory acquisition. See 
“Navigating the Time Base" on page 77.

For more information see Chapter 2, “Horizontal Controls,” starting on 
page 65.

8. Run Control 
keys

When the [Run/Stop] key is green, the oscilloscope is running, that is, 
acquiring data when trigger conditions are met. To stop acquiring data, 
press [Run/Stop].
When the [Run/Stop] key is red, data acquisition is stopped. To start 
acquiring data, press [Run/Stop].
To capture and display a single acquisition (whether the oscilloscope is 
running or stopped), press [Single]. The [Single] key is yellow until the 
oscilloscope triggers.
For more information, see “Running, Stopping, and Making Single 
Acquisitions (Run Control)" on page 213.

9. [Default Setup] 
key

Press this key to restore the oscilloscope's default settings (details on 
“Recall the Default Oscilloscope Setup" on page 35).
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10. [Auto Scale] 
key

When you press the [AutoScale] key, the oscilloscope will quickly 
determine which channels have activity, and it will turn these channels 
on and scale them to display the input signals. See “Use Auto Scale" on 
page 35.

11. Additional 
waveform 
controls

The additional waveform controls consist of:
• [Math] key — provides access to math (add, subtract, etc.) waveform 

functions. See Chapter 4, “Math Waveforms,” starting on page 91.
• [Ref] key — provides access to reference waveform functions. 

Reference waveforms are saved waveforms that can be displayed and 
compared against other analog channel or math waveforms. Also, 
measurements can be made on reference waveforms. See Chapter 5, 
“Reference Waveforms,” starting on page 121.

• [Digital] key — Press this key to turn the digital channels on or off 
(the arrow to the left will illuminate).
When the arrow to the left of the [Digital] key is illuminated, the 
upper multiplexed knob selects (and highlights in red) individual 
digital channels, and the lower multiplexed knob positions the 
selected digital channel.
If a trace is repositioned over an existing trace the indicator at the left 
edge of the trace will change from Dnn designation (where nn is a one 
or two digit channel number from 0 to 15) to D*. The "*" indicates that 
two or more channels are overlaid.
You can rotate the upper knob to select an overlaid channel, then 
rotate the lower knob to position it just as you would any other 
channel.
For more information on digital channels see Chapter 6, “Digital 
Channels,” starting on page 125.

• [Serial] key — This key is used to enable serial decode. The 
multiplexed scale and position knobs are not used with serial decode. 
For more information on serial decode, see Chapter 7, “Serial 
Decode,” starting on page 145.

• Multiplexed scale knob — This scale knob is used with Math, Ref, or 
Digital waveforms, whichever has the illuminated arrow to the left. 
For math and reference waveforms, the scale knob acts like an analog 
channel vertical scale knob.

• Multiplexed position knob — This position knob is used with Math, 
Ref, or Digital waveforms, whichever has the illuminated arrow to the 
left. For math and reference waveforms, the position knob acts like an 
analog channel vertical position knob.
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12. Measure 
controls

The measure controls consist of:
• Cursors knob — Push this knob to select cursors from a popup menu. 

Then, after the popup menu closes (either by timeout or by pushing 
the knob again), rotate the knob to adjust the selected cursor 
position.

• [Cursors] key — Press this key to open a menu that lets you select 
the cursors mode and source.

• [Meas] key — Press this key to access a set of predefined 
measurements. See Chapter 14, “Measurements,” starting on page 
241.

13. File keys Press the [Save/Recall] key to save or recall a waveform or setup. See 
Chapter 18, “Save/Email/Recall (Setups, Screens, Data),” starting on 
page 309.
The [Print] key opens the Print Configuration Menu so you can print the 
displayed waveforms. See Chapter 19, “Print (Screens),” starting on page 
323.

14. Tools keys The Tools keys consist of:
• [Utility] key — Press this key to access the Utility Menu, which lets 

you configure the oscilloscope's I/O settings, use the file explorer, set 
preferences, access the service menu, and choose other options. See 
Chapter 20, “Utility Settings,” starting on page 329.

• [Quick Action] key — Press this key to perform the selected quick 
action: measure all snapshot, print, save, recall, freeze display, and 
more. See “Configuring the [Quick Action] Key" on page 347.

• [Wave Gen1], [Wave Gen2] keys — Press these keys to access 
waveform generator functions. See Chapter 17, “Waveform 
Generator,” starting on page 287.

15. [Help] key Opens the Help Menu where you can display overview help topics and 
select the Language. See also “Access the Built-In Quick Help" on 
page 62.
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16. Vertical 
controls

The Vertical controls consist of:
• Analog channel on/off keys — Use these keys to switch a channel on 

or off, or to access a channel's menu in the softkeys. There is one 
channel on/off key for each analog channel.

• Vertical scale knob — There are knobs marked  for each 
channel. Use these knobs to change the vertical sensitivity (gain) of 
each analog channel.

• Vertical position knobs — Use these knobs to change a channel's 
vertical position on the display. There is one Vertical Position control 
for each analog channel.

• [Label] key — Press this key to access the Label Menu, which lets 
you enter labels to identify each trace on the oscilloscope display. See 
Chapter 9, “Labels,” starting on page 159.

For more information, see Chapter 3, “Vertical Controls,” starting on 
page 81.

17. Analog channel 
inputs

Attach oscilloscope probes or BNC cables to these BNC connectors.
With the InfiniiVision 4000 X-Series oscilloscopes, you can set the input 
impedance of the analog channels to either 50 Ω or 1 MΩ. See “To 
specify channel input impedance" on page 85.
The InfiniiVision 4000 X-Series oscilloscopes also provide the AutoProbe 
interface. The AutoProbe interface uses a series of contacts directly 
below the channel's BNC connector to transfer information between the 
oscilloscope and the probe. When you connect a compatible probe to the 
oscilloscope, the AutoProbe interface determines the type of probe and 
sets the oscilloscope's parameters (units, offset, attenuation, coupling, 
and impedance) accordingly.

18. Demo 2, 
Ground, and 
Demo 1 
terminals

• Demo 2 terminal — This terminal outputs the Probe Comp signal 
which helps you match a probe's input capacitance to the 
oscilloscope channel to which it is connected. See “Compensate 
Passive Probes" on page 37. With certain licensed features, the 
oscilloscope can also output demo or training signals on this terminal.

• Ground terminal — Use the ground terminal for oscilloscope probes 
connected to the Demo 1 or Demo 2 terminals.

• Demo 1 terminal — With certain licensed features, the oscilloscope 
can output demo or training signals on this terminal.
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Front Panel Overlays for Different Languages

Front panel overlays, which have translations for the English front panel 
keys and label text, are available in 10 languages. The appropriate overlay 
is included when the localization option is chosen at time of purchase.

To install a front panel overlay:

1 Gently pull on the front panel knobs to remove them.

2 Insert the overlay's side tabs into the slots on the front panel.

19. USB Host ports These ports are for connecting a USB mass storage device, printer, 
mouse, or keyboard to the oscilloscope.
Connect a USB compliant mass storage device (flash drive, disk drive, 
etc.) to save or recall oscilloscope setup files and reference waveforms 
or to save data and screen images. See Chapter 18, “Save/Email/Recall 
(Setups, Screens, Data),” starting on page 309.
To print, connect a USB compliant printer. For more information about 
printing see Chapter 19, “Print (Screens),” starting on page 323.
You can also use the USB port to update the oscilloscope's system 
software when updates are available.
You do not need to take special precautions before removing the USB 
mass storage device from the oscilloscope (you do not need to "eject" 
it). Simply unplug the USB mass storage device from the oscilloscope 
when the file operation is complete.

CAUTION: Do not connect a host computer to the oscilloscope's 
USB host port. Use the device port. A host computer sees the 
oscilloscope as a device, so connect the host computer to the 
oscilloscope's device port (on the rear panel). See “I/O Interface 
Settings" on page 329.
There is a third USB host port on the back panel.

20. EXT TRIG IN 
connector

External trigger input BNC connector. See “External Trigger Input" on 
page 210 for an explanation of this feature.

21. Waveform 
generator 
outputs

Built-in, license-enabled 2-channel waveform generator can output 
arbitrary, sine, square, ramp, pulse, DC, noise, sine cardinal, exponential 
rise, exponential fall, cardiac, or Gaussian pulse waveforms on the 
Gen Out 1 or Gen Out 2 BNC connectors. Modulated waveforms are 
available on WaveGen1 except for arbitrary, pulse, DC, and noise 
waveforms. Press the [Wave Gen1] or [Wave Gen2] keys to set up the 
waveform generator. See Chapter 17, “Waveform Generator,” starting on 
page 287.
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3 Reinstall the front panel knobs.

Front panel overlays may be ordered from "www.parts.agilent.com" using 
the following part numbers:

Language 2 Channel Overlay 4 Channel Overlay

French 54709-94315 54709-94316

German 54709-94313 54709-94314

Italian 54709-94317 54709-94318

Japanese 54709-94321 54709-94322

Korean 54709-94311 54709-94312

Portuguese 54709-94323 54709-94324

Russian 54709-94325 54709-94326

Simplified Chinese 54709-94306 54709-94308

Spanish 54709-94319 54709-94320

Traditional Chinese 54709-94309 54709-94310

http://www.parts.agilent.com
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Learn the Touchscreen Controls

When the [Touch] key is lit, you can control the oscilloscope by touching 
different areas of the screen. You can:

• “Draw Rectangles for Waveform Zoom or Zone Trigger Set Up" on 
page 47

• “Drag Waveforms Left and Right to Change the Horizontal Position" on 
page 48

• “Select Sidebar Information or Controls" on page 49

• “Undock Sidebar Dialogs by Dragging" on page 50

• “Select Dialog Menus and Close Dialogs" on page 51

• “Drag Cursors" on page 51

• “Touch Softkeys and Menus On the Screen" on page 51

• “Enter Names Using Alpha- Numeric Keypad Dialogs" on page 52

• “Change Waveform Offsets By Dragging Ground Reference Icons" on 
page 53

• “Access Controls and Menus Via the Spark Icon" on page 54

• “Turn Channels On/Off and Open Scale/Offset Dialogs" on page 56

• “Access the Horizontal Menu and Open the Scale/Delay Dialog" on 
page 56

• “Access the Trigger Menu, Change the Trigger Mode, and Open the 
Trigger Level Dialog" on page 57

• “Use a USB Mouse and/or Keyboard for Touchscreen Controls" on 
page 58

Draw Rectangles for Waveform Zoom or Zone Trigger Set Up

1 Touch the upper- right corner to select the rectangle draw mode.
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2 Drag your finger across the screen to draw a rectangle.

3 Take your finger off the screen.

4 Touch the desired option from the popup menu.

Drag Waveforms Left and Right to Change the Horizontal Position

1 Touch the upper- right corner to select the horizontal drag mode.
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2 Drag your finger across the screen to change the horizontal delay.

Select Sidebar Information or Controls

1 Touch the blue menu icon in the sidebar.

2 In the popup menu, touch the type of information or controls you want 
to see in the sidebar.
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Sidebar dialogs can be undocked and placed anywhere on the screen.

1 Drag the sidebar dialog title wherever you like.

This lets you view multiple types of information or controls at the same 
time.



Getting Started 1

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 51

 

Select Dialog Menus and Close Dialogs

• Touch the blue menu icon in the dialog for options.

• Touch the red "X" icon to close a dialog.

Drag Cursors

When cursors are displayed, you can drag the name handles to position 
them.

Touch Softkeys and Menus On the Screen

• Touch onscreen softkey labels to select them.
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This is the same as pressing the softkey keys.

• When softkeys provide menus, double- touch to select a menu item.

This may be an easier than selecting a menu item via the  Entry 
knob.

Enter Names Using Alpha-Numeric Keypad Dialogs

Some softkeys open alpha- numeric dialogs that let you touch to enter 
names.
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Change Waveform Offsets By Dragging Ground Reference Icons

You can drag ground icons to change a waveform's vertical offset.



54 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

1 Getting Started
 

Access Controls and Menus Via the Spark Icon

1 Touch the upper- left spark icon to open the main menu.

2 Touch left side controls to perform oscilloscope operations.
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3 Touch menu items and submenu items to access menus and additional 
controls.
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Turn Channels On/Off and Open Scale/Offset Dialogs

• Touch channel numbers to turn them on or off.

• When channels are on, touch the scale and offset values to access a 
dialog for changing them.

Access the Horizontal Menu and Open the Scale/Delay Dialog

• Touch "H" to access the Horizontal Menu.

• Touch the horizontal scale and delay values to access a dialog for 
changing them.
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Access the Trigger Menu, Change the Trigger Mode, and Open the Trigger 
Level Dialog

• Touch "T" to access the Trigger Menu.

• Touch the trigger level value(s) to access a dialog for changing the 
level(s).

• Touch "Auto" or "Trig'd" to quickly toggle the trigger mode.
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Use a USB Mouse and/or Keyboard for Touchscreen Controls

Connecting a USB mouse gives you a mouse pointer on the display. Mouse 
clicks and drags behave the same as screen touches and finger drags.

If you connect a USB keyboard, you can use it to enter values in 
alpha- numeric keypad dialogs.

Learn the Rear Panel Connectors

For the following figure, refer to the numbered descriptions in the table 
that follows.
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1. Power cord 
connector

Attach the power cord here.

2. Kensington 
lock hole

This is where you can attach a Kensington lock for securing the 
instrument.

3. TRIG OUT 
connector

Trigger output BNC connector. See “Setting the Rear Panel TRIG OUT 
Source" on page 339.

4. 10 MHz REF 
connector

For synchronizing the timebase of multiple instruments. See “Setting the 
Reference Signal Mode" on page 339.

5. Calibration 
protect switch

See “To perform user calibration" on page 342.

9. USB Device port

8. USB Host port

1. Power cord connector

2. Kensington lock hole

3. TRIG OUT connector

5. Calibration protect switch

4. 10 MHz REF connector

6. Digital channel inputs

7. VGA Video Out

10. LAN port
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Learn the Oscilloscope Display

The oscilloscope display contains acquired waveforms, setup information, 
measurement results, and the softkey definitions.

6. Digital channel 
inputs

Connect the digital probe cable to this connector (MSO models only). See 
Chapter 6, “Digital Channels,” starting on page 125.

7. VGA video 
output

Lets you connect an external monitor or projector to provide a larger 
display or to provide a display at a viewing position away from the 
oscilloscope.
The oscilloscope's built-in display remains on even when an external 
display is connected. The video output connector is always active.
For optimal video quality and performance, we recommend you use a 
shielded video cable with ferrite cores.

8. USB Host port This port functions identically to the USB host port on the front panel. 
USB Host Port is used for saving data from the oscilloscope and loading 
software updates. See also USB Host port (see page 45).

9. USB Device 
port

This port is for connecting the oscilloscope to a host PC. You can issue 
remote commands from a host PC to the oscilloscope via the USB device 
port. See “Remote Programming with Agilent IO Libraries" on page 356.

10. LAN port Lets you print to network printers (see Chapter 19, “Print (Screens),” 
starting on page 323) and access the oscilloscope's built-in web server. 
See Chapter 21, “Web Interface,” starting on page 349 and “Accessing 
the Web Interface" on page 350.
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Figure 1 Interpreting the oscilloscope display

Status line The top line of the display contains vertical, horizontal, and trigger setup 
information.

Display area The display area contains the waveform acquisitions, channel identifiers, and 
analog trigger, and ground level indicators. Each analog channel's information 
appears in a different color.
Signal detail is displayed using 256 levels of intensity. For more information 
about viewing signal detail see “To adjust waveform intensity" on page 151.
For more information about display modes see Chapter 8, “Display Settings,” 
starting on page 151.
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Access the Built-In Quick Help

To view Quick
Help

1 Press and hold the key or softkey for which you would like to view 
help.

Sidebar 
information and 
controls area

The sidebar information area can contain summary, cursors, measurements, 
or digital voltmeter information dialogs or it can contain navigation and other 
control dialogs.
For more information, see:
• “Select Sidebar Information or Controls" on page 49
• “Undock Sidebar Dialogs by Dragging" on page 50

Menu line This line normally contains menu name or other information associated with 
the selected menu.

Softkey labels These labels describe softkey functions. Typically, softkeys let you set up 
additional parameters for the selected mode or menu.

Pressing the Back/Up key at the top of the menu hierarchy turns off 
softkey labels and displays additional status information describing channel 
offset and other configuration parameters.

Back
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Quick Help remains on the screen until another key is pressed or a knob 
is turned.

To select the user
interface and

Quick Help
language

To select the user interface and Quick Help language:

1 Press [Help], then press the Language softkey.

2 Repeatedly press and release the Language softkey or rotate the Entry 
knob until the desired language is selected.

The following languages are available: English, French, German, Italian, 
Japanese, Korean, Portuguese, Russian, Simplified Chinese, Spanish, and 
Traditional Chinese.

Quick Help
message

Press and hold front panel key or softkey
(or right-click softkey when using web browser remote front panel).
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To adjust the horizontal (time/div) scale 67

To adjust the horizontal delay (position) 67

Panning and Zooming Single or Stopped Acquisitions 68

To change the horizontal time mode (Normal, XY, or Roll) 69

To display the zoomed time base 73

To change the horizontal scale knob's coarse/fine adjustment setting 75

To position the time reference (left, center, right) 75

Searching for Events 76

Navigating the Time Base 77

The horizontal controls include:

• The horizontal scale and position knobs.

• The [Horiz] key for accessing the Horizontal Menu.

• The  zoom key for quickly enabling/disabling the split- screen zoom 
display.

• The [Search] key for finding events on analog channels or in serial 
decode.

• The [Navigate] keys for navigating time, search events, or segmented 
memory acquisitions.

• Touchscreen controls for setting the horizontal scale and position 
(delay), accessing the Horizontal Menu, and navigating.

The following figure shows the Horizontal Menu which appears after 
pressing the [Horiz] key.
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The Horizontal Menu lets you select the time mode (Normal, XY, or Roll), 
enable Zoom, set the time base fine control (vernier), and specify the time 
reference.

The current sample rate is displayed in the right- side information area.

Figure 2 Horizontal Menu
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To adjust the horizontal (time/div) scale

1 Turn the large horizontal scale (sweep speed) knob marked  to 
change the horizontal time/div setting.

You can also make this adjustment using the touchscreen. See "Access 
the Horizontal Menu and Open the Scale/Delay Dialog" on page 56.

Notice how the time/div information in the status line changes.

The ∇ symbol at the top of the display indicates the time reference point.

The horizontal scale knob works (in the Normal time mode) while 
acquisitions are running or when they are stopped. When running, 
adjusting the horizontal scale knob changes the sample rate. When 
stopped, adjusting the horizontal scale knob lets you zoom into acquired 
data. See "Panning and Zooming Single or Stopped Acquisitions" on 
page 68.

Note that the horizontal scale knob has a different purpose in the Zoom 
display. See "To display the zoomed time base" on page 73.

To adjust the horizontal delay (position)

1 Turn the horizontal delay (position) knob ( ).

The trigger point moves horizontally, pausing at 0.00 s (mimicking a 
mechanical detent), and the delay value is displayed in the status line.

You can also make this adjustment using the touchscreen. See "Drag 
Waveforms Left and Right to Change the Horizontal Position" on 
page 48 and "Access the Horizontal Menu and Open the Scale/Delay 
Dialog" on page 56.

Changing the delay time moves the trigger point (solid inverted triangle) 
horizontally and indicates how far it is from the time reference point 
(hollow inverted triangle ∇). These reference points are indicated along 
the top of the display grid.
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Figure 2 shows the trigger point with the delay time set to 200 µs. The 
delay time number tells you how far the time reference point is located 
from the trigger point. When delay time is set to zero, the delay time 
indicator overlays the time reference indicator.

All events displayed left of the trigger point happened before the trigger 
occurred. These events are called pre- trigger information, and they show 
events that led up to the trigger point.

Everything to the right of the trigger point is called post- trigger 
information. The amount of delay range (pre- trigger and post- trigger 
information) available depends on the time/div selected and memory 
depth.

The horizontal position knob works (in the Normal time mode) while 
acquisitions are running or when they are stopped. When running, 
adjusting the horizontal scale knob changes the sample rate. When 
stopped, adjusting the horizontal scale knob lets you zoom into acquired 
data. See "Panning and Zooming Single or Stopped Acquisitions" on 
page 68.

Note that the horizontal position knob has a different purpose in the 
Zoom display. See "To display the zoomed time base" on page 73.

Panning and Zooming Single or Stopped Acquisitions

When the oscilloscope is stopped, use the horizontal scale and position 
knobs to pan and zoom your waveform. The stopped display may contain 
several acquisitions worth of information, but only the last acquisition is 
available for pan and zoom.

The ability to pan (move horizontally) and scale (expand or compress 
horizontally) an acquired waveform is important because of the additional 
insight it can reveal about the captured waveform. This additional insight 
is often gained from seeing the waveform at different levels of abstraction. 
You may want to view both the big picture and the specific little picture 
details.

The ability to examine waveform detail after the waveform has been 
acquired is a benefit generally associated with digital oscilloscopes. Often 
this is simply the ability to freeze the display for the purpose of 
measuring with cursors or printing the screen. Some digital oscilloscopes 
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go one step further by including the ability to further examine the signal 
details after acquiring them by panning through the waveform and 
changing the horizontal scale.

There is no limit imposed on the scaling ratio between the time/div used 
to acquire the data and the time/div used to view the data. There is, 
however, a useful limit. This useful limit is somewhat a function of the 
signal you are analyzing.

To change the horizontal time mode (Normal, XY, or Roll)

1 Press [Horiz].

2 In the Horizontal Menu, press Time Mode; then, select:

• Normal — the normal viewing mode for the oscilloscope.

In the Normal time mode, signal events occurring before the trigger 
are plotted to the left of the trigger point (▼) and signal events after 
the trigger plotted to the right of the trigger point.

• XY — XY mode changes the display from a volts- versus- time display 
to a volts- versus- volts display. The time base is turned off. Channel 1 
amplitude is plotted on the X- axis and Channel 2 amplitude is 
plotted on the Y- axis.

You can use XY mode to compare frequency and phase relationships 
between two signals. XY mode can also be used with transducers to 
display strain versus displacement, flow versus pressure, volts versus 
current, or voltage versus frequency.

Use the cursors to make measurements on XY mode waveforms.

For more information about using XY mode for measurements, refer 
to "XY Time Mode" on page 70.

NOTE Zooming into stopped acquisitions

The screen will still contain a relatively good display if you zoom-in horizontally by a factor 
of 1000 and zoom-in vertically by a factor of 10 to display the information from where it was 
acquired. Remember that you can only make automatic measurements on displayed data.
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• Roll — causes the waveform to move slowly across the screen from 
right to left. It only operates on time base settings of 50 ms/div and 
slower. If the current time base setting is faster than the 50 ms/div 
limit, it will be set to 50 ms/div when Roll mode is entered.

In Roll mode there is no trigger. The fixed reference point on the 
screen is the right edge of the screen and refers to the current 
moment in time. Events that have occurred are scrolled to the left of 
the reference point. Since there is no trigger, no pre- trigger 
information is available.

If you would like to pause the display in Roll mode press the [Single] 
key. To clear the display and restart an acquisition in Roll mode, 
press the [Single] key again.

Use Roll mode on low- frequency waveforms to yield a display much 
like a strip chart recorder. It allows the waveform to roll across the 
display.

XY Time Mode

The XY time mode converts the oscilloscope from a volts- versus- time 
display to a volts- versus- volts display using two input channels. Channel 1 
is the X- axis input, channel 2 is the Y- axis input. You can use various 
transducers so the display could show strain versus displacement, flow 
versus pressure, volts versus current, or voltage versus frequency.

Example This exercise shows a common use of the XY display mode by measuring 
the phase difference between two signals of the same frequency with the 
Lissajous method.

1 Connect a sine wave signal to channel 1, and a sine wave signal of the 
same frequency but out of phase to channel 2.

2 Press the [AutoScale] key, press the [Horiz] key; then, press Time Mode 
and select "XY".

3 Center the signal on the display with the channel 1 and 2 position ( ) 
knobs. Use the channel 1 and 2 volts/div knobs and the channel 1 and 
2 Fine softkeys to expand the signal for convenient viewing.

The phase difference angle (θ) can be calculated using the following 
formula (assuming the amplitude is the same on both channels):
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 4 Press the [Cursors] key.

5 Set the Y2 cursor to the top of the signal, and set Y1 to the bottom of 
the signal.

Note the ΔY value at the bottom of the display. In this example, we are 
using the Y cursors, but you could have used the X cursors instead.

6 Move the Y1 and Y2 cursors to the intersection of the signal and the Y 
axis. Again, note the ΔY value.

Figure 3 XY time mode signals, centered on display
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7 Calculate the phase difference using the formula below.

For example, if the first ΔY value is 2.297 and the second ΔY value is 
1.319:

Figure 4 Phase difference measurements, automatic and using cursors

sinθ = second ΔY
first ΔY = 1.319

2.297; θ = 35.05 degrees of phase shift
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To display the zoomed time base

Zoom, formerly called Delayed sweep mode, is a horizontally expanded 
version of the normal display. When Zoom is selected, the display divides 
in half. The top half of the display shows the normal time/div window and 
the bottom half displays a faster Zoom time/div window.

The Zoom window is a magnified portion of the normal time/div window. 
You can use Zoom to locate and horizontally expand part of the normal 
window for a more detailed (higher- resolution) analysis of signals.

To turn on (or off) Zoom:

1 Press the  zoom key (or press the [Horiz] key and then the Zoom 
softkey).

NOTE Z-Axis Input in XY Display Mode (Blanking)

When you select the XY display mode, the time base is turned off. Channel 1 is the X-axis 
input, channel 2 is the Y-axis input, and the EXT TRIG IN is the Z-axis input. If you only want 
to see portions of the Y versus X display, use the Z-axis input. Z-axis turns the trace on and 
off (analog oscilloscopes called this Z-axis blanking because it turned the beam on and off). 
When Z is low (<1.4 V), Y versus X is displayed; when Z is high (>1.4 V), the trace is turned 
off.
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The area of the normal display that is expanded is outlined with a box 
and the rest of the normal display is ghosted. The box shows the portion 
of the normal sweep that is expanded in the lower half.

To change the time/div for the Zoom window, turn the horizontal scale 
(sweep speed) knob. As you turn the knob, the zoomed window time/div 
is highlighted in the status line above the waveform display area. The 
Horizontal scale (sweep speed) knob controls the size of the box.

The Horizontal position (delay time) knob sets the left- to- right position of 
the zoom window. The delay value, which is the time displayed relative to 
the trigger point) is momentarily displayed in the upper- right portion of 
the display when the delay time ( ) knob is turned.

These markers show the
beginning and end of the
Zoom window

Normal
window

Time/div
for zoomed
window

Time/div
for normal
window

Delay time 
momentarily displays
when the Horizontal
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Negative delay values indicate you're looking at a portion of the waveform 
before the trigger event, and positive values indicate you're looking at the 
waveform after the trigger event.

To change the time/div of the normal window, turn off Zoom; then, turn 
the horizontal scale (sweep speed) knob.

For information about using zoom mode for measurements, refer to "To 
isolate a pulse for Top measurement" on page 250 and "To isolate an event 
for frequency measurement" on page 257.

To change the horizontal scale knob's coarse/fine adjustment setting

1 Push the horizontal scale knob (or press [Horiz] > Fine) to toggle between 
fine and coarse adjustment of the horizontal scale.

When Fine is enabled, turning the horizontal scale knob changes the 
time/div (displayed in the status line at the top of the display) in smaller 
increments. The time/div remains fully calibrated when Fine is on.

When Fine is turned off, the Horizontal scale knob changes the time/div 
setting in a 1- 2- 5 step sequence.

To position the time reference (left, center, right)

Time reference is the reference point on the display for delay time 
(horizontal position).

1 Press [Horiz].

2 In the Horizontal Menu, press Time Ref; then, select:

• Left — the time reference is set to one major division from the left 
edge of the display.

• Center — the time reference is set to the center of the display.

• Right — the time reference is set to one major division from the right 
edge of the display.

A small hollow triangle (∇) at the top of the display grid marks the 
position of the time reference. When delay time is set to zero, the trigger 
point indicator (▼) overlays the time reference indicator.
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The time reference position sets the initial position of the trigger event 
within acquisition memory and on the display, with delay set to 0.

Turning the Horizontal scale (sweep speed) knob expands or contracts the 
waveform about the time reference point (∇). See "To adjust the horizontal 
(time/div) scale" on page 67.

Turning the Horizontal position ( ) knob in Normal mode (not Zoom) 
moves the trigger point indicator (▼) to the left or right of the time 
reference point (∇). See "To adjust the horizontal delay (position)" on 
page 67.

Searching for Events

You can use the [Search] key and menu to search for Edge, Pulse Width, 
Rise/Fall Time, Runt, and Serial events on the analog channels.

Setting up searches (see "To set up searches" on page 76) is similar to 
setting up triggers. In fact, except for Serial events, you can copy search 
setups to trigger setups and vice- versa (see "To copy search setups" on 
page 77).

Searches are different than triggers in that they use the measurement 
threshold settings instead of trigger levels.

Found search events are marked with white triangles at the top of the 
graticule, and the number of events found is displayed in the menu line 
just above the softkey labels.

To set up searches

1 Press [Search].

2 In the Search Menu, press Search; then, turn the Entry knob to select 
the search type.

3 Press Settings, and use the Search Settings Menu to set up the selected 
search type.

Setting up searches is similar to setting up triggers:

• For setting up Edge searches, see "Edge Trigger" on page 170.
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• For setting up Pulse Width searches, see "Pulse Width Trigger" on 
page 174.

• For setting up Rise/Fall Time searches, see "Rise/Fall Time 
Trigger" on page 182.

• For setting up Runt searches, see "Runt Trigger" on page 185.

• For setting up Serial searches, see Chapter 10, “Triggers,” starting on 
page 167 and "Searching Lister Data" on page 148.

Remember that searches use the measurement threshold settings instead 
of trigger levels. Use the Thresholds softkey in the Search Menu to access 
the Measurement Threshold Menu. See "Measurement Thresholds" on 
page 266.

To copy search setups

Except for Serial event search setups, you can copy search setups to 
trigger setups and vice- versa.

1 Press [Search].

2 In the Search Menu, press Search; then, turn the Entry knob to select 
the search type.

3 Press Copy.

4 In the Search Copy Menu:

• Press Copy to Trigger to copy the setup for the selected search type to 
the same trigger type. For example, if the current search type is 
Pulse Width, pressing Copy to Trigger copies the search settings to the 
Pulse Width trigger settings and selects the Pulse Width trigger.

• Press Copy from Trigger to copy the trigger setup for the selected search 
type to the search setup.

• To undo a copy, press Undo Copy.

The softkeys in the Search Copy Menu may not be available when one 
of the settings cannot be copied or there is no trigger type that 
corresponds to the search type.

Navigating the Time Base

You can use the [Navigate] key and controls to navigate through:
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• Captured data (see "To navigate time" on page 78).

• Search events (see "To navigate search events" on page 78).

• Segments, when segmented memory acquisitions are turned on (see "To 
navigate segments" on page 79).

You can also access navigation controls on the touchscreen. See "Select 
Sidebar Information or Controls" on page 49.

To navigate time

When acquisitions are stopped, you can use the navigation controls to play 
through the captured data.

1 Press [Navigate].

2 In the Navigate Menu, press Navigate; then, select Time.

3 Press the  navigation keys to play backward, stop, or play 

forward in time. You can press the  or  keys multiple times to 
speed up the playback. There are three speed levels.

You can also access navigation controls on the touchscreen. See "Select 
Sidebar Information or Controls" on page 49.

To navigate search events

When acquisitions are stopped, you can use the navigation controls to go 
to found search events (set using the [Search] key and menu, see 
"Searching for Events" on page 76).

1 Press [Navigate].

2 In the Navigate Menu, press Navigate; then, select Search.

3 Press the  back and forward keys to go to the previous or next 
search event.

When searching Serial decode:

• You can press the  stop key to set or clear a mark.

• The Auto zoom softkey specifies whether the waveform display is 
automatically zoomed to fit the marked row as you navigate.
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• Pressing the Scroll Lister softkey lets you use the Entry knob to scroll 
through data rows in the Lister display.

You can also access navigation controls on the touchscreen. See "Select 
Sidebar Information or Controls" on page 49.

To navigate segments

When the segmented memory acquisition is enabled and acquisitions are 
stopped, you can use the navigation controls to play through the acquired 
segments.

1 Press [Navigate].

2 In the Navigate Menu, press Navigate; then, select Segments.

3 Press Play Mode; then, select:

• Manual — to play through segments manually.

In the Manual play mode:

• Press the  back and forward keys to go to the previous or 
next segment.

• Press the  softkey to go to the first segment.

• Press the  softkey to go to the last segment.

• Auto — to play through segments in an automated fashion.

In the Auto play mode:

• Press the  navigation keys to play backward, stop, or 

play forward in time. You can press the  or  keys multiple 
times to speed up the playback. There are three speed levels.

You can also access navigation controls on the touchscreen. See "Select 
Sidebar Information or Controls" on page 49.
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To turn waveforms on or off (channel or math) 82

To adjust the vertical scale 83

To adjust the vertical position 83

To specify channel coupling 84

To specify channel input impedance 85

To specify bandwidth limiting 85

To change the vertical scale knob's coarse/fine adjustment setting 86

To invert a waveform 86

Setting Analog Channel Probe Options 87

The vertical controls include:

• The vertical scale and position knobs for each analog channel.

• The channel keys for turning a channel on or off and accessing the 
channel's softkey menu.

• Touchscreen controls for setting the vertical scale and position (offset) 
and accessing the Channel menus.

The following figure shows the Channel 1 Menu that appears after 
pressing the [1] channel key.
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The ground level of the signal for each displayed analog channel is 

identified by the position of the  icon at the far- left side of the display.

To turn waveforms on or off (channel or math)

1 Press an analog channel key turn the channel on or off (and to display 
the channel's menu).

When a channel is on, its key is illuminated.

You can also do this using the touchscreen. See "Turn Channels On/Off 
and Open Scale/Offset Dialogs" on page 56.

Channel,
Volts/div

Channel 1
ground
level

Trigger
source

Trigger level
or threshold 

Channel 2
ground
level
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To adjust the vertical scale

1 Turn the large knob above the channel key marked  to set the 
vertical scale (volts/division) for the channel.

You can also do this using the touchscreen. See "Turn Channels On/Off 
and Open Scale/Offset Dialogs" on page 56.

The vertical scale knob changes the analog channel scale in a 1- 2- 5 step 
sequence (with a 1:1 probe attached) unless fine adjustment is enabled 
(see "To change the vertical scale knob's coarse/fine adjustment setting" on 
page 86).

The analog channel Volts/Div value is displayed in the status line.

The default mode for expanding the signal when you turn the 
volts/division knob is vertical expansion about the ground level of the 
channel; however, you can change this to expand about the center of the 
display. See "To choose "expand about" center or ground" on page 335.

To adjust the vertical position

1 Turn the small vertical position knob ( ) to move the channel's 
waveform up or down on the display.

You can also make this adjustment using the touchscreen. See "Change 
Waveform Offsets By Dragging Ground Reference Icons" on page 53 and 
"Turn Channels On/Off and Open Scale/Offset Dialogs" on page 56.

NOTE Turning channels off

You must be viewing the menu for a channel before you can turn it off. For example, if 
channel 1 and channel 2 are turned on and the menu for channel 2 is being displayed, to 
turn channel 1 off, press [1] to display the channel 1 menu; then, press [1] again to turn 
channel 1 off.
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The offset voltage value represents the voltage difference between the 

vertical center of the display and the ground level ( ) icon. It also 
represents the voltage at the vertical center of the display if vertical 
expansion is set to expand about ground (see "To choose "expand about" 
center or ground" on page 335).

To specify channel coupling

Coupling changes the channel's input coupling to either AC (alternating 
current) or DC (direct current).

1 Press the desired channel key.

2 In the Channel Menu, press the Coupling softkey to select the input 
channel coupling:

• DC — DC coupling is useful for viewing waveforms as low as 0 Hz 
that do not have large DC offsets.

• AC — AC coupling is useful for viewing waveforms with large DC 
offsets.

When AC coupling is chosen, you cannot select 50Ω mode. This is 
done to prevent damage to the oscilloscope.

AC coupling places a 10 Hz high- pass filter in series with the input 
waveform that removes any DC offset voltage from the waveform.

Note that Channel Coupling is independent of Trigger Coupling. To change 
trigger coupling see "To select the trigger coupling" on page 208.

TIP If the channel is DC coupled, you can quickly measure the DC component of the signal by 
simply noting its distance from the ground symbol.

If the channel is AC coupled, the DC component of the signal is removed, allowing you to 
use greater sensitivity to display the AC component of the signal.
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To specify channel input impedance

1 Press the desired channel key.

2 In the Channel Menu, press Imped (impedance); then, select either:

• 50 Ohm — matches 50 ohm cables commonly used in making high 
frequency measurements, and 50 ohm active probes.

When 50 Ohm input impedance is selected, it is displayed with the 
channel information on- screen.

When AC coupling is selected (see "To specify channel coupling" on 
page 84) or excessive voltage is applied to the input, the oscilloscope 
automatically switches to 1M Ohm mode to prevent possible damage.

• 1M Ohm — is for use with many passive probes and for 
general- purpose measurements. The higher impedance minimizes the 
loading effect of the oscilloscope on the device under test.

This impedance matching gives you the most accurate measurements 
because reflections are minimized along the signal path.

See Also • For more information on probing, visit: 
"www.agilent.com/find/scope_probes"

• Information about selecting a probe can be found in document number 
"Agilent Oscilloscope Probes and Accessories Selection Guide (part 
number 5989- 6162EN)", available at "www.agilent.com".

To specify bandwidth limiting

1 Press the desired channel key.

2 In the Channel Menu, press the BW Limit softkey to enable or disable 
bandwidth limiting.

NOTE When you connect an AutoProbe, self-sensing probe, or a compatible InfiniiMax probe, the 
oscilloscope automatically configures the analog input channels to the correct impedance.

http://www.agilent.com/find/scope_probes
http://cp.literature.agilent.com/litweb/pdf/5989-6162EN.pdf
http://www.agilent.com
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When bandwidth limit is on, the maximum bandwidth for the channel is 
approximately 20 MHz. For waveforms with frequencies below this, turning 
bandwidth limit on removes unwanted high frequency noise from the 
waveform. The bandwidth limit also limits the trigger signal path of any 
channel that has BW Limit turned on.

To change the vertical scale knob's coarse/fine adjustment setting

1 Push the channel's vertical scale knob (or press the channel key and 
then the Fine softkey in the Channel Menu) to toggle between fine and 
coarse adjustment of the vertical scale.

You can also do this using the touchscreen. See "Turn Channels On/Off 
and Open Scale/Offset Dialogs" on page 56.

When Fine adjustment is selected, you can change the channel's vertical 
sensitivity in smaller increments. The channel sensitivity remains fully 
calibrated when Fine is on.

The vertical scale value is displayed in the status line at the top of the 
display.

When Fine is turned off, turning the volts/division knob changes the 
channel sensitivity in a 1- 2- 5 step sequence.

To invert a waveform

1 Press the desired channel key.

2 In the Channel Menu, press the Invert softkey to invert the selected 
channel.

When Invert is selected, the voltage values of the displayed waveform are 
inverted.

Invert affects how a channel is displayed. However, when using basic 
triggers, the oscilloscope attempts to maintain the same trigger point by 
changing trigger settings.

Inverting a channel also changes the result of any math function selected 
in the Waveform Math Menu or any measurement.
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Setting Analog Channel Probe Options

1 Press the probe's associated channel key.

2 In the Channel Menu, press the Probe softkey to display the Channel 
Probe Menu.

This menu lets you select additional probe parameters such as 
attenuation factor and units of measurement for the connected probe.

The Channel Probe Menu changes depending on the type of probe 
connected.

For passive probes (such as the N2862A/B, N2863A/B, N2889A, N2890A, 
10073C, 10074C, or 1165A probes), the Probe Check softkey appears; it 
guides you through the process of compensating probes.

For some active probes (such as InfiniiMax probes), the oscilloscope can 
accurately calibrate its analog channels for the probe. When you 
connect a probe that can be calibrated, the Calibrate Probe softkey 
appears (and the probe attenuation softkey may change). See "To 
calibrate a probe" on page 89.

See Also • "To specify the channel units" on page 87

• "To specify the probe attenuation" on page 88

• "To specify the probe skew" on page 88

To specify the channel units

1 Press the probe's associated channel key.

2 In the Channel Menu, press Probe.

3 In the Channel Probe Menu, press Units; then, select:

• Volts — for a voltage probe.

• Amps — for a current probe.

Channel sensitivity, trigger level, measurement results, and math functions 
will reflect the measurement units you have selected.
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To specify the probe attenuation

This is set automatically if the oscilloscope can identify the connected 
probe. See Analog channel inputs (see page 44).

The probe attenuation factor must be set properly for accurate 
measurement results.

If you connect a probe that is not automatically identified by the 
oscilloscope, you can manually set the attenuation factor as follows:

1 Press the channel key.

2 Press the Probe softkey until you have selected how you want to specify 
the attenuation factor, choosing either Ratio or Decibels.

3 Turn the Entry knob  to set the attenuation factor for the 
connected probe.

When measuring voltage values, the attenuation factor can be set from 
0.1:1 to 10000:1 in a 1- 2- 5 sequence.

When measuring current values with a current probe, the attenuation 
factor can be set from 10 V/A to 0.0001 V/A.

When specifying the attenuation factor in decibels, you can select values 
from - 20 dB to 80 dB.

If Amps is chosen as the units and a manual attenuation factor is chosen, 
then the units as well as the attenuation factor are displayed above the 
Probe softkey.

To specify the probe skew

When measuring time intervals in the nanoseconds (ns) range, small 
differences in cable length can affect the measurement. Use Skew to 
remove cable- delay errors between any two channels.

1 Probe the same point with both probes.

2 Press one of the probes associated channel key.
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3 In the Channel Menu, press Probe.

4 In the Channel Probe Menu, press Skew; then, select the desired skew 
value.

Each analog channel can be adjusted ±100 ns in 10 ps increments for a 
total of 200 ns difference.

The skew setting is not affected by pressing [Default Setup] or [Auto Scale].

To calibrate a probe

The Calibrate Probe softkey guides you through the process of calibrating 
probes.

For certain active probes, such as InfiniiMax probes, the oscilloscope can 
accurately calibrate its analog channels for the probe. When you connect a 
probe that can be calibrated, the Calibrate Probe softkey in the Channel 
Probe Menu becomes active.

To calibrate one of these probes:

1 First, plug your probe into one of the oscilloscope channels.

This could be, for example, an InfiniiMax probe amplifier/probe head 
with attenuators attached.

2 Connect the probe to the left side, Demo 2, Probe Comp terminal, and 
the probe ground to the ground terminal.

3 Press the Channel on/off key to turn the channel on (if the channel is 
off).

4 In the Channel Menu, press the Probe softkey.

5 In the Channel Probe Menu, the second softkey from the left is for 
specifying your probe head (and attenuation). Repeatedly press this 
softkey until the probe head selection matches the attenuator you are 
using.

NOTE When calibrating a differential probe, connect the positive lead to the Probe Comp terminal 
and the negative lead to the ground terminal. You may need to connect an alligator clip to 
the ground lug to allow a differential probe to span between the Probe Comp test point and 
ground. A good ground connection ensures the most accurate probe calibration.
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The choices are:

• 10:1 single- ended browser (no attenuator).

• 10:1 differential browser (no attenuator).

• 10:1 (+6 dB Atten) single- ended browser.

• 10:1 (+6 dB Atten) differential browser.

• 10:1 (+12 dB Atten) single- ended browser.

• 10:1 (+12 dB Atten) differential browser.

• 10:1 (+20 dB Atten) single- ended browser.

• 10:1 (+20 dB Atten) differential browser.

6 Press the Calibrate Probe softkey and follow the instructions on the 
display.

For more information on InfiniiMax probes and accessories, see the 
probe's User's Guide.
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4
Math Waveforms

To display math waveforms 91

To adjust the math waveform scale and offset 93

Units for Math Waveforms 93

Math Operators 94

Math Transforms 96

Math Filters 112

Math Visualizations 114

You can define up to four math functions. One math function waveform 
can be displayed at a time. The math function waveform is displayed in 
light purple.

Math functions can be performed on analog channels or they can be 
performed on lower math functions when using operators other than add, 
subtract, multiply, or divide.

To display math waveforms

1 Press the [Math] key on the front panel to display the Waveform Math 
Menu.

2 Press the Display Math softkey and turn the Entry knob to select the 
math function you want to display. Then, either push the Entry knob or 
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press the Display Math softkey again to display the selected math 
function.

3 Use the Operator softkey to select an operator, transform, filter, or 
visualization.

For more information on the operators, see:

• "Math Operators" on page 94

• "Math Transforms" on page 96

• "Math Filters" on page 112

• "Math Visualizations" on page 114

4 Use the Source 1 softkey to select the analog channel (or lower math 
function) on which to perform math. You can rotate the Entry knob or 
repetitively press the Source 1 softkey to make your selection.

Higher math functions can operate on lower math functions when using 
operators other than the simple arithmetic operations (+, - , *, /). For 
example, if Math 1 is set up as a subtract operation between channels 1 
and 2, the Math 2 function could be set up as a FFT operation on the 
Math 1 function. These are called cascaded math functions.

To cascade math functions, select the lower math function using the 
Source 1 softkey.

5 If you selected an arithmetic operator for the math function, use the 
Source 2 softkey to select the second source for the arithmetic operation.

6 To re- size and re- position the math waveform, see "To adjust the math 
waveform scale and offset" on page 93.

TIP When cascading math functions, to get the most accurate results, be sure to vertically 
scale lower math functions so that their waveforms take up the full screen without being 
clipped.
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To adjust the math waveform scale and offset

1 Make sure the multiplexed scale and position knobs above and below 
the [Math] key are selected for the math waveform.

If the arrow to the left of the [Math] key is not illuminated, press the 
key.

2 Use the multiplexed scale and position knobs above and below the 
[Math] key to re- size and re- position the math waveform.

See Also • "Units for Math Waveforms" on page 93

Units for Math Waveforms

Units for each input channel can be set to Volts or Amps using the Units 
softkey in the channel's Probe Menu. Units for math function waveforms 
are:

TIP Math Operating Hints

If the analog channel or math function is clipped (not fully displayed on screen) the 
resulting displayed math function will also be clipped.

Once the function is displayed, the analog channel(s) may be turned off for better viewing 
of the math waveform.

The vertical scaling and offset of each math function can be adjusted for ease of viewing 
and measurement considerations.

The math function waveform can be measured using [Cursors] and/or [Meas].

NOTE Math Scale and Offset are Set Automatically

Any time the currently displayed math function definition is changed, the function is 
automatically scaled for optimum vertical scale and offset. If you manually set scale and 
offset for a function, select a new function, then select the original function, the original 
function will be automatically rescaled.
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A scale unit of U (undefined) will be displayed for math functions when 
two source channels are used and they are set to dissimilar units and the 
combination of units cannot be resolved.

Math Operators

Math operators perform arithmetic operations (like add, subtract, or 
multiply) on analog input channels.

• "Add or Subtract" on page 94

• "Multiply or Divide" on page 95

Add or Subtract

When you select add or subtract, the Source 1 and Source 2 values are 
added or subtracted point by point, and the result is displayed.

You can use subtract to make a differential measurement or to compare 
two waveforms.

Math function Units

add or subtract V or A

multiply V2, A2, or W (Volt-Amp)

d/dt V/s or A/s (V/second or A/second)

 dt Vs or As (V-seconds or A-seconds)

FFT dB* (decibels). See also "FFT Units" on 
page 105.

√(square root) V1/2, A1/2, or W1/2 (Volt-Amp)

* When the FFT source is channel 1, 2, 3 or 4, FFT units will be displayed in dBV when channel 
units is set to Volts and channel impedance is set to 1 MΩ. FFT units will be displayed in dBm 
when channel units is set to Volts and channel impedance is set to 50Ω. FFT units will be 
displayed as dB for all other FFT sources or when a source channel's units has been set to Amps.
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If your waveforms' DC offsets are larger than the dynamic range of the 
oscilloscope's input channels you will need to use a differential probe 
instead.

See Also • "Units for Math Waveforms" on page 93

Multiply or Divide

When you select the multiply or divide math function, the Source 1 and 
Source 2 values are multiplied or divided point by point, and the result is 
displayed.

The divide by zero case places holes (that is, zero values) in the output 
waveform.

Multiply is useful for seeing power relationships when one of the channels 
is proportional to the current.

Figure 5 Example of Subtract Channel 2 from Channel 1
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See Also • "Units for Math Waveforms" on page 93

Math Transforms

Math transforms perform a transform function (like differentiate, integrate, 
FFT, or square root) on an analog input channel or on the result of an 
arithmetic operation.

• "Differentiate" on page 97

• "Integrate" on page 98

• "FFT Measurement" on page 100

• "Square Root" on page 108

• "Ax + B" on page 108

Figure 6 Example of Multiply Channel 1 by Channel 2
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• "Square" on page 109

• "Absolute Value" on page 110

• "Common Logarithm" on page 110

• "Natural Logarithm" on page 111

• "Exponential" on page 111

• "Base 10 Exponential" on page 112

Differentiate

d/dt (differentiate) calculates the discrete time derivative of the selected 
source.

You can use differentiate to measure the instantaneous slope of a 
waveform. For example, the slew rate of an operational amplifier may be 
measured using the differentiate function.

Because differentiation is very sensitive to noise, it is helpful to set 
acquisition mode to Averaging (see "Selecting the Acquisition Mode" on 
page 219).

d/dt plots the derivative of the selected source using the "average slope 
estimate at 4 points" formula. The equation is:

Where:

• d = differential waveform.

• y = channel 1, 2, 3, 4, or Math 1, Math 2, Math 3 (lower math function) 
data points.

• i = data point index.

• Δt = point- to- point time difference.

di =
yi+4 + 2yi+2 − 2yi−2 − yi−4

8 Δ t
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See Also • "Units for Math Waveforms" on page 93

Integrate

 dt (integrate) calculates the integral of the selected source. You can use 
integrate to calculate the energy of a pulse in volt- seconds or measure the 
area under a waveform.

 dt plots the integral of the source using the "Trapezoidal Rule". The 
equation is:

Where:

Figure 7 Example of Differentiate Function

In = co + Δ t∑
i=0

n
yi
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• I = integrated waveform.

• Δt = point- to- point time difference.

• y = channel 1, 2, 3, 4, or Math 1, Math 2, Math 3 (lower math function) 
data points.

• co = arbitrary constant.

• i = data point index.

The integrate operator provides an Offset softkey that lets you enter a DC 
offset correction factor for the input signal. Small DC offset in the 
integrate function input (or even small oscilloscope calibration errors) can 
cause the integrate function output to "ramp" up or down. This DC offset 
correction lets you level the integrate waveform.

Figure 8 Integrate Without Signal Offset

0 V level

Integrate
without
DC offset
correction
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See Also • "Units for Math Waveforms" on page 93

FFT Measurement

FFT is used to compute the fast Fourier transform using analog input 
channels or a lower math function. FFT takes the digitized time record of 
the specified source and transforms it to the frequency domain. When the 
FFT function is selected, the FFT spectrum is plotted on the oscilloscope 
display as magnitude in dBV versus frequency. The readout for the 
horizontal axis changes from time to frequency (Hertz) and the vertical 
readout changes from volts to dB.

Use the FFT function to find crosstalk problems, to find distortion 
problems in analog waveforms caused by amplifier non- linearity, or for 
adjusting analog filters.

To display a FFT waveform:

Figure 9 Integrate With Signal Offset

Integrate
with DC offset
correction
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1 Press the Display Math softkey and turn the Entry knob to select the 
math function you want to display. Then, either push the Entry knob or 
press the Display Math softkey again to display the selected math 
function.

2 Press the [Math] key. Then, press the Display Math softkey and select the 
math function you want to use. Then, press the Operator softkey and 
select FFT.

• Source 1 — selects the source for the FFT.

• Span — sets the overall width of the FFT spectrum that you see on 
the display (left to right). Divide span by 10 to calculate the number 
of Hertz per division. It is possible to set Span above the maximum 
available frequency, in which case the displayed spectrum will not 
take up the whole screen. Press the Span softkey, then turn the Entry 
knob to set the desired frequency span of the display.

• Center — sets the FFT spectrum frequency represented at the center 
vertical grid line of the display. It is possible to set the Center to 
values below half the span or above the maximum available 
frequency, in which case the displayed spectrum will not take up the 
whole screen. Press the Center softkey, then turn the Entry knob to 
set the desired center frequency of the display.

• Scale — lets you set your own vertical scale factors for FFT expressed 
in dB/div (decibels/division). See "To adjust the math waveform scale 
and offset" on page 93.

• Offset — lets you set your own offset for the FFT. The offset value is 
in dB and is represented by the center horizontal grid line of the 
display. See "To adjust the math waveform scale and offset" on 
page 93.

• More FFT — displays the More FFT Settings Menu.

3 Press the More FFT softkey to display additional FFT settings.
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• Window— selects a window to apply to your FFT input signal:

• Hanning — window for making accurate frequency measurements or 
for resolving two frequencies that are close together.

• Flat Top — window for making accurate amplitude measurements of 
frequency peaks.

• Rectangular — good frequency resolution and amplitude accuracy, 
but use only where there will be no leakage effects. Use on 
self- windowing waveforms such as pseudo- random noise, impulses, 
sine bursts, and decaying sinusoids.

• Blackman Harris — window reduces time resolution compared to a 
rectangular window, but improves the capacity to detect smaller 
impulses due to lower secondary lobes.

• Vertical Units — lets you select Decibels or V RMS as the units for the 
FFT vertical scale.

• Auto Setup — sets the frequency Span and Center to values that will 
cause the entire available spectrum to be displayed. The maximum 
available frequency is half the FFT sample rate, which is a function 
of the time per division setting. The FFT resolution is the quotient of 
the sampling rate and the number of FFT points (fS/N). The current 
FFT Resolution is displayed above the softkeys.

4 To make cursor measurements, press the [Cursors] key and set the 
Source softkey to Math N.

NOTE Scale and offset considerations

If you do not manually change the FFT scale or offset settings, when you turn the horizontal 
scale knob, the span and center frequency settings will automatically change to allow 
optimum viewing of the full spectrum.

If you do manually set scale or offset, turning the horizontal scale knob will not change the 
span or center frequency settings, allowing you see better detail around a specific 
frequency.

Pressing the FFT Auto Setup softkey will automatically rescale the waveform and span and 
center will again automatically track the horizontal scale setting.
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Use the X1 and X2 cursors to measure frequency values and difference 
between two frequency values (ΔX). Use the Y1 and Y2 cursors to 
measure amplitude in dB and difference in amplitude (ΔY).

5 To make other measurements, press the [Meas] key and set the Source 
softkey to Math N.

You can make peak- to- peak, maximum, minimum, and average dB 
measurements on the FFT waveform. You can also find the frequency 
value at the first occurrence of the waveform maximum by using the X 
at Max Y measurement.

The following FFT spectrum was obtained by connecting a 2.5 V, 100 kHz 
square wave to channel 1. Set the horizontal scale to 50 µs/div, vertical 
sensitivity to 1 V/div, Units/div to 20 dBV, Offset to - 40.0 dBV, Center 
frequency to 500 kHz, frequency Span to 1 MHz, and window to Hanning.

See Also • "FFT Measurement Hints" on page 104

• "FFT Units" on page 105
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• "FFT DC Value" on page 105

• "FFT Aliasing" on page 105

• "FFT Spectral Leakage" on page 107

• "Units for Math Waveforms" on page 93

FFT Measurement Hints

The number of points acquired for the FFT record can be up to 65,536, 
and when frequency span is at maximum, all points are displayed. Once 
the FFT spectrum is displayed, the frequency span and center frequency 
controls are used much like the controls of a spectrum analyzer to 
examine the frequency of interest in greater detail. Place the desired part 
of the waveform at the center of the screen and decrease frequency span 
to increase the display resolution. As frequency span is decreased, the 
number of points shown is reduced, and the display is magnified.

While the FFT spectrum is displayed, use the [Math] and [Cursors] keys to 
switch between measurement functions and frequency domain controls in 
FFT Menu.

Decreasing the effective sampling rate by selecting a greater time/div 
setting will increase the low frequency resolution of the FFT display and 
also increase the chance that an alias will be displayed. The resolution of 
the FFT is the effective sample rate divided by the number of points in 
the FFT. The actual resolution of the display will not be this fine as the 
shape of the window will be the actual limiting factor in the FFTs ability 
to resolve two closely space frequencies. A good way to test the ability of 
the FFT to resolve two closely spaced frequencies is to examine the 
sidebands of an amplitude modulated sine wave.

For the best vertical accuracy on peak measurements:

• Make sure the probe attenuation is set correctly. The probe attenuation 
is set from the Channel Menu if the operand is a channel.

NOTE FFT Resolution

The FFT resolution is the quotient of the sampling rate and the number of FFT points (fS/N). 
With a fixed number of FFT points (up to 65,536), the lower the sampling rate, the better the 
resolution.



Math Waveforms 4

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 105

 

• Set the source sensitivity so that the input signal is near full screen, 
but not clipped.

• Use the Flat Top window.

• Set the FFT sensitivity to a sensitive range, such as 2 dB/division.

For best frequency accuracy on peaks:

• Use the Hanning window.

• Use Cursors to place an X cursor on the frequency of interest.

• Adjust frequency span for better cursor placement.

• Return to the Cursors Menu to fine tune the X cursor.

For more information on the use of FFTs please refer to Agilent 
Application Note 243, The Fundamentals of Signal Analysis at 
"http://cp.literature.agilent.com/litweb/pdf/5952- 8898E.pdf". Additional 
information can be obtained from Chapter 4 of the book Spectrum and 
Network Measurements by Robert A. Witte.

FFT Units

0 dBV is the amplitude of a 1 Vrms sinusoid. When the FFT source is 
channel 1 or channel 2 (or channel 3 or 4 on 4- channel models), FFT 
units will be displayed in dBV when channel units is set to Volts and 
channel impedance is set to 1 MΩ.

FFT units will be displayed in dBm when channel units is set to Volts and 
channel impedance is set to 50Ω.

FFT units will be displayed as dB for all other FFT sources or when a 
source channel's units has been set to Amps.

FFT DC Value

The FFT computation produces a DC value that is incorrect. It does not 
take the offset at center screen into account. The DC value is not 
corrected in order to accurately represent frequency components near DC.

FFT Aliasing

When using FFTs, it is important to be aware of frequency aliasing. This 
requires that the operator have some knowledge as to what the frequency 
domain should contain, and also consider the sampling rate, frequency 

http://cp.literature.agilent.com/litweb/pdf/5952-8898E.pdf


106 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

4 Math Waveforms
 

span, and oscilloscope vertical bandwidth when making FFT 
measurements. The FFT resolution (the quotient of the sampling rate and 
the number of FFT points) is displayed directly above the softkeys when 
the FFT Menu is displayed.

Aliasing happens when there are frequency components in the signal 
higher than half the sample rate. Because the FFT spectrum is limited by 
this frequency, any higher components are displayed at a lower (aliased) 
frequency.

The following figure illustrates aliasing. This is the spectrum of a 990 Hz 
square wave, which has many harmonics. The horizontal time/div setting 
for the square wave sets the sample rate and results in a FFT resolution 
of 1.91 Hz. The displayed FFT spectrum waveform shows the components 
of the input signal above the Nyquist frequency to be mirrored (aliased) 
on the display and reflected off the right edge.

NOTE Nyquist Frequency and Aliasing in the Frequency Domain

The Nyquist frequency is the highest frequency that any real-time digitizing oscilloscope 
can acquire without aliasing. This frequency is half of the sample rate. Frequencies above 
the Nyquist frequency will be under sampled, which causes aliasing. The Nyquist 
frequency is also called the folding frequency because aliased frequency components fold 
back from that frequency when viewing the frequency domain.
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Because the frequency span goes from ≈ 0 to the Nyquist frequency, the 
best way to prevent aliasing is to make sure that the frequency span is 
greater than the frequencies of significant energy present in the input 
signal.

FFT Spectral Leakage

The FFT operation assumes that the time record repeats. Unless there is 
an integral number of cycles of the sampled waveform in the record, a 
discontinuity is created at the end of the record. This is referred to as 
leakage. In order to minimize spectral leakage, windows that approach 
zero smoothly at the beginning and end of the signal are employed as 
filters to the FFT. The FFT Menu provides four windows: Hanning, Flat 
Top, Rectangular, and Blackman- Harris. For more information on leakage, 
see Agilent Application Note 243, The Fundamentals of Signal Analysis at 
"http://cp.literature.agilent.com/litweb/pdf/5952- 8898E.pdf."

Figure 10 Aliasing

http://cp.literature.agilent.com/litweb/pdf/5952-8898E.pdf


108 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

4 Math Waveforms
 

Square Root

Square root (√) calculates the square root of the selected source.

Where the transform is undefined for a particular input, holes (zero 
values) appear in the function output.

See Also • "Units for Math Waveforms" on page 93

Ax + B

The Ax + B function lets you apply a gain and offset to an existing input 
source.

Figure 11 Example of √ (Square Root)
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Use the Gain (A) softkey to specify the gain.

Use the Offset (B) softkey to specify the offset.

The Ax + B function differs from the Magnify math visualization function 
in that the output is likely different than the input.

See Also • "Magnify" on page 114

Square

The square function calculates the square of the selected source, point by 
point, and displays the result.

Press the Source softkey to select the signal source.

See Also • "Square Root" on page 108

Figure 12 Example of Ax + B
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Absolute Value

The absolute value function changes negative values in the input to 
positive values and displays the resulting waveform.

See Also • "Square" on page 109

Common Logarithm

The Common Logarithm (log) function performs a transform of the input 
source. Where the transform is undefined for a particular input, holes 
(zero values) appear in the function output.

See Also • "Natural Logarithm" on page 111

Figure 13 Example of Absolute Value
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Natural Logarithm

The Natural Logarithm (ln) function performs a transform of the input 
source. Where the transform is undefined for a particular input, holes 
(zero values) appear in the function output.

See Also • "Common Logarithm" on page 110

Exponential

The Exponential (e^x) function performs a transform of the input source.

See Also • "Base 10 Exponential" on page 112

Figure 14 Example of Natural Logarithm
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Base 10 Exponential

The Base 10 Exponential (10^x) function performs a transform of the 
input source.

See Also • "Exponential" on page 111

Math Filters

You can use math filters to create a waveform that is the result of a high-  
or low- pass filter on an analog input channel or on the result of an 
arithmetic operation.

• "High Pass and Low Pass Filter" on page 113

• "Averaged Value" on page 114

Figure 15 Example of Base 10 Exponential



Math Waveforms 4

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 113

 

High Pass and Low Pass Filter

The high- pass or low- pass filter functions apply the filter to the selected 
source waveform and display the result in the math waveform.

The high- pass filter is a single- pole high- pass filter.

The low- pass filter is a 4th order Bessel- Thompson filter.

Use the Bandwidth softkey to select the filter's - 3 dB cutoff frequency.

NOTE The ratio of the input signal's Nyquist frequency and the selected -3 dB cutoff frequency 
affects how many points are available in the output, and under some circumstances, there 
are no points in the output waveform.

Figure 16 Example of Low Pass Filter
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Averaged Value

When the Averaged Value operator is selected, the math waveform 
becomes the selected source waveform, averaged the selected number of 
times.

The source waveform can be one of the analog input channels or one of 
the previous math function waveforms.

Unlike acquisition averaging, the math averaging operator can be used to 
average the data on a single analog input channel or math function.

If acquisition averaging is also used, the analog input channel data is 
averaged and the math function averages it again. You can use both types 
of averaging to get a certain number of averages on all waveforms and an 
increased number of averages on a particular waveform.

As with acquisition averaging, averages are calculated using a "decaying 
average" approximation, where:

next_average = current_average + (new_data -  current_average)/N

Where N starts at 1 for the first acquisition and increments for each 
following acquisition until it reaches the selected number of averages, 
where it holds.

See Also • "Averaging Acquisition Mode" on page 223

Math Visualizations

You can apply visualization math functions that give you different ways of 
viewing captured data and measurement values.

• "Magnify" on page 114

• "Measurement Trend" on page 115

• "Chart Logic Bus Timing" on page 117

• "Chart Logic Bus State" on page 118

Magnify

The magnify math function lets you display an existing input source at 
different vertical settings to provide more vertical detail.
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See Also • "Ax + B" on page 108

Measurement Trend

The measurement trend math function shows measurement values for a 
waveform (based on measurement threshold settings) as the waveform 
progresses across the screen. For every cycle, a measurement is made, and 
the value is displayed on the screen for the cycle.

Figure 17 Example of Magnify
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Use the Type: softkey to select the measurement whose trend you want to 
look at. You can display trend values for these measurements:

• Average

• RMS -  AC

• Ratio

• Period

• Frequency

• +Width

• - Width

• Duty Cycle

• Rise Time

• Fall Time

Figure 18 Example of Measurement Trend
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Use the Thresholds softkey to access the Measurement Threshold Menu. See 
"Measurement Thresholds" on page 266.

If a measurement cannot be made for part of a waveform, the trend 
function output is a hole (that is, no value) until a measurement can be 
made.

Chart Logic Bus Timing

The Chart Logic Bus Timing function displays bus data values as an 
analog waveform (like a D/A conversion). When the bus value is 
transitioning, the function output is the bus's last stable state.

Use the Units/Code softkey to specify the analog value equivalent of each 
increment in the bus data value.

Figure 19 Example of Chart Logic Bus Timing
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Use the 0 Offset softkey to specify the analog value equivalent of a bus data 
value of zero.

Use the Units softkey to specify the type of values the bus data represents 
(volts, amps, etc.).

See Also • "Chart Logic Bus State" on page 118

Chart Logic Bus State

The Chart Logic Bus State function displays bus data values, sampled on 
a clock signal's edge, as an analog waveform (like a D/A conversion).

Use the Clock softkey to select the clock signal.

Use the Slope softkey to select the edge of the clock signal to be used.

Figure 20 Example of Chart Logic Bus State
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Use the More Chart softkey to open a submenu for specifying the analog 
value equivalent of each bus value increment, the analog equivalent of a 
zero bus value, and the type of values the charted bus data represents 
(volts, amps, etc.).

Use the Units/Code softkey to specify the analog value equivalent of each 
increment in the bus data value.

Use the 0 Offset softkey to specify the analog value equivalent of a bus data 
value of zero.

Use the Units softkey to specify the type of values the bus data represents 
(volts, amps, etc.).

See Also • "Chart Logic Bus Timing" on page 117
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To save a waveform to a reference waveform location 121

To display a reference waveform 122

To scale and position reference waveforms 123

To adjust reference waveform skew 124

To display reference waveform information 124

To save/recall reference waveform files to/from a USB storage 
device 124

Analog channel or math waveforms can be saved to one of four reference 
waveform locations in the oscilloscope. Then, a reference waveform can be 
displayed and compared against other waveforms. One reference waveform 
can be displayed at a time.

When the multiplexed knobs are assigned to reference waveforms (this 
happens when you press the [Ref] key and the LED to the left of it is lit), 
you can use the knobs to scale and position reference waveforms. There is 
also a skew adjustment for reference waveforms. Reference waveform 
scale, offset, and skew information can optionally be included on the 
oscilloscope display.

Analog channel, math, or reference waveforms can be saved to a reference 
waveform file on a USB storage device. You can recall a reference 
waveform file from a USB storage device into one of the reference 
waveform locations.

To save a waveform to a reference waveform location

1 Press the [Ref] key to turn on reference waveforms.
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2 In the Reference Waveform Menu, press the Display Ref softkey and turn 
the Entry knob to select the desired reference waveform location you 
want to display. Then, either push the Entry knob or press the Display 
Ref softkey again to display the selected reference waveform location.

3 Press the Source softkey and turn the Entry knob to select the source 
waveform.

4 Press the Save to R1/R2/R3/R4 softkey to save the waveform to the 
reference waveform location.

To clear a
reference
waveform

location

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Ref softkey and turn the 
Entry knob to select the desired reference waveform location.

3 Press the Clear R1/R2/R3/R4 softkey to clear the reference waveform 
location.

Reference waveforms are also cleared by a Factory Default or Secure 
Erase (see Chapter 18, “Save/Email/Recall (Setups, Screens, Data),” 
starting on page 309).

To display a reference waveform

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Ref softkey and turn the 
Entry knob to select the desired reference waveform location.

3 Then, press the Ref softkey again to enable/disable the reference 
waveform display.

NOTE Reference waveforms are non-volatile — they remain after power cycling or performing a 
default setup.
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One reference waveform can be displayed at a time.

Reference waveforms are always drawn as vectors (that is, lines between 
waveform data points) and may look different than waveforms drawn as 
dots (if that option is available in your oscilloscope).

See Also • "To display reference waveform information" on page 124

To scale and position reference waveforms

1 Make sure the multiplexed scale and position knobs above and below 
the [Ref] key are selected for the reference waveform.

If the arrow to the left of the [Ref] key is not illuminated, press the key.

2 Turn the upper multiplexed knob to adjust the reference waveform 
scale.

3 Turn the lower multiplexed knob to adjust the reference waveform 
position.
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To adjust reference waveform skew

Once reference waveforms are displayed, you can adjust their skew.

1 Display the desired reference waveform (see "To display a reference 
waveform" on page 122).

2 Press the Skew softkey and turn the Entry knob to adjust the reference 
waveform skew.

To display reference waveform information

1 Press the [Ref] key to turn on reference waveforms.

2 In the Reference Waveform Menu, press the Options softkey.

3 In the Reference Waveform Options Menu, press the Display Info softkey 
to enable or disable reference waveform information on the oscilloscope 
display.

To save/recall reference waveform files to/from a USB storage device

Analog channel, math, or reference waveforms can be saved to a reference 
waveform file on a USB storage device. See "To save reference waveform 
files to a USB storage device" on page 316.

You can recall a reference waveform file from a USB storage device into 
one of the reference waveform locations. See "To recall reference waveform 
files from a USB storage device" on page 320.
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Acquiring waveforms using the digital channels 129

To display digital channels using AutoScale 129

Interpreting the digital waveform display 131

To switch all digital channels on or off 132

To switch groups of channels on or off 132

To switch a single channel on or off 132

To change the displayed size of the digital channels 132

To reposition a digital channel 133

To change the logic threshold for digital channels 133

To display digital channels as a bus 134

Digital channel signal fidelity: Probe impedance and grounding 137

To replace digital probe leads 142

This chapter describes how to use the digital channels of a Mixed- Signal 
Oscilloscope (MSO).

The digital channels are enabled on MSOX4000 X- Series models and 
DSOX4000 X- Series models that have the MSO upgrade license installed.

To connect the digital probes to the device under test

1 If necessary, turn off the power supply to the device under test.
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Turning off power to the device under test would only prevent damage 
that might occur if you accidentally short two lines together while 
connecting probes. You can leave the oscilloscope powered on because 
no voltage appears at the probes.

2 Connect the digital probe cable to the DIGITAL Dn -  D0 connector on 
the mixed- signal oscilloscope. The digital probe cable is keyed so you 
can connect it only one way. You do not need to power- off the 
oscilloscope.

3 Connect the ground lead on each set of channels (each pod), using a 
probe grabber. The ground lead improves signal fidelity to the 
oscilloscope, ensuring accurate measurements.

Off

CAUTION  Probe cable for digital channels

Use only the Agilent logic probe and accessory kit supplied with the mixed-signal 
oscilloscope (see "Accessories Available" on page 373).
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4 Connect a grabber to one of the probe leads. (Other probe leads are 
omitted from the figure for clarity.)

5 Connect the grabber to a node in the circuit you want to test.

Channel
Pod Ground

Circuit
Ground

Grabber
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6 For high- speed signals, connect a ground lead to the probe lead, 
connect a grabber to the ground lead, and attach the grabber to ground 
in the device under test.

7 Repeat these steps until you have connected all points of interest.

Grabber

Signal

Ground

Signals

Ground
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Acquiring waveforms using the digital channels

When you press [Run/Stop] or [Single] to run the oscilloscope, the 
oscilloscope examines the input voltage at each input probe. When the 
trigger conditions are met the oscilloscope triggers and displays the 
acquisition.

For digital channels, each time the oscilloscope takes a sample it compares 
the input voltage to the logic threshold. If the voltage is above the 
threshold, the oscilloscope stores a 1 in sample memory; otherwise, it 
stores a 0.

To display digital channels using AutoScale

When signals are connected to the digital channels — be sure to connect 
the ground leads — AutoScale quickly configures and displays the digital 
channels.

• To configure the instrument quickly, press the [AutoScale] key.
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Any digital channel with an active signal will be displayed. Any digital 
channels without active signals will be turned off.

• To undo the effects of AutoScale, press the Undo AutoScale softkey before 
pressing any other key.

This is useful if you have unintentionally pressed the [AutoScale] key or do 
not like the settings AutoScale has selected. This will return the 
oscilloscope to its previous settings. See also: "How AutoScale Works" on 
page 36.

To set the instrument to the factory- default configuration, press the 
[Default Setup] key.

Figure 21 Example: AutoScale of digital channels (MSO models only)
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Interpreting the digital waveform display

The following figure shows a typical display with digital channels.

Activity indicator When any digital channels are turned on, an activity indicator is displayed 
in the status line at the bottom of the display. A digital channel can be 

always high ( ), always low ( ), or actively toggling logic states ( ).

Activity
indicators

Delay
time

Time/
div

Trigger
type and
source

Digital
channel
identifiers

Waveform
size

Turn
individual
channels
on/off

Turn
groups of
channels
on/off

Threshold
menu key

Trigger
mode or
run status
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To change the displayed size of the digital channels

1 Press the [Digital] key.

2 Press the size ( ) softkey to select how the digital channels are 
displayed.

The sizing control lets you spread out or compress the digital traces 
vertically on the display for more convenient viewing.

To switch a single channel on or off

1 With the Digital Channel Menu displayed, rotate the Entry knob to 
select the desired channel from the popup menu.

2 Push the Entry knob or press the softkey that is directly below the 
popup menu to switch the selected channel on or off.

To switch all digital channels on or off

1 Press the [Digital] key to toggle the display of digital channels. The 
Digital Channel Menu is displayed above the softkeys.

If you want to switch the digital channels off, and the Digital Channel 
Menu is not already displayed, you must push the [Digital] key twice to 
switch the digital channels off. The first push displays the Digital Channel 
Menu, and the second push switches the channels off.

To switch groups of channels on or off

1 Press the [Digital] key on the front panel if the Digital Channel Menu is 
not already displayed.

2 Press the Turn off (or Turn on) softkey for the D15 - D8 group or the D7 - D0 
group.

Each time you press the softkey, the softkey's mode toggles between Turn on 
and Turn off.
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To change the logic threshold for digital channels

1 Press the [Digital] key so that the Digital Channel Menu is displayed.

2 Press the Thresholds softkey

3 Press the D15 - D8 or D7 - D0 softkey, then select a logic family preset or 
select User to define your own threshold.

The threshold you set applies to all channels within the selected D15 - D8 
or D7 - D0 group. Each of the two channel groups can be set to a 
different threshold if desired.

Values greater than the set threshold are high (1) and values less than the 
set threshold are low (0).

If the Thresholds softkey is set to User, press the User softkey for the 
channel group, then turn the Entry knob to set the logic threshold. There 
is one User softkey for each group of channels.

To reposition a digital channel

1 Make sure the multiplexed scale and position knobs above and below 
the key are selected for digital channels.

If the arrow to the left of the [Digital] key is not illuminated, press the 
key.

2 Use the multiplexed Select knob to select the channel.

The selected waveform is highlighted in red.

3 Use the multiplexed Position knob to move the selected channel 
waveform.

Logic family Threshold Voltage

TTL +1.4 V

CMOS +2.5 V

ECL –1.3 V

User Variable from –8 V to +8 V
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If a channel waveform is repositioned over another channel waveform, 
the indicator at the left edge of the trace will change from Dnn 
designation (where nn is a one or two digit channel number) to D*. The 
"*" indicates that multiple channels are overlaid.

To display digital channels as a bus

Digital channels may be grouped and displayed as a bus, with each bus 
value displayed at the bottom of the display in hex or binary. You can 
create up to two buses. To configure and display each bus, press the 
[Digital] key on the front panel. Then press the Bus softkey.

Next, select a bus. Rotate the Entry knob, then press the Entry knob or 
the Bus1/Bus2 softkey to switch it on.

Use the Channel softkey and the Entry knob to select individual channels 
to be included in the bus. You can rotate the Entry knob and push it or 
push the softkey to select channels. You can also press the Select/Deselect 
D15-D8 and Select/Deselect D7-D0 softkeys to include or exclude groups of 
eight channels in each bus.

If the bus display is blank, completely white, or if the display includes "...", 
you need to expand the horizontal scale to allow space for the data to be 
shown, or use the cursors to display the values (see "Using cursors to read 
bus values" on page 135).

The Base softkey lets you choose to display the bus values in hex or 
binary.

The buses are shown at the bottom of the display.
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Bus values can be shown in hex or binary.

Using cursors to
read bus values

To read the digital bus value at any point using the cursors:

1 Turn on Cursors (by pressing the [Cursors] key on the front panel)

2 Press the cursor Mode softkey and change the mode to Hex or Binary.

3 Press the Source softkey and select Bus1 or Bus2.

4 Use the Entry knob and the X1 and X2 softkeys to position the cursors 
where you want to read the bus values.
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Bus values are
displayed when

using Pattern
trigger

The bus values are also displayed when using the Pattern trigger function. 
Press the [Pattern] key on the front panel to display the Pattern Trigger 
Menu and the bus values will be displayed on the right, above the 
softkeys.

The dollar sign ($) will be displayed in the bus value when the bus value 
cannot be displayed as a hex value. This occurs when one or more "don't 
cares" (X) are combined with low (0) and high (1) logic levels in the 

pattern specification, or when a transition indicator — rising edge ( ) or 

falling edge ( ) — are included in the pattern specification. A byte that 
consists of all don't cares (X) will be displayed in the bus as a don't care 
(X).

Bus values
at cursors
shown here

Bus values

Set cursors
mode to
Binary or Hex

Select Bus1
or Bus2 source

X2 cursor

X1 cursor
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See "Pattern Trigger" on page 177 for more information on Pattern 
triggering.

Digital channel signal fidelity: Probe impedance and grounding

When using the mixed- signal oscilloscope you may encounter problems 
that are related to probing. These problems fall into two categories: probe 
loading and probe grounding. Probe loading problems generally affect the 
device under test, while probe grounding problems affect the accuracy of 
the data to the measurement instrument. The design of the probes 
minimizes the first problem, while the second is easily addressed by good 
probing practices.

Digital
channel
values
at cursor

Trigger
pattern
definition

Bus values
displayed

Analog
channel
values
at cursor
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Input Impedance

The logic probes are passive probes, which offer high input impedance and 
high bandwidths. They usually provide some attenuation of the signal to 
the oscilloscope, typically 20 dB.

Passive probe input impedance is generally specified in terms of a parallel 
capacitance and resistance. The resistance is the sum of the tip resistor 
value and the input resistance of the test instrument (see the following 
figure). The capacitance is the series combination of the tip compensating 
capacitor and the cable, plus instrument capacitance in parallel with the 
stray tip capacitance to ground. While this results in an input impedance 
specification that is an accurate model for DC and low frequencies, the 
high- frequency model of the probe input is more useful (see the following 
figure). This high- frequency model takes into account pure tip capacitance 
to ground as well as series tip resistance, and the cable's characteristic 
impedance (Zo).

Figure 22 DC and Low-Frequency Probe Equivalent Circuit
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The impedance plots for the two models are shown in these figures. By 
comparing the two plots, you can see that both the series tip resistor and 
the cable's characteristic impedance extend the input impedance 
significantly. The stray tip capacitance, which is generally small (1 pF), 
sets the final break point on the impedance chart.

Figure 23 High-Frequency Probe Equivalent Circuit
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The logic probes are represented by the high- frequency circuit model 
shown above. They are designed to provide as much series tip resistance 
as possible. Stray tip capacitance to ground is minimized by the proper 
mechanical design of the probe tip assembly. This provides the maximum 
input impedance at high frequencies.

Probe Grounding

A probe ground is the low- impedance path for current to return to the 
source from the probe. Increased length in this path will, at high 
frequencies, create large common mode voltages at the probe input. The 
voltage generated behaves as if this path were an inductor according to 
the equation:

Figure 24 Impedance versus Frequency for Both Probe Circuit Models
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Increasing the ground inductance (L), increasing the current (di) or 
decreasing the transition time (dt), will all result in increasing the voltage 
(V). When this voltage exceeds the threshold voltage defined in the 
oscilloscope, a false data measurement will occur.

Sharing one probe ground with many probes forces all the current that 
flows into each probe to return through the same common ground 
inductance of the probe whose ground return is used. The result is 
increased current (di) in the above equation, and, depending on the 
transition time (dt), the common mode voltage may increase to a level that 
causes false data generation.

In addition to the common mode voltage, longer ground returns also 
degrade the pulse fidelity of the probe system. Rise time is increased, and 
ringing, due to the undamped LC circuit at the input of the probe, is also 
increased. Because the digital channels display reconstructed waveforms, 
they do not show ringing and perturbations. You will not find ground 
problems through examination of the waveform display. In fact, it is likely 

Figure 25 Common Mode Input Voltage Model

Zin

Zin

in

i2

+i 2i1

i1

+i n

+i n

Zin

Probe 1

Probe
Ground

Probe 2

Probe N

L (GND)

Vn (Common Mode)



142 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

6 Digital Channels
 

you will discover the problem through random glitches or inconsistent 
data measurements. Use the analog channels to view ringing and 
perturbations.

Best Probing Practices

Because of the variables L, di, and dt, you may be unsure how much 
margin is available in your measurement setup. The following are 
guidelines for good probing practices:

• The ground lead from each digital channel group (D15–D8 and D7–D0) 
should be attached to the ground of the device under test if any 
channel within the group is being used for data capture.

• When capturing data in a noisy environment, every third digital channel 
probe's ground should be used in addition to the channel group's 
ground.

• High- speed timing measurements (rise time < 3 ns) should make use of 
each digital channel probe's own ground.

When designing a high- speed digital system, you should consider designing 
dedicated test ports that interface directly to the instrument's probe 
system. This will ease measurement setup and ensure a repeatable method 
for obtaining test data. The 01650- 61607 16- channel logic probe cable and 
the 01650- 63203 termination adapter are designed to make it easy to 
connect to industry- standard, 20- pin board connectors. The cable is a 2 m 
logic analyzer probe cable, and the termination adapter provides the 
proper RC networks in a very convenient package. These parts, as well as 
the 1251- 8106 20- pin, low- profile, straight board connector, can be 
ordered from Agilent Technologies.

To replace digital probe leads

If you need to remove a probe lead from the cable, insert a paper clip or 
other small pointed object into the side of the cable assembly, and push to 
release the latch while pulling out the probe lead.
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For other replacement parts, consult the InfiniiVision 4000 X- Series 
Oscilloscopes Service Guide.

Table 3 Digital Probe Replacement Parts

Part Number Description

N6450-60001 Digital probe kit, contains: 54620-61601 16-channel cable, 
01650-82103 2-inch probe grounds (qty 5), and 5090-4832 
grabbers (qty 20)

54620-61601 16-channel cable with 16 probe leads and 2 pod ground leads 
(qty 1)

5959-9333 Replacement probe leads (qty 5), also contains 01650-94309 
probe labels

5959-9334 Replacement 2-inch probe grounds (qty 5)

5959-9335 Replacement pod ground leads (qty 5)

5090-4833 Grabbers (qty 20)

01650-94309 Package of probe labels
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Triggering on
Serial Data

In some cases, such as when triggering on a slow serial signal (for 
example, I2C, SPI, CAN, LIN, etc.) it may be necessary to switch from the 
Auto trigger mode to the Normal trigger mode to prevent the oscilloscope 
from Auto- triggering and stabilize the display. You can select the trigger 
mode by pressing the [Mode/Coupling] key, then the Mode softkey.

Also, the threshold voltage level must be set appropriately for each source 
channel. The threshold level for each serial signal can be set in the Signals 
Menu. Press the [Serial] key, then the Signals softkey.

Serial Decode Options

Agilent's hardware- accelerated serial decode options can be installed when 
the oscilloscope is manufactured, or added later. The following serial 
decode licenses are available:

Serial Decode License See:

DSOX4AUTO — you can decode CAN 
(Controller Area Network) and LIN (Local 
Interconnect Network) serial buses.

• "CAN Serial Decode" on page 392.
• "LIN Serial Decode" on page 400.
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To determine whether these licenses are installed on your oscilloscope, see 
"To display oscilloscope information" on page 345.

To order serial decode licenses, go to "www.agilent.com" and search for the 
product number (for example, DSOX4AUTO) or contact your local Agilent 
Technologies representative (see "www.agilent.com/find/contactus)."

Lister

Lister is a powerful tool for investigating protocol failures. You can use 
Lister to view large amounts of packet level serial data in a tabular 
format, including time tags and specific decoded values. After pressing the 
[Single] key, you can press the Scroll Lister softkey and then rotate the 
Entry knob to select an event and press the Zoom to Selection softkey to 
jump to the event.

To use the Lister:

DSOX4FLEX — you can decode FlexRay serial 
buses.

• "FlexRay Serial Decode" on page 409.

DSOX4EMBD — you can decode I2C (Inter-IC) 
and SPI (Serial Peripheral Interface) serial 
buses.

• "I2C Serial Decode" on page 420.
• "SPI Serial Decode" on page 430.

DSOX4AUDIO — you can decode I2S (Inter-IC 
Sound or Integrated Interchip Sound) serial 
buses.

• "I2S Serial Decode" on page 441.

DSOX4COMP — you can decode many UART 
(Universal Asynchronous 
Receiver/Transmitter) protocols including 
RS232 (Recommended Standard 232).

• "UART/RS232 Serial Decode" on page 465.

DSOX4AERO — you can decode MIL-STD-1553 
and ARINC 429 serial buses.

• "MIL-STD-1553 Serial Decode" on page 448.
• "ARINC 429 Serial Decode" on page 455.

DSOX4USBFL or DSOX4USBH — you can 
decode USB Full/Low Speed or USB High 
Speed serial buses.

• "USB 2.0 Serial Decode" on page 475.

Serial Decode License See:

http://www.agilent.com/
http://www.agilent.com/find/contactus
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1 Set up trigger and decode on the serial data signals to be analyzed.

2 Press [Serial] > Lister.

3 Press Window; then, turn the Entry knob to select the size of the Lister 
window (Half-Screen or Full-Screen).

When the touchscreen is enabled, you can touch the Lister down or up 
chevrons at the top right of the graticule to select the size of the Lister 
window.

4 Press Display; then, turn the Entry knob to select the serial slot (Serial 1 
or Serial 2) on which the serial bus signals are being decoded. (If you 
select All, the decode information for different buses is interleaved in 
time.)

Before you can select a row or navigate through the Lister data, 
oscilloscope acquisitions must be stopped.

5 Press the [Single] key (in the Run Control group on the front panel) to 
stop the acquisition.
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Pressing [Single] instead of [Stop] fills the maximum memory depth.

When zoomed out and viewing a large number of packets, the Lister 
may not be able to display information for all packets. However, when 
you press the [Single] key the Lister will contain all on- screen serial 
decode information.

6 Press the Scroll Lister softkey and use the Entry knob to scroll through 
the data.

Time tags in the Time column indicate the event time relative to the 
trigger point by default, and can optionally be configured to be relative 
to the previous row, as described in step 9 that follows. The time tags 
of events that are shown in the waveform display area are displayed 
with a dark background.

7 Press the Zoom to Selection softkey (or push the Entry knob) to center 
the waveform display at the time associated with the selected Lister 
row and automatically set the horizontal scale setting.

8 Press the Undo Zoom softkey to return to the horizontal scale and delay 
settings before the last Zoom to Selection.

9 Press the Options softkey to open the Lister Options Menu. In this menu, 
you can:

• Enable or disable the Track Time option. When enabled, as you select 
different Lister rows (using the Entry knob while acquisitions are 
stopped), the horizontal delay changes to the Time of the selected 
row. Also, changing the horizontal delay will scroll the Lister.

• Press the Scroll Lister softkey and use the Entry knob to scroll though 
data rows in the Lister display.

• Press the Time Ref softkey and use the Entry knob to select whether 
the Time column in the Lister display shows times relative to the 
trigger or relative to the previous packet row.

Searching Lister Data

When serial decode is enabled, you can use the [Search] key to find and 
place marks on rows in the Lister.

The Search softkey lets you specify events to find. It is similar to 
specifying protocol triggers.
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Events found are marked in orange in the far left Lister column. The total 
number of events found is displayed above the softkeys.

Each serial decode option lets you find protocol- specific headers, data, 
errors, etc. See:

• "Searching for ARINC 429 Data in the Lister" on page 460

• "Searching for CAN Data in the Lister" on page 396

• "Searching for FlexRay Data in the Lister" on page 413

• "Searching for I2C Data in the Lister" on page 423

• "Searching for I2S Data in the Lister" on page 444

• "Searching for LIN Data in the Lister" on page 404

• "Searching for MIL- STD- 1553 Data in the Lister" on page 451

• "Searching for SPI Data in the Lister" on page 433

• "Searching for UART/RS232 Data in the Lister" on page 469

• "Searching for USB 2.0 Data in the Lister" on page 479
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To adjust waveform intensity

You can adjust the intensity of displayed waveforms to account for various 
signal characteristics, such as fast time/div settings and low trigger rates.

Increasing the intensity lets you see the maximum amount of noise and 
infrequently occurring events.

Reducing the intensity can expose more detail in complex signals as 
shown in the following figures.

1 Press the [Intensity] key to illuminate it.

This key is located just below the Entry knob.

2 Turn the Entry knob to adjust the waveform intensity.

Waveform intensity adjustment affects analog channel waveforms only (not 
math waveforms, reference waveforms, digital waveforms, etc.).
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Figure 26 Amplitude Modulation Shown at 100% Intensity
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To set or clear persistence

With persistence, the oscilloscope updates the display with new 
acquisitions, but does not immediately erase the results of previous 
acquisitions. All previous acquisitions are displayed with reduced 
intensity. New acquisitions are shown in their normal color with normal 
intensity.

Waveform persistence is kept only for the current display area; you cannot 
pan and zoom the persistence display.

To use persistence:

1 Press the [Display] key.

Figure 27 Amplitude Modulation Shown at 40% Intensity
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2 Press Persistence; then, turn the Entry knob to select between:

• Off — turns off persistence.

When persistence is off, you can press the Capture Waveforms softkey 
to perform a single- shot infinite persistence. A single acquisition's 
data is displayed with reduced intensity, and it remains on the 
display until you clear persistence or clear the display.

• ∞ Persistence — (infinite persistence) Results of previous acquisitions 
are never erased.

Use infinite persistence to measure noise and jitter, to see the 
worst- case extremes of varying waveforms, to look for timing 
violations, or to capture events that occur infrequently.

• Variable Persistence — Results of previous acquisitions are erased after 
a certain amount of time.

Variable persistence gives you a view of acquired data that is similar 
to analog oscilloscopes.

When variable persistence is selected, press the Time softkey and use 
the Entry knob to specify the amount of time that previous 
acquisitions are to be displayed.

The display will begin accumulating multiple acquisitions.

3 To erase the results of previous acquisitions from the display, press the 
Clear Persistence softkey.

The oscilloscope will start to accumulate acquisitions again.

4 To return the oscilloscope to the normal display mode, turn off 
persistence; then, press the Clear Persistence softkey.

Turning off persistence does not clear the display. The display is 
cleared if you press the Clear Display softkey or if you press the 
[AutoScale] key (which also turns off persistence).

For another method of seeing worst- case extremes of varying waveforms, 
see "Glitch or Narrow Pulse Capture" on page 221.
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To clear the display

1 Press [Clear Display] (or press [Display] > Clear Display).

You can also configure the [Quick Action] key to clear the display. See 
"Configuring the [Quick Action] Key" on page 347.

To select the grid type

When the Video trigger type is selected (see "Video Trigger" on page 188), 
and the vertical scaling of at least one displayed channel is 140 mV/div, 
the Grid softkey lets you select from these grid types:

• Full — the normal oscilloscope grid.

• mV — shows vertical grids, labeled on the left, from - 0.3 V to 0.8 V.

• IRE — (Institute of Radio Engineers) shows vertical grids in IRE units, 
labeled on the left, from - 40 to 100 IRE. The 0.35 V and 0.7 V levels 
from the mV grid are also shown and labeled at the right. When the IRE 
grid is selected, cursor values are also shown in IRE units. (Cursor 
values via the remote interface are not in IRE units.)

The mV and IRE grid values are accurate (and match Y cursor values) 
when the vertical scaling is 140 mV/division and the vertical offset is 
245 mV.

To select the grid type:

1 Press [Display] (or [Display] > More on 1 Ghz and 1.5 GHz bandwidth 
models).

2 Press the Grid softkey; then, turn the Entry knob  to select the grid 
type.

To adjust the grid intensity

To adjust the display grid (graticule) intensity:

1 Press [Display].
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2 Press the Intensity softkey; then, turn the Entry knob  to change the 
intensity of the displayed grid.

The intensity level is shown in the Intensity softkey and is adjustable from 
0 to 100%.

Each major vertical division in the grid corresponds to the vertical 
sensitivity shown in the status line at the top of the display.

Each major horizontal division in the grid corresponds to the time/div 
shown in the status line at the top of the display.

To display waveforms as vectors or dots

Agilent InfiniiVision 4000 X- Series oscilloscopes are designed to operate 
optimally with vectors (connect the dots) on. This mode produces the 
most insightful waveforms for most situations.

On the 1 GHz and 1.5 GHz bandwidth models, you can disable vectors to 
view just waveform data points.

To disable or re- enable vectors:

1 Press [Display] > More.

2 Press Vectors.

When enabled, Vectors draws a line between consecutive waveform data 
points.

• Vectors give an analog look to a digitized waveform. Complex analog 
signals like video and modulated signals show analog- like intensity 
information with vectors on.

• Vectors allow you to see steep edges on waveforms, such as square 
waves.

• Vectors allow subtle detail of complex waveforms to be viewed, much 
like an analog oscilloscope trace, even when the detail is just a small 
number of pixels in size.

You may want to turn vectors off when highly complex or multivalued 
waveforms are displayed. Turning vectors off may aid the display of 
multivalued waveforms such as eye diagrams.
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Having vectors on does not slow down the display rate.

Digital channels on a mixed- signal oscilloscope are not affected by the 
Vectors setting. They are always displayed with vectors on. They also only 
contain one acquisition worth of information.

To freeze the display

To freeze the display without stopping running acquisitions, you must 
configure the [Quick Action] key. See "Configuring the [Quick Action] 
Key" on page 347.

1 Once the [Quick Action] key has been configured, press it to freeze the 
display.

2 To un- freeze the display, press [Quick Action] again.

Manual cursors can be used on the frozen display.

Many activities, such as adjusting the trigger level, adjusting vertical or 
horizontal settings, or saving data will un- freeze the display.
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You can define labels and assign them to each analog input channel, or 
you can turn labels off to increase the waveform display area. Labels can 
also be applied to digital channels on MSO models.

To turn the label display on or off

1 Press the [Label] key on the front panel.

This turns on labels for the displayed analog and digital channels. 
Labels are displayed at the left edge of the displayed traces.

The figure below shows an example of displayed labels.
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2 To turn the labels off, press the [Label] key again.

To assign a predefined label to a channel

1 Press the [Label] key.

2 Press the Channel softkey, then turn the Entry knob or successively 
press the Channel softkey to select a channel for label assignment.
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The figure above shows the list of channels and their default labels. The 
channel does not have to be turned on to have a label assigned to it.

3 Press the Library softkey, then turn the Entry knob or successively press 
the Library softkey to select a predefined label from the library.

4 Press the Apply New Label softkey to assign the label to your selected 
channel.

5 Repeat the above procedure for each predefined label you want to 
assign to a channel.

To define a new label

1 Press the [Label] key.

2 Press the Channel softkey; then, turn the Entry knob or successively 
press the softkey to select a channel for label assignment.
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The channel does not have to be turned on to have a label assigned to 
it. If the channel is turned on, its current label will be highlighted.

3 Press the New Label softkey.

4 In the New Label keypad dialog, you can enter text using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; 

then, push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that 
can be touched.

5 When you are done entering text, select the dialog's Enter or OK key or 
press the New Label softkey again.

The new label appears in the softkey.

6 Press the Apply New Label softkey to assign the new label to the selected 
channel and to save the new label to the Library.

When you define a new label, it is added to the nonvolatile label list.

Label Assignment
Auto-Increment

When you assign a label ending in a digit, such as ADDR0 or DATA0, the 
oscilloscope automatically increments the digit and displays the modified 
label in the "New label" field after you press the Apply New Label softkey. 
Therefore, you only need to select a new channel and press the Apply New 
Label softkey again to assign the label to the channel. Only the original 
label is saved in the label list. This feature makes it easier to assign 
successive labels to numbered control lines and data bus lines.

To load a list of labels from a text file you create

It may be convenient to create a list of labels using a text editor, then 
load the label list into the oscilloscope. The list can have up to 75 labels. 
When loaded, labels are added to the beginning of the oscilloscope's list. If 
more than 75 labels are loaded, only the first 75 are stored.

To load labels from a text file into the oscilloscope:

1 Use a text editor to create each label. Each label can be up to ten 
characters in length. Separate each label with a line feed.
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2 Name the file labellist.txt and save it on a USB mass storage device 
such as a thumb drive.

3 Load the list into the oscilloscope using the File Explorer (press [Utility] 
> File Explorer).

To reset the label library to the factory default

1 Press [Label] (or [Utility] > Options > Preferences).

2 Press the Reset Library softkey.

This will delete all user- defined labels from the library and set the 
labels in the library back to the factory default. However, this does not 
default the labels currently assigned to the channels (those labels that 
appear in the waveform area).

NOTE Label List Management

When you press the Library softkey, you will see a list of the last 75 labels used. The list 
does not save duplicate labels. Labels can end in any number of trailing digits. As long as 
the base string is the same as an existing label in the library, the new label will not be put in 
the library. For example, if label A0 is in the library and you make a new label called A12345, 
the new label is not added to the library.

When you save a new user-defined label, the new label will replace the oldest label in the 
list. Oldest is defined as the longest time since the label was last assigned to a channel. 
Any time you assign any label to a channel, that label will move to the newest in the list. 
Thus, after you use the label list for a while, your labels will predominate, making it easier 
to customize the instrument display for your needs.

When you reset the label library list (see next topic), all of your custom labels will be 
deleted, and the label list will be returned to its factory configuration.

NOTE Pressing the Reset Library softkey will remove all user-defined labels from the library and 
set the labels back to the factory default. Once deleted, these user-defined labels cannot be 
recovered.
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To add an annotation

You can add an annotation to the oscilloscope's display. The annotation is 
useful for documentation purposes, to add notes before capturing screens.

To add an annotation:

1 On the oscilloscope's front panel, press [Label].

2 In the label menu, press Annotation.

3 In the Annotation Menu, press Annotation to enable the annotation.

When enabled, you can drag the annotation anywhere in the graticule 
using the touchscreen or a USB mouse.

4 Press Edit Annotation.

5 In the Edit Annotation keypad dialog, you can enter text using:

NOTE Defaulting labels without erasing the default library

Pressing [Default Setup] sets all channel labels back to the default labels but does not 
erase the list of user-defined labels in the library.



Labels 9

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 165

 

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; 

then, push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that 
can be touched.

6 When you are done entering text, select the dialog's Enter or OK key or 
press the Edit Annotation softkey again.

The annotation text appears in the softkey.

7 Press the Text Color softkey and turn the Entry knob to select the 
annotation color.

You can choose white, red, or colors that match analog channels, digital 
channels, math waveforms, reference waveforms, or markers.

8 Press the Background softkey and turn the Entry knob to select the 
annotation background:
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• Opaque — the annotation has a solid background.

• Inverted — the annotation's foreground and background colors are 
switched.

• Transparent — the annotation has a transparent background.

See Also • "To save BMP or PNG image files" on page 312

• "To print the oscilloscope's display" on page 323
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A trigger setup tells the oscilloscope when to acquire and display data. 
For example, you can set up to trigger on the rising edge of the analog 
channel 1 input signal.

You can adjust the vertical level used for analog channel edge detection by 
turning the Trigger Level knob.

In addition to the edge trigger type, you can also set up triggers on 
rise/fall times, Nth edge bursts, patterns, pulse widths, runt pulses, setup 
and hold violations, TV signals, and serial signals (if option licenses are 
installed).

You can use any input channel or the "External Trigger Input" on 
page 210 BNC as the source for most trigger types.
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Changes to the trigger setup are applied immediately. If the oscilloscope is 
stopped when you change a trigger setup, the oscilloscope uses the new 
specification when you press [Run/Stop] or [Single]. If the oscilloscope is 
running when you change a trigger setup, it uses the new trigger 
definition when it starts the next acquisition.

You can use the [Force Trigger] key to acquire and display data when 
triggers are not occurring.

You can use the [Mode/Coupling] key to set options that affect all trigger 
types (see Chapter 11, “Trigger Mode/Coupling,” starting on page 205).

You can save trigger setups along with the oscilloscope setup (see 
Chapter 18, “Save/Email/Recall (Setups, Screens, Data),” starting on page 
309).

Triggers - General
Information

A triggered waveform is one in which the oscilloscope begins tracing 
(displaying) the waveform, from the left side of the display to the right, 
each time a particular trigger condition is met. This provides stable 
display of periodic signals such as sine waves and square waves, as well 
as nonperiodic signals such as serial data streams.

The figure below shows the conceptual representation of acquisition 
memory. You can think of the trigger event as dividing acquisition memory 
into a pre- trigger and post- trigger buffer. The position of the trigger event 
in acquisition memory is defined by the time reference point and the 
delay (horizontal position) setting (see "To adjust the horizontal delay 
(position)" on page 67).

Pre-Trigger Buffer Post-Trigger Buffer

Acquisition Memory

Trigger Event



Triggers 10

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 169

 

Adjusting the Trigger Level

You can adjust the trigger level for a selected analog channel by turning 
the Trigger Level knob.

You can also adjust the trigger level using the touchscreen. See "Access the 
Trigger Menu, Change the Trigger Mode, and Open the Trigger Level 
Dialog" on page 57.

You can push the Trigger Level knob to set the level of all displayed 
analog channels to the waveform's 50% value. If AC coupling is used, 
pushing the Trigger Level knob sets the trigger level to about 0 V.

When High and Low (dual) trigger levels are used (as with the Rise/Fall 
Time and Runt triggers, for example), pushing the Level knob toggles 
between high and low level adjustment.

The position of the trigger level for the analog channel is indicated by the 
trigger level icon  (if the analog channel is on) at the far left side of the 
display. The value of the analog channel trigger level is displayed in the 
upper- right corner of the display.

The trigger level for a selected digital channel is set using the threshold 
menu in the Digital Channel Menu. Press the [Digital] key on the front 
panel, then press the Thresholds softkey to set the threshold level (TTL, 
CMOS, ECL, or user defined) for the selected digital channel group. The 
threshold value is displayed in the upper- right corner of the display.

The line trigger level is not adjustable. This trigger is synchronized with 
the power line supplied to the oscilloscope.

Forcing a Trigger

The [Force Trigger] key causes a trigger (on anything) and displays the 
acquisition.

T

NOTE You can also change the trigger level of all channels by pressing [Analyze] > Features and 
then selecting Trigger Levels.
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This key is useful in the Normal trigger mode where acquisitions are made 
only when the trigger condition is met. In this mode, if no triggers are 
occurring (that is, the "Trig'd?" indicator is displayed), you can press [Force 
Trigger] to force a trigger and see what the input signals look like.

In the Auto trigger mode, when the trigger condition is not met, triggers 
are forced and the "Auto?" indicator is displayed.

Edge Trigger

The Edge trigger type identifies a trigger by looking for a specified edge 
(slope) and voltage level on a waveform. You can define the trigger source 
and slope in this menu. The trigger type, source, and level are displayed in 
the upper- right corner of the display.

1 On the front panel, in the Trigger section, press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey, and use the Entry knob 
to select Edge.

3 Select the trigger source:

• Analog channel, 1 to the number of channels

• Digital channel (on mixed- signal oscilloscopes), D0 to the number of 
digital channels minus one.

• External — triggers on the EXT TRIG IN signal.

• Line — triggers at the 50% level of the rising or falling edge of the AC 
power source signal.

• WaveGen 1/2 — triggers at the 50% level of the rising edge of the 
waveform generator output signal. (Not available when the DC, Noise, 
or Cardiac waveforms are selected.)

• WaveGen Mod (FSK/FM) — when waveform generator FSK or FM 
modulation is used, triggers at the 50% level of the rising edge of the 
modulating signal.

You can choose a channel that is turned off (not displayed) as the 
source for the edge trigger.

The selected trigger source is indicated in the upper- right corner of the 
display next to the slope symbol:

• 1 through 4 = analog channels.
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• D0 through Dn = digital channels.

• E = External trigger input.

• L = Line trigger.

• W = Waveform generator.

4 Press the Slope softkey and select rising edge, falling edge, alternating 
edges, or either edge (depending on the selected source). The selected 
slope is displayed in the upper- right corner of the display.

NOTE Alternating edge mode is useful when you want to trigger on both edges of a clock (for 
example, DDR signals).

Either edge mode is useful when you want to trigger on any activity of a selected source.

All modes operate up to the bandwidth of the oscilloscope except Either edge mode, which 
has a limitation. Either edge mode will trigger on Constant Wave signals up to 100 MHz, but 
can trigger on isolated pulses down to 1/(2*oscilloscope's bandwidth).
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Using AutoScale
to Set Up Edge

Triggers

The easiest way to set up an Edge trigger on a waveform is to use 
AutoScale. Simply press the [AutoScale] key and the oscilloscope will 
attempt to trigger on the waveform using a simple Edge trigger type. See 
"Use Auto Scale" on page 35.

Edge then Edge Trigger

The Edge then Edge trigger mode triggers when the Nth edge occurs after 
an arming edge and a delay period.

The arm and trigger edges can be specified as  (Rising) or  (Falling) 
edges on analog or digital channels.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Edge then Edge.

NOTE MegaZoom Technology Simplifies Triggering

With the built-in MegaZoom technology, you can simply AutoScale the waveforms, then 
stop the oscilloscope to capture a waveform. You can then pan and zoom through the data 
using the Horizontal and Vertical knobs to find a stable trigger point. AutoScale often 
produces a triggered display.
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3 Press the Sources softkey.

4 In the Edge then edge Sources Menu:

a Press the Arm A softkey, and turn the Entry knob to select the 
channel on which the arming edge will occur.

b Press the Slope A softkey to specify which edge of the Arm A signal 
will arm the oscilloscope.

c Press the Trigger B softkey, and turn the Entry knob to select the 
channel on which the trigger edge will occur.

d Press the Slope B softkey to specify which edge of the Trigger B 
signal will trigger the oscilloscope.
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Adjust the trigger level for the selected analog channel by turning the 
Trigger Level knob. Press the [Digital] key and select Thresholds to set 
the threshold level for digital channels. The value of the trigger level or 
digital threshold is displayed in the upper- right corner of the display.

5 Press the Back/Up key to return to the Trigger Menu.

6 Press the Delay softkey; then, turn the Entry knob to enter the delay 
time between the Arm A edge and the Trigger B edge.

7 Press the Nth Edge B softkey; then, turn the Entry knob to select the Nth 
edge of the Trigger B signal to trigger on.

Pulse Width Trigger

Pulse Width (glitch) triggering sets the oscilloscope to trigger on a positive 
or negative pulse of a specified width. If you want to trigger on a specific 
timeout value, use Pattern trigger in the Trigger Menu (see "Pattern 
Trigger" on page 177).

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Pulse Width.

Back
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3 Press the Source softkey; then, rotate the Entry knob to select a channel 
source for the trigger.

The channel you select is shown in the upper- right corner of the 
display next to the polarity symbol.

The source can be any analog or digital channel available on your 
oscilloscope.

4 Adjust the trigger level:

• For analog channels, turn the Trigger Level knob.

• For digital channels, press the [Digital] key and select Thresholds to set 
the threshold level.

The value of the trigger level or digital threshold is displayed in the 
upper- right corner of the display.

5 Press the pulse polarity softkey to select positive ( ) or negative ( ) 
polarity for the pulse width you want to capture.
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The selected pulse polarity is displayed in the upper- right corner of the 
display. A positive pulse is higher than the current trigger level or 
threshold and a negative pulse is lower than the current trigger level or 
threshold.

When triggering on a positive pulse, the trigger will occur on the high 
to low transition of the pulse if the qualifying condition is true. When 
triggering on a negative pulse, the trigger will occur on the low to high 
transition of the pulse if the qualifying condition is true.

6 Press the qualifier softkey (< > ><) to select the time qualifier.

The Qualifier softkey can set the oscilloscope to trigger on a pulse 
width that is:

• Less than a time value (<).

For example, for a positive pulse, if you set t<10 ns:

• Greater than a time value (>).

For example, for a positive pulse, if you set t>10 ns:

• Within a range of time values (><).

For example, for a positive pulse, if you set t>10 ns and t<15 ns:

7 Select the qualifier time set softkey (< or >), then rotate the Entry 
knob to set the pulse width qualifier time.

The qualifiers can be set as follows:

• 2 ns to 10 s for > or < qualifier (5 ns to 10 s for 350 MHz and lower 
bandwidth models).

10 ns 10 ns Trigger

10 ns 10 ns Trigger

10 ns 15 ns Trigger12 ns
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• 10 ns to 10 s for >< qualifier, with minimum difference of 5 ns 
between upper and lower settings.

Pulse width
trigger < qualifier

time set softkey

• When the less than (<) qualifier is selected, the Entry knob sets the 
oscilloscope to trigger on a pulse width less than the time value 
displayed on the softkey.

• When the time range (><) qualifier is selected, the Entry knob sets the 
upper time range value.

Pulse width
trigger > qualifier

time set softkey

• When the greater than (>) qualifier is selected, the Entry knob sets the 
oscilloscope to trigger on a pulse width greater than the time value 
displayed on the softkey.

• When the time range (><) qualifier is selected, the Entry knob sets the 
lower time range value.

Pattern Trigger

The Pattern trigger identifies a trigger condition by looking for a specified 
pattern. This pattern is a logical AND combination of the channels. Each 
channel can have a value of 0 (low), 1 (high), or don't care (X). A rising 
or falling edge can be specified for one channel included in the pattern.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Pattern.

3 Press the Qualifier softkey; then, turn the Entry knob to select from the 
pattern duration qualifier options:

• Entered – when the pattern is entered.

• < (Less Than) – when the pattern is present for less than a time 
value.

• > (Greater Than) – when the pattern is present for greater than a 
time value. The trigger occurs when the pattern exits (not when the 
> softkey time value is exceeded).

• Timeout – when the pattern is present for greater than a time value. 
In this case, the trigger occurs when the > softkey time value is 
exceeded (not when the pattern exits).

• >< (In Range) – when the pattern is present for a time within a range 
of values.
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• <> (Out of Range) – when the pattern is present for a time outside of 
range of values.

Pattern durations are evaluated using a timer. The timer starts on the 
last edge that makes the pattern (logical AND) true. Except when the 
Timeout qualifier is selected, the trigger occurs on the first edge that 
makes the pattern false, provided the time qualifier criteria has been 
met.

The time values for the selected qualifier are set using the qualifier 
time set softkeys (< and >) and the Entry knob.

4 To set the analog or digital channel patterns, press the Analog softkey 
or the Digital softkey and use the binary keypad dialog to enter:

• 0 sets the pattern to zero (low) on the selected channel. A low is a 
voltage level that is less than the channel's trigger level or threshold 
level.
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• 1 sets the pattern to 1 (high) on the selected channel. A high is a 
voltage level that is greater than the channel's trigger level or 
threshold level.

• X sets the pattern to don't care on the selected channel. Any channel 
set to don't care is ignored and is not used as part of the pattern. 
However, if all channels in the pattern are set to don't care, the 
oscilloscope will not trigger.

• The rising edge ( ) or falling edge ( ) softkey sets the pattern to an 
edge on the selected channel. Only one rising or falling edge can be 
specified in the pattern. When an edge is specified, the oscilloscope 
will trigger at the edge specified if the pattern set for the other 
channels is true.

If no edge is specified, the oscilloscope will trigger on the last edge 
that makes the pattern true.

You can also specify patterns for digital channels using the Bus1 and 
Bus2 softkeys and entering hexadecimal values. See "Hex Bus Pattern 
Trigger" on page 179.

The specified pattern is shown in the "Pattern =" line directly above the 
softkeys.

5 Adjust the trigger levels for analog and digital channels by using the 
softkeys in the Analyze Menu after pressing [Analyze] > Features and 
selecting Trigger Levels.

You can also set the threshold levels for digital channels by pressing 
[Digital] > Thresholds.

Hex Bus Pattern Trigger

You can specify a bus value on which to trigger. To do this, first define 
the bus. See "To display digital channels as a bus" on page 134 for details. 
You can trigger on a bus value whether you are displaying the bus or not.

NOTE Specifying an Edge in a Pattern

You are allowed to specify only one rising or falling edge term in the pattern. If you define an 
edge term, then select a different channel in the pattern and define another edge term, the 
previous edge definition is changed to a don't care.
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To trigger on a bus value:

1 Select the pattern trigger type and qualifier as described in "Pattern 
Trigger" on page 177.

2 Press the Bus1 or Bus2 softkey and use the hex keypad dialog to enter 
nibble (hex character) values.

When a hex bus digit contains one or more don't care (X) bits and one or 
more bits with a value or 0 or 1, the "$" sign will be displayed for the 
digit.

For information regarding digital bus display when Pattern triggering see 
"Bus values are displayed when using Pattern trigger" on page 136.

OR Trigger

The OR trigger mode triggers when any one (or more) of the specified 
edges on analog or digital channels is found.

1 On the front panel, in the Trigger section, press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey, and use the Entry knob 
to select OR.

3 Press the Slope softkey and select rising edge, falling edge, either edge, 
or don't care. The selected slope is displayed in the upper- right corner 
of the display.

4 For each analog or digital channel you want to include in the OR 
trigger, press the Channel softkey to select the channel.

As you press the Channel softkey (or rotate the Entry knob), the channel 
you select is highlighted in the OR = line directly above the softkeys 
and in the upper- right corner of the display next to the OR gate 
symbol.

NOTE If a digit is made up of less than four bits, the value of the digit is limited to the greatest 
number that can be represented by the number of bits.
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Adjust the trigger level for the selected analog channel by turning the 
Trigger Level knob. Press the [Digital] key and select Thresholds to set 
the threshold level for digital channels. The value of the trigger level or 
digital threshold is displayed in the upper- right corner of the display.

5 For each channel you select, press the Slope softkey and select  

(Rising),  (Falling),  (Either), or X (Don't Care). The selected slope is 
displayed above the softkeys.

If all channels in the OR trigger are set to don't care, the oscilloscope 
will not trigger.

6 To set all analog and digital channels to the edge selected by the Slope 
softkey, press the Set all Edges softkey.
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Rise/Fall Time Trigger

The Rise/Fall Time trigger looks for a rising or falling transition from one 
level to another level in greater than or less than a certain amount of 
time.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Rise/Fall Time.

High level

Low level

Rising edge time Falling edge time
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3 Press the Source softkey, and turn the Entry knob to select the input 
channel source.

4 Press the Rising Edge or Falling Edge softkey to toggle between edge types.

5 Press the Level Select softkey to select High; then, turn the Trigger Level 
knob to adjust the high level.

6 Press the Level Select softkey to select Low; then, turn the Trigger Level 
knob to adjust the low level.

You can also push the Trigger Level knob to toggle between High and 
Low selection.

7 Press the Qualifier softkey to toggle between "greater than" or "less than".

8 Press the Time softkey, and turn the Entry knob to select the time.
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Nth Edge Burst Trigger

The Nth Edge Burst trigger lets you trigger on the Nth edge of a burst that 
occurs after an idle time.

Nth Edge Burst trigger set up consists of selecting the source, the slope of 
the edge, the idle time, and the number of the edge:

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Nth Edge Burst.

3 Press the Source softkey, and turn the Entry knob to select the input 
channel source.
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4 Press the Slope softkey to specify the slope of the edge.

5 Press the Idle softkey; then, turn the Entry knob to specify the idle 
time.

6 Press the Edge softkey; then, turn the Entry knob to which edge number 
to trigger on.

Runt Trigger

The Runt trigger looks for pulses that cross one threshold but not another.

• A positive runt pulse crosses through a lower threshold but not an 
upper threshold.

• A negative runt pulse crosses through an upper threshold but not a 
lower threshold.

To trigger on runt pulses:

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Runt.

High level

Low level

Positive runt pulse Negative runt pulse
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3 Press the Source softkey, and turn the Entry knob to select the input 
channel source.

4 Press the Positive, Negative, or Either Runt Pulse softkey to toggle between 
pulse types.

5 Press the Level Select softkey to select High; then, turn the Trigger Level 
knob to adjust the high level.

6 Press the Level Select softkey to select Low; then, turn the Trigger Level 
knob to adjust the low level.

You can also push the Trigger Level knob to toggle between High and 
Low selection.

7 Press the Qualifier softkey to toggle between "less than", "greater than", 
or None.

This lets you specify that a runt pulse be less than or greater than a 
certain width.

8 If you selected the "less than" or "greater than" Qualifier, press the Time 
softkey; then, turn the Entry knob to select the time.
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Setup and Hold Trigger

The Setup and Hold trigger looks for setup and hold violations.

One oscilloscope channel probes the clock signal and another channel 
probes the data signal.

To trigger on setup and hold violations:

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Setup and Hold.

3 Press the Clock softkey; then, turn the Entry knob to select the input 
channel with the clock signal.

4 Set the appropriate trigger level for the clock signal using the Trigger 
Level knob.

5 Press the Rising Edge or Falling Edge softkey to specify the clock edge being 
used.

6 Press the Data softkey; then, turn the Entry knob to select the input 
channel with the data signal.

7 Set the appropriate trigger level for the data signal using the Trigger 
Level knob.

8 Press the < Setup softkey, and turn the Entry knob to select the setup 
time.

Data

Clock
(rising
edge)

Setup time Hold time
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9 Press the < Hold softkey, and turn the Entry knob to select the hold 
time.

Video Trigger

Video triggering can be used to capture the complicated waveforms of 
most standard analog video signals. The trigger circuitry detects the 
vertical and horizontal interval of the waveform and produces triggers 
based on the video trigger settings you have selected.

The oscilloscope's MegaZoom IV technology gives you bright, easily viewed 
displays of any part of the video waveform. Analysis of video waveforms is 
simplified by the oscilloscope's ability to trigger on any selected line of the 
video signal.
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1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Video.

3 Press the Source softkey and select any analog channel as the video 
trigger source.

The selected trigger source is displayed in the upper- right corner of the 
display. Turning the Trigger Level knob does not change the trigger level 
because the trigger level is automatically set to the sync pulse. Trigger 
coupling is automatically set to TV in the Trigger Mode and Coupling 
Menu.

NOTE It is important, when using a 10:1 passive probe, that the probe is correctly compensated. 
The oscilloscope is sensitive to this and will not trigger if the probe is not properly 
compensated, especially for progressive formats.
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4 Press the sync polarity softkey to set the Video trigger to either positive 

( ) or negative ( ) sync polarity.

5 Press the Settings softkey.

6 In the Video Trigger Menu, press the Standard softkey to set the video 
standard.

The oscilloscope supports triggering on the following television (TV) and 
video standards.

With the DSOX4VID extended video triggering license, the oscilloscope 
additionally supports these standards:

NOTE Provide Correct Matching

Many video signals are produced from 75 Ω sources. To provide correct matching to these 
sources, a 75 Ω terminator (such as an Agilent 11094B) should be connected to the 
oscilloscope input.

Standard Type Sync Pulse

NTSC Interlaced Bi-level

PAL Interlaced Bi-level

PAL-M Interlaced Bi-level

SECAM Interlaced Bi-level
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The Generic selection lets you trigger on custom bi- level and tri- level 
sync video standards. See "To set up Generic video triggers" on 
page 193.

7 Press the Auto Setup softkey to automatically set up the oscilloscope for 
the selected Source and Standard:

• Source channel vertical scaling is set to 140 mV/div.

• Source channel offset is set to 245 mV.

• Source channel is turned on.

• Trigger type is set to Video.

• Video trigger mode is set to All Lines (but left unchanged if Standard is 
Generic).

• Display Grid type is set to IRE (when Standard is NTSC) or mV (see "To 
select the grid type" on page 155).

• Horizontal time/division is set to 10 µs/div for NTSC/PAL/SECAM 
standards or 4 µs/div for EDTV or HDTV standards (unchanged for 
Generic).

Standard Type Sync Pulse

Generic Interlaced/Progressive Bi-level/Tri-level

EDTV 480p/60 Progressive Bi-level

EDTV 567p/50 Progressive Bi-level

HDTV 720p/50 Progressive Tri-level

HDTV 720p/60 Progressive Tri-level

HDTV 1080p/24 Progressive Tri-level

HDTV 1080p/25 Progressive Tri-level

HDTV 1080p/30 Progressive Tri-level

HDTV 1080p/50 Progressive Tri-level

HDTV 1080p/60 Progressive Tri-level

HDTV 1080i/50 Interlaced Tri-level

HDTV 1080i/60 Interlaced Tri-level
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• Horizontal delay is set so that trigger is at first horizontal division 
from the left (unchanged for Generic).

You can also press [Analyze]> Features and then select Video to quickly 
access the video triggering automatic set up and display options.

8 Press the Mode softkey to select the portion of the video signal that you 
would like to trigger on.

The Video trigger modes available are:

• Field1 and Field2 — Trigger on the rising edge of the first serration 
pulse of field 1 or field 2 (interlaced standards only).

• All Fields — Trigger on the rising edge of the first pulse in the vertical 
sync interval.

• All Lines — Trigger on all horizontal sync pulses.

• Line — Trigger on the selected line number (EDTV and HDTV 
standards only).

• Line: Field1 and Line:Field2 — Trigger on the selected line # in field 1 or 
field 2 (interlaced standards only).

• Line: Alternate — Alternately trigger on the selected line # in field 1 
and field 2 (NTSC, PAL, PAL- M, and SECAM only).

9 If you select a line # mode, press the Line # softkey, then rotate the 
Entry knob to select the line number on which you want to trigger.

The following table lists the line (or count) numbers per field for each 
video standard.

The following table lists the line numbers for each EDTV/HDTV video 
standard (available with the DSOX4VID extended video triggering 
license).

Video standard Field 1 Field 2 Alt Field

NTSC 1 to 263 1 to 262 1 to 262

PAL 1 to 313 314 to 625 1 to 312

PAL-M 1 to 263 264 to 525 1 to 262

SECAM 1 to 313 314 to 625 1 to 312
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Video Triggering
Examples

The following are exercises to familiarize you with video triggering. These 
exercises use the NTSC video standard.

• "To trigger on a specific line of video" on page 194

• "To trigger on all sync pulses" on page 195

• "To trigger on a specific field of the video signal" on page 196

• "To trigger on all fields of the video signal" on page 197

• "To trigger on odd or even fields" on page 198

To set up Generic video triggers

When Generic (available with the DSOX4VID extended video triggering 
license) is selected as the Video trigger Standard, you can trigger on custom 
bi- level and tri- level sync video standards. The Video Trigger Menu 
changes as follows.

1 Press the Time > softkey; then, turn the Entry knob to set the time to 
greater- than the sync- pulse width so that the oscilloscope synchronizes 
to the vertical sync.

2 Press the Edge # softkey; then, turn the Entry knob to select the Nth 
edge after after vertical sync to trigger on.

3 To enable or disable the horizontal sync control, press the first 
Horiz Sync softkey.

EDTV 480p/60 1 to 525

EDTV 567p/50 1 to 625

HDTV 720p/50, 720p/60 1 to 750

HDTV 1080p/24, 1080p/25, 1080p/30, 
1080p/50, 1080p/60

1 to 1125

HDTV 1080i/50, 1080i/60 1 to 1125
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• For interleaved video, enabling the Horiz Sync control and setting the 
Horiz Sync adjustment to the sync time of the probed video signal 
allows the Edge # function to count only lines and not double count 
during equalization. Additionally, the Field Holdoff can be adjusted so 
that the oscilloscope triggers once per frame.

• Similarly, for progressive video with a tri- level sync, enabling the 
Horiz Sync control and setting the Horiz Sync adjustment to the sync 
time of the probed video signal allows the Edge # function to count 
only lines and not double count during vertical sync.

When the horizontal sync control is enabled, press the second Horiz Sync 
softkey; then, turn the Entry knob to set the minimum time the 
horizontal sync pulse must be present to be considered valid.

To trigger on a specific line of video

Video triggering requires greater than 1/2 division of sync amplitude with 
any analog channel as the trigger source. Turning the trigger Level knob in 
Video trigger does not change the trigger level because the trigger level is 
automatically set to the sync pulse tips.

One example of triggering on a specific line of video is looking at the 
vertical interval test signals (VITS), which are typically in line 18. Another 
example is closed captioning, which is typically in line 21.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard (NTSC).

4 Press the Mode softkey and select the TV field of the line you want to 
trigger on. You can choose Line:Field1, Line:Field2, or Line:Alternate.

5 Press the Line # softkey and select the number of the line you want to 
examine.

NOTE Alternate Triggering

If Line:Alternate is selected, the oscilloscope will alternately trigger on the selected line 
number in Field 1 and Field 2. This is a quick way to compare the Field 1 VITS and Field 2 
VITS or to check for the correct insertion of the half line at the end of Field 1.
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To trigger on all sync pulses

To quickly find maximum video levels, you could trigger on all sync 
pulses. When All Lines is selected as the Video trigger mode, the 
oscilloscope will trigger on all horizontal sync pulses.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select All Lines.

Figure 28 Example: Triggering on Line 136
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To trigger on a specific field of the video signal

To examine the components of a video signal, trigger on either Field 1 or 
Field 2 (available for interleaved standards). When a specific field is 
selected, the oscilloscope triggers on the rising edge of the first serration 
pulse in the vertical sync interval in the specified field (1 or 2).

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select Field1 or Field2.

Figure 29 Triggering on All Lines
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To trigger on all fields of the video signal

To quickly and easily view transitions between fields, or to find the 
amplitude differences between the fields, use the All Fields trigger mode.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select All Fields.

Figure 30 Triggering on Field 1
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To trigger on odd or even fields

To check the envelope of your video signals, or to measure worst case 
distortion, trigger on the odd or even fields. When Field 1 is selected, the 
oscilloscope triggers on color fields 1 or 3. When Field 2 is selected, the 
oscilloscope triggers on color fields 2 or 4.

1 Press the [Trigger] key.

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select Video.

3 Press the Settings softkey, then press the Standard softkey to select the 
appropriate TV standard.

4 Press the Mode softkey and select Field1 or Field2.

Figure 31 Triggering on All Fields
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The trigger circuits look for the position of the start of Vertical Sync to 
determine the field. But this definition of field does not take into 
consideration the phase of the reference subcarrier. When Field 1 is 
selected, the trigger system will find any field where the vertical sync 
starts on Line 4. In the case of NTSC video, the oscilloscope will trigger 
on color field 1 alternating with color field 3 (see the following figure). 
This setup can be used to measure the envelope of the reference burst.

If a more detailed analysis is required, then only one color field should be 
selected to be the trigger. You can do this by using the Field Holdoff softkey 
in the Video Trigger Menu. Press the Field Holdoff softkey and use the Entry 
knob to adjust the holdoff in half- field increments until the oscilloscope 
triggers on only one phase of the color burst.

A quick way to synchronize to the other phase is to briefly disconnect the 
signal and then reconnect it. Repeat until the correct phase is displayed.

Figure 32 Triggering on Color Field 1 Alternating with Color Field 3
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When holdoff is adjusted using the Field Holdoff softkey and the Entry knob, 
the corresponding holdoff time will be displayed in the Trigger Mode and 
Coupling Menu.

Table 4 Half-field holdoff time

Standard Time

NTSC 8.35 ms

PAL 10 ms

PAL-M 10 ms

SECAM 10 ms

Generic 8.35 ms

EDTV 480p/60 8.35 ms

EDTV 567p/50 10 ms

HDTV 720p/50 10 ms

HDTV 720p/60 8.35 ms

HDTV 1080p/24 20.835 ms

HDTV 1080p/25 20 ms

HDTV 1080p/30 20 ms

HDTV 1080p/50 16.67 ms

HDTV 1080p/60 8.36 ms

HDTV 1080i/50 10 ms

HDTV 1080i/60 8.35 ms
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Serial Trigger

With serial decode option licenses (see "Serial Decode Options" on 
page 145), you can enable serial trigger types. To set up these triggers, 
see:

• "ARINC 429 Triggering" on page 454

• "CAN Triggering" on page 390

• "FlexRay Triggering" on page 406

• "I2C Triggering" on page 416

• "I2S Triggering" on page 438

• "LIN Triggering" on page 398

• "MIL- STD- 1553 Triggering" on page 447

Figure 33 Using Field Holdoff to Synchronize to Color Field 1 or 3 (Field 1 mode)
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• "SPI Triggering" on page 428

• "UART/RS232 Triggering" on page 463

• "USB 2.0 Triggering" on page 473

Zone Qualified Trigger

The zone qualified trigger feature gives you one or two rectangular areas, 
Zone 1 and Zone 2, that a waveform must either intersect or not intersect 
in order for an acquisition to be displayed and stored in memory.

The zone qualified trigger feature works on top of the oscilloscope's 
hardware trigger, which determines the acquisitions whose waveforms are 
evaluated for zone intersection.

To set up a zone qualified trigger:

1 Touch the upper- right corner to select the rectangle draw mode.

2 Drag your finger (or connected USB mouse pointer) across the screen 
to draw a rectangular zone that the waveform must either intersect or 
not intersect.

3 Take your finger off the screen (or release the mouse button).

4 In the popup menu, select whether the rectangle is Zone 1 or Zone 2 
and whether it is a "Must Intersect" or "Must Not Intersect" zone.
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The [Zone] key becomes lit to show the zone qualified trigger feature is 
enabled.

5 In the Zone Qualified Trigger Menu, press the Source softkey and select 
the analog channel input source that both zones are associated with.

Zone colors match the selected analog input channel. "Must Not 
Intersect" zones are shaded differently than the solid "Must Intersect" 
zones.

The zone qualified trigger source does not have to be the same as the 
hardware trigger source.

6 You can use the Zone 1 On and Zone 2 On softkeys to disable or enable 
zones, and you can use the Zone 1 and Zone 2 softkeys to toggle between 
the "Must Intersect" and "Must Not Intersect" conditions.
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Disabling both zones disables the zone qualified trigger feature. When 
the zone qualified trigger feature is enabled, at least one zone must be 
enabled.

You can press the [Zone] key to disable or re- enable the zone qualified 
trigger.

When two non- overlapping zones are used, their conditions are ANDed to 
become the final qualifying condition.

When two overlapping zones have the must intersect condition, the zones 
are ORed. When two overlapping zones have different conditions, Zone 1 
takes precedence and Zone 2 is not used. In this case, Zone 2 will have no 
fill (that is, neither solid nor shaded) to indicate that it is not being used.

The zone qualified trigger feature is incompatible with, and will disable, 
the XY and Roll horizontal time modes and the Averaging acquisition 
mode.

NOTE Keep in mind that the TRIG OUT signal comes from the oscilloscope's hardware trigger. The 
TRIG OUT signal indicates when there is a trigger (acquisition) that is evaluated for zone 
intersection, not when an acquisition meets the zone qualification and is plotted on the 
oscilloscope's display.
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To enable or disable trigger HF Reject 209

To set the trigger holdoff 210

External Trigger Input 210

To access the Trigger Mode and Coupling Menu:

• In the Trigger section of the front panel, press the [Mode/Coupling] key.

Noisy Signals If the signal you are probing is noisy, you can set up the oscilloscope to 
reduce the noise in the trigger path and on the displayed waveform. First, 
stabilize the displayed waveform by removing the noise from the trigger 
path. Second, reduce the noise on the displayed waveform.

1 Connect a signal to the oscilloscope and obtain a stable display.

2 Remove the noise from the trigger path by turning on high- frequency 
rejection ("To enable or disable trigger HF Reject" on page 209), 
low- frequency rejection ("To select the trigger coupling" on page 208), 
or "To enable or disable trigger noise rejection" on page 209.

3 Use "Averaging Acquisition Mode" on page 223 to reduce noise on the 
displayed waveform.
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To select the Auto or Normal trigger mode

When the oscilloscope is running, the trigger mode tells the oscilloscope 
what to do when triggers are not occurring.

In the Auto trigger mode (the default setting), if the specified trigger 
conditions are not found, triggers are forced and acquisitions are made so 
that signal activity is displayed on the oscilloscope.

In the Normal trigger mode, triggers and acquisitions only occur when the 
specified trigger conditions are found.

To select the trigger mode:

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the Mode softkey; then 
select either Auto or Normal.

You can also make this selection using the touchscreen. See "Access the 
Trigger Menu, Change the Trigger Mode, and Open the Trigger Level 
Dialog" on page 57.

See the following "When to Use Auto Trigger Mode" on page 207 and 
"When to Use Normal Trigger Mode" on page 207 descriptions.

You can also configure the [Quick Action] key to toggle between the Auto 
and Normal trigger modes. See "Configuring the [Quick Action] Key" on 
page 347.

Triggering and
the Pre- and
Post-Trigger

Buffers

After the oscilloscope starts running (after pressing [Run] or [Single] or 
changing the trigger condition), the oscilloscope first fills the pre- trigger 
buffer. Then, after the pre- trigger buffer is filled, the oscilloscope starts 
searching for a trigger, and sampled data continues to flow data through 
the pre- trigger buffer in a first- in first- out (FIFO) manner.

When a trigger is found, the pre- trigger buffer contains the events that 
occurred just before the trigger. Then, the oscilloscope fills the post- trigger 
buffer and displays the acquisition memory. If the acquisition was 
initiated by [Run/Stop], the process repeats. If the acquisition was initiated 
by pressing [Single], the acquisition stops (and you can Pan and Zoom the 
waveform).
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In either Auto or Normal trigger mode, a trigger may be missed if the 
event occurs while the pre- trigger buffer is being filled. This may be more 
likely, for example, when the horizontal scale knob is set to a slow 
time/div setting, such as 500 ms/div.

Trigger Indicator The trigger indicator at the top right of the display shows whether triggers 
are occurring.

In the Auto trigger mode, the trigger indicator can show:

• Auto?— the trigger condition is not found (after the pre- trigger buffer 
has filled), and forced triggers and acquisitions are occurring.

• Auto — the trigger condition is found (or the pre- trigger buffer is being 
filled).

In the Normal trigger mode, the trigger indicator can show:

• Trig'd?— the trigger condition is not found (after the pre- trigger buffer 
has filled), and no acquisitions are occurring.

• Trig'd— trigger condition is found (or pre- trigger buffer is being filled).

When the oscilloscope is not running, the trigger indicator area shows 
Stop.

When to Use Auto
Trigger Mode

The Auto trigger mode is appropriate when:

• Checking DC signals or signals with unknown levels or activity.

• When trigger conditions occur often enough that forced triggers are 
unnecessary.

When to Use
Normal Trigger

Mode

The Normal trigger mode is appropriate when:

• You only want to acquire specific events specified by the trigger 
settings.

• Triggering on an infrequent signal from a serial bus (for example, I2C, 
SPI, CAN, LIN, etc.) or another signal that arrives in bursts. The Normal 
trigger mode lets you stabilize the display by preventing the oscilloscope 
from auto- triggering.

• Making single- shot acquisitions with the [Single] key.

Often with single- shot acquisitions, you must initiate some action in the 
device under test, and you don't want the oscilloscope to auto- trigger 
before that happens. Before initiating the action in the circuit, wait for 
the trigger condition indicator Trig'd? to display (this tells you the 
pre- trigger buffer is filled).
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See Also • "Forcing a Trigger" on page 169

• "To set the trigger holdoff" on page 210

• "To position the time reference (left, center, right)" on page 75

To select the trigger coupling

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the Coupling softkey; 
then, turn the Entry knob to select:

• DC coupling — allows DC and AC signals into the trigger path.

• AC coupling — places a 10 Hz high- pass filter in the trigger path 
removing any DC offset voltage from the trigger waveform.

The high- pass filter in the External Trigger input path is 50 Hz for 
all models.

Use AC coupling to get a stable edge trigger when your waveform has 
a large DC offset.

• LF (low frequency) Reject coupling — adds a high- pass filter with the 
3- dB point at 50 kHz in series with the trigger waveform.

Low frequency reject removes any unwanted low frequency 
components from a trigger waveform, such as power line frequencies, 
etc., that can interfere with proper triggering.

Use LF Reject coupling to get a stable edge trigger when your 
waveform has low frequency noise.

Pass
Band

50 kHz

0 dB

3 dB down point

DC
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• Video coupling — is normally grayed- out, but is automatically selected 
when Video trigger is enabled in the Trigger Menu.

Note that Trigger Coupling is independent of Channel Coupling (see "To 
specify channel coupling" on page 84).

To enable or disable trigger noise rejection

Noise Rej adds additional hysteresis to the trigger circuitry. By increasing 
the trigger hysteresis band, you reduce the possibility of triggering on 
noise. However, this also decreases the trigger sensitivity so that a slightly 
larger signal is required to trigger the oscilloscope.

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the Noise Rej softkey to 
enable or disable.

To enable or disable trigger HF Reject

HF Reject adds a 50 kHz low- pass filter in the trigger path to remove high 
frequency components from the trigger waveform.

You can use HF Reject to remove high- frequency noise, such as AM or FM 
broadcast stations or noise from fast system clocks, from the trigger path.

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the HF Reject softkey to 
enable or disable.

Pass
Band

50 kHzDC

0 dB

-3 dB
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To set the trigger holdoff

Trigger holdoff sets the amount of time the oscilloscope waits after a 
trigger before re- arming the trigger circuitry.

Use the holdoff to trigger on repetitive waveforms that have multiple edges 
(or other events) between waveform repetitions. You can also use holdoff 
to trigger on the first edge of a burst when you know the minimum time 
between bursts.

For example, to get a stable trigger on the repetitive pulse burst shown 
below, set the holdoff time to be >200 ns but <600 ns.

To set the trigger holdoff:

1 Press the [Mode/Coupling] key.

2 In the Trigger Mode and Coupling Menu, press the Holdoff softkey; then, 
turn the Entry knob to increase or decrease the trigger holdoff time.

Trigger Holdoff
Operating Hints

The correct holdoff setting is typically slightly less than one repetition of 
the waveform. Set the holdoff to this time to generate a unique trigger 
point for a repetitive waveform.

Changing the time base settings does not affect the trigger holdoff time.

With Agilent's MegaZoom technology, you can press [Stop], then pan and 
zoom through the data to find where the waveform repeats. Measure this 
time using cursors; then, set the holdoff.

External Trigger Input

The external trigger input can be used as a source in several of the trigger 
types. The external trigger BNC input is labeled EXT TRIG IN.

200 ns

Oscilloscope triggers hereHoldoff

600 ns
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The external trigger input impedance is 1M Ohm. This lets you use passive 
probes for general- purpose measurements. The higher impedance 
minimizes the loading effect of the oscilloscope on the device under test.

To set the EXT TRIG IN units and probe attenuation:

1 Press the [Mode/Coupling] key in the Trigger section of the front panel.

2 In the Trigger Mode and Coupling Menu, press the External softkey.

3 In the External Trigger Menu, press the Units softkey to select between:

• Volts — for a voltage probe.

• Amps — for a current probe.

Measurement results, channel sensitivity, and the trigger level will 
reflect the measurement units you have selected.

4 Press the Probe softkey; then, turn the Entry knob to specify the probe 
attenuation.

The attenuation factor can be set from 0.1:1 to 10000:1 in a 1- 2- 5 
sequence.

The probe attenuation factor must be set properly for measurements to 
be made correctly.

CAUTION  Maximum voltage at oscilloscope external trigger input

CAT I 300 Vrms, 400 Vpk; transient overvoltage 1.6 kVpk

1 M ohm input: For steady-state sinusoidal waveforms derate at 20 dB/decade above 
57 kHz to a minimum of 5 Vpk

With N2863A 10:1 probe: CAT I 600 V (DC + peak AC)

With 10073C or 10074C 10:1 probe: CAT I 500 Vpk
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5 Press the Range softkey; then, turn the Entry knob to set the External 
Trigger input signal range.

The range is either 1.6 V or 8 V when you are using a 1:1 probe.

The range is automatically recalculated when a different External 
Trigger probe attenuation factor is chosen.



213

Agilent InfiniiVision 4000 X-Series Oscilloscopes 
User's Guide

 

s1

12
Acquisition Control

Running, Stopping, and Making Single Acquisitions (Run Control) 213

Overview of Sampling 215

Selecting the Acquisition Mode 219

Realtime Sampling Option 226
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This chapter shows how to use the oscilloscope's acquisition and run 
controls.

Running, Stopping, and Making Single Acquisitions (Run Control)

There are two front panel keys for starting and stopping the oscilloscope's 
acquisition system: [Run/Stop] and [Single].

• When the [Run/Stop] key is green, the oscilloscope is running, that is, 
acquiring data when trigger conditions are met.

To stop acquiring data, press [Run/Stop]. When stopped, the last 
acquired waveform is displayed.

• When the [Run/Stop] key is red, data acquisition is stopped.

"Stop" is displayed next to the trigger type in the status line at the top 
of the display.

To start acquiring data, press [Run/Stop].

• To capture and display a single acquisition (whether the oscilloscope is 
running or stopped), press [Single].
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The [Single] run control lets you view single- shot events without 
subsequent waveform data overwriting the display. Use [Single] when 
you want maximum memory depth for pan and zoom.

When you press [Single], the trigger mode is temporarily set to Normal 
(to keep the oscilloscope from auto- triggering immediately), the trigger 
circuitry is armed, the [Single] key is illuminated, and the oscilloscope 
waits until a trigger condition occurs before it displays a waveform.

When the oscilloscope triggers, the single acquisition is displayed and 
the oscilloscope is stopped (the [Run/Stop] key is illuminated in red). 
Press [Single] again to acquire another waveform.

If the oscilloscope doesn't trigger, you can press the [Force Trigger] key to 
trigger on anything and make a single acquisition.

To display the results of multiple acquisitions, use persistence. See "To set 
or clear persistence" on page 153.

Single vs.
Running and

Record Length

The maximum data record length is greater for a single acquisition than 
when the oscilloscope is running (or when the oscilloscope is stopped 
after running):

• Single — Single acquisitions always use the maximum memory available 
— at least twice as much memory as acquisitions captured when 
running — and the oscilloscope stores at least twice as many samples. 
At slower time/div settings, because there is more memory available for 
a single acquisition, the acquisition has a higher effective sample rate.

• Running — When running (versus taking a single acquisition), the 
memory is divided in half. This lets the acquisition system acquire one 
record while processing the previous acquisition, dramatically improving 
the number of waveforms per second processed by the oscilloscope. 
When running, a high waveform update rate provides the best 
representation of your input signal.

To acquire data with the longest possible record length, press the [Single] 
key.

For more information on settings that affect record length, see "Length 
Control" on page 314.
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Overview of Sampling

To understand the oscilloscope's sampling and acquisition modes, it is 
helpful to understand sampling theory, aliasing, oscilloscope bandwidth 
and sample rate, oscilloscope rise time, oscilloscope bandwidth required, 
and how memory depth affects sample rate.

Sampling Theory

The Nyquist sampling theorem states that for a limited bandwidth 
(band- limited) signal with maximum frequency fMAX, the equally spaced 
sampling frequency fS must be greater than twice the maximum frequency 
fMAX, in order to have the signal be uniquely reconstructed without 
aliasing.

fMAX = fS/2 = Nyquist frequency (fN) = folding frequency

Aliasing

Aliasing occurs when signals are under- sampled (fS < 2fMAX). Aliasing is 
the signal distortion caused by low frequencies falsely reconstructed from 
an insufficient number of sample points.

Figure 34 Aliasing
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Oscilloscope Bandwidth and Sample Rate

An oscilloscope's bandwidth is typically described as the lowest frequency 
at which input signal sine waves are attenuated by 3 dB (- 30% amplitude 
error).

At the oscilloscope bandwidth, sampling theory says the required sample 
rate is fS = 2fBW. However, the theory assumes there are no frequency 
components above fMAX (fBW in this case) and it requires a system with 
an ideal brick- wall frequency response.

However, digital signals have frequency components above the fundamental 
frequency (square waves are made up of sine waves at the fundamental 
frequency and an infinite number of odd harmonics), and typically, for 
500 MHz bandwidths and below, oscilloscopes have a Gaussian frequency 
response.

Figure 35 Theoretical Brick-Wall Frequency Response
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 So, in practice, an oscilloscope's sample rate should be four or more times 
its bandwidth: fS = 4fBW. This way, there is less aliasing, and aliased 
frequency components have a greater amount of attenuation.

Note that 1.5 GHz bandwidth 4000 X- Series oscilloscope models have 
more of a brick- wall type frequency response than the Gaussian response 
of lower bandwidth 4000 X- Series oscilloscope models. To understand the 
characteristics of each type of oscilloscope frequency response, see 
Understanding Oscilloscope Frequency Response and Its Effect on 
Rise- Time Accuracy, Agilent Application Note 1420 
("http://cp.literature.agilent.com/litweb/pdf/5988- 8008EN.pdf").

See Also Evaluating Oscilloscope Sample Rates vs. Sampling Fidelity: How to 
Make the Most Accurate Digital Measurements, Agilent Application Note 
1587 ("http://cp.literature.agilent.com/litweb/pdf/5989- 5732EN.pdf")

Oscilloscope Rise Time

Closely related to an oscilloscope's bandwidth specification is its rise time 
specification. Oscilloscopes with a Gaussian- type frequency response have 
an approximate rise time of 0.35/fBW based on a 10% to 90% criterion.

Figure 36 Sample Rate and Oscilloscope Bandwidth

Limiting oscilloscope bandwidth (fBW) to 1/4 the sample rate (fS/4)
reduces frequency components above the Nyquist frequency (fN).

http://cp.literature.agilent.com/litweb/pdf/5988-8008EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5989-5732EN.pdf
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An oscilloscope's rise time is not the fastest edge speed that the 
oscilloscope can accurately measure. It is the fastest edge speed the 
oscilloscope can possibly produce.

Oscilloscope Bandwidth Required

The oscilloscope bandwidth required to accurately measure a signal is 
primarily determined by the signal's rise time, not the signal's frequency. 
You can use these steps to calculate the oscilloscope bandwidth required:

1 Determine the fastest edge speeds.

You can usually obtain rise time information from published 
specifications for devices used in your designs.

2 Compute the maximum "practical" frequency component.

From Dr. Howard W. Johnson's book, High- Speed Digital Design – A 
Handbook of Black Magic, all fast edges have an infinite spectrum of 
frequency components. However, there is an inflection (or "knee") in the 
frequency spectrum of fast edges where frequency components higher 
than fknee are insignificant in determining the shape of the signal.

fknee = 0.5 / signal rise time (based on 10% -  90% thresholds)

fknee = 0.4 / signal rise time (based on 20% -  80% thresholds)

3 Use a multiplication factor for the required accuracy to determine the 
oscilloscope bandwidth required.

See Also Choosing an Oscilloscope with the Right Bandwidth for your 
Application, Agilent Application Note 1588 
("http://cp.literature.agilent.com/litweb/pdf/5989- 5733EN.pdf")

Required accuracy Oscilloscope bandwidth required

20% fBW = 1.0 x fknee

10% fBW = 1.3 x fknee

3% fBW = 1.9 x fknee

http://cp.literature.agilent.com/litweb/pdf/5989-5733EN.pdf
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Memory Depth and Sample Rate

The number of points of oscilloscope memory is fixed, and there is a 
maximum sample rate associated with oscilloscope's analog- to- digital 
converter; however, the actual sample rate is determined by the time of 
the acquisition (which is set according to the oscilloscope's horizontal 
time/div scale).

sample rate = number of samples / time of acquisition

For example, when storing 50 µs of data in 50,000 points of memory, the 
actual sample rate is 1 GSa/s.

Likewise, when storing 50 ms of data in 50,000 points of memory, the 
actual sample rate is 1 MSa/s.

The actual sample rate is displayed in the right- side information area.

The oscilloscope achieves the actual sample rate by throwing away 
(decimating) unneeded samples.

Selecting the Acquisition Mode

When selecting the oscilloscope acquisition mode, keep in mind that 
samples are normally decimated at slower time/div settings.

At slower time/div settings, the effective sample rate drops (and the 
effective sample period increases) because the acquisition time increases 
and the oscilloscope's digitizer is sampling faster than is required to fill 
memory.

For example, suppose an oscilloscope's digitizer has a sample period of 
1 ns (maximum sample rate of 1 GSa/s) and a 1 M memory depth. At that 
rate, memory is filled in 1 ms. If the acquisition time is 100 ms 
(10 ms/div), only 1 of every 100 samples is needed to fill memory.

To select the acquisition mode:

1 Press the [Acquire] key on the front panel.

2 In the Acquire Menu, press the Acq Mode softkey; then, turn the Entry 
knob to select the acquisition mode.

The InfiniiVision oscilloscopes have the following acquisition modes:
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• Normal — at slower time/div settings, normal decimation occurs, and 
there is no averaging. Use this mode for most waveforms. See 
"Normal Acquisition Mode" on page 220.

• Peak Detect — at slower time/div settings, the maximum and minimum 
samples in the effective sample period are stored. Use this mode for 
displaying narrow pulses that occur infrequently. See "Peak Detect 
Acquisition Mode" on page 220.

• Averaging — at all time/div settings, the specified number of triggers 
are averaged together. Use this mode for reducing noise and 
increasing resolution of periodic signals without bandwidth or rise 
time degradation. See "Averaging Acquisition Mode" on page 223.

• High Resolution — at slower time/div settings, all samples in the 
effective sample period are averaged and the average value is stored. 
Use this mode for reducing random noise. See "High Resolution 
Acquisition Mode" on page 225.

Normal Acquisition Mode

In Normal mode at slower time/div settings, extra samples are decimated 
(in other words, some are thrown away). This mode yields the best display 
for most waveforms.

Peak Detect Acquisition Mode

In Peak Detect mode at slower time/div settings, minimum and maximum 
samples are kept in order to capture infrequent and narrow events (at the 
expense of exaggerating any noise). This mode displays all pulses that are 
at least as wide as the sample period.

For InfiniiVision 4000 X- Series oscilloscopes, which have a maximum 
sample rate of 5 GSa/s, a sample is taken every 200 ps (sample period).

See Also • "Glitch or Narrow Pulse Capture" on page 221

• "Using Peak Detect Mode to Find a Glitch" on page 222
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Glitch or Narrow Pulse Capture

A glitch is a rapid change in the waveform that is usually narrow as 
compared to the waveform. Peak detect mode can be used to more easily 
view glitches or narrow pulses. In peak detect mode, narrow glitches and 
sharp edges are displayed more brightly than when in Normal acquire 
mode, making them easier to see.

To characterize the glitch, use the cursors or the automatic measurement 
capabilities of the oscilloscope.

Figure 37 Sine With Glitch, Normal Mode
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Using Peak Detect Mode to Find a Glitch

1 Connect a signal to the oscilloscope and obtain a stable display.

2 To find the glitch, press the [Acquire] key; then, press the Acq Mode 
softkey until Peak Detect is selected.

3 Press the [Display] key then press the ∞ Persistence (infinite persistence) 
softkey.

Infinite persistence updates the display with new acquisitions but does 
not erase previous acquisitions. New sample points are shown at normal 
intensity while previous acquisitions are displayed at reduced intensity. 
Waveform persistence is not kept beyond the display area boundary.

Press the Clear Display softkey to erase previously acquired points. The 
display will accumulate points until ∞ Persistence is turned off.

Figure 38 Sine With Glitch, Peak Detect Mode
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4 Characterize the glitch with Zoom mode:

a Press the  zoom key (or press the [Horiz] key and then the Zoom 
softkey).

b To obtain a better resolution of the glitch, expand the time base.

Use the horizontal position knob ( ) to pan through the waveform to set 
the expanded portion of the normal window around the glitch.

Averaging Acquisition Mode

The Averaging mode lets you average multiple acquisitions together to 
reduce noise and increase vertical resolution (at all time/div settings). 
Averaging requires a stable trigger.

The number of averages can be set from 2 to 65536 in power- of- 2 
increments.

A higher number of averages reduces noise more and increases vertical 
resolution.

The higher the number of averages, the slower the displayed waveform 
responds to waveform changes. You must compromise between how quickly 
the waveform responds to changes and how much you want to reduce the 
displayed noise on the signal.

To use the Averaging mode:

1 Press the [Acquire] key, then press the Acq Mode softkey until the 
Averaging mode is selected.

2 Press the #Avgs softkey and turn the Entry knob to set the number of 
averages that best eliminates the noise from the displayed waveform. 

# Avgs Bits of resolution

2 8

4 9

16 10

64 11

≥ 256 12
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The number of acquisitions being averaged is displayed in the # Avgs 
softkey.

Figure 39 Random noise on the displayed waveform
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See Also • Chapter 11, “Trigger Mode/Coupling,” starting on page 205

• "Averaged Value" on page 114

High Resolution Acquisition Mode

In High Resolution mode, at slower time/div settings extra samples are 
averaged in order to reduce random noise, produce a smoother trace on 
the screen, and effectively increase vertical resolution.

High Resolution mode averages sequential sample points within the same 
acquisition. An extra bit of vertical resolution is produced for every factor 
of 2 averages. Random noise is reduced by ½ for every factor of 4 
averages. The number of extra bits of vertical resolution is dependent on 
the time per division setting (sweep speed) of the oscilloscope.

Figure 40 128 Averages used to reduce random noise
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The slower the time/div setting, the greater the number of samples that 
are averaged together for each display point.

High Resolution mode can be used on both single- shot and repetitive 
signals and it does not slow waveform update because the computation is 
done in the MegaZoom custom ASIC. High Resolution mode limits the 
oscilloscope's real- time bandwidth because it effectively acts like a 
low- pass filter.

Realtime Sampling Option

With the 4000 X- Series 1 GHz and 1.5 GHz bandwidth models, you can 
turn off Realtime sampling and switch to equivalent time sampling. 
(Realtime sampling is always on for the lower bandwidth models, and 
there is no option for turning it off.)

This setting only has an effect when sweep speeds are 20 ns/div or faster. 
At slower sweep speeds, there are enough sample points in a trigger 
(acquisition, in other words) to render a waveform on the display.

Realtime sampling specifies that the oscilloscope produce the waveform 
display from samples collected during one trigger event (that is, one 
acquisition).

Use Realtime sampling to capture infrequent triggers, unstable triggers, or 
complex changing waveforms, such as eye diagrams.

When Realtime sampling is on (as in the default setup):

Sweep speed Bits of resolution

≤ 1 µs/div 8

2 µs/div 9

5 µs/div 10

10 µs/div 11

≥ 20 µs/div 12
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• When less than 1000 samples can be collected in the time spanned by 
the screen, a sophisticated reconstruction filter is used to fill- in and 
enhance the waveform display.

• If you press the [Stop] key, and pan and zoom through the waveform 
using the Horizontal and Vertical controls, only the last trigger's 
acquisition will be displayed.

When Realtime sampling is off (equivalent time mode):

• Instead of the reconstruction filter, a technique known as random 
repetitive sampling is used to build- up and draw one waveform using 
multiple triggers (acquisitions).

• Equivalent time sampling mode requires a repetitive waveform with a 
stable trigger.

See Also • "Realtime Sampling and Oscilloscope Bandwidth" on page 227

Realtime Sampling and Oscilloscope Bandwidth

To accurately reproduce a sampled waveform, the sample rate should be at 
least 2.5 times the highest frequency component of the waveform. If not, it 
is possible for the reconstructed waveform to be distorted or aliased. 
Aliasing is most commonly seen as jitter on fast edges.

The maximum sample rate for the 4000 X- Series oscilloscopes is 5 GSa/s 
for a single channel in a channel pair. Channels 1 and 2 constitute a 
channel pair, and channels 3 and 4 constitute another channel pair. For 
example, the sample rate of a 4- channel oscilloscope is 5 GSa/s when 
channels 1 and 3, 1 and 4, 2 and 3, or 2 and 4 are on.

Whenever both channels in a channel pair are on, the sample rate for all 
channels is halved. For example, when channels 1, 2, and 3 are on, the 
sample rate for all channels is 2.5 GSa/s.

When Realtime sampling is on, the bandwidth of the oscilloscope is 
limited because the bandwidth of the reconstruction filter is set to fs/4. 
For example, a MSOX410xA oscilloscope with channels 1 and 2 on has a 
bandwidth of 625 MHz when Realtime sampling on and 1 GHz when 
Realtime sampling is off.

The sample rate is displayed in the sidebar Summary dialog.
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Acquiring to Segmented Memory

When capturing multiple infrequent trigger events it is advantageous to 
divide the oscilloscope's memory into segments. This lets you capture 
signal activity without capturing long periods of signal inactivity.

Each segment is complete with all analog channel, digital channel (on MSO 
models), and serial decode data.

When using segmented memory, use the Analyze Segments feature (see 
"Measurements, Statistics, and Infinite Persistence with Segmented 
Memory" on page 229) to show infinite persistence across all acquired 
segments. See also "To set or clear persistence" on page 153 for details.

To acquire to
segmented

memory

1 Set up a trigger condition. (See Chapter 10, “Triggers,” starting on page 
167 for details.)

2 Press the [Acquire] key in the Waveform section of the front panel.

3 Press the Segmented softkey.

4 In the Segmented Memory Menu, press the Segmented softkey to enable 
segmented memory acquisitions.

5 Press the # of Segs softkey and turn the Entry knob to select the 
number of segments into which you would like to divide the 
oscilloscope's memory.

Memory can be divided into as few as two segments and as many as 
1000 segments, depending on the oscilloscope model.

6 Press the [Run] or [Single] key.

The oscilloscope runs and fills a memory segment for each trigger event. 
When the oscilloscope is busy acquiring multiple segments, the progress is 
displayed on screen. The oscilloscope continues to trigger until memory is 
filled, then the oscilloscope stops.

If the signal you are measuring has more than about 1 s of inactivity, 
consider selecting the Normal trigger mode to prevent AutoTriggering. See 
"To select the Auto or Normal trigger mode" on page 206.

See Also • "Navigating Segments" on page 229

• "Measurements, Statistics, and Infinite Persistence with Segmented 
Memory" on page 229

• "Segmented Memory Re- Arm Time" on page 230
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• "Saving Data from Segmented Memory" on page 230

Navigating Segments

1 Press the Current Seg softkey and turn the Entry knob to display the 
desired segment along with a time tag indicating the time from the first 
trigger event.

You can also navigate segments using the [Navigate] key and controls. See 
"To navigate segments" on page 79.

Measurements, Statistics, and Infinite Persistence with Segmented Memory

To perform measurements and view statistical information, press [Meas] 
and set up your desired measurements (see Chapter 14, “Measurements,” 
starting on page 241). Then, press Analyze Segments. Statistical data will be 
accumulated for the measurements you have chosen.
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The Analyze Segments softkey appears when the acquisition is stopped and 
the segmented memory feature is on or when the serial Lister is enabled.

You can also turn on infinite persistence (in the Display Menu) and press 
the Analyze Segments softkey to create an infinite persistence display.

Segmented Memory Re-Arm Time

After each segment fills, the oscilloscope re- arms and is ready to trigger 
in about 1 µs.

Remember though, for example: if the horizontal time per division control 
is set to 5 µs/div, and the Time Reference is set to Center, it will take at 
least 50 µs to fill all ten divisions and re- arm. (That is 25 µs to capture 
pre- trigger data and 25 µs to capture post- trigger data.)

Saving Data from Segmented Memory

You can save either the currently displayed segment (Save Segment - 
Current), or all segments (Save Segment - All) in the following data formats: 
CSV, ASCII XY, and BIN.

Be sure to set the Length control to capture enough points to accurately 
represent the captured data. When the oscilloscope is busy saving multiple 
segments, progress is displayed in the upper right area of the display.

For more information, see "To save CSV, ASCII XY, or BIN data files" on 
page 312.
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Cursors

To make cursor measurements 232

Cursor Examples 235

Cursors are horizontal and vertical markers that indicate X- axis values 
and Y- axis values on a selected waveform source. You can use cursors to 
make custom voltage, time, phase, or ratio measurements on oscilloscope 
signals.

Cursor information is displayed in the right- side information area.

Cursors are not always limited to the visible display. If you set a cursor, 
then pan and zoom the waveform until the cursor is off screen, its value 
will not be changed. It will still be there when you return to its original 
location.

X Cursors X cursors are vertical dashed lines that adjust horizontally and can be 
used to measure time (s), frequency (1/s), phase (°), and ratio (%).

The X1 cursor is the short- dashed vertical line, and the X2 cursor is the 
long- dashed vertical line.

When used with the FFT math function as a source, the X cursors 
indicate frequency.

In XY horizontal mode, the X cursors display channel 1 values (Volts or 
Amps).

The X1 and X2 cursor values for the selected waveform source are 
displayed in the softkey menu area.

The difference between X1 and X2 (ΔX) and 1/ΔX are displayed in the 
Cursors box in the right- side information area.
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Y Cursors Y cursors are horizontal dashed lines that adjust vertically and can be 
used to measure Volts or Amps, dependent on the channel Probe Units 
setting, or they can measure ratios (%). When math functions are used as 
a source, the measurement units correspond to that math function.

The Y1 cursor is the short- dashed horizontal line and the Y2 cursor is the 
long- dashed horizontal line.

The Y cursors adjust vertically and typically indicate values relative to the 
waveform's ground point, except math FFT where the values are relative 
to 0 dB.

In XY horizontal mode, the Y cursors display channel 2 values (Volts or 
Amps).

When active, the Y1 and Y2 cursor values for the selected waveform 
source are displayed in the softkey menu area.

The difference between Y1 and Y2 (ΔY) is displayed in the Cursors box in 
the right- side information area.

To make cursor measurements

1 Connect a signal to the oscilloscope and obtain a stable display.

2 Press the [Cursors] key.

The Cursors box in the right- side information area appears, indicating 
that cursors are "on". (Press the [Cursors] key again when you want to 
turn cursors off.)

3 In the Cursors Menu, press Mode; then, select the desired mode:

• Manual — ΔX, 1/ΔX, and ΔY values are displayed. ΔX is the difference 
between the X1 and X2 cursors and ΔY is the difference between the 
Y1 and Y2 cursors.



Cursors 13

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 233

 

• Track Waveform — As you move a marker horizontally, the vertical 
amplitude of the waveform is tracked and measured. The time and 
voltage positions are shown for the markers. The vertical (Y) and 
horizontal (X) differences between the markers are shown as ΔX and 
ΔY values.

• Measure — When measurements are displayed, this mode shows the 
cursor locations used to make the measurement. When you add a 
measurement, it becomes the one that cursors are displayed for. You 
can use the Measurement softkey or touch in the Meas sidebar dialog 
to select the measurement whose cursor locations are displayed.

• Binary — Logic levels of displayed waveforms at the current X1 and 
X2 cursor positions are displayed in the Cursor sidebar dialog in 
binary. The display is color coded to match the color of the related 
channel's waveform.

• Hex — Logic levels of displayed waveforms at the current X1 and X2 
cursor positions are displayed in the Cursor sidebar dialog in 
hexadecimal.

Manual and Track Waveform modes can be used on waveforms that are 
displayed on the analog input channels (including math functions).

Binary and Hex modes apply to digital signals (of MSO oscilloscope 
models).

In Hex and Binary modes, a level can be displayed as 1 (higher than 
trigger level), 0 (lower than trigger level), indeterminate state (- ), or X 
(don't care).

In Binary mode, X is displayed if the channel is turned off.

In Hex mode, the channel is interpreted as 0 if turned off.

4 Press Source (or X1 Source, X2 Source in the Track Waveform mode); then, 
select the input source for cursor values.
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5 Select the cursor(s) to be adjusted:

• Push the Cursors knob; then, turn the Cursors knob. To finalize your 
selection, either push the Cursors knob again or wait about five 
seconds for the popup menu to disappear.

Or:

• Press the Cursors softkey; then, turn the Entry knob.

The X1 X2 linked and Y1 Y2 linked selections let you adjust both cursors at 
the same time, while the delta value remains the same. This can be 
useful, for example, for checking pulse width variations in a pulse train.

The currently selected cursor(s) display brighter than the other cursors.

6 To change the cursor units, press the Units softkey.

In the Cursor Units Menu:

You can press the X Units softkey to select:

• Seconds (s).

• Hz (1/s).

• Phase (°) — when selected, use the Use X Cursors softkey to set the 
current X1 location as 0 degrees and the current X2 location as 360 
degrees.

• Ratio (%) — when selected, use the Use X Cursors softkey to set the 
current X1 location as 0% and the current X2 location as 100%.

You can press the Y Units softkey to select:

• Base — the same units used for the source waveform.

• Ratio (%) — when selected, use the Use Y Cursors softkey to set the 
current Y1 location as 0% and the current Y2 location as 100%.

For phase or ratio units, once the 0 and 360 degree or 0 and 100% 
locations are set, adjusting cursors will display measurements relative 
to the set locations.

7 Adjust the selected cursor(s) by turning the Cursors knob.
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You can also position cursors using the touchscreen. See "Drag 
Cursors" on page 51.

Cursor Examples

Figure 41 Cursors used to measure pulse widths other than middle threshold points
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Expand the display with Zoom mode, then characterize the event of 
interest with the cursors.

Figure 42 Cursors measure frequency of pulse ringing
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Put the X1 cursor on one side of a pulse and the X2 cursor on the other 
side of the pulse.

Figure 43 Cursors track Zoom window



238 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

13 Cursors
 

Press the X1 X2 linked softkey and move the cursors together to check for 
pulse width variations in a pulse train.

Figure 44 Measuring pulse width with cursors
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Figure 45 Moving the cursors together to check pulse width variations
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To make automatic measurements 242

Measurements Summary 244

Voltage Measurements 248

Time Measurements 256

Count Measurements 264

Mixed Measurements 265

Measurement Thresholds 266

Measurement Window 268

Measurement Statistics 268

The [Meas] key lets you make automatic measurements on waveforms. 
Some measurements can only be made on analog input channels.

The results of the last 10 selected measurements are displayed in the 
Measurements list dialog (which can be selected from the right- hand 
sidebar menu — see "Select Sidebar Information or Controls" on page 49 
and "Undock Sidebar Dialogs by Dragging" on page 50).

When you add a measurement, it appears at the bottom of the 
Measurements list dialog, and cursors that show the portion of the 
waveform being measured are automatically displayed. You can change the 
measurement for which cursors are displayed by touching the 
measurement in the list and choosing Track With Cursors in the popup menu 
or by selecting the measurement in the Cursors Menu.
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To make automatic measurements

1 Press the [Meas] key to display the Measurement Menu.

2 Press the Source softkey to select the channel, running math function, 
or reference waveform to be measured.

Only channels, math functions, or reference waveforms that are 
displayed are available for measurements.

If a portion of the waveform required for a measurement is not 
displayed or does not display enough resolution to make the 
measurement, the result will display "No Edges", "Clipped", "Low Signal", 
"< value", or "> value", or a similar message to indicate that the 
measurement may not be reliable.

3 Press the Type: softkey; then, rotate the Entry knob to select a 
measurement to be made.

NOTE Post Acquisition Processing

In addition to changing display parameters after the acquisition, you can perform all of the 
measurements and math functions after the acquisition. Measurements and math 
functions will be recalculated as you pan and zoom and turn channels on and off. As you 
zoom in and out on a signal using the horizontal scale knob and vertical volts/division knob, 
you affect the resolution of the display. Because measurements and math functions are 
performed on displayed data, you affect the resolution of functions and measurements.
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You can also use the touchscreen to select measurements. You can 
touch the "+" in the Measurements sidebar dialog to open the 
measurement type menu. See also "Touch Softkeys and Menus On the 
Screen" on page 51.

For more information on the types of measurements, see "Measurements 
Summary" on page 244.

4 The Settings softkey will be available to make additional measurement 
settings on some measurements.

5 Press the Add Measurement softkey or push the Entry knob to display the 
measurement.

Cursors are turned on to show the portion of the waveform being 
measured for the most recently added measurement (bottom- most on 
the display). To view the cursors for a previously added measurement 
(but not the last one), add the measurement again.

By default, measurement statistics are displayed. See "Measurement 
Statistics" on page 268.
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6 To turn off measurements, press the [Meas] key again.

Measurements are erased from the display.

7 To stop making one or more measurements, press the Clear Meas softkey 
and choose the measurement to clear, or press Clear All.

After all measurements have been cleared, when [Meas] is pressed 
again, the default measurements will be Frequency and Peak- Peak.

Measurements Summary

The automatic measurements provided by the oscilloscope are listed in the 
following table. All measurements are available for analog channel 
waveforms. All measurements except Counter are available for reference 
waveforms and math waveforms other than FFT. A limited set of 
measurements is available for math FFT waveforms and for digital channel 
waveforms (as described in the following table).

Measurement Valid 
for 
Math 
FFT*

Valid for 
Digital 
Channels

Notes

"Snapshot All" on page 247

"Amplitude" on page 249

"Area" on page 265

"Average" on page 253 Yes, Full 
Screen

"Base" on page 251

"Burst Width" on page 259

"Counter" on page 258 Yes Not valid for math waveforms.
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"Delay" on page 260 Measures between two sources. 
Press Settings to specify the 
second source.

"Duty Cycle" on page 259 Yes

"Fall Time" on page 260

"Frequency" on page 257 Yes

"Maximum" on page 249 Yes

"Minimum" on page 249 Yes

"Rising Edge Count" on 
page 265

"Falling Edges Count" on 
page 265

"Positive Pulse Count" on 
page 264

"Negative Pulse Count" on 
page 264

"Overshoot" on page 251

"Peak-Peak" on page 249 Yes

"Period" on page 257 Yes

"Phase" on page 261 Measures between two sources. 
Press Settings to specify the 
second source.

"Preshoot" on page 252

"Ratio" on page 256 Measures between two sources. 
Press Settings to specify the 
second source.

"Rise Time" on page 260

"DC RMS" on page 253

Measurement Valid 
for 
Math 
FFT*

Valid for 
Digital 
Channels

Notes
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Power App
Measurements

Note that additional Power App measurements are available when the 
DSOX4PWR power measurement and analysis license is installed and the 
Power Application is enabled. For more information, see the DSOX4PWR 
Power Measurement Application User's Guide at 
"www.agilent.com/find/4000X- Series- manual" or on the Documentation CD.

Dual-Channel
(N2820A Probe)
Measurements

Note that additional measurements are available with the N2820A 
high- sensitivity current probe when both the Primary and Secondary 
probe cables are used. Zoom In waveform data below the probe's clamp 
level is joined with Zoom Out waveform data above the probe's clamp level 
to create the waveform on which the measurement is made. These 
measurements are only valid for analog input channels.

"AC RMS" on page 254

"Top" on page 250

"+ Width" on page 259 Yes

"– Width" on page 259 Yes

"X at Max Y" on page 263 Yes The resultant units are in Hertz.

"X at Min Y" on page 263 Yes The resultant units are in Hertz.

* Use the cursors to make other measurements on FFT.

Measurement Valid 
for 
Math 
FFT*

Valid for 
Digital 
Channels

Notes

Dual-Channel (N2820A Probe) 
Measurement

Notes

Amplitude See "Amplitude" on page 249.

Charge Charge (in Amp-hours) is the measured area under 
the waveform. See "Area" on page 265.

Average See "Average" on page 253.

Base See "Base" on page 251.

Peak-Peak See "Peak-Peak" on page 249.

http://www.agilent.com/find/4000X-Series-manual
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When using the N2820A probe to make measurements on a 
battery- powered (floating) device, always connect the supplied ground lead 
between ground on your device and the probe's ground connector as 
shown in the following figure. Simply snap the end of the ground lead 
onto the probe's connector. Without the ground connection, the probe's 
common- mode input amplifier cannot properly display waveforms.

Snapshot All

The Snapshot All measurement type displays a popup containing a 
snapshot of all the single waveform measurements.

DC RMS See "DC RMS" on page 253.

AC RMS See "AC RMS" on page 254.

Figure 46 Measurements on Battery Powered Devices Using the N2820A Probe

Dual-Channel (N2820A Probe) 
Measurement

Notes
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You can also configure the [Quick Action] key to display the Snapshot All 
popup. See "Configuring the [Quick Action] Key" on page 347.

Voltage Measurements

The following figure shows the voltage measurement points.

Measurement units for each input channel can be set to Volts or Amps 
using the channel Probe Units softkey. See "To specify the channel units" on 
page 87.

Amplitude

Maximum

Minimum
Base

Top

Peak-Peak
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The units of math waveforms are described in "Units for Math 
Waveforms" on page 93.

• "Peak- Peak" on page 249

• "Maximum" on page 249

• "Minimum" on page 249

• "Amplitude" on page 249

• "Top" on page 250

• "Base" on page 251

• "Overshoot" on page 251

• "Preshoot" on page 252

• "Average" on page 253

• "DC RMS" on page 253

• "AC RMS" on page 254

• "Ratio" on page 256

Peak-Peak

The peak- to- peak value is the difference between Maximum and Minimum 
values. The Y cursors show the values being measured.

Maximum

Maximum is the highest value in the waveform display. The Y cursor 
shows the value being measured.

Minimum

Minimum is the lowest value in the waveform display. The Y cursor shows 
the value being measured.

Amplitude

The Amplitude of a waveform is the difference between its Top and Base 
values. The Y cursors show the values being measured.
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Top

The Top of a waveform is the mode (most common value) of the upper 
part of the waveform, or if the mode is not well defined, the top is the 
same as Maximum. The Y cursor shows the value being measured.

See Also • "To isolate a pulse for Top measurement" on page 250

To isolate a pulse for Top measurement

The following figure shows how to use Zoom mode to isolate a pulse for a 
Top measurement.

You may need to change the measurement window setting so that the 
measurement is made in the lower, Zoom window. See "Measurement 
Window" on page 268.

Figure 47 Isolating area for Top measurement
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Base

The Base of a waveform is the mode (most common value) of the lower 
part of the waveform, or if the mode is not well defined, the base is the 
same as Minimum. The Y cursor shows the value being measured.

Overshoot

Overshoot is distortion that follows a major edge transition expressed as a 
percentage of Amplitude. The X cursors show which edge is being 
measured (edge closest to the trigger reference point).

Rising edge overshοot =
local Maximum − D Top

Amplitude × 100

Falling edge overshοot = Base − D local Minimum
Amplitude × 100

Overshoot
local Maximum

local Minimum

Base

Top

Overshoot
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Preshoot

Preshoot is distortion that precedes a major edge transition expressed as a 
percentage of Amplitude. The X cursors show which edge is being 
measured (edge closest to the trigger reference point).

Figure 48 Automatic Overshoot measurement

Rising edge preshοot =
local Maximum − D Top

Amplitude × 100

Falling edge preshοot = Base − D local Minimum
Amplitude × 100
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Average

Average is the sum of the levels of the waveform samples divided by the 
number of samples.

Where xi = value at ith point being measured, n = number of points in 
measurement interval.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an 
integral number of periods of the displayed signal. If less than three edges 
are present, the measurement shows "No edges".

The X cursors show what interval of the waveform is being measured.

DC RMS

DC RMS is the root- mean- square value of the waveform over one or more 
full periods.

Where xi = value at ith point being measured, n = number of points in 
measurement interval.

The Full Screen measurement interval variation measures the value on all 
displayed data points.

Preshootlocal Maximum

local Minimum

Base

Top

Preshoot

Average =
∑ xi
n

RMS (dc) =
∑i=1

n
xi

2

n
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The N Cycles measurement interval variation measures the value on an 
integral number of periods of the displayed signal. If less than three edges 
are present, the measurement shows "No edges".

The X cursors show the interval of the waveform being measured.

AC RMS

AC RMS is the root- mean- square value of the waveform, with the DC 
component removed. It is useful, for example, for measuring power supply 
noise.

The N Cycles measurement interval measures the value on an integral 
number of periods of the displayed signal. If less than three edges are 
present, the measurement shows "No edges".

The X cursors show the interval of the waveform being measured.

The Full Screen (Std Deviation) measurement interval variation is an RMS 
measurement across the full screen with the DC component removed. It 
shows the standard deviation of the displayed voltage values.

The standard deviation of a measurement is the amount that a 
measurement varies from the mean value. The Mean value of a 
measurement is the statistical average of the measurement.

The following figure graphically shows the mean and standard deviation. 
Standard deviation is represented by the Greek letter sigma: σ. For a 
Gaussian distribution, two sigma (± 1σ) from the mean, is where 68.3 
percent of the measurement results reside. Six sigma (± 3σ) from is where 
99.7 percent of the measurement results reside.
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The mean is calculated as follows:

where:

• x = the mean.

• N = the number of measurements taken.

• xi = the ith measurement result.

The standard deviation is calculated as follows:

where:

• σ = the standard deviation.

• N = the number of measurements taken.

• xi = the ith measurement result.

• x = the mean.

-2σ -1σ 1σ 2σ-3σ 3σ

x̄ =
∑i=1
N xi
N

σ =
∑i=1
N (xi − x̄)2

N
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Ratio

The Ratio measurement displays the ratio of the AC RMS voltages of two 
sources, expressed in dB. Press the Settings softkey to select the source 
channels for the measurement.

Time Measurements

The following figure shows time measurement points.

The default lower, middle, and upper measurement thresholds are 10%, 
50%, and 90% between Top and Base values. See "Measurement 
Thresholds" on page 266 for other percentage threshold and absolute value 
threshold settings.

• "Period" on page 257

• "Frequency" on page 257

• "Counter" on page 258

• "+ Width" on page 259

• "– Width" on page 259

• "Burst Width" on page 259

• "Duty Cycle" on page 259

• "Rise Time" on page 260

• "Fall Time" on page 260

• "Delay" on page 260

• "Phase" on page 261

• "X at Min Y" on page 263

• "X at Max Y" on page 263

Rise Time

+ Width

Fall Time

- Width
Period

Middle
Upper

Thresholds

Lower
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Period

Period is the time period of the complete waveform cycle. The time is 
measured between the middle threshold points of two consecutive, 
like- polarity edges. A middle threshold crossing must also travel through 
the lower and upper threshold levels which eliminates runt pulses. The X 
cursors show what portion of the waveform is being measured. The Y 
cursor shows the middle threshold point.

Frequency

Frequency is defined as 1/Period. Period is defined as the time between 
the middle threshold crossings of two consecutive, like- polarity edges. A 
middle threshold crossing must also travel through the lower and upper 
threshold levels which eliminates runt pulses. The X cursors show what 
portion of the waveform is being measured. The Y cursor shows the 
middle threshold point.

See Also • "To isolate an event for frequency measurement" on page 257

To isolate an event for frequency measurement

The following figure shows how to use Zoom mode to isolate an event for 
a frequency measurement.

You may need to change the measurement window setting so that the 
measurement is made in the lower, Zoom window. See "Measurement 
Window" on page 268.

If the waveform is clipped, it may not be possible to make the 
measurement.



258 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

14 Measurements
 

Counter

The InfiniiVision 4000 X- Series oscilloscopes have an integrated hardware 
frequency counter which counts the number of cycles that occur within a 
period of time (known as the gate time) to measure the frequency of a 
signal.

The gate time is the horizontal range of the oscilloscope but is limited to 
>= 0.1 s and <= 10 s. Unlike other measurements, the Zoom horizontal 
timebase window does not gate the Counter measurement.

The Counter measurement can measure frequencies up to the bandwidth 
of the oscilloscope. The minimum frequency supported is 2.0 / gateTime.

Figure 49 Isolating an event for Frequency measurement
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The hardware counter uses the trigger comparator output. Therefore, the 
counted channel's trigger level (or threshold for digital channels) must be 
set correctly. The Y cursor shows the threshold level used in the 
measurement.

Analog and digital channels can be selected as the source.

Only one Counter measurement can be displayed at a time.

+ Width

+ Width is the time from the middle threshold of the rising edge to the 
middle threshold of the next falling edge. The X cursors show the pulse 
being measured. The Y cursor shows the middle threshold point.

– Width

– Width is the time from the middle threshold of the falling edge to the 
middle threshold of the next rising edge. The X cursors show the pulse 
being measured. The Y cursor shows the middle threshold point.

Burst Width

The Burst Width measurement is the time from the first edge to the last 
edge on screen.

Duty Cycle

The duty cycle of a repetitive pulse train is the ratio of the pulse width to 
the period, expressed as a percentage. The X cursors show the time period 
being measured. The Y cursor shows the middle threshold point.

Burst width
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Rise Time

The rise time of a signal is the time difference between the crossing of the 
lower threshold and the crossing of the upper threshold for a 
positive- going edge. The X cursor shows the edge being measured. For 
maximum measurement accuracy, set the horizontal time/div as fast as 
possible while leaving the complete rising edge of the waveform on the 
display. The Y cursors show the lower and upper threshold points.

Fall Time

The fall time of a signal is the time difference between the crossing of the 
upper threshold and the crossing of the lower threshold for a 
negative- going edge. The X cursor shows the edge being measured. For 
maximum measurement accuracy, set the horizontal time/div as fast as 
possible while leaving the complete falling edge of the waveform on the 
display. The Y cursors show the lower and upper threshold points.

Delay

Delay measures the time difference from the specified source 1 edge that 
is closest to the center of the screen and the nearest specified source 2 
edge using the middle threshold points on the waveforms.

Negative delay values indicate that the selected edge of source 1 occurred 
after the selected edge of source 2.

1 Press the [Meas] key to display the Measurement Menu.

2 Press the Source softkey; then turn the Entry knob to select the first 
analog channel source.

3 Press the Type: softkey; then, turn the Entry knob to select Delay.

+ Duty cycle = + Width
Period × 100 − Duty cycle = − Width

Period × 100

Source 2

Source 1

Delay
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4 Press the Settings softkey to select the second analog channel source 
and slope for the delay measurement.

The default Delay settings measure from the rising edge of channel 1 to 
the rising edge of channel 2.

5 Press the Back/Up key to return to the Measurement Menu.

6 Press the Add Measurement softkey to make the measurement.

The example below shows a delay measurement between the rising edge of 
channel 1 and the rising edge of channel 2.

Phase

Phase is the calculated phase shift from source 1 to source 2, expressed in 
degrees. Negative phase shift values indicate that the rising edge of source 
1 occurred after the rising edge of source 2.

Back
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1 Press the [Meas] key to display the Measurement Menu.

2 Press the Source softkey; then turn the Entry knob to select the first 
analog channel source.

3 Press the Type: softkey; then, turn the Entry knob to select Delay.

4 Press the Settings softkey to select the second analog channel source for 
the phase measurement.

The default Phase settings measure from channel 1 to channel 2.

5 Press the Back/Up key to return to the Measurement Menu.

6 Press the Add Measurement softkey to make the measurement.

The example below shows a phase measurement between the channel 1 
and the math d/dt function on channel 1.

Phase =
Delay

Source 1 Period × 360

Source 2

Source 1

Delay

Period

Back
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X at Min Y

X at Min Y is the X axis value (usually time) at the first displayed 
occurrence of the waveform Minimum, starting from the left- side of the 
display. For periodic signals, the position of the minimum may vary 
throughout the waveform. The X cursor shows where the current X at Min 
Y value is being measured.

X at Max Y

X at Max Y is the X axis value (usually time) at the first displayed 
occurrence of the waveform Maximum, starting from the left- side of the 
display. For periodic signals, the position of the maximum may vary 
throughout the waveform. The X cursor shows where the current X at Max 
Y value is being measured.

See Also • "To measure the peak of an FFT" on page 264
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To measure the peak of an FFT

1 Select FFT as the Operator in the Waveform Math Menu.

2 Choose Math N as the source in the Measurement Menu.

3 Choose Maximum and X at Max Y measurements.

Maximum units are in dB and X at Max Y units are in Hertz for FFT.

Count Measurements

• "Positive Pulse Count" on page 264

• "Negative Pulse Count" on page 264

• "Rising Edge Count" on page 265

• "Falling Edges Count" on page 265

Positive Pulse Count

The Positive Pulse Count measurement is a pulse count for the selected 
waveform source.

This measurement is available for analog channels.

Negative Pulse Count

The Negative Pulse Count measurement is a pulse count for the selected 
waveform source.

Positive pulse count
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This measurement is available for analog channels.

Rising Edge Count

The Rising Edge Count measurement is an edge count for the selected 
waveform source.

This measurement is available for analog channels.

Falling Edges Count

The Falling Edges Count measurement is an edge count for the selected 
waveform source.

This measurement is available for analog channels.

Mixed Measurements

• "Area" on page 265

Area

Area measures the area between the waveform and the ground level. Area 
below the ground level is subtracted from area above the ground level.

Negative pulse count
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The Full Screen measurement interval variation measures the value on all 
displayed data points.

The N Cycles measurement interval variation measures the value on an 
integral number of periods of the displayed signal. If less than three edges 
are present, the measurement shows "No edges".

The X cursors show what interval of the waveform is being measured.

Measurement Thresholds

Setting measurement thresholds defines the vertical levels where 
measurements will be taken on an analog channel or math waveform.

1 From the Measurement Menu, press the Settings softkey; then, press the 
Thresholds softkey to set analog channel measurement thresholds.

You can also open the Measurement Threshold Menu by pressing 
[Analyze] > Features and then selecting Measurement Thresholds.

2 Press the Source softkey to select the analog channel or math waveform 
source for which you want to change measurement thresholds.

T

Negative area
N cycles

Positive area

NOTE Changing default thresholds may change measurement results

The default lower, middle, and upper threshold values are 10%, 50%, and 90% of the value 
between Top and Base. Changing these threshold definitions from the default values may 
change the returned measurement results for Average, Delay, Duty Cycle, Fall Time, 
Frequency, Overshoot, Period, Phase, Preshoot, Rise Time, +Width, and -Width.
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Each analog channel and the math waveform can be assigned unique 
threshold values.

3 Press the Type softkey to set the measurement threshold to % 
(percentage of Top and Base value) or to Absolute (absolute value).

• Percentage thresholds can be set from 0% to 100%.

• The units for absolute threshold for each channel is set in the 
channel probe menu.

4 Press the Lower softkey; then, turn the Entry knob to set the lower 
measurement threshold value.

Increasing the lower value beyond the set middle value will 
automatically increase the middle value to be more than the lower 
value. The default lower threshold is 10% or 800 mV.

If threshold Type is set to %, the lower threshold value can be set from 
0% to 98%.

5 Press the Middle softkey; then, turn the Entry knob to set the middle 
measurement threshold value.

The middle value is bounded by the values set for lower and upper 
thresholds. The default middle threshold is 50% or 1.20 V.

• If threshold Type is set to %, the middle threshold value can be set 
from 1% to 99%.

6 Press the Upper softkey; then, turn the Entry knob to set the upper 
measurement threshold value.

TIP Absolute threshold hints

• Absolute thresholds are dependent on channel scaling, probe attenuation, and probe units. 
Always set these values first before setting absolute thresholds.

• The minimum and maximum threshold values are limited to on-screen values.
• If any of the absolute threshold values are above or below the minimum or maximum waveform 

values, the measurement may not be valid.
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Decreasing the upper value below the set middle value will 
automatically decrease the middle value to be less than the upper value. 
The default upper threshold is 90% or 1.50 V.

• If threshold Type is set to %, the upper threshold value can be set 
from 2% to 100%.

Measurement Window

You can choose whether measurements are made in the Main window 
portion of the display, the Zoom window portion of the display (when the 
zoomed time base is displayed), or gated by the X1 and X2 cursors.

1 Press the [Meas] key.

2 In the Measurement Menu, press the Settings softkey.

3 In the Measurement Settings Menu, press the Meas Window softkey; then, 
turn the Entry knob to select from:

• Auto Select — When the zoomed time base is displayed, the 
measurement is attempted in the lower, Zoom window; if it cannot be 
made there, or if the zoomed time base is not displayed, the Main 
window is used.

• Main — The measurement window is the Main window.

• Zoom — The measurement window is the lower, Zoom window.

• Gated by Cursors — The measurement window is between the X1 and 
X2 cursors. When the zoomed time base is displayed, the X1 and X2 
cursors in the Zoom window portion of the display are used.

Measurement Statistics

To display measurement statistics:

1 Press the [Meas] key to enter the Measurement Menu. By default 
frequency and peak- to- peak voltage are measured on channel 1.

2 Select the measurements you desire for the channels you are using (see 
"Measurements Summary" on page 244).

3 From the Measurement Menu, press the Statistics softkey to enter the 
Statistics Menu.
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4 Press the Display On softkey to enable the measurement statistics display.

The source channel of the measurement is shown in parenthesis after 
the measurement name. For example: "Freq(1)" indicates a frequency 
measurement on channel 1.

The following statistics are shown: Name of the measurement, current 
measured value, mean, minimum measured value, maximum measured 
value, standard deviation, and the number of times the measurement 
has been made (count). Statistics are based on the total number of 
captured waveforms (count).

The standard deviation shown in Statistics is calculated using the same 
formula used for calculating the standard deviation measurement. The 
formula is shown in the section titled "AC RMS" on page 254.



270 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

14 Measurements
 

You can press the Display On softkey again to disable the measurement 
statistics display. Statistics continue to accumulate even when the 
statistics display is disabled.

5 To reset the statistics measurements, press the Reset Statistics softkey. 
This resets all statistics and begins recording statistical data again.

Each time a new measurement (for example: frequency, period, or 
amplitude) is added the statistics are reset and accumulation of 
statistical data begins again.

6 To enable a relative standard deviation, press the Relative σ softkey.

When enabled, the standard deviation shown in measurement statistics 
becomes the standard deviation/mean.

7 To specify the number of values used when calculating measurement 
statistics, press the Max Count softkey and enter the desired value.

Other things to know about measurement statistics:

• When the [Single] key is pressed, statistics are reset and a single 
measurement is done (count = 1). Successive [Single] acquisitions 
accumulate statistical data (and the count is incremented).

• The Increment Statistics softkey only appears when the acquisition is 
stopped and the optional segmented memory feature is off. Press the 
[Single] or [Run/Stop] key to stop the acquisition. You can use the 
horizontal position control (in the Horizontal control section of the 
front panel) to pan through the waveform. Active measurements will 
stay on screen, allowing you to measure various aspects of the captured 
waveforms. Press Increment Statistics to add the currently measured 
waveform to the collected statistical data.

• The Analyze Segments softkey only appears when the acquisition is 
stopped and the optional segmented memory feature is on. After an 
acquisition has completed (and the oscilloscope is stopped), you can 
press the Analyze Segments softkey to accumulate measurement statistics 
for the acquired segments.

You can also turn on infinite persistence (in the Display Menu) and 
press the Analyze Segments softkey to create an infinite persistence 
display.
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One way to verify a waveform's compliance to a particular set of 
parameters is to use mask testing. A mask defines a region of the 
oscilloscope's display in which the waveform must remain in order to 
comply with chosen parameters. Compliance to the mask is verified 
point- by- point across the display. Mask test operates on displayed analog 
channels; it does not operate on channels that are not displayed.

To enable mask test order Option LMT at time of oscilloscope purchase, or 
order DSOX4MASK as a stand- alone item after oscilloscope purchase.

To create a mask from a "golden" waveform (Automask)

A golden waveform meets all chosen parameters, and it is the waveform to 
which all others will be compared.

1 Configure the oscilloscope to display the golden waveform.

2 Press the [Analyze] key.

3 Press Features; then, select Mask Test.

4 Press Features again to enable mask testing.
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5 Press Automask.

6 In the Automask Menu, press the Source softkey and ensure the desired 
analog channel is selected.

7 Adjust the mask's horizontal tolerance (± Y) and vertical tolerance 
(± X). These are adjustable in graticule divisions or in absolute units 
(volts or seconds), selectable using the Units softkey.

8 Press the Create Mask softkey.

The mask is created and testing begins.

Whenever the Create Mask softkey is pressed the old mask is erased and 
a new mask is created.
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9 To clear the mask and switch off mask testing, press the Back/Up 
key to return to the Mask Test Menu, then press the Clear Mask softkey.

If infinite persistence display mode (see "To set or clear persistence" on 
page 153) is "on" when mask test is enabled, it stays on. If infinite 
persistence is "off" when mask test is enabled, it is switched on when 
mask test is switched on, then infinite persistence is switched off when 
mask test is switched off.

Troubleshooting
Mask Setup

If you press Create Mask and the mask appears to cover the entire screen, 
check the ± Y and ± X settings in the Automask Menu. If these are set to 
zero the resulting mask will be extremely tight around the waveform.

If you press Create Mask and it appears that no mask was created, check 
the ± Y and ± X settings. They may be set so large that the mask is not 
visible.

Back
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Mask Test Setup Options

From the Mask Test Menu, press the Setup softkey to enter the Mask Setup 
Menu.

Run Until The Run Until softkey lets you specify a condition on which to terminate 
testing.
• Forever — The oscilloscope runs continuously. However, if an error occurs 

the action specified using the On Error softkey will occur.
• Minimum # of Tests — Choose this option and then use the # of Tests 

softkey to select the number of times the oscilloscope will trigger, display 
the waveform(s), and compare them to the mask. The oscilloscope will 
stop after the specified number of tests have been completed. The 
specified minimum number of tests may be exceeded. If an error occurs the 
action specified using the On Error softkey will occur. The actual number of 
tests completed is displayed above the softkeys.

• Minimum Time — Choose this option and then use the Test Time softkey 
to select how long the oscilloscope will run. When the selected time has 
passed the oscilloscope will stop. The specified time may be exceeded. If 
an error occurs the action specified using the On Error softkey will occur. 
The actual test time is displayed above the softkeys.

• Minimum Sigma — Choose this option and then use the Sigma softkey to 
select a minimum sigma. The mask test runs until enough waveforms are 
tested to achieve a minimum test sigma. (If an error occurs the 
oscilloscope will perform the action specified by the On Error softkey.) 
Note that this is a test sigma (the max achievable process sigma, 
assuming no defects, for a certain number of tested waveforms) as 
opposed to a process sigma (which is tied to the amount of failures per 
test). The sigma value may exceed the selected value when a small sigma 
value is chosen. The actual sigma is displayed.
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On Error The On Error setting specifies the action(s) to take when the input waveform 
does not conform to the mask. This setting supersedes the Run Until setting.
• Stop — The oscilloscope will stop when the first error is detected (on the 

first waveform that does not conform to the mask). This setting 
supersedes the Minimum # of Tests and Minimum Time settings.

• Save — The oscilloscope saves the screen image when an error is 
detected. In the Save Menu (press [Save/Recall] > Save), select an 
image format (*.bmp or *.png), destination (on a USB storage device), and 
file name (which can be auto-incrementing). If errors occur too frequently 
and the oscilloscope spends all its time saving images, press the [Stop] 
key to stop acquisitions.

• Print — The oscilloscope prints the screen image when an error is 
detected. This option is only available when a printer is connected as 
described in "To print the oscilloscope's display" on page 323.

• Measure — Measurements (and measurement statistics if your 
oscilloscope supports them) run only on waveforms that contain a mask 
violation. Measurements are not affected by passing waveforms. This 
mode is not available when the acquisition mode is set to Averaging.

Note that you can choose to Print or Save, but you cannot select both at the 
same time. All other actions may be selected at the same time. For example, 
you can select both Stop and Measure to cause the oscilloscope to measure 
and stop on the first error..
You can also output a signal on the rear panel TRIG OUT BNC connector when 
there is a mask test failure. See "Setting the Rear Panel TRIG OUT Source" on 
page 339.

Source Lock When you turn on Source Lock using the Source Lock softkey, the mask is 
redrawn to match the source whenever you move the waveform. For example, 
if you change the horizontal timebase or the vertical gain the mask is redrawn 
with the new settings.
When you turn off Source Lock, the mask is not redrawn when horizontal or 
vertical settings are changed.

Source If you change the Source channel, the mask is not erased. It is re-scaled to the 
vertical gain and offset settings of the channel to which it is assigned. To 
create a new mask for the selected source channel, go back up in the menu 
hierarchy; then, press Automask, and press Create Mask.
The Source softkey in the Mask Setup Menu is the same as the Source 
softkey in the Automask Menu.

Test All When enabled, all displayed analog channels are included in the mask test. 
When disabled, just the selected source channel is included in the test.
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Mask Statistics

From the Mask Test Menu, press the Statistics softkey to enter the Mask 
Statistics Menu.

Show Stats When you enable Show Statistics the following information is displayed:
• Current mask, name of mask, Channel number, date and time.
• # of Tests (total number of mask tests executed).
• Status (Passing, Failing, or Untested).
• Accumulated test time (in hours, minutes, seconds, and tenths of 

seconds).
And for each analog channel:
• Number of failures (acquisitions in which the signal excursion went 

beyond the mask).
• Failure rate (percentage of failures).
• Sigma (the ratio of process sigma to maximum achievable sigma, based on 

number of waveforms tested).
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To manually modify a mask file

You can manually modify a mask file that you created using the Automask 
function.

1 Follow the steps 1- 7 in "To create a mask from a "golden" waveform 
(Automask)" on page 271. Do not clear the mask after creating it.

2 Attach a USB mass storage device to the oscilloscope.

3 Press the [Save/Recall] key.

4 Press the Save softkey.

5 Press the Format softkey and select Mask.

6 Press the second softkey and select a destination folder on your USB 
mass storage device.

7 Press the Press to Save softkey. This creates an ASCII text file that 
describes the mask.

8 Remove the USB mass storage device and connect it to a PC.

9 Open the .msk file your created using a text editor (such as Wordpad).

10 Edit, save, and close the file.

The mask file contains the following sections:

• Mask File Identifier.

• Mask Title.

• Mask Violation Regions.

• Oscilloscope Setup Information.

Mask File
Identifier

The Mask File Identifier is MASK_FILE_548XX.

Reset Statistics Note that statistics are also reset when:
• Mask Test is switched on after being switched off.
• Clear Mask softkey is pressed.
• An Automask is created.
Additionally, the accumulated time counter is reset whenever the 
oscilloscope is run after the acquisition was stopped.

Clear Display Clears acquisition data from the oscilloscope display.
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Mask Title The Mask Title is a string of ASCII characters. Example: autoMask CH1 
OCT 03 09:40:26 2008

When a mask file contains the keyword "autoMask" in the title, the edge of 
the mask is passing by definition. Otherwise, the edge of the mask is 
defined as a failure.

Mask Violation
Regions

Up to 8 regions can be defined for a mask. They can be numbered 1- 8. 
They can appear in any order in the .msk file. The numbering of the 
regions must go from top to bottom, left to right.

An Automask file contains two special regions: the region "glued" to the 
top of the display, and the region that is "glued" to the bottom. The top 
region is indicated by y- values of "MAX" for the first and last points. The 
bottom region is indicated by y- values of "MIN" for the first and last 
points.

The top region must be the lowest numbered region in the file. The 
bottom region must be the highest numbered region in the file.

Region 1

Region 2
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Region number 1 is the top mask region. The vertices in Region 1 describe 
points along a line; that line is the bottom edge of the top portion of the 
mask.

Similarly, the vertices in Region 2 describe the line that forms the top of 
the bottom part of the mask.

The vertices in a mask file are normalized. There are four parameters that 
define how values are normalized:

• X1

• ΔX

• Y1

• Y2

These four parameters are defined in the Oscilloscope Setup portion of the 
mask file.

The Y- values (normally voltage) are normalized in the file using the 
following equation:

Ynorm = (Y -  Y1)/ΔY

where ΔY = Y2 -  Y1

To convert the normalized Y- values in the mask file to voltage:

Y = (Ynorm * ΔY) + Y1

where ΔY = Y2 -  Y1

The X- values (normally time) are normalized in the file using the 
following equation:

Xnorm = (X -  X1)/ΔX

To convert the normalized X- values to time:

X = (Xnorm * ΔX) + X1

Oscilloscope
Setup Information

The keywords "setup" and "end_setup" (appearing alone on a line) define 
the beginning and end of the oscilloscope setup region of the mask file. 
The oscilloscope setup information contains remote programming language 
commands that the oscilloscope executes when the mask file is loaded.

Any legal remote programming command can be entered in this section.
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The mask scaling controls how the normalized vectors are interpreted. 
This in turn controls how the mask is drawn on the display. The remote 
programming commands that control mask scaling are:
:MTES:SCAL:BIND 0
:MTES:SCAL:X1 -400.000E-06
:MTES:SCAL:XDEL +800.000E-06
:MTES:SCAL:Y1 +359.000E-03
:MTES:SCAL:Y2 +2.35900E+00

Building a Mask File

The following mask uses all eight mask regions. The most difficult part of 
creating a mask file is normalizing the X and Y values from the time and 
voltage values. This example shows an easy way to convert voltage and 
time to normalized X and Y values in the mask file.

The following mask file produced the mask shown above:
MASK_FILE_548XX
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"All Regions"

/* Region Number */ 1
/* Number of vertices */ 4

-12.50, MAX
-10.00, 1.750
10.00, 1.750
12.50, MAX

/* Region Number */ 2
/* Number of vertices */ 5

-10.00, 1.000
-12.50, 0.500
-15.00, 0.500
-15.00, 1.500
-12.50, 1.500

/* Region Number */ 3
/* Number of vertices */ 6

-05.00, 1.000
-02.50, 0.500
02.50, 0.500
05.00, 1.000
02.50, 1.500

-02.50, 1.500

/* Region Number */ 4
/* Number of vertices */ 5

10.00, 1.000
12.50, 0.500
15.00, 0.500
15.00, 1.500
12.50, 1.500

/* Region Number */ 5
/* Number of vertices */ 5

-10.00, -1.000
-12.50, -0.500
-15.00, -0.500
-15.00, -1.500
-12.50, -1.500

/* Region Number */ 6
/* Number of vertices */ 6

-05.00, -1.000
-02.50, -0.500
02.50, -0.500
05.00, -1.000
02.50, -1.500

-02.50, -1.500

/* Region Number */ 7
/* Number of vertices */ 5

10.00, -1.000
12.50, -0.500
15.00, -0.500
15.00, -1.500
12.50, -1.500

/* Region Number */ 8
/* Number of vertices */ 4

-12.50, MIN
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-10.00, -1.750
10.00, -1.750
12.50, MIN

setup
:MTES:ENAB 1
:CHAN1:RANG +4.00E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 1;BWL 0;INV 0
:CHAN1:LAB "1";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN2:RANG +16.0E+00;OFFS +1.62400E+00;COUP DC;IMP FIFT;DISP 0;BWL 0;INV
0

:CHAN2:LAB "2";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN3:RANG +40.0E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 0;BWL 0;INV 0
:CHAN3:LAB "3";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:CHAN4:RANG +40.0E+00;OFFS +0.0E+00;COUP DC;IMP ONEM;DISP 0;BWL 0;INV 0
:CHAN4:LAB "4";UNIT VOLT;PROB +1.0E+00;PROB:SKEW +0.0E+00;STYP SING
:EXT:BWL 0;IMP ONEM;RANG +5E+00;UNIT VOLT;PROB +1.0E+00;PROB:STYP SING
:TIM:MODE MAIN;REF CENT;MAIN:RANG +50.00E-09;POS +0.0E+00
:TRIG:MODE EDGE;SWE AUTO;NREJ 0;HFR 0;HOLD +60E-09
:TRIG:EDGE:SOUR CHAN1;LEV -75.00E-03;SLOP POS;REJ OFF;COUP DC
:ACQ:MODE RTIM;TYPE NORM;COMP 100;COUNT 8;SEGM:COUN 2
:DISP:LAB 0;CONN 1;PERS MIN;SOUR PMEM1
:HARD:APR "";AREA SCR;FACT 0;FFE 0;INKS 1;PAL NONE;LAY PORT
:SAVE:FIL "mask_0"
:SAVE:IMAG:AREA GRAT;FACT 0;FORM NONE;INKS 0;PAL COL
:SAVE:WAV:FORM NONE
:MTES:SOUR CHAN1;ENAB 1;LOCK 1
:MTES:AMAS:SOUR CHAN1;UNIT DIV;XDEL +3.00000000E-001;YDEL +2.00000000E-00
1
:MTES:SCAL:BIND 0;X1 +0.0E+00;XDEL +1.0000E-09;Y1 +0.0E+00;Y2 +1.00000E+0
0
:MTES:RMOD FOR;RMOD:TIME +1E+00;WAV 1000;SIGM +6.0E+00
:MTES:RMOD:FACT:STOP 0;PRIN 0;SAVE 0
end_setup

How is mask testing done?

InfiniiVision oscilloscopes start mask testing by creating a database that is 
200 x 640 for the waveform viewing area. Each location in the array is 
designated as either a violation or a pass area. Each time a data point 
from a waveform occurs in a violation area a failure is logged. If Test All 
was selected, every active analog channel is tested against the mask 
database for each acquisition. Over 2 billion failures can be logged 
per- channel. The number of acquisitions tested is also logged and 
displayed as "# of Tests".

The mask file allows greater resolution than the 200 X 640 database. Some 
quantization of data occurs to reduce the mask file data for display 
on- screen.
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The Digital Voltmeter (DVM) analysis feature provides 3- digit voltage and 
5- digit frequency measurements using any analog channel. DVM 
measurements are asynchronous from the oscilloscope's acquisition system 
and are always acquiring.

To enable the digital voltmeter analysis feature, order Option DVM at time 
of oscilloscope purchase, or order DSOXDVM as a stand- alone item after 
oscilloscope purchase.

The DVM display is a seven- segment readout like you would see on a 
digital voltmeter. It shows the selected mode as well as the units. Units 
are selected using the Units softkey in the channel's Probe Menu.

The DVM display also has a scale and the frequency counter value. The 
DVM scale is determined by the channel's vertical scale and reference 
level. The scale's blue triangle pointer shows the most recent 
measurement. The white bar above that shows the measurement extrema 
over the last 3 seconds.
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The DVM makes accurate RMS measurements when the signal frequency is 
between 20 Hz and 100 kHz. When the signal frequency is outside this 
range, "<BW Limit?" or ">BW Limit?" appears in the DVM display to 
caution you about inaccurate RMS measurement results.

To use the digital voltmeter:

1 Press the [Analyze] key.

2 Press Features; then, select Digital Voltmeter.

3 Press Features again to enable the DVM measurements.

4 Press the Source softkey and turn the Entry knob to select the analog 
channel on which digital voltmeter (DVM) measurements are made.

The selected channel does not have to be on (displaying a waveform) in 
order for DVM measurements to be made.

5 Press the Mode softkey and turn the Entry knob to select the digital 
voltmeter (DVM) mode:

• AC RMS — displays the root- mean- square value of the acquired data, 
with the DC component removed.
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• DC — displays the DC value of the acquired data.

• DC RMS — displays the root- mean- square value of the acquired data.

• Frequency — displays the frequency counter measurement.

6 If the selected source channel is not used in oscilloscope triggering, 
press Auto Range to disable or enable automatic adjustment of the DVM 
channel's vertical scale, vertical (ground level) position, and trigger 
(threshold voltage) level (used for the counter frequency measurement).

When enabled, Auto Range overrides attempted adjustments of the 
channel's vertical scale and position knobs.

When disabled, you can use the channel's vertical scale and position 
knobs normally.
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To select generated waveform types and settings 287

To edit arbitrary waveforms 291

To output the waveform generator sync pulse 299

To specify the expected output load 300

To use waveform generator logic presets 300

To add noise to the waveform generator output 301

To add modulation to the waveform generator output 302

To restore waveform generator defaults 307

To set up dual channel tracking 307

A waveform generator is built into the oscilloscope. It is enabled by 
Option WGN or the DSOX4WAVEGEN2 upgrade. The waveform generator 
gives you an easy way to provide input signals when testing circuitry with 
the oscilloscope.

Waveform generator settings can be saved and recalled with oscilloscope 
setups. See Chapter 18, “Save/Email/Recall (Setups, Screens, Data),” 
starting on page 309.

To select generated waveform types and settings

1 To access the Waveform Generator Menu and enable or disable the 
waveform generator output on the front panel Gen Out BNC, press the 
[Wave Gen] key.

When waveform generator output is enabled, the [Wave Gen] key is 
illuminated. When waveform generator output is disabled, the [Wave 
Gen] key is off.
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The waveform generator output is always disabled when the instrument 
is first turned on.

The waveform generator output is automatically disabled if excessive 
voltage is applied to the Gen Out BNC.

2 In the Waveform Generator Menu, press the Waveform softkey and turn 
the Entry knob to select the waveform type.

3 Depending on the selected waveform type, use the remaining softkeys 
and the Entry knob to set the waveform's characteristics.
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Waveform 
Type

Characteristics Frequency 
Range

Max. 
Amplitude2 
(High-Z)?1

Offset2 
(High-Z)1

Arbitrary Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
and Offset/Low-Level softkeys to set the arbitrary 
waveform signal parameters.
Use the Edit Waveform softkey to define the 
arbitrary waveform shape. See "To edit arbitrary 
waveforms" on page 291.

100 mHz to 
12 MHz

20 mVpp to 
10 Vpp

±5.00 V

Sine Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
and Offset/Low-Level softkeys to set the sine 
signal parameters.

100 mHz to 
20 MHz

20 mVpp to 
10 Vpp

±4.00 V

Square Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
Offset/Low-Level, and Duty Cycle softkeys to set 
the square wave signal parameters.
The duty cycle can be adjusted from 20% to 80%.

100 mHz to 
10 MHz

20 mVpp to 
10 Vpp

±5.00 V

Ramp Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
Offset/Low-Level, and Symmetry softkeys to set 
the ramp signal parameters.
Symmetry represents the amount of time per cycle 
that the ramp waveform is rising and can be 
adjusted from 0% to 100%.

100 mHz to 
200 kHz

20 mVpp to 
10 Vpp

±5.00 V

Pulse Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
Offset/Low-Level, and Width/Width Fine 
softkeys to set the pulse signal parameters.
The pulse width can be adjusted from 20 ns to the 
period minus 20 ns.

100 mHz to 
10 MHz.

20 mVpp to 
10 Vpp

±5.00 V

DC Use the Offset softkey to set the DC level. n/a n/a ±10.00 V

Noise Use the Amplitude/High-Level and 
Offset/Low-Level to set the noise signal 
parameters.

n/a 20 mVpp to 
10 Vpp

±5.00 V

Sine Cardinal Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude, and Offset 
softkeys to set the sinc signal parameters.

100 mHz to 
1 MHz

20 mVpp to 
9 Vpp

±2.50 V
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Pressing a signal parameter softkey can open a menu for selecting the 
type of adjustment. For example, you can choose to enter amplitude 
and offset values, or you can choose to enter high- level and low- level 
values. Or, you can choose to enter frequency values or period values. 
Keep pressing the softkey to select the type of adjustment. Turn the 
Entry knob to adjust the value.

Also note that you can set up the other waveform generator output to 
track frequency, amplitude, offset, and duty cycle adjustments. See "To 
set up dual channel tracking" on page 307.

The Settings softkey opens the Waveform Generator Settings Menu which 
lets you make other settings related to the waveform generator.

Exponential 
Rise

Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
and Offset/Low-Level softkeys to set the 
exponential rise signal parameters.

100 mHz to 
5 MHz

20 mVpp to 
10 Vpp

±5.00 V

Exponential 
Fall

Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude/High-Level, 
and Offset/Low-Level softkeys to set the 
exponential fall signal parameters.

100 mHz to 
5 MHz

20 mVpp to 
10 Vpp

±5.00 V

Cardiac Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude, and Offset 
softkeys to set the cardiac signal parameters.

100 mHz to 
200 kHz

20 mVpp to 
9 Vpp

±2.50 V

Gaussian 
Pulse

Use the Frequency/Frequency 
Fine/Period/Period Fine, Amplitude, and Offset 
softkeys to set the Gaussian pulse signal 
parameters.

100 mHz to 
5 MHz

20 mVpp to 
7.5 Vpp

±2.50 V

1When the output load is 50 Ω, these values are halved.
2The minimum amplitude is limited to 40 mVpp if the offset is greater than 500 mV or less than -500 mV. Likewise, the offset 
is limited to +/-500 mV if the amplitude is less than 40 mVpp.

Waveform 
Type

Characteristics Frequency 
Range

Max. 
Amplitude2 
(High-Z)?1

Offset2 
(High-Z)1
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See:

• "To output the waveform generator sync pulse" on page 299

• "To specify the expected output load" on page 300

• "To use waveform generator logic presets" on page 300

• "To set up dual channel tracking" on page 307

• "To add modulation to the waveform generator output" on page 302

• "To add noise to the waveform generator output" on page 301

• "To restore waveform generator defaults" on page 307

To edit arbitrary waveforms

1 When Arbitrary is selected as the generated waveform type (see "To 
select generated waveform types and settings" on page 287), press the 
Edit Waveform softkey to open the Edit Waveform Menu.
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When you open the Edit Waveform Menu, you see the existing arbitrary 
waveform definition. The voltage and time period you see in the 
diagram are the bounding parameters — they come from the frequency 
and amplitude settings in the main Waveform Generator Menu.

2 Use the softkeys in the Edit Waveform Menu to define the shape of the 
arbitrary waveform:

Softkey Description

Create New Opens the New Waveform Menu. See "Creating New Arbitrary Waveforms" on page 293.

Edit Existing Opens the Edit Waveform Points Menu. See "Editing Existing Arbitrary Waveforms" on 
page 294.

Interpolate Specifies how lines are drawn between arbitrary waveform points.
When enabled, lines are drawn between points in the waveform editor. Voltage levels 
change linearly between one point and the next.
When disabled, all line segments in the waveform editor are horizontal. The voltage level of 
one point remains until the next point.
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Creating New Arbitrary Waveforms

The New Waveform Menu is opened by pressing Create New in the Edit 
Waveform Menu.

To create a new arbitrary waveform:

1 In the New Waveform Menu, press Initial Pts; then, use the Entry knob to 
select the initial number of points in the new waveform.

The new waveform will be a square wave with the number of points 
you specify. The points are evenly spaced over the time period.

2 Use the Frequency/Frequency Fine/Period/Period Fine softkey to set the time 
period bounding parameter (repetition frequency) of the arbitrary 
waveform.

3 Use the Amplitude/High-Level and Offset/Low-Level softkeys to set the 
voltage bounding parameter of the arbitrary waveform.

4 When you are ready to create the new arbitrary waveform, press Apply 
& Edit.

Source Selects the analog channel or reference waveform to be captured and stored to the arbitrary 
waveform. See "Capturing Other Waveforms to the Arbitrary Waveform" on page 299.

Store Source to Arb Captures the selected waveform source and copy it to the arbitrary waveform. See 
"Capturing Other Waveforms to the Arbitrary Waveform" on page 299.

Softkey Description

NOTE You can use the [Save/Recall] key and menu to save arbitrary waveforms to one of four 
internal storage locations or to a USB storage device, and you can recall them later. See "To 
save arbitrary waveforms" on page 317 and "To recall arbitrary waveforms" on page 321.
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The new waveform is created and the Edit Waveform Points menu is 
opened. See "Editing Existing Arbitrary Waveforms" on page 294.

Note that you can also create a new arbitrary waveform by capturing 
another waveform. See "Capturing Other Waveforms to the Arbitrary 
Waveform" on page 299.

Editing Existing Arbitrary Waveforms

Using the
Touchscreen to

Edit Existing
Waveforms

To select a point, touch or drag in the upper, full waveform display:

For fine points selection, touch the previous point or next point arrows:

To adjust the value of a point, drag the voltage level handle up or down:

CAUTION When you create a new arbitrary waveform, the existing arbitrary waveform definition 
is overwritten. Note that you can use the [Save/Recall] key and menu to save 
arbitrary waveforms to one of four internal storage locations or to a USB storage 
device, and you can recall them later. See "To save arbitrary waveforms" on page 317 
and "To recall arbitrary waveforms" on page 321.
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To select a points region, first make sure you are in region selection drag 
mode:

Then, drag across the lower waveform display:

For fine adjustment of the region selection (or to clear the selection), use 
the Selected Region controls:
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To perform points operations, touch the Operation controls drop- down, 
select the operation, and use the controls for the selected operation:

• Cut/Copy selected points regions to the clipboard and Paste points from 
the clipboard.

When pasting points from the clipboard, you can paste at the beginning, 
end, cursor location (currently selected point), or you can replace the 
currently selected points region.

• Insert New points.

You can specify the number of new points and their voltage.

• Replace a selected points region with new points.

• Delete a selected points region.

To navigate the arbitrary waveform (and select points), first make sure 
you are in waveform drag mode:
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Then, drag the lower waveform across the display area:

Using Softkeys to
Edit Existing
Waveforms

The Edit Waveform Points Menu is opened by pressing Edit Existing in the 
Edit Waveform Menu or by pressing Apply & Edit when creating a new 
arbitrary waveform.
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To specify the voltage values of points:

1 Press Point #; then, use the Entry knob to select the point whose voltage 
value you wish to set.

2 Press Voltage; then, use the Entry knob to set the point's voltage value.

To insert a point:

1 Press Point #; then, use the Entry knob to select the point after which 
the new point will be inserted.

2 Press Insert Point.

All points are adjusted to maintain uniform time spacing between 
points.

To remove a point:

1 Press Point #; then, use the Entry knob to select the point you want to 
remove.

2 Press Remove Point.
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All points are adjusted to maintain uniform time spacing between 
points.

Capturing Other Waveforms to the Arbitrary Waveform

The Edit Waveform Menu is opened by pressing Edit Waveform in the main 
Waveform Generator Menu.

To capture another waveform to the arbitrary waveform:

1 Press Source; then, use the Entry knob to select the analog channel, 
math, or reference location whose waveform you wish to capture.

2 Press Store Source to Arb.

The source waveform is decimated into 8192 (maximum) or fewer 
arbitrary waveform points.

To output the waveform generator sync pulse

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

CAUTION When you create a new arbitrary waveform, the existing arbitrary waveform definition 
is overwritten. Note that you can use the [Save/Recall] key and menu to save 
arbitrary waveforms to one of four internal storage locations or to a USB storage 
device, and you can recall them later. See "To save arbitrary waveforms" on page 317 
and "To recall arbitrary waveforms" on page 321.

NOTE If the source waveform frequency and/or voltage exceed the capabilities of the waveform 
generator, the arbitrary waveform will be limited to the capabilities of the waveform 
generator. For example, a 20 MHz waveform captured as the arbitrary waveform, becomes a 
12 MHz waveform.
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3 In the Waveform Generator Settings Menu, press the Trig Out softkey and 
turn the Entry knob to select Waveform Generator Sync Pulse.

To specify the expected output load

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Out Load softkey 
and turn the Entry knob to select:

• 50 Ω
• High-Z

The output impedance of the Gen Out BNC is fixed at 50 ohms. However, 
the output load selection lets the waveform generator display the correct 
amplitude and offset levels for the expected output load.

If the actual load impedance is different than the selected value, the 
displayed amplitude and offset levels will be incorrect.

To use waveform generator logic presets

With logic level presets, you can easily set the output voltage to TTL, 
CMOS (5.0V), CMOS (3.3V), CMOS (2.5V), or ECL compatible Low and High 
levels.

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

Waveform Type Sync Signal Characteristics

All waveforms except 
DC, Noise, and 
Cardiac

The Sync signal is a TTL positive pulse that occurs when the waveform 
rises above zero volts (or the DC offset value).

DC, Noise, and 
Cardiac

N/A
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3 In the Waveform Generator Settings Menu, press the Logic Presets 
softkey.

4 In the Waveform Generator Logic Level Presets Menu, press one of the 
softkeys to set the generated signal's Low and High voltages to logic 
compatible levels:

To add noise to the waveform generator output

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Add Noise softkey 
and turn the Entry knob to select the amount of white noise to add to 
the waveform generator output.

Note that adding noise affects edge triggering on the waveform generator 
source (see "Edge Trigger" on page 170) as well as the waveform generator 
sync pulse output signal (which can be sent to TRIG OUT, see "Setting the 
Rear Panel TRIG OUT Source" on page 339). This is because the trigger 
comparator is located after the noise source.

Softkey (logic levels) Low level High level

TTL 0 V +5 V (or a 
TTL-compatible high level 
if +5 V cannot be 
reached)

CMOS (5.0V) 0 V +5 V

CMOS (3.3V) 0 V +3.3 V

CMOS (2.5V) 0 V +2.5 V

ECL -1.7 V -0.9 V
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To add modulation to the waveform generator output

Modulation is where an original carrier signal is modified according to the 
amplitude of a second modulating signal. The modulation type (AM, FM, or 
FSK) specifies how the carrier signal is modified.

Modulated waveforms are available on the WaveGen1 output.

To enable and set up modulation for the waveform generator output:

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Modulation softkey.

4 In the Waveform Generator Modulation Menu:

• Press the Modulation softkey to enable or disable modulated waveform 
generator output.

You can enable modulation for all waveform generator function types 
except arbitrary, square, pulse, DC, noise, and Gaussian pulse.

Modulation is not available when waveform generator dual channel 
tracking is being used.

• Press the Type softkey and turn the Entry knob to select the 
modulation type:

• Amplitude Modulation (AM) — the amplitude of the original carrier 
signal is modified according to the amplitude of the modulating 
signal. See "To set up Amplitude Modulation (AM)" on page 303.

• Frequency Modulation (FM) — the frequency of the original carrier 
signal is modified according to the amplitude of the modulating 
signal. See "To set up Frequency Modulation (FM)" on page 304.

• Frequency-Shift Keying Modulation (FSK) — the output frequency "shifts" 
between the original carrier frequency and a "hop frequency" at 
the specified FSK rate. The FSK rate specifies a digital square 
wave modulating signal. See "To set up Frequency- Shift Keying 
Modulation (FSK)" on page 306.
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To set up Amplitude Modulation (AM)

In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings > 
Modulation):

1 Press the Type softkey and turn the Entry knob to select Amplitude 
Modulation (AM).

2 Press the Waveform softkey and turn the Entry knob to select the shape 
of the modulating signal:

• Sine

• Square

• Ramp

When the Ramp shape is selected, a Symmetry softkey appears so that 
you can specify the amount of time per cycle that the ramp waveform is 
rising.

3 Press the AM Freq softkey and turn the Entry knob to specify the 
frequency of the modulating signal.

4 Press the AM Depth softkey and turn the Entry knob to specify the 
amount of amplitude modulation.

AM Depth refers to the portion of the amplitude range that will be used 
by the modulation. For example, a depth setting of 80% causes the 
output amplitude to vary from 10% to 90% (90% – 10% = 80%) of the 
original amplitude as the modulating signal goes from its minimum to 
maximum amplitude.

The following screen shows an AM modulation of a 100 kHz sine wave 
carrier signal.
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To set up Frequency Modulation (FM)

In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings > 
Modulation):

1 Press the Type softkey and turn the Entry knob to select Frequency 
Modulation (FM).

2 Press the Waveform softkey and turn the Entry knob to select the shape 
of the modulating signal:

• Sine

• Square

• Ramp

When the Ramp shape is selected, a Symmetry softkey appears so that 
you can specify the amount of time per cycle that the ramp waveform is 
rising.
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3 Press the FM Freq softkey and turn the Entry knob to specify the 
frequency of the modulating signal.

4 Press the FM Dev softkey and turn the Entry knob to specify the 
frequency deviation from the original carrier signal frequency.

When the modulating signal is at its maximum amplitude, the output 
frequency is the carrier signal frequency plus the deviation amount, and 
when the modulating signal is at its minimum amplitude, the output 
frequency is the carrier signal frequency minus the deviation amount.

The frequency deviation cannot be greater than the original carrier 
signal frequency.

Also, the sum of the original carrier signal frequency and the frequency 
deviation must be less than or equal to the maximum frequency for the 
selected waveform generator function plus 100 kHz.

The following screen shows an FM modulation of a 100 kHz sine wave 
carrier signal.
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To set up Frequency-Shift Keying Modulation (FSK)

In the Waveform Generator Modulation Menu (under [Wave Gen] > Settings > 
Modulation):

1 Press the Type softkey and turn the Entry knob to select Frequency-Shift 
Keying Modulation (FSK).

2 Press the Hop Freq softkey and turn the Entry knob to specify the "hop 
frequency".

The output frequency "shifts" between the original carrier frequency and 
this "hop frequency".

3 Press the FSK Rate softkey and turn the Entry knob to specify the rate 
at which the output frequency "shifts".

The FSK rate specifies a digital square wave modulating signal.

The following screen shows an FSK modulation of a 100 kHz sine wave 
carrier signal.
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To restore waveform generator defaults

1 If the Waveform Generator Menu is not currently displayed on the 
oscilloscope's softkeys, press the [Wave Gen] key.

2 In the Waveform Generator Menu, press the Settings softkey.

3 In the Waveform Generator Settings Menu, press the Default Wave Gen 
softkey.

The waveform generator factory default settings (1 kHz sine wave, 
500 mVpp, 0 V offset, High- Z output load) are restored.

To set up dual channel tracking

You can set up one waveform generator output to track adjustments in the 
other waveform generator output.

To set up dual channel tracking:

1 Press the [Wave Gen1] or [Wave Gen2] key for the waveform generator 
output that you want to be tracked.

2 In the Waveform Generator Menu, press Settings.

3 In the Waveform Generator Settings Menu, press Dual Chan.

4 In the Waveform Generator: Dual- Channel Menu, you have these 
options:

• Tracking — frequency, amplitude, offset, and duty cycle adjustments to 
this waveform generator output signal are tracked by the other 
waveform generator output.

• Freq Tracking — frequency adjustments to this waveform generator 
output signal are tracked by the other waveform generator output.

• Amp Tracking — amplitude and offset adjustments to this waveform 
generator output signal are tracked by the other waveform generator 
output.

• Copy Waveform to WaveGen2/1 — sets the other waveform generator 
output to be identical to this waveform generator output (except that 
the shape of either output may be inverted).
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Not all waveform shapes can be frequency tracked. When Tracking or Freq 
Tracking is enabled, the other generator's waveform selections will be 
limited dependent upon this generator's waveform.

Also, when tracking is enabled, adjustments for tracked settings in the 
other waveform generator become unavailable (ghosted).
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Save/Email/Recall (Setups, Screens, 
Data)

Saving Setups, Screen Images, or Data 309

Emailing Setups, Screen Images, or Data 318

Recalling Setups, Masks, or Data 319

Recalling Default Setups 322

Performing a Secure Erase 322

Oscilloscope setups, reference waveforms, and mask files can be saved to 
internal oscilloscope memory or to a USB storage device and recalled 
later. You can also recall default or factory default setups.

Oscilloscope screen images can be saved to a USB storage device in BMP 
or PNG formats.

Acquired waveform data can be saved to a USB storage device in 
comma- separated value (CSV), ASCII XY, and binary (BIN) formats.

Any file that can be saved to a USB storage device can also be e- mailed 
over the network.

There is also a command to securely erase all the oscilloscope's 
non- volatile internal memory.

Saving Setups, Screen Images, or Data

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Save.
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3 In the Save Trace and Setup Menu, press Format; then, turn the Entry 
knob to select the type of file you want to save:

• Setup (*.scp) — The oscilloscope's horizontal timebase, vertical 
sensitivity, trigger mode, trigger level, measurements, cursors, and 
math function settings that tell the oscilloscope how to make a 
particular measurement. See "To save setup files" on page 311.

• 8-bit Bitmap image (*.bmp) — The complete screen image in a reduced 
color (8- bit) bitmap format. See "To save BMP or PNG image files" on 
page 312.

• 24-bit Bitmap image (*.bmp) — The complete screen image in a 24- bit 
color bitmap format. See "To save BMP or PNG image files" on 
page 312.

• 24-bit image (*.png) — The complete screen image in a 24- bit color PNG 
format that uses lossless compression. Files are much smaller than 
the BMP format. See "To save BMP or PNG image files" on page 312.

• CSV data (*.csv) — This creates a file of comma- separated values of all 
displayed channels and math waveforms. This format is suitable for 
spreadsheet analysis. See "To save CSV, ASCII XY, or BIN data 
files" on page 312.

• ASCII XY data (*.csv) — This creates separate files of comma- separated 
values for each displayed channel. This format is also suitable for 
spreadsheets. See "To save CSV, ASCII XY, or BIN data files" on 
page 312.

• Binary data (*.bin) — This creates a binary file, with a header, and data 
in the form of time and voltage pairs. This file is much smaller than 
the ASCII XY data file. See "To save CSV, ASCII XY, or BIN data 
files" on page 312.

• Lister data (*.csv) — This is a CSV format file containing serial decode 
row information with commas separating the columns. See "To save 
Lister data files" on page 315.

• Reference Waveform data (*.h5) — Saves waveform data in a format that 
can be recalled to one of the oscilloscope's reference waveform 
locations. See "To save reference waveform files to a USB storage 
device" on page 316.

• Multi Channel Waveform data (*.h5) — Saves multiple channels of 
waveform data in a format that can be opened by the N8900A 
InfiniiView oscilloscope analysis software. You can recall the first 
Analog or Math channel from a multi channel waveform data file.
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• Mask (*.msk) — This creates a mask file in an Agilent proprietary 
format that can be read by Agilent InfiniiVision oscilloscopes. A mask 
data file includes some oscilloscope setup information, but not all 
setup information. To save all setup information including the mask 
data file, choose "Setup (*.scp)" format instead. See "To save 
masks" on page 316.

• Arbitrary Waveform data (*.csv) — This creates a file of comma- separated 
values for the arbitrary waveform points' time and voltage values. See 
"To save arbitrary waveforms" on page 317.

• Power Harmonics data (*.csv) — When the DSOX4PWR power analysis 
application is licensed, this creates a file of comma- separated values 
for the current harmonics power analysis results. See the DSOX4PWR 
Power Measurement Application User's Guide for more information.

• USB Signal Quality (*.html & *.bmp) — When the DSOX4USBSQ USB 2.0 
signal quality analysis application is licensed, this saves test results 
information which includes waveform plot and eye diagram pictures. 
See the DSOX4USBSQ USB 2.0 Signal Quality Analysis Application 
Electrical Testing Notes manual for more information.

You can also configure the [Quick Action] key to save setups, screen images, 
or data. See "Configuring the [Quick Action] Key" on page 347.

To save setup files

Setup files can be saved to one of 10 internal (\Agilent Flash) locations or 
to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 
Setup (*.scp).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

Setup files have the extension SCP. These extensions appear when using 
the File Explorer (see "File Explorer" on page 333), but they do not 
appear when using the Recall Menu.
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To save BMP or PNG image files

Image files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 
8-bit Bitmap image (*.bmp), 24-bit Bitmap image (*.bmp), or 24-bit image (*.png).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — setup information (vertical, horizontal, trigger, acquisition, 
math, and display settings) is also saved in a separate file with a 
TXT extension.

• Invert Grat — the graticule in the image file has a white background 
instead of the black background that appears on- screen.

• Palette — lets you choose between Color or Grayscale images.

4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

See Also • "To add an annotation" on page 164

To save CSV, ASCII XY, or BIN data files

Data files can be saved to an external USB storage device.

NOTE When saving screen images, the oscilloscope uses the last menu visited before pressing 
the [Save/Recall] key. This lets you save any relevant information within the softkey menu 
area.

To save a screen image showing the Save/Recall Menu at the bottom, press the 
[Save/Recall] key twice before saving the image.

NOTE You can also save the oscilloscope's display image using a web browser. See "Get 
Image" on page 359 for details.
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1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 
CSV data (*.csv), ASCII XY data (*.csv), or  Binary data (*.bin).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — when enabled, setup information (vertical, horizontal, 
trigger, acquisition, math, and display settings) is also saved in a 
separate file with a TXT extension.

• Length — sets the number of data points that will be output to the 
file. For more information, see "Length Control" on page 314.

• Save Seg — when data is acquired to segmented memory, you can 
specify whether the currently displayed segment is saved or all 
acquired segments are saved. (See also "Saving Data from Segmented 
Memory" on page 230.)

4 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

CSV Data When the CSV data (*.csv) file format is selected, comma- separated values 
for each displayed waveform and digital channel pod are saved as multiple 
columns in a single file. Math FFT waveforms, whose values are in the 
frequency domain, are appended at the bottom of the .csv file. Pod names 
(for example, D0- D7) or waveform labels are used as column headers. This 
format is suitable for spreadsheet analysis.

For CSV data, length "N" value- at- time measurements are performed 
across the entire screen (using the measurement record data) for each 
active source. Interpolation between measurement record data points is 
performed as needed.

ASCII XY Data When the ASCII XY data (*.csv) file format is selected, comma- separated 
value files for each displayed waveform, digital channel pod, digital bus, 
and serial bus are saved. For digital pods, an underscore (_) and the pod 
name (for example, D0- D7) are appended to the specified file name; 
otherwise, an underscore and the waveform's label are appended.
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If the oscilloscope acquisition is stopped, data from the raw acquisition 
record (which has more points than the measurement record) can be 
written. Press the [Single] key to obtain maximum memory depth with 
current settings. If enabled, serial decode data is saved.

When you want to save less than the maximum number of data points, a 
1- of- N decimation is performed to produce an output whose length is less 
than or equal to the requested length. For example, if there are 100k 
points of data, and you specify a length of 2k, 1 of every 50 data points is 
saved.

See Also • "Binary Data (.bin) Format" on page 377

• "CSV and ASCII XY files" on page 384

• "Minimum and Maximum Values in CSV Files" on page 385

Length Control

The Length control is available when saving data to CSV, ASCII XY, or BIN 
format files. It sets the number of data points that will be output to the 
file. Only displayed data points are saved.

When Max Length is enabled, the maximum number of waveform data 
points is saved.

The maximum number of data points depends on these things:

• Whether acquisitions are running. When stopped, data comes from the 
raw acquisition record. When running, data comes from the smaller 
measurement record.

• Whether the oscilloscope was stopped using [Stop] or [Single]. Running 
acquisitions split memory to provide fast waveform update rates. Single 
acquisitions use full memory.

• Whether only one channel of a pair is turned on. (Channels 1 and 2 are 
one pair, channels 3 and 4 are the other.) Acquisition memory is 
divided among the channels in a pair.

• Whether reference waveforms are on. Displayed reference waveforms 
consume acquisition memory.

• Whether digital channels are on. Displayed digital channels consume 
acquisition memory.

• Whether segmented memory is on. Acquisition memory is divided by 
the number of segments.
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• The horizontal time/div (sweep speed) setting. At faster settings, fewer 
data points appear on the display.

• When saving to a CSV format file, the maximum number of data points 
is 64K.

When necessary, the Length control performs a "1 of n" decimation of the 
data . For example: if the Length is set to 1000, and you are displaying a 
record that is 5000 data points in length, four of each five data points will 
be decimated, creating an output file 1000 data points in length.

When saving waveform data, the save times depend on the chosen format:

See Also • "Binary Data (.bin) Format" on page 377

• "CSV and ASCII XY files" on page 384

• "Minimum and Maximum Values in CSV Files" on page 385

To save Lister data files

Lister data files can be saved to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 
Lister data file.

2 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

3 Press the Settings softkey.

In the File Settings Menu, you have these softkeys and options:

• Setup Info — when enabled, setup information (vertical, horizontal, 
trigger, acquisition, math, and display settings) is also saved in a 
separate file with a TXT extension.

4 Finally, press the Press to Save softkey.

Data File Format Save Times

BIN fastest

ASCII XY medium

CSV slowest
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A message indicating whether the save was successful is displayed.

To save reference waveform files to a USB storage device

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press the Save softkey.

3 In the Save Menu, press the Format softkey and turn the Entry knob to 
select Reference Waveform data (*.h5) .

4 Press the Source softkey and turn the Entry knob to select the source 
waveform.

5 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

6 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

To save masks

Mask files can be saved to one of four internal (\Agilent Flash) locations 
or to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 
Mask (*.msk).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

Mask files have the extension MSK.

See Also • Chapter 15, “Mask Testing,” starting on page 271

NOTE Masks are also saved as part of setup files. See "To save setup files" on page 311.
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To save arbitrary waveforms

Arbitrary waveform files can be saved to one of four internal (\Agilent 
Flash) locations or to an external USB storage device.

1 Press [Save/Recall] > Save > Format; then, turn the Entry knob to select 
Arbitrary Waveform data (*.csv).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the save location. See "To navigate storage locations" on 
page 317.

3 Finally, press the Press to Save softkey.

A message indicating whether the save was successful is displayed.

See Also • "To edit arbitrary waveforms" on page 291

To navigate storage locations

When saving or recalling files, the softkey in the second position of the 
Save Menu or Recall Menu, along with the Entry knob, are used to 
navigate to storage locations. The storage locations can be internal 
oscilloscope storage locations (for setup files or mask files) or they can be 
external storage locations on a connected USB storage device.

The softkey in the second position can have these labels:

• Press to go — when you can push the Entry knob to navigate to a new 
folder or storage location.

• Location — when you have navigated to the current folder location (and 
are not saving files).

• Save to — when you can save to the selected location.

• Load from — when you can recall from the selected file.

When saving files:

• The proposed file name is shown in the Save to file = line above the 
softkeys.

• To overwrite an existing file, browse to that file and select it. To create 
a new file name, see "To enter file names" on page 317.

To enter file names

To create new file names when saving files to a USB storage device:
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1 In the Save Menu, press the File Name softkey.

You must have a USB storage device connected to the oscilloscope for 
this softkey to be active.

2 In the File Name Menu, press the File Name softkey.

3 In the File Name keypad dialog, you can enter file names using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; 

then, push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen that 
can be touched.

4 When you are done entering the file name, select the dialog's Enter or 
OK key or press the File Name softkey again.

The file name appears in the softkey.

5 When available, the Increment softkey can be used to enable or disable 
automatically incremented file names. Auto increment adds a numeric 
suffix to your file name and increments the number with each 
successive save. It will truncate characters as necessary when the file 
name length is at maximum and more digits are required for the 
numeric portion of the file name.

Emailing Setups, Screen Images, or Data

You can send oscilloscope files over the network via e- mail. You can 
e- mail any file that can be saved.

To e- mail a setup, screen image, or data file:

1 Make sure the oscilloscope is connected to the local area network (see 
"To establish a LAN connection" on page 331).

2 Press the [Save/Recall] key.

3 In the Save/Recall Menu, press Email.

4 In the Email Menu, press Format; then, select the type of file you want 
to send.
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You can select from the same formats that are available when saving 
files. Settings for the selected format are also the same. See "Saving 
Setups, Screen Images, or Data" on page 309.

5 Press the Attachment Name softkey and use the keypad dialog to enter 
the name of the attachment file that will be sent.

6 In the e- mail configuration dialog box, touch the To, From, Server, and 
Subject fields and use the keypad dialog to enter the appropriate 
strings.

You can also enter these strings by pressing the Config Email softkey and 
the To, From, Server, and Subject softkeys in the Configure Email Menu.

You can specify multiple e- mail addresses by separating each address 
by a semi- colon.

The Server name is the name of your mail server running the Simple 
Mail Transfer Protocol (SMTP). If you do not know this name, ask your 
Network Administrator.

7 Finally, press the Press to Send Email softkey.

You can also configure the [Quick Action] key to e- mail setups, screen 
images, or data. See "Configuring the [Quick Action] Key" on page 347.

Recalling Setups, Masks, or Data

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Recall.

3 In the Recall Menu, press Recall:, then, turn the Entry knob to select 
the type of file you want to recall:

• Setup (*.scp) — See "To recall setup files" on page 320.

• Mask (*.msk) — See "To recall mask files" on page 320.

• Reference Waveform data (*.h5) — See "To recall reference waveform files 
from a USB storage device" on page 320.

• Arbitrary Waveform data (*.csv) — See "To recall arbitrary waveforms" on 
page 321.

• CAN Symbolic data (*.dbc) — See "Loading and Displaying CAN Symbolic 
Data" on page 389.
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You can also recall setups and mask files by loading them using the File 
Explorer. See "File Explorer" on page 333.

You can also configure the [Quick Action] key to recall setups, masks, or 
reference waveforms. See "Configuring the [Quick Action] Key" on 
page 347.

To recall setup files

Setup files can be recalled from one of 10 internal (\Agilent Flash) 
locations or from an external USB storage device.

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select 
Setup (*.scp).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the file to recall. See "To navigate storage locations" on 
page 317.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display, press Clear Display.

To recall mask files

Mask files can be recalled from one of four internal (\Agilent Flash) 
locations or from an external USB storage device.

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select 
Mask (*.msk).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the file to recall. See "To navigate storage locations" on 
page 317.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

4 If you would like to clear the display or clear the recalled mask, press 
Clear Display or Clear Mask.

To recall reference waveform files from a USB storage device

1 Press the [Save/Recall] key.
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2 In the Save/Recall Menu, press the Recall softkey.

3 In the Recall Menu, press the Recall softkey and turn the Entry knob to 
select Reference Waveform data (*.h5) .

4 Press the To Ref: softkey and turn the Entry knob to select the desired 
reference waveform location.

5 Press the softkey in the second position and use the Entry knob to 
navigate to the file to recall. See "To navigate storage locations" on 
page 317.

6 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.

7 If you would like to clear the display of everything except the reference 
waveform, press Clear Display.

To recall arbitrary waveforms

Arbitrary waveform files can be recalled from one of four internal (\
Agilent Flash) locations or from an external USB storage device.

When recalling arbitrary waveforms (from an external USB storage device) 
that were not saved from the oscilloscope, be aware that:

• If the file contains two columns, the second column is automatically 
chosen.

• If the file contains more than two columns, you are prompted to select 
which column to load. Up to five columns are parsed by the 
oscilloscope; columns above the fifth are ignored.

• The oscilloscope uses a maximum of 8192 points for an arbitrary 
waveform. For more efficient recalls, make sure your arbitrary 
waveforms are 8192 points or less.

To recall an arbitrary waveform:

1 Press [Save/Recall] > Recall > Recall:; then, turn the Entry knob to select 
Arbitrary Waveform data (*.csv).

2 Press the softkey in the second position and use the Entry knob to 
navigate to the file to recall. See "To navigate storage locations" on 
page 317.

3 Press the Press to Recall softkey.

A message indicating whether the recall was successful is displayed.
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4 If you would like to clear the display, press Clear Display.

See Also • "To edit arbitrary waveforms" on page 291

Recalling Default Setups

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Default/Erase.

3 In the Default Menu, press one of these softkeys:

• Default Setup— recalls the oscilloscope's default setup. This is the same 
as pressing the front panel [Default Setup] key. See "Recall the Default 
Oscilloscope Setup" on page 35.

Some user settings are not changed when recalling the default setup.

• Factory Default— recalls the oscilloscope's factory default settings.

You must confirm the recall because there are no user settings that 
are left unchanged.

Performing a Secure Erase

1 Press the [Save/Recall] key.

2 In the Save/Recall Menu, press Default/Erase.

3 In the Default menu, press Secure Erase.

This performs a secure erase of all non- volatile memory in compliance 
with National Industrial Security Program Operation Manual (NISPOM) 
Chapter 8 requirements.

You must confirm the secure erase, and the oscilloscope will reboot 
when finished.
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To print the oscilloscope's display 323

To set up network printer connections 325

To specify the print options 326

To specify the palette option 327

You can print the complete display, including the status line and softkeys, 
to a USB printer or a network printer when the LAN connection is used.

The Print Configuration Menu is displayed when you press the [Print] key. 
The print option softkeys and the Press to Print softkey are ghosted (not 
available) until a printer is connected.

To print the oscilloscope's display

1 Connect a printer. You can:

• Connect a USB printer to one of the the USB ports on the front 
panel or the rectangular USB host port on the rear panel.

For the most up- to- date listing of printers that are compatible with 
the InfiniiVision oscilloscopes, please visit 
"www.agilent.com/find/InfiniiVision- printers".

• Set up a network printer connection. See "To set up network printer 
connections" on page 325.

2 Press the [Print] key on the front panel.

3 In the Print Configuration Menu, press the Print to softkey; then, turn 
the Entry knob to select the desired printer.

4 Press the Options softkey to select the print options.

http://www.agilent.com/find/InfiniiVision-printers
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See "To specify the print options" on page 326.

5 Press the Palette softkey to select the print palette. See "To specify the 
palette option" on page 327.

6 Press the Press to Print softkey.

You can stop printing by pressing the Cancel Print softkey.

You can also configure the [Quick Action] key to print the display. See 
"Configuring the [Quick Action] Key" on page 347.

See Also • "To add an annotation" on page 164

NOTE The oscilloscope will print the last menu visited before you pressed the [Print] key. 
Therefore, if you have measurements (Amplitude, Frequency, etc.) showing on the display 
before you press [Print], the measurements will be shown on the printout.

To print the display showing the Print Configuration Menu at the bottom, press the [Print] 
key twice; then, press the Press to Print softkey.
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To set up network printer connections

When the oscilloscope is connected to a LAN, you can set up network 
printer connections.

A network printer is a printer attached to a computer or print server on 
the network.

1 Press the [Print] key on the front panel.

2 In the Print Configuration Menu, press the Print to softkey; then, turn 
the Entry knob to select the network printer you want to configure 
(either #0 or #1).

3 Press the Network Setup softkey.

4 In the Network Printer Setup Menu:

a Press the Address softkey.

b In the Address keypad dialog, you can enter text using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; 

then, push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen 
that can be touched.

The Address is the printer or print server's address in one of the 
following formats:

• IP address of a network- enabled printer (for example: 
192.168.1.100 or 192.168.1.100:650). Optionally, a non- standard 
port number can be specified following a colon.

• IP address of a print server followed by the path to the printer 
(for example: 192.168.1.100/printers/printer- name or 
192.168.1.100:650/printers/printer- name).

• Path to a Windows network printer share (for example: \\server\
share).

c When you are done entering text, select the dialog's Enter or OK key 
or press the Address softkey again.
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The address appears in the softkey.

d When the Address is a Windows network printer share, these softkeys 
appear and let you enter additional settings:

• Domain — this is the Windows network domain name.

• Username — this is your login name for the Windows network 
domain.

• Password — this is your login password for the Windows network 
domain.

To clear an entered password, press the Clear key in the Password 
keypad dialog.

e Press the Apply softkey to make the printer connection.

A message appears to tell you whether the connection was 
successful.

To specify the print options

In the Print Configuration Menu, press the Options softkey to change the 
following options:

• Setup Information — Select this to print oscilloscope setup information on 
your printout, including vertical, horizontal, trigger, acquisition, math, 
and display settings.

• Invert Graticule Colors — Select this to reduce the amount of black ink it 
takes to print oscilloscope images by changing the black background to 
white. Invert Graticule Colors is the default mode.

• Form Feed — Select this to send a form feed command to the printer 
after the waveform is printed and before the setup information is 
printed. Switch Form Feed off if you want setup information printed on 
the same sheet of paper with the waveform. This option only has an 
effect when the Setup Information option is selected. Also, if the amount 
of setup information will not fit on the same page with the waveform, it 
will be printed on a new page regardless of the Form Feed setting.

• Landscape — Select this to print horizontally on the page instead of 
vertically (portrait mode).
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To specify the palette option

In the Print Configuration Menu, press the Palette softkey to change the 
following options.

• Color — Select this to print the screen in color.

• Grayscale — Select this to print the screen in shades of gray rather than 
in color.
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This chapter explains oscilloscope utility functions.

I/O Interface Settings

The oscilloscope can be accessed and/or controlled remotely via these I/O 
interfaces:

• USB device port on the rear panel (square shaped USB port).

• LAN interface on the rear panel.

To configure the I/O interfaces:

1 On the oscilloscope's front panel, press [Utility].

2 In the Utility Menu, press I/O.

3 In the I/O Menu, press Configure.
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• LAN — When connected to a LAN, you can use the LAN Settings and 
LAN Reset softkeys to configure the LAN interface. See "Setting up the 
Oscilloscope's LAN Connection" on page 330.

• There are no configuration settings for the USB interface.

When an I/O interface is installed, remote control over that interface is 
always enabled. Also, the oscilloscope can be controlled via multiple I/O 
interfaces (for example, USB and LAN) at the same time.

See Also • Chapter 21, “Web Interface,” starting on page 349 (when the 
oscilloscope is connected to a LAN).

• "Remote Programming via the Web Interface" on page 355

• The oscilloscope's Programmer's Guide.

• "Remote Programming with Agilent IO Libraries" on page 356

Setting up the Oscilloscope's LAN Connection

Using the rear panel LAN port, you can place the oscilloscope on the 
network and set up its LAN connection. Once that is done, you can set up 
and use network printers or use the oscilloscope's web interface or 
remotely control the oscilloscope via the LAN interface.

The oscilloscope supports methods for automated LAN configuration or 
manual LAN configuration (see "To establish a LAN connection" on 
page 331). It is also possible to set up a point- to- point LAN connection 
between a PC and the oscilloscope (see "Stand- alone (Point- to- Point) 
Connection to a PC" on page 332).

Once the oscilloscope is set up on the network, you can use the 
oscilloscope's web page to view or change its network configuration and 
access additional settings (like the network password). See Chapter 21, 
“Web Interface,” starting on page 349.

NOTE When you connect the oscilloscope to a LAN it is a good practice to limit access to the 
oscilloscope by setting a password. By default, the oscilloscope is not password protected. 
See "Setting a Password" on page 363 to set a password.
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To establish a LAN connection

Automatic
Configuration

1 Press [Utility] > I/O.

2 Press the LAN Settings softkey.

3 Press the Config softkey; then, turn the Entry knob to select Automatic, 
and press the softkey again to enable it.

If your network supports DHCP or AutoIP, enabling Automatic lets the 
oscilloscope use those services to get its LAN configuration settings

4 If your network provides Dynamic DNS, you can enable the Dynamic DNS 
option to let the oscilloscope register its hostname and use the DNS 
server for name resolution.

5 You can enable the Multicast DNS option to let the oscilloscope use 
Multicast DNS for name resolution on small networks without a 
conventional DNS server.

6 Connect the oscilloscope to the local area network (LAN) by inserting 
the LAN cable into the "LAN" port on the rear panel of the 
oscilloscope.

In a few moments the oscilloscope will connect to the network 
automatically.

If the oscilloscope does not automatically connect to the network, press 
[Utility] > I/O > LAN Reset. In a few moments the oscilloscope will connect 
to the network.

Manual
Configuration

1 Get the oscilloscope's network parameters (host name, IP address, 
subnet mask, gateway IP, DNS IP, etc.) from your network 
administrator.

2 Press [Utility] > I/O.

3 Press the LAN Settings softkey.

4 Press the Config softkey; then, turn the Entry knob to select Automatic, 
and press the softkey again to disable it.

NOTE Any time you modify the oscilloscope's hostname, it breaks the connection between the 
oscilloscope and the LAN. You need to re-establish communication to the oscilloscope 
using the new hostname.
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If Automatic is not enabled, the oscilloscope's LAN configuration must 
be set up manually using the Modify and Host name softkeys

5 Configure the oscilloscope's LAN interface:

a Use the Modify softkey (and the other softkeys and keypad entry 
dialogs) to enter the IP Address, Subnet Mask, Gateway IP, and DNS 
IP values.

b Press the Host name softkey and use the keypad entry dialog to enter 
the Host Name.

c Press the Apply softkey.

6 Connect the oscilloscope to the local area network (LAN) by inserting 
the LAN cable into the "LAN" port on the rear panel of the 
oscilloscope.

Stand-alone (Point-to-Point) Connection to a PC

The following procedure describes how to establish a point- to- point (stand 
alone) connection to the oscilloscope. This is useful if you want to control 
the oscilloscope using a laptop computer or a stand- alone computer.

1 Press [Utility] > I/O.

2 Press the LAN Settings softkey.

3 Press the Config softkey; then, turn the Entry knob to select Automatic, 
and press the softkey again to enable it.

If your network supports DHCP or AutoIP, enabling Automatic lets the 
oscilloscope use those services to get its LAN configuration settings

4 Connect your PC to the oscilloscope using a cross- over LAN cable such 
as Agilent part number 5061- 0701, available on the web at 
"www.parts.agilent.com".

5 Cycle power on the oscilloscope. Wait until the LAN connection is 
configured:

• Press [Utility] > I/O and wait until the LAN status shows "configured".

This may take a few minutes.

Now, the instrument is connected, and the instrument's web interface or 
remote control via LAN may be used.

http://www.parts.agilent.com
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File Explorer

The File Explorer lets you navigate the oscilloscope's internal file system 
and the file systems of connected USB storage devices.

From the internal file system, you can load oscilloscope setup files or 
mask files.

From a connected USB storage device, you can load setup files, mask files, 
license files, firmware update (*.agx) files, label files, etc. Also, you can 
delete files on a connected USB storage device.

The oscilloscope's internal file system, under "\Agilent Flash", consists of 
10 locations for oscilloscope setup files, four locations for mask files, and 
four locations for waveform generator arbitrary waveform files.

To use the File Explorer:

1 Press [Utility] > File Explorer.

2 In the File Explorer Menu, press the softkey in the first position and 
use the Entry knob to navigate.

NOTE The USB port on the front panel, and the USB port on the rear panel labeled "HOST" are 
USB Series A receptacles. These are the receptacles to which you can connect USB mass 
storage devices and printers.

The square receptacle on the rear panel labeled "DEVICE" is provided for controlling the 
oscilloscope over USB. See the Programmer's Guide for more information.
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The softkey in the first position can have these labels:

• Press to go — when you can push the Entry knob to navigate to a new 
folder or storage location.

• Location — when pointing to a directory that is currently selected.

• Selected — when pointing to a file that can be loaded or deleted.

When this label appears, you can press the Load File or Delete File 
softkeys to take the action.

Pushing the Entry knob is the same as pressing the Load File softkey.

A file that has been deleted from a USB storage device cannot be 
recovered by the oscilloscope.

Use your PC to create directories on a USB storage device.

USB Storage
Devices

Most USB mass storage devices are compatible with the oscilloscope. 
However, certain devices may be incompatible, and may not be able to be 
read or written to.
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When the USB mass storage device is connected to the oscilloscope's front 
or rear USB host port, a small four- color circle icon may be displayed 
briefly as the USB device is read.

You do not need to "eject" the USB mass storage device before removing it. 
Simply ensure that any file operation you've initiated is done, and remove 
the USB drive from the oscilloscope's host port.

Do not connect USB devices that identify themselves as hardware type 
"CD" because these devices are not compatible with the InfiniiVision 
X- Series oscilloscopes.

If two USB mass storage devices are connected to the oscilloscope, the 
first one is designated "\usb" and the second one is designated "\usb2".

See Also • Chapter 18, “Save/Email/Recall (Setups, Screens, Data),” starting on 
page 309

Setting Oscilloscope Preferences

The User Preferences Menu (under [Utility] > Options > Preferences) lets you 
specify oscilloscope preferences.

• "To choose "expand about" center or ground" on page 335

• "To disable/enable transparent backgrounds" on page 336

• "To load the default label library" on page 336

• "To set up the screen saver" on page 336

• "To set AutoScale preferences" on page 337

To choose "expand about" center or ground

When you change a channel's volts/division setting, the waveform display 
can be set to expand (or compress) about the signal ground level or the 
center of the display.

To set the waveform expansion reference point:

1 Press [Utility] > Options > Preferences > Expand and select:

• Ground— The displayed waveform will expand about the position of 
the channel's ground. This is the default setting.
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The ground level of the signal is identified by the position of the 

ground level ( ) icon at the far- left side of the display.

The ground level will not move when you adjust the vertical 
sensitivity (volts/division) control.

If the ground level is off screen, the waveform will expand about the 
top or bottom edge of the screen based on where the ground is off 
screen.

• Center— The displayed waveform will expand about the center of the 
display.

To disable/enable transparent backgrounds

There is a preference setting for whether measurements, statistics, 
reference waveform information, and other text displays have transparent 
or solid backgrounds.

1 Press [Utility] > Options > Preferences.

2 Press Transparent to toggle between transparent and solid text display 
backgrounds.

To load the default label library

See "To reset the label library to the factory default" on page 163.

To set up the screen saver

The oscilloscope can be configured to turn on a display screen saver when 
the oscilloscope has been idle for a specified length of time.

1 Press [Utility] > Options > Preferences > Screen Saver to display the Screen 
Saver Menu.

2 Press the Screen Saver softkey to select the screen saver type.

The screen saver can be set to Off, to display any of the images shown 
in the list, or can display a user- defined text string.
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If User is selected:

a Press the Text softkey.

b In the Text keypad dialog, you can enter text using:

• The touch screen (when the front panel [Touch] key is lit).

• The  Entry knob. Turn the knob to select a key in the dialog; 

then, push the  Entry knob to enter it.

• A connected USB keyboard.

• A connected USB mouse — you can click anything on the screen 
that can be touched.

c When you are done entering text, select the dialog's Enter or OK key 
or press the Text softkey again.

The user- defined screen saver text appears in the softkey.

3 Press the Wait softkey; then, turn the Entry knob to select the number 
of minutes to wait before the selected screen saver activates.

When you turn the Entry knob, the number of minutes is displayed on 
the Wait softkey. The default time is 180 minutes (3 hours).

4 Press the Preview softkey to preview the screen saver you have selected 
with the Saver softkey.

5 To view the normal display after the screen saver has started, press any 
key or turn any knob.

To set AutoScale preferences

1 Press [Utility] > Options > Preferences > AutoScale.

2 In the AutoScale Preferences Menu, you can:

• Press the Fast Debug softkey enable/disable this type of autoscale.

When fast debug is enabled, autoscale lets you make quick visual 
comparisons to determine whether the signal being probed is a DC 
voltage, ground, or an active AC signal.
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Channel coupling is maintained to allow easy viewing of oscillating 
signals.

• Press the Channels softkey and turn the Entry knob to specify the 
channels to be autoscaled:

• All Channels — The next time you press [AutoScale], all channels that 
meet the requirements of AutoScale will be displayed.

• Only Displayed Channels — The next time you press [AutoScale], only 
the channels that are turned on will be examined for signal 
activity. This is useful if you only want to view specific active 
channels after pressing [AutoScale].

• Press the Acq Mode softkey and turn the Entry knob to select whether 
the acquisition mode should be preserved during autoscale:

• Normal — to make the oscilloscope switch to Normal acquisition 
mode whenever the [AutoScale] key is pressed. This is the default 
mode.

• Preserve — to make the oscilloscope remain in the acquisition mode 
you have chosen when the [AutoScale] key is pressed.

Setting the Oscilloscope's Clock

The Clock Menu lets you set the current date and time of day (24- hour 
format). This time/date stamp will appear on hardcopy prints and 
directory information on the USB mass storage device.

To set the date and time, or to view the current date and time:

1 Press [Utility] > Options > Clock.

2 Press the Year, Month, Day, Hour or Minute softkey; then, rotate the Entry 
knob to set to the desired number.

The hours are shown in the 24- hour format. So 1:00 PM is hour 13.
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The real- time clock only allows selection of valid dates. If a day is 
selected and the month or year is changed so the day is invalid, the day 
is automatically adjusted.

Setting the Rear Panel TRIG OUT Source

You can choose the source of the TRIG OUT connector on the rear panel 
of the oscilloscope:

1 Press [Utility] > Options > Rear Panel.

2 In the Rear Panel Menu, press Trig Out; then, turn the Entry knob to 
select from:

• Triggers— Each time the oscilloscope triggers, a rising edge occurs on 
TRIG OUT. The rising edge is delayed 30 ns from the oscilloscope's 
trigger point. The output level is 0- 5 V into an open circuit, and 
0- 2.5 V into 50 Ω. See Chapter 10, “Triggers,” starting on page 167.

• Mask— The pass/fail status is evaluated periodically. When the 
evaluation of the testing period results in a failure, the trigger output 
pulses high (+5 V). Otherwise, the trigger output remains at low 
(0 V). See Chapter 15, “Mask Testing,” starting on page 271.

• Waveform Generator 1/2 Sync Pulse— All of the waveform generator 
output functions (except DC, Noise, and Cardiac) have an associated 
Sync signal:

The Sync signal is a TTL positive pulse that occurs when the 
waveform rises above zero volts (or the DC offset value).

See Chapter 17, “Waveform Generator,” starting on page 287.

The TRIG OUT connector also provides the User Calibration signal. See 
"To perform user calibration" on page 342.

Setting the Reference Signal Mode

The 10 MHz REF BNC connector on the rear panel is provided so you 
can:

• Supply a more accurate sample clock signal to the oscilloscope, or
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• Synchronize the timebase of two or more instruments.

Sample clock and
frequency

counter accuracy

The oscilloscope's timebase uses a built- in reference that has an accuracy 
of 15 ppm. This is sufficient for most uses. However, if you are looking at 
a window that is very narrow compared to the selected delay (for 
example, looking at a 15 ns pulse with the delay set to 1 ms), significant 
error can be introduced.

Using the built- in sample clock, the oscilloscope's hardware frequency 
counter is a 5- digit counter.

See "To supply a sample clock to the oscilloscope" on page 340.

Supplying an
external timebase

reference

When you supply an external timebase reference, the hardware frequency 
counter is automatically changed to an 8- digit counter. In this case, the 
frequency counter ([Meas] > Select > Counter) is as accurate as the external 
clock.

See "To synchronize the timebase of two or more instruments" on 
page 341.

For more information on the hardware frequency counter, see 
"Counter" on page 258.

To supply a sample clock to the oscilloscope

1 Connect a 10 MHz square or sine wave to the BNC connector labeled 
10 MHz REF. The amplitude must be from - 5 dBm to 17 dBm 
(356 mVpp to 4.48 Vpp).

2 Press [Utility] > Options > Rear Panel > Ref Signal.

3 Use the Entry knob and the Ref Signal softkey to select 10 MHz input.

A locked padlock icon appears at the top of the display.

CAUTION  Maximum input voltage at 10 MHz REF connector

Do not apply more than 20 dBm Max (6.32 Vpp Max) at the 10 MHz REF BNC connector 
on the rear panel or damage to the instrument may occur.
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If the externally supplied sample clock signal is lost, a hard unlock will 
occur. The lock symbol in the upper right part of the display will become 
an unlocked padlock icon and the oscilloscope will stop acquiring data. 
The oscilloscope will resume sampling when the externally supplied 
sample clock becomes stable again.

To synchronize the timebase of two or more instruments

The oscilloscope can output its 10 MHz system clock for the purpose of 
synchronization with other instruments.

1 Connect a BNC cable to the BNC connector labeled 10 MHz REF on the 
rear panel of the oscilloscope.

2 Connect the other end of the BNC cable to the instrument(s) that will 
accept the 10 MHz reference signal. Put a 50 Ω termination at the input 
to the other instrument to terminate the signal.

3 Press [Utility] > Options > Rear Panel > Ref Signal.

4 Use the Entry knob and the Ref Signal softkey to select 10 MHz output.
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The oscilloscope will output its 10 MHz reference signal at TTL levels.

Performing Service Tasks

The Service Menu (under [Utility] > Service) lets you perform service- related 
tasks:

• "To perform user calibration" on page 342

• "To perform hardware self test" on page 344

• "To perform front panel self test" on page 345

• "To display oscilloscope information" on page 345

• "To display the user calibration status" on page 345

For other information related to oscilloscope maintenance and service, see:

• "To clean the oscilloscope" on page 345

• "To check warranty and extended services status" on page 346

• "To contact Agilent" on page 346

• "To return the instrument" on page 346

To perform user calibration

Perform user- calibration:

• Every two years or after 4000 hours of operation.

• If the ambient temperature is >10° C from the calibration temperature.

• If you want to maximize the measurement accuracy.

The amount of use, environmental conditions, and experience with other 
instruments help determine if you need shorter User Calibration intervals.

User Calibration performs an internal self- alignment routine to optimize 
the signal path in the oscilloscope. The routine uses internally generated 
signals to optimize circuits that affect channel sensitivity, offset, and 
trigger parameters.
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Performing User Calibration will invalidate your Certificate of Calibration. 
If NIST (National Institute of Standards and Technology) traceability is 
required, perform the "Performance Verification" procedure in the Agilent 
InfiniiVision 4000 X- Series Oscilloscopes Service Guide using traceable 
sources.

To perform user calibration:

1 Disconnect all inputs from the front and rear panels, including the 
digital channels cable on an MSO, and allow the oscilloscope to warm 
up before performing this procedure.

2 Press the rear- panel CAL button to disable calibration protection.

3 Connect short (12 inch maximum) equal length cables to each analog 
channel's BNC connector on the front of the oscilloscope. You will need 
two equal- length cables for a 2- channel oscilloscope or four 
equal- length cables for a 4- channel oscilloscope.

Use 50W RG58AU or equivalent BNC cables when performing User 
Calibration.

For a 2- channel oscilloscope, connect a BNC tee to the equal length 
cables. Then connect a BNC(f)- to- BNC(f) (also called a barrel 
connector) to the tee as shown below.

Figure 50 User Calibration cable for 2-channel oscilloscope

To Channel 1

To Channel 2

Long cable
to TRIG OUT



344 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

20 Utility Settings
 

For a 4- channel oscilloscope, connect BNC tees to the equal- length 
cables as shown below. Then connect a BNC(f)- to- BNC(f) (barrel 
connector) to the tee as shown below.

4 Connect a BNC cable (40 inches maximum) from the TRIG OUT 
connector on the rear panel to the BNC barrel connector.

5 Press the [Utility] key; then, press the Service softkey.

6 Begin the Self Calibration by pressing the Start User Calibration softkey.

To perform hardware self test

Pressing [Utility] > Service > Hardware Self Test performs a series of internal 
procedures to verify that the oscilloscope is operating properly.

It is recommended you run Hardware Self Test:

• After experiencing abnormal operation.

• For additional information to better describe an oscilloscope failure.

• To verify proper operation after the oscilloscope has been repaired.

Figure 51 User Calibration cable for 4-channel oscilloscope

To Channel 4

To Channel 1

To Channel 3

Longer cable
to TRIG OUT

To Channel 2
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Successfully passing Hardware Self Test does not guarantee 100% of the 
oscilloscope's functionality. Hardware Self Test is designed to provide an 
80% confidence level that the oscilloscope is operating properly.

To perform front panel self test

Pressing [Utility] > Service > Front Panel Self Test lets you test the front panel 
keys and knobs as well as the oscilloscope display.

Follow the on- screen instructions.

To display oscilloscope information

Press [Help] > About Oscilloscope to display information about your 
oscilloscope:

• Model number.

• Serial number.

• Bandwidth.

• Module installed.

• Software version.

• Installed licenses. See also "Loading Licenses and Displaying License 
Information" on page 374.

To display the user calibration status

Pressing [Utility] > Service > User Calibration Status displays the summary 
results of the previous User Calibration, and the status of probe 
calibrations for probes that can be calibrated. Note that passive probes do 
not need to be calibrated, but InfiniiMax probes can be calibrated. For 
more information about calibrating probes see "To calibrate a probe" on 
page 89.

To clean the oscilloscope

1 Remove power from the instrument.

2 Clean the external surfaces of the oscilloscope with a soft cloth 
dampened with a mixture of mild detergent and water.
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3 Make sure that the instrument is completely dry before reconnecting it 
to a power source.

To check warranty and extended services status

To learn the warranty status of your oscilloscope:

1 Point your web browser to: "www.agilent.com/find/warrantystatus"

2 Enter your product's model number and serial number. The system will 
search for the warranty status of your product and display the results. 
If the system cannot find your product's warranty status, select Contact 
Us and speak with an Agilent Technologies representative.

To contact Agilent

Information on contacting Agilent Technologies can be found at: 
"www.agilent.com/find/contactus"

To return the instrument

Before shipping the oscilloscope to Agilent Technologies, contact your 
nearest Agilent Technologies sales or service office for additional details. 
Information on contacting Agilent Technologies can be found at: 
"www.agilent.com/find/contactus"

1 Write the following information on a tag and attach it to the 
oscilloscope.

• Name and address of owner.

• Model number.

• Serial number.

• Description of service required or failure indication.

2 Remove accessories from the oscilloscope.

Only return accessories to Agilent Technologies if they are associated 
with the failure symptoms.

3 Package the oscilloscope.

You can use the original shipping container, or provide your own 
materials sufficient to protect the instrument during shipping.

4 Seal the shipping container securely, and mark it FRAGILE.

http://www.agilent.com/find/warrantystatus
http://www.agilent.com/find/contactus
http://www.agilent.com/find/contactus
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Configuring the [Quick Action] Key

The [Quick Action] key lets you perform common, repetitive actions by 
pressing a single key.

To configure the [Quick Action] key:

1 Press [Utility] > Quick Action > Action; then, select the action that should be 
performed:

• Off — disables the [Quick Action] key.

• Quick Measure All — displays a popup containing a snapshot of all the 
single waveform measurements. The Source softkey lets you select the 
waveform source (which also becomes the source selection in the 
Measurement Menu). See Chapter 14, “Measurements,” starting on 
page 241.

• Quick Measure Statistics Reset — resets all measurement statistics and 
the measurement count. See "Measurement Statistics" on page 268.

• Quick Mask Statistics Reset — resets mask statistics and counters. See 
"Mask Statistics" on page 276.

• Quick Print — prints the current screen image. Press Settings to set up 
the printing options. See Chapter 19, “Print (Screens),” starting on 
page 323.

• Quick Save — saves the current image, waveform data, or setup. Press 
Settings to set up the save options. See Chapter 18, 
“Save/Email/Recall (Setups, Screens, Data),” starting on page 309.

• Quick Email — e- mails the current setup, screen image, or data file. 
Press Settings to set up the e- mail options. See "Emailing Setups, 
Screen Images, or Data" on page 318.

• Quick Recall — recalls a setup, mask, or reference waveform. Press 
Settings to set up the recall options. See Chapter 18, 
“Save/Email/Recall (Setups, Screens, Data),” starting on page 309.

• Quick Freeze Display — freezes the display without stopping running 
acquisitions or un- freezes the display if currently frozen. For more 
information, see "To freeze the display" on page 157.

• Quick Trigger Mode — toggles the trigger mode between Auto and 
Normal, see "To select the Auto or Normal trigger mode" on 
page 206.
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• Quick Clear Display — clears the display, see "To clear the display" on 
page 155.

Once the [Quick Action] key is configured, you simply press it to perform 
the selected action.
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When Agilent InfiniiVision 4000 X- Series oscilloscopes are set up on the 
LAN, you can access the oscilloscope's built- in web server using a 
Java- enabled web browser. The oscilloscope's web interface lets you:

• View information about the oscilloscope like its model number, serial 
number, host name, IP address, and VISA (address) connect string.

• Control the oscilloscope using the Remote Front Panel.

• Send SCPI (Standard Commands for Programmable Instrumentation) 
remote programming commands via the SCPI Commands applet window.

• Save setups, screen images, waveform data, and mask files.

• Recall setup files, reference waveform data files, or mask files.

• Get screen images and save or print them from the browser.

• Activate the Identification function to identify a particular instrument 
by causing a message to be displayed or a front panel light to blink.

• View installed options, view firmware versions and install firmware 
upgrade files, and view calibration status (via the Instrument Utilities 
page).

• View and modify the oscilloscope's network configuration.
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The web interface for InfiniiVision X- Series oscilloscopes also provides 
help for each of its pages.

Microsoft Internet Explorer is the recommended Web browser for 
communication and control of the oscilloscope. Other Web browsers may 
work but are not guaranteed to work with the oscilloscope. The Web 
browser must be Java- enabled with Sun Microsystems Java Plug- in.

Before you can use the web interface, you must place the oscilloscope on 
the network and set up its LAN connection.

Accessing the Web Interface

To access the oscilloscope's web interface:

1 Connect the oscilloscope to your LAN (see "To establish a LAN 
connection" on page 331) or establish a point- to- point connection (see 
"Stand- alone (Point- to- Point) Connection to a PC" on page 332).

It is possible to use a point- to- point connection, but using a normal 
LAN connection is the preferred method.

2 Type the oscilloscope's hostname or IP address in the web browser.

The oscilloscope's web interface Welcome Page is displayed.
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Browser Web Control

The web interface's Browser Web Control page gives you access to:

• The Real Scope Remote Front Panel (see "Real Scope Remote Front 
Panel" on page 352).

• The Simple Remote Front Panel (see "Simple Remote Front Panel" on 
page 353).

• The Browser- Based Remote Front Panel (see "Browser- Based Remote 
Front Panel" on page 354).

• The SCPI Command window applet for Remote Programming (see 
"Remote Programming via the Web Interface" on page 355).
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The SCPI Command window is useful for testing commands or entering a 
few commands interactively. When creating automated programs for 
controlling the oscilloscope, you will typically use the Agilent IO Libraries 
from within a programming environment like Microsoft Visual Studio (see 
"Remote Programming with Agilent IO Libraries" on page 356).

Real Scope Remote Front Panel

To operate the oscilloscope using the web interface's Real Scope Remote 
Front Panel:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select 
Browser Web Control, then select Real Scope Remote Front Panel. After a few 
seconds the Remote Front Panel appears.

3 Click keys or knobs that you would normally press on the oscilloscope's 
front panel. Drag on edges of knobs to turn them.

NOTE If Java is not installed on your PC, you will be prompted to install the Sun Microsystems 
Java Plug-in. This plug-in must be installed on the controlling PC for the web interface's 
Remote Front Panel or Remote Programming operations.
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Simple Remote Front Panel

To operate the oscilloscope using the web interface's Simple Remote Front 
Panel:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select 
Browser Web Control, then select Simple Remote Front Panel. After a few 
seconds the Remote Front Panel appears.

3 Use the Main Menu and the Function Keys to control the oscilloscope. 
To view Quick Help, right- click on a softkey.
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Scrolling and
Monitor

Resolution

When using a monitor resolution of 800 x 600 or less on the remote 
computer, you need to scroll to access the full remote front panel. To 
display the remote front panel without scroll bars, use a monitor 
resolution greater than 800 x 600 on your computer's display.

Browser-Based Remote Front Panel

To operate the oscilloscope using the web interface's Browser- Based 
Remote Front Panel:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select 
Browser Web Control, then select Browser-Based Remote Front Panel. After a 
few seconds the Remote Front Panel appears.

3 Click keys or knobs that you would normally press on the oscilloscope's 
front panel. Buttons have been added for turning knobs.
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 Remote Programming via the Web Interface

To send remote programming commands to the oscilloscope via the SCPI 
Commands applet window:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select 
Browser Web Control, then select Remote Programming.

The SCPI Commands applet appears within the browser web page.
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Remote Programming with Agilent IO Libraries

While the SCPI Commands applet window lets you enter and remote 
programming commands, remote programming for automated test and data 
acquisition is typically done using the Agilent IO Libraries, which are 
separate from the instrument's web interface.

The Agilent IO Libraries let a controller PC communicate with Agilent 
InfiniiVision 4000 X- Series oscilloscopes via their USB or LAN interfaces.

The Agilent IO Libraries Suite connectivity software to enables 
communication over these interfaces. You can download the Agilent IO 
Libraries Suite from "www.agilent.com/find/iolib".

http://www.agilent.com/find/iolib
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Information about controlling the oscilloscope through remote commands 
is contained in the Programmer's Guide, which is included on the 
documentation CD supplied with this oscilloscope. You can also access this 
document on the Agilent web site.

For more information about connecting to the oscilloscope, refer to the 
Agilent Technologies USB/LAN/GPIB Interfaces Connectivity Guide. For a 
printable electronic copy of the Connectivity Guide, direct your Web 
browser to "www.agilent.com" and search for "Connectivity Guide".

Save/Recall

You can save setup files, screen images, waveform data files, or mask files 
to your PC via the oscilloscope's web interface (see "Saving Files via the 
Web Interface" on page 357).

You can recall setup files, reference waveform data files, or mask files 
from your PC via the oscilloscope's web interface (see "Recalling Files via 
the Web Interface" on page 358).

Saving Files via the Web Interface

To save setup files, screen images, waveform data, Lister data, or mask 
files to your PC via the oscilloscope's web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select the Save/Recall 
tab from the left side of the Welcome screen.

3 Click the Save link.

4 On the Save page:

a Enter the name of the file you are saving to.

b Select the format.

http://www.agilent.com
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You can click Preview to view the oscilloscope's current screen image. 
When previewing, you can use the New Acquisition check box to force 
a new acquisition before the preview.

With some formats, you can click Save Setup Info to save setup 
information to an ASCII .txt format file.

c Click Save.

The current acquisition is saved.

d In the File Download dialog, click Save.

e In the Save As dialog, navigate to the folder where you want to save 
the file; then, click Save.

Recalling Files via the Web Interface

To recall setup files, reference waveform data files, mask files, or arbitrary 
waveform files from your PC via the oscilloscope's web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select the Save/Recall 
tab from the left side of the Welcome screen.

3 Click the Recall link.
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4 On the Recall page:

a Click Browse....

b In the "Choose file" dialog, select the file you want to recall; then, 
click Open.

c When recalling reference waveform data files, select the To Reference 
Waveform location.

d Click Recall.

Get Image

To save (or print) the oscilloscope's display from the web interface:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select the Get Image 
tab from the left side of the Welcome screen. After a delay of several 
seconds, the oscilloscope's screen image will be displayed.

3 Right- click on the image and select Save Picture As... (or Print Picture...).

4 Select a storage location for the image file and click Save.
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Identification Function

The Identification web interface feature is useful when trying to locate a 
specific instrument in a rack of equipment.

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface Welcome Page is displayed, select 
the Identification on radio button.

An "Identify" message is displayed on the oscilloscope; you can either 
select Identification off or press the OK softkey on the oscilloscope to 
continue.

Instrument Utilities

The Instrument Utilities page of the web interface lets you:

Identification option
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• View installed options.

• View firmware versions.

• Install firmware upgrade files.

• View calibration status.

You can select these capabilities via a drop- down menu.
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Setting a Password

Whenever you connect the oscilloscope to a LAN, it is good practice to set 
a password. The password prevents someone from remotely accessing the 
oscilloscope via a Web browser and changing parameters. Remote users 
can still view the Welcome screen, view network status, etc., but they can't 
operate the instrument or change its setup without the password.

To set a password:

1 Access the oscilloscope's web interface (see "Accessing the Web 
Interface" on page 350).

2 When the oscilloscope's web interface is displayed, select the Configure 
Network tab from the instrument's Welcome page.

3 Click the Modify Configuration button.
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4 Enter your desired password, and click Apply Changes.

Configure
Network

tab

Modify Configuration
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When accessing the password protected oscilloscope, the user name is the 
IP address of the oscilloscope.

To reset the
password

Do one of these things to reset the password:

• Using the keys on the front panel of the oscilloscope, press [Utility] > I/O 
> LAN Reset.

• Using the web browser select the Configure Network tab, select Modify 
Configuration, erase the Password, and select Apply Changes.

Enter
password
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Specifications and Characteristics

Please see the InfiniiVision oscilloscope data sheets for complete, 
up- to- date specifications and characteristics. To download a data sheet, 
please visit: "www.agilent.com/find/4000X- Series"

Then, select the Library tab, followed by Specifications.

Or, go to the Agilent home page at "www.agilent.com" and search for "4000 
X- Series oscilloscopes data sheet".

To order a data sheet by phone, please contact your local Agilent office. 
The complete list is available at: "www.agilent.com/find/contactus".

Measurement Category

• "Oscilloscope Measurement Category" on page 368

• "Measurement Category Definitions" on page 368

• "Transient Withstand Capability" on page 369

http://www.agilent.com/find/4000X-Series
http://www.agilent.com
http://www.agilent.com/find/contactus
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Oscilloscope Measurement Category

The InfiniiVision oscilloscopes are intended to be used for measurements 
in Measurement Category I.

Measurement Category Definitions

Measurement category I is for measurements performed on circuits not 
directly connected to MAINS. Examples are measurements on circuits not 
derived from MAINS, and specially protected (internal) MAINS derived 
circuits. In the latter case, transient stresses are variable; for that reason, 
the transient withstand capability of the equipment is made known to the 
user.

Measurement category II is for measurements performed on circuits 
directly connected to the low voltage installation. Examples are 
measurements on household appliances, portable tools and similar 
equipment.

Measurement category III is for measurements performed in the building 
installation. Examples are measurements on distribution boards, 
circuit- breakers, wiring, including cables, bus- bars, junction boxes, 
switches, socket- outlets in the fixed installation, and equipment for 
industrial use and some other equipment, for example, stationary motors 
with permanent connection to the fixed installation.

Measurement category IV is for measurements performed at the source of 
the low- voltage installation. Examples are electricity meters and 
measurements on primary overcurrent protection devices and ripple 
control units.

WARNING Use this instrument only for measurements within its specified measurement 
category.
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Transient Withstand Capability

Environmental Conditions

CAUTION  Maximum input voltage at analog inputs

CAT I 300 Vrms, 400 Vpk; transient overvoltage 1.6 kVpk

50Ω input: 5 Vrms Input protection is enabled in 50 Ω mode and the 50 Ω load will 
disconnect if greater than 5 Vrms is detected. However the inputs could still be 
damaged, depending on the time constant of the signal. The 50 Ω input protection only 
functions when the oscilloscope is powered on.

With 10073C 10:1 probe: CAT I 500 Vpk

With N2871A, N2872A, N2873A 10:1 probe: CAT I 400 Vpk, transient overvoltage 
1.25 kVpk

CAUTION  Maximum input voltage at digital channels

±40 V peak CAT I; transient overvoltage 800 Vpk

Environment Indoor use only.

Ambient 
temperature

Operating 0 °C to +55 °C; non-operating –30 °C to +70 °C

Humidity Operating: 50% to 95% RH at 40 °C for 5 days.
Non-operating: 90% RH at 65 °C for 24 hr.

Altitude Maximum operating altitude: 3,000 m (9,842 ft)

Overvoltage 
Category

This product is intended to be powered by MAINS that comply to Overvoltage 
Category II, which is typical of cord-and-plug connected equipment.

Pollution Degree The InfiniiVision 4000 X-Series oscilloscopes may be operated in 
environments of Pollution Degree 2 (or Pollution Degree 1).
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Probes and Accessories

This section lists the probes and accessories that are compatible with the 
4000 X- Series oscilloscopes.

• "Passive Probes" on page 371

• "Single- Ended Active Probes" on page 371

• "Differential Probes" on page 372

• "Current Probes" on page 373

• "Accessories Available" on page 373

AutoProbe
Interface

Most Agilent single- ended active, differential, and current probes are 
compatible with the AutoProbe interface. Active probes that do not have 
their own external power supply require substantial power from the 
AutoProbe interface.

In the following tables, for AutoProbe interface compatible probes, 
"Quantity Supported" indicates the maximum number of each type of 
active probe that can be connected to the oscilloscope.

If too much current is drawn from the AutoProbe interface, an error 
message will be displayed, indicating that you must momentarily 
disconnect all probes to reset the AutoProbe interface, then connect only 
the supported quantity of active probes.

See Also For more information on probes and accessories, see "www.agilent.com" 
for:

• "Probes and Accessories Selection Guide (5989- 6162EN)"

• "InfiniiVision Oscilloscope Probes and Accessories Selection Guide Data 
Sheet (5968- 8153EN)"

Pollution Degree 
Definitions

Pollution Degree 1: No pollution or only dry, non-conductive pollution occurs. 
The pollution has no influence. Example: A clean room or climate controlled 
office environment.
Pollution Degree 2. Normally only dry non-conductive pollution occurs. 
Occasionally a temporary conductivity caused by condensation may occur. 
Example: General indoor environment.
Pollution Degree 3: Conductive pollution occurs, or dry, non-conductive 
pollution occurs which becomes conductive due to condensation which is 
expected. Example: Sheltered outdoor environment.

http://www.agilent.com
http://cp.literature.agilent.com/litweb/pdf/5989-6162EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5968-8153EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5968-8153EN.pdf
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Passive Probes

InfiniiVision 4000 X- Series oscilloscopes recognize passive probes such as 
the N2894A, 10070D, N2870A, etc. These probes have a pin on their 
connector that connects to the ring around the oscilloscope's BNC 
connector. Therefore, the oscilloscope will automatically set the 
attenuation factor for recognized Agilent passive probes.

Passive probes that do not have a pin that connects to the ring around 
the BNC connector will not be recognized by the oscilloscope, and you 
must set the probe attenuation factor manually. See "To specify the probe 
attenuation" on page 88.

The following passive probes can be used with the InfiniiVision 
4000 X- Series oscilloscopes. Any combination of passive probes can be 
used.

Single-Ended Active Probes

The following single- ended active probes can be used with the 
InfiniiVision 4000 X- Series oscilloscopes.

Table 5 Passive Probes

Model Description

10070D Passive probe, 1:1 20 MHz, 1.5 m

10076B High-voltage passive probe, 100:1, 4 kV, 250 MHz

N2771B High-voltage passive probe, 1000:1, 30 kV, 50 MHz

N2870A Passive probe, 1:1 35 MHz, 1.3 m

N2874A Low impedance passive probe, 10:1, 1.5 GHz, 500 ohm input Z, 1.3 m

N2876A Low impedance passive probe, 100:1, 1.5 GHz, 5 kohm input Z, 1.3 m

N2894A Passive probe, 10:1, 700 MHz, 1.3 m
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 Differential Probes

The following differential probes can be used with the InfiniiVision 
4000 X- Series oscilloscopes.

Table 6 Active Probes

Model Description Quantity 
Supported1

1130A 1.5 GHz InfiniiMax amplifier (with single-ended probe 
head)

4

N2750A InfiniiMode active differential probe (in single-ended 
modes), 1.5 GHz, 30 VDC + peak AC max with AutoProbe 
interface

4

N2744A T2A probe interface adapter Unknown, 
depends on 
probes 
connected

N2795A Active probe, 1 GHz with AutoProbe interface 4

N2796A Active probe, 2 GHz with AutoProbe interface 4

1See "AutoProbe Interface" on page 370.

Table 7 Differential Probes

Model Description Quantity 
Supported1

1130A 1.5 GHz InfiniiMax amplifier (with differential probe head) 4

N2750A InfiniiMode active differential probe, 1.5 GHz, 30 VDC + peak AC max 
with AutoProbe interface

4

N2790A High-voltage differential probe, 50:1 or 500:1 (switchable), 100 MHz with 
AutoProbe interface

4

N2791A High-voltage differential probe, 25 MHz, +/-700 V, 1 MOhm termination, 
10:1 or 100:1 (switchable)

N2792A Differential probe, 200 MHz 10:1, 50 Ohm termination

N2793A Differential probe, 800 MHz 10:1, +/-15 V, 50 Ohm termination
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Current Probes

The following current probes can be used with the InfiniiVision 
4000 X- Series oscilloscopes.

Accessories Available

In addition to passive proves ("Passive Probes" on page 371), single- ended 
active probes ("Single- Ended Active Probes" on page 371), differential 
probes ("Differential Probes" on page 372), and current probes ("Current 
Probes" on page 373), the following accessories are available for the 
InfiniiVision 4000 X- Series oscilloscopes.

N2891A 70 MHz, 7 kV high-voltage differential probe

1See "AutoProbe Interface" on page 370.

Table 7 Differential Probes (continued)

Model Description Quantity 
Supported1

Table 8 Current Probes

Model Description Quantity 
Supported1

1146B Current probe, 100 kHz, 100 A, AC/DC

1147B Current probe, 50 MHz, 15 A, AC/DC with AutoProbe interface 4

N2780B Current probe, 2 MHz, 500 A, AC/DC (use with N2779A power supply)

N2781B Current probe, 10 MHz, 150 A, AC/DC (use with N2779A power supply)

N2782B Current probe, 50 MHz, 30 A, AC/DC (use with N2779A power supply)

N2783B Current probe, 100 MHz, 30 A, AC/DC (use with N2779A power supply)

N2893A Current probe, 100 MHz, 15 A, AC/DC with AutoProbe interface 4

1See "AutoProbe Interface" on page 370.
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 You can find these items at "www.agilent.com" or at 

"www.parts.agilent.com".

For information on more probes and accessories, see "www.agilent.com" 
for:

• "Probes and Accessories Selection Guide (5989- 6162EN)"

• "InfiniiVision Oscilloscope Probes and Accessories Selection Guide Data 
Sheet (5968- 8153EN)"

Loading Licenses and Displaying License Information

License files are loaded from a USB storage device using the File Explorer 
(see "File Explorer" on page 333).

License information is displayed with other oscilloscope information (see 
"To display oscilloscope information" on page 345).

For more information about the licenses and other oscilloscope options 
available, see:

• "Licensed Options Available" on page 375

Table 9 Accessories Available for InfiniiVision 4000 X-Series Oscilloscopes

Model/Part # Description

N2763A Rack mount kit

N2733B Soft carrying case

N2786A 2-leg probe positioner

N2787A 3D probe positioner

1180CZ Testmobile

N6455A Hardcopy user's guide

various Front panel overlays - see "Front Panel Overlays for Different Languages" on 
page 45.

N6450-60001 16-channel logic probe and accessory kit (standard with MSO models and 
with MSO upgrade)

01650-61607 Logic cable and terminator (40 pin to 40 pin MSO cable)

http://www.agilent.com
http://www.parts.agilent.com
http://www.agilent.com
http://cp.literature.agilent.com/litweb/pdf/5989-6162EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5968-8153EN.pdf
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• "Other Options Available" on page 376

• "Upgrading to an MSO" on page 376

Licensed Options Available

The following licensed options can be easily installed without returning 
the oscilloscope to a Service Center. See data sheets for details.

Table 10 Licensed Options Available

License Description After purchase model number, notes

AERO MIL-STD-1553 and ARINC 429 Serial Triggering and 
Analysis.

Order DSOX4AERO.

AUDIO Audio Serial Triggering and Analysis (I2S). Order DSOX4AUDIO.

AUTO Automotive Serial Triggering and Analysis (CAN,LIN). Order DSOX4AUTO.

COMP Computer Serial Triggering and Analysis 
(RS232/422/485/UART).
Provides trigger and decode capability for many UART 
(Universal Asynchronous Receiver/Transmitter) protocols 
including RS232 (Recommended Standard 232).

Order DSOX4COMP.

DVM Digital Voltmeter
Provides provides 3-digit voltage and 5-digit frequency 
measurements using any analog channel.

Order DSOXDVM.

EDK Educator's Kit
Provides training signals on the oscilloscope's Demo 
terminals and a lab guide/tutorial for education 
environments.

Order DSOXEDK.

EMBD Embedded Serial Triggering and Analysis (I2C, SPI). Order DSOX4EMBD.

FLEX FlexRay Triggering and Analysis. Order DSOX4FLEX.

MASK Mask Limit Test
Lets you create a mask and test waveforms to determine 
whether they comply to the mask.

Order DSOX4MASK.

mem4M Memory Upgrade.
It shows the total memory depth (4 Mpts interleaved).

Order DSOX4MEMUP.
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Other Options Available

Upgrading to an MSO

A license can be installed to activate the digital channels of an 
oscilloscope that was not originally ordered as a mixed- signal oscilloscope 
(MSO). A mixed signal oscilloscope has analog channels plus 16 
time- correlated digital timing channels.

MSO Mixed Signal Oscilloscope (MSO). Upgrade a DSO to an 
MSO.
Adds 16 digital channels. You do not have to install any 
hardware.

Order DSOXPERFMSO.
The digital probe cable kit is supplied with 
the MSO license.

PWR Power Measurement and Analysis. Order DSOX4PWR.
You can find the DSOX4PWR Power 
Measurement Application User's Guide at 
"www.agilent.com/find/4000X-Series-man
ual" or on the Documentation CD.

U2H USB 2.0 High Speed Triggering and Decode. Order DSOX4USBH.

USF USB 2.0 Full/Low Speed Triggering and Decode. Order DSOX4USBFL.

USBSQ USB 2.0 Signal Quality Analysis. Order DSOX4USBSQ.
You can find the DSOX4USBSQ USB 2.0 
Signal Quality Analysis Application 
Electrical Testing Notes manual at 
"www.agilent.com/find/4000X-Series-man
ual" or on the Documentation CD.

VID Extended Video Triggering and Analysis. Order DSOX4VID.

WAVEGEN Waveform Generator. Order DSOX4WAVEGEN2.

Table 10 Licensed Options Available (continued)

License Description After purchase model number, notes

Table 11 Calibration Option

Option Order

A6J ANSI Z540 Compliant Calibration

http://www.agilent.com/find/4000X-Series-manual
http://www.agilent.com/find/4000X-Series-manual
http://www.agilent.com/find/4000X-Series-manual
http://www.agilent.com/find/4000X-Series-manual
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For information about upgrading your oscilloscope through licensing, 
contact your local Agilent Technologies representative or see 
"www.agilent.com/find/4000X- Series".

Software and Firmware Updates

From time to time Agilent Technologies releases software and firmware 
updates for its products. To search for firmware updates for your 
oscilloscope, direct your web browser to 
"www.agilent.com/find/4000X- Series- sw".

To view the currently installed software and firmware press [Help] > About 
Oscilloscope.

Once you have downloaded a firmware update file, you can place it on a 
USB storage device and load the file using File Explorer (see "File 
Explorer" on page 333), or you can use the Instrument Utilities page of 
the oscilloscope's web interface (see "Instrument Utilities" on page 360).

Binary Data (.bin) Format

The binary data format stores waveform data in binary format and 
provides data headers that describe that data.

Because the data is in binary format, the size of the file is approximately 
5 times smaller than the ASCII XY format.

If more than one source is on, all displayed sources will be saved, except 
math functions.

When using segmented memory, each segment is treated as a separate 
waveform. All segments for a channel are saved, then all segments of the 
next (higher numbered) channel are saved. This continues until all 
displayed channels are saved.

When the oscilloscope is in the Peak Detect acquisition mode, the 
minimum and maximum value waveform data points are saved to the file 
in separate waveform buffers. The minimum value data points are saved 
first; then, the maximum value data points are saved.

http://www.agilent.com/find/4000X-Series
http://www.agilent.com/find/4000X-Series-sw
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BIN data - using
segmented

memory

When saving all segments, each segment has its own waveform header (see 
"Binary Header Format" on page 378).

In BIN file format, data are presented as follows:

• Channel 1 data (all segments)

• Channel 2 data (all segments)

• Channel 3 data (all segments)

• Channel 4 data (all segments)

• Digital channel data (all segments)

• Math waveform data (all segments)

When not saving all segments, the number of waveforms is equivalent to 
the number of active channels (including math and digital channels, with 
up to seven waveforms for each digital pod). When saving all segments, 
the number of waveforms is equal to the number of active channels 
multiplied by the number of segments acquired.

Binary Data in MATLAB

Binary data from an InfiniiVision oscilloscope can be imported to The 
MathWorks MATLAB®. You can download the appropriate MATLAB 
functions from the Agilent Technologies web site at 
"www.agilent.com/find/4000X- Series- examples".

Agilent provides the .m files, which need to be copied into the work 
directory for MATLAB. The default work directory is C:\MATLAB7\work.

Binary Header Format

File Header There is only one file header in a binary file. The file header consists of 
the following information.

Cookie Two byte characters, AG, that indicate the file is in the Agilent Binary Data file 
format.

Version Two bytes that represent the file version.

File Size A 32-bit integer that is the number of bytes that are in the file.

Number of 
Waveforms

A 32-bit integer that is the number of waveforms that are stored in the file.

http://www.agilent.com/find/4000X-Series-examples
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Waveform Header It is possible to store more than one waveform in the file, and each 
waveform stored will have a waveform header. When using segmented 
memory, each segment is treated as a separate waveform. The waveform 
header contains information about the type of waveform data that is 
stored following the waveform data header.

Header Size A 32-bit integer that is the number of bytes in the header.

Waveform Type A 32-bit integer that is the type of waveform stored in the file:
• 0 = Unknown.
• 1 = Normal.
• 2 = Peak Detect.
• 3 = Average.
• 4 = Not used in InfiniiVision oscilloscopes.
• 5 = Not used in InfiniiVision oscilloscopes.
• 6 = Logic.

Number of 
Waveform 
Buffers

A 32-bit integer that is the number of waveform buffers required to read the 
data.

Points A 32-bit integer that is the number of waveform points in the data.

Count A 32-bit integer that is the number of hits at each time bucket in the waveform 
record when the waveform was created using an acquisition mode like 
averaging. For example, when averaging, a count of four would mean every 
waveform data point in the waveform record has been averaged at least four 
times. The default value is 0.

X Display Range A 32-bit float that is the X-axis duration of the waveform that is displayed. For 
time domain waveforms, it is the duration of time across the display. If the 
value is zero then no data has been acquired.

X Display Origin A 64-bit double that is the X-axis value at the left edge of the display. For time 
domain waveforms, it is the time at the start of the display. This value is 
treated as a double precision 64-bit floating point number. If the value is zero 
then no data has been acquired.

X Increment A 64-bit double that is the duration between data points on the X axis. For 
time domain waveforms, this is the time between points. If the value is zero 
then no data has been acquired.

X Origin A 64-bit double that is the X-axis value of the first data point in the data 
record. For time domain waveforms, it is the time of the first point. This value 
is treated as a double precision 64-bit floating point number. If the value is 
zero then no data has been acquired.



380 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

22 Reference
 

Waveform Data
Header

A waveform may have more than one data set. Each waveform data set 
will have a waveform data header. The waveform data header consists of 
information about the waveform data set. This header is stored 
immediately before the data set.

X Units A 32-bit integer that identifies the unit of measure for X values in the acquired 
data:
• 0 = Unknown.
• 1 = Volts.
• 2 = Seconds.
• 3 = Constant.
• 4 = Amps.
• 5 = dB.
• 6 = Hz.

Y Units A 32-bit integer that identifies the unit of measure for Y values in the acquired 
data. The possible values are listed above under X Units.

Date A 16-byte character array, left blank in InfiniiVision oscilloscopes.

Time A 16-byte character array, left blank in the InfiniiVision oscilloscopes.

Frame A 24 byte character array that is the model number and serial number of the 
oscilloscope in the format of: MODEL#:SERIAL#.

Waveform Label A 16 byte character array that contains the label assigned to the waveform.

Time Tags A 64-bit double, only used when saving multiple segments (requires 
segmented memory option). This is the time (in seconds) since the first 
trigger.

Segment Index A 32-bit unsigned integer. This is the segment number. Only used when saving 
multiple segments.

Waveform Data 
Header Size

A 32-bit integer that is the size of the waveform data header.

Buffer Type A 16-bit short that is the type of waveform data stored in the file:
• 0 = Unknown data.
• 1 = Normal 32-bit float data.
• 2 = Maximum float data.
• 3 = Minimum float data.
• 4 = Not used in InfiniiVision oscilloscopes.
• 5 = Not used in InfiniiVision oscilloscopes.
• 6 = Digital unsigned 8-bit char data (for digital channels).
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Example Program for Reading Binary Data

To find an example program for reading binary data, direct your web 
browser to "www.agilent.com/find/4000X- Series- examples", and select 
"Example Program for Reading Binary Data".

Examples of Binary Files

Single
Acquisition

Multiple Analog
Channels

The following picture shows a binary file of a single acquisition with 
multiple analog channels.

Bytes Per Point A 16-bit short that is the number of bytes per data point.

Buffer Size A 32-bit integer that is the size of the buffer required to hold the data points.

http://www.agilent.com/find/4000X-Series-examples
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Single
Acquisition All

Pods Logic
Channels

The following picture shows a binary file of a single acquisition with all 
pods for the logic channels saved.

File Header
12 bytes

Number of Waveforms = N

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Voltage Data N
buffer size

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1

Buffer Type = 1 (floating point)
Bytes per Point = 4
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Segmented
Memory

Acquisition on
One Analog

Channel

The following picture shows a binary file of a segmented memory 
acquisition on one analog channel.

File Header
12 bytes

Waveform Header 2
140 bytes

Waveform Data
Header 1
12 bytes

Pod 1 Timing Data
buffer size

Waveform Data
Header 2
12 bytes

Pod 2 Timing Data
buffer size

Number of Waveforms = 2

Number of Waveform Buffers = 1

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Buffer Type = 6 (unsigned char)
Bytes per Point = 1

Waveform Header 1
140 bytes

Number of Waveform Buffers = 1
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CSV and ASCII XY files

• "CSV and ASCII XY file structure" on page 385

• "Minimum and Maximum Values in CSV Files" on page 385

File Header
12 bytes

Waveform Header 1
140 bytes

Waveform Data
Header 1
12 bytes

Voltage Data 1
buffer size

Waveform Header 2
140 bytes

Waveform Data
Header 2
12 bytes

Voltage Data 2
buffer size

Waveform Header N
140 bytes

Waveform Data
Header N
12 bytes

Voltage Data N
buffer size

Number of Waveforms = N = Number of Segments

Number of Waveform Buffers = 1
Index = 1
Time Tag = 0.0

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1
Index = 2
Time Tag = time between segment 1 and 2

Buffer Type = 1 (floating point)
Bytes per Point = 4

Number of Waveform Buffers = 1
Index = N
Time Tag = time between segment 1 and N

Buffer Type = 1 (floating point)
Bytes per Point = 4
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CSV and ASCII XY file structure

In CSV or ASCII XY format the Length control selects the number of points 
per segment. All segments are contained in the CSV file or in each ASCII 
XY data file.

For example: If the Length control is set to 1000 points, there will be 1000 
points (rows in the spreadsheet) per segment. When saving all segments 
there are three header rows, so the data for the first segment starts at 
row 4. The second segment's data starts at row 1004. The time column 
shows the time since the trigger on the first segment. The top row shows 
the selected number of points per segment.

BIN files are a more efficient data transfer format than CSV or ASCII XY. 
Use this file format for fastest data transfer.

Minimum and Maximum Values in CSV Files

If you are running a Minimum or Maximum measurement, the minimum 
and maximum values shown in the measurement display may not appear 
in the CSV file.

Explanation: When the oscilloscope's sample rate is 4 GSa/s, a sample will be taken 
every 250 ps. If the horizontal scale is set to 10 us/div, there will be 
100 us of data displayed (because there are ten divisions across the 
screen). To find the total number of samples the oscilloscope will take:

100 us x 4 GSa/s = 400K samples

The oscilloscope is required to display those 400K samples using 640 pixel 
columns. The oscilloscope will decimate the 400K samples to 640 pixel 
columns, and this decimation keeps track of the min and max values of all 
the points that are represented by any given column. Those min and max 
values will be displayed in that screen column.

A similar process is used to reduce the acquired data to produce a record 
usable for various analysis needs such as measurements and CSV data. 
This analysis record (or measurement record) is much larger than 640 
and may in fact contain up to 65536 points. Still, once the # of acquired 
points > 65536, some form of decimation is required. The decimator used 
to produce a CSV record is configured to provide a best- estimate of all 
the samples that each point in the record represents. Therefore, the min 
and max values may not appear in the CSV file.
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Acknowledgements

RealVNC RealVNC is licensed under the GNU General Public License. Copyright (C) 
2002- 2005 RealVNC Ltd. All Rights Reserved.

This is free software; you can redistribute it and/or modify it under the 
terms of the GNU General Public License as published by the Free 
Software Foundation; either version 2 of the License, or (at your option) 
any later version.

This software is distributed in the hope that it will be useful, but 
WITHOUT ANY WARRANTY; without even the implied warranty of 
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the 
GNU General Public License for more details.

This license is located on the Agilent InfiniiVision Oscilloscopes 
Documentation CD- ROM.

RealVNC source code can be obtained from RealVNC or by contacting 
Agilent. Agilent will charge for the cost of physically performing the 
source distribution.

HDF5 Reference Waveform files use HDF5.

HDF5 was developed by "The HDF Group" and by the National Center for 
Supercomputing Applications at the University of Illinois at 
Urbana- Champaign.

CUPS Network printing uses the CUPS (Common Unix Printing System) library.

The CUPS and CUPS Imaging libraries are developed by Apple Inc. and 
licensed under the GNU Library General Public License ("LGPL"), Version 
2.

This license is located on the Agilent InfiniiVision Oscilloscopes 
Documentation CD- ROM.

mDNSResponder CUPS network printing uses the mDNSResponder library.

The mDNSResponder library is developed by Apple Inc. and licensed 
under the Apache License, Version 2.0.

This license is located on the Agilent InfiniiVision Oscilloscopes 
Documentation CD- ROM.

http://www.hdfgroup.org/
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LIN Serial Decode 400

CAN/LIN triggering and serial decode requires Option AUTO or the 
DSOX4AUTO upgrade.

Setup for CAN Signals

Setup consists of connecting the oscilloscope to a CAN signal, using the 
Signals Menu to specify the signal source, threshold voltage level, baud 
rate, and sample point.

To set up the oscilloscope to capture CAN signals, use the Signals softkey 
which appears in the Serial Decode Menu:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select CAN trigger type.

5 Press the Signals softkey to open the CAN Signals Menu.
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6 Press Source; then, select the channel for the CAN signal.

The label for the CAN source channel is automatically set.

7 Press the Threshold softkey; then, turn the Entry knob to select the CAN 
signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode 
slot.

8 Press the Baud softkey; then, turn the Entry knob to select the baud 
rate that matches match your CAN bus signal.

The CAN baud rate can be set to predefined baud rates from 10 kb/s 
up to 5 Mb/s or a user- defined baud rate from 10.0 kb/s to 4 Mb/s in 
increments of 100 b/s. Fractional user- defined baud rates between 
4 Mb/s and 5 Mb/s are not allowed.

The default baud rate is 125 kb/s

If none of the pre- defined selections match your CAN bus signal, select 
User Defined; then, press the User Baud softkey and turn the Entry knob 
to enter the baud rate.

9 Press the Sample Point softkey; then, turn the Entry knob to select the 
point between phase segments 1 and 2 where the state of the bus is 
measured. This controls the point within the bit's time where the bit 
value is captured.

10 Press the Signal softkey and select the type and polarity of the CAN 
signal. This also automatically sets the channel label for the source 
channel.

• CAN_H — The actual CAN_H differential bus.

60%
70%

80%
Sample Point

One Bit
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• Differential (H-L) — The CAN differential bus signals connected to an 
analog source channel using a differential probe. Connect the probe's 
positive lead to the dominant- high CAN signal (CAN_H) and connect 
the negative lead to the dominant- low CAN signal (CAN_L).

Dominant low signals:

• Rx — The Receive signal from the CAN bus transceiver.

• Tx — The Transmit signal from the CAN bus transceiver.

• CAN_L — The actual CAN_L differential bus signal.

• Differential (L-H) — The CAN differential bus signals connected to an 
analog source channel using a differential probe. Connect the probe's 
positive lead to the dominant- low CAN signal (CAN_L) and connect 
the negative lead to the dominant- high CAN signal (CAN_H).

Loading and Displaying CAN Symbolic Data

When you load (recall) a CAN DBC communication database (*.dbc) file 
into the oscilloscope, its symbolic infomation can be:

• Displayed in the decode waveform and Lister window.

• Used when setting up CAN triggering.

• Used when searching for CAN data in the decode.

To recall a DBC file into the oscilloscope:

1 Press [Save/Recall] > Recall > Recall > CAN Symbolic data (*.dbc).

2 Press Press to go and navigate to the DBC file on a USB storage device.

3 Press Load to: and select which serial decode (S1 or S2) the symbolic 
information will be used with.

4 Press Press to Recall.

The DBC file remains in the oscilloscope until it is overwritten or a secure 
erase is performed.

To display CAN symbolic data:

1 Press [Serial].

2 Press the Display softkey and select Symbolic (instead of Hexadecimal).

Your choice affects both the decode waveform and the Lister window.
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CAN Triggering

To set up the oscilloscope to capture a CAN signal, see "Setup for CAN 
Signals" on page 387.

The Controller Area Network (CAN) trigger allows triggering on CAN 
version 2.0A and 2.0B signals.

A CAN message frame in CAN_L signal type is shown below:

After setting up the oscilloscope to capture a CAN signal:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the CAN signal 
is being decoded.

3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger 
condition:

• SOF - Start of Frame — The oscilloscope triggers at the start of a frame.

• Remote Frame ID (RTR) — The oscilloscope triggers on remote frames 
with the specified ID. Press the Bits softkey to select the ID.

• Data Frame ID (~RTR) — The oscilloscope will trigger on data frames 
matching the specified ID. Press the Bits softkey to select the ID.

• Remote or Data Frame ID — The oscilloscope will trigger on remote or 
data frames matching the specified ID. Press the Bits softkey to select 
the ID.

• Data Frame ID and Data — The oscilloscope will trigger on data frames 
matching the specified ID and data. Press the Bits softkey to select 
the ID and set up the number of data bytes and values.

Arbitration
Field

Bus
Idle

Data
Field

SOF edge

Control
Field

ACK
Field

IntermissionCRC
Field

EOF
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• Error Frame — The oscilloscope will trigger on CAN active error frames.

• All Errors — The oscilloscope will trigger when any form error or 
active error is encountered.

• Acknowledge Error — The oscilloscope will trigger when the 
acknowledge bit is recessive (high).

• Overload Frame — The oscilloscope will trigger on CAN overload 
frames.

• Message, Message and Signal — When CAN symbolic data is loaded into 
the oscilloscope (see "Loading and Displaying CAN Symbolic Data" on 
page 389), you can trigger on a symbolic message or a message and a 
signal value.

Symbolic messages, signals, and values are defined in the DBC 
communication database file.

A message is the symbolic name for a CAN frame ID, a signal is the 
symbolic name for a bit or set of bits within the CAN data, and a 
value can be a symbolic representation of the signal bit values or it 
can be a decimal number with units.

4 If you select a condition that lets you trigger on ID or data values, use 
the Bits softkey and the CAN Bits Menu to specify those values.

For details about using the CAN Bits Menu softkeys, press and hold the 
softkey in question to display the built- in help.

You can use the Zoom mode for easier navigation of the decoded data.

NOTE If the setup does not produce a stable trigger, the CAN signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.

NOTE To display CAN serial decode, see "CAN Serial Decode" on page 392.
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CAN Serial Decode

To set up the oscilloscope to capture CAN signals, see "Setup for CAN 
Signals" on page 387.

To set up CAN serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
decoded data.

See Also • "Interpreting CAN Decode" on page 393

• "CAN Totalizer" on page 394

• "Interpreting CAN Lister Data" on page 395

• "Searching for CAN Data in the Lister" on page 396

NOTE For CAN triggering set up see "CAN Triggering" on page 390.

NOTE If the setup does not produce a stable trigger, the CAN signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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Interpreting CAN Decode

• Frame ID appears in yellow as hex digits or symbolic information (see 
"Loading and Displaying CAN Symbolic Data" on page 389). Frames of 
11 or 29 bits are automatically detected.

• Remote frame (RMT) appears in green.

• Data length code (DLC) appears in blue for data frames and green for 
remote frames.

• Data bytes (for data frames) appear in white as hex digits or symbolic 
information.

• Cyclic redundancy check (CRC) appears in hex digits in blue when 
valid, or in red to indicate that the oscilloscope's hardware decode 
calculated a CRC that is different from the incoming CRC data stream.

• Angled waveforms show an active bus (inside a packet/frame).

• Mid- level blue lines show an idle bus.
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• Decoded text is truncated at the end of the associated frame when 
there is insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and 
run again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red 
with a "?" label.

• Flagged error frames are drawn in red with an "ERR" label.

CAN Totalizer

The CAN totalizer provides a direct measure of bus quality and efficiency. 
The CAN totalizer measures total CAN frames, flagged error frames, 
overload frames, and bus utilization.

The totalizer is always running (counting frames and calculating 
percentages) and is displayed whenever CAN decode is displayed. The 
totalizer counts even when the oscilloscope is stopped (not acquiring 
data). Pressing the [Run/Stop] key does not affect the totalizer. When an 
overflow condition occurs, the counter displays OVERFLOW. The counters 
can be reset to zero by pressing the Reset CAN Counters softkey.

Types of Frames • Active error frames are CAN frames in which a CAN node recognizes 
an error condition during a data or remote frame and issues an active 
error flag.

• A partial frame occurs when the oscilloscope detects any error 
condition during a frame that is not followed by an active error flag. 
Partial frames are not counted.

Counters • The FRAMES counter gives the total number of completed remote, data, 
overload, and active error frames.

• The OVLD counter gives the total number of completed overload frames 
and their percentage of the total number of frames.
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• The ERR counter gives the total number of completed active error 
frames and their percentage of the total number of frames.

• The UTIL (bus load) indicator measures the percentage of time the bus 
is active. The calculation is done on 330 ms periods, approximately 
every 400 ms.

Example: If a data frame contains an active error flag, both the FRAMES 
counter and the ERR counter will be incremented. If a data frame 
contains an error that is not an active error it is considered a partial 
frame and no counters are incremented.

Interpreting CAN Lister Data

In addition to the standard Time column, the CAN Lister contains these 
columns:

• ID — frame ID. Can be displayed as hex digits or symbolic information 
(see "Loading and Displaying CAN Symbolic Data" on page 389).

• Type — frame type (RMT remote frame or Data).
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• DLC — data length code.

• Data — data bytes. Can be displayed as hex digits or symbolic 
information.

• CRC — cyclic redundancy check.

• Errors — highlighted in red. Errors can be Acknowledge (Ack, A), Form 
(Fo), or Frame (Fr). Different kinds of errors can be combined like 
"Fo,Fr" in the above example.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for CAN Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of CAN data in the Lister. You can use the [Navigate] key and 
controls to navigate through the marked rows.

1 With CAN selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the CAN signal 
is being decoded.

3 Press Search; then, select from these options:

• Remote Frame ID (RTR) — Finds remote frames with the specified ID. 
Press the Bits softkey to enter the ID.

• Data Frame ID (~RTR) — Finds data frames matching the specified ID. 
Press the Bits softkey to enter the ID.

• Remote or Data Frame ID — Finds remote or data frames matching the 
specified ID. Press the Bits softkey to select the ID.

• Data Frame ID and Data — Finds data frames matching the specified ID 
and data. Press the Bits softkey to set the ID length, ID value, 
number of data bytes, and data value.

• Error Frame — Finds CAN active error frames.

• All Errors — Finds any form error or active error.

• Overload Frame — Finds CAN overload frames.

• Message, Message and Signal — When CAN symbolic data is loaded into 
the oscilloscope (see "Loading and Displaying CAN Symbolic Data" on 
page 389), you can search for a symbolic message or a message and 
a signal value.
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For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.

Setup for LIN Signals

LIN (Local Interconnect Network) signal setup consists of connecting the 
oscilloscope to a serial LIN signal, specifying the signal source, threshold 
voltage level, baud rate, sample point, and other LIN signal parameters.

To set up the oscilloscope to capture LIN signals:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select LIN trigger type.

5 Press the Signals softkey to open the LIN Signals Menu.

6 Press the Source softkey to select the channel connected to the LIN 
signal line.

The label for the LIN source channel is automatically set.

7 Press the Threshold softkey; then, turn the Entry knob to set the LIN 
signal threshold voltage level to the middle of the LIN signal.

The threshold voltage level is used in decoding, and it will become the 
trigger level when the trigger type is set to the selected serial decode 
slot.

8 Press the Baud Rate softkey to open the LIN Baud Rate Menu.

9 Press the Baud softkey; then, turn the Entry knob to select the baud 
rate that matches match your LIN bus signal.

The default baud rate is 19.2 kb/s.
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If none of the pre- defined selections match your LIN bus signal, select 
User Defined; then, press the User Baud softkey and turn the Entry knob 
to enter the baud rate.

You can set the LIN baud rate from 2.4 kb/s to 625 kb/s in increments 
of 100 b/s.

10 Press the Back/Up key to return to the LIN Signals Menu.

11 Press the Sample Point softkey; then, turn the Entry knob to select the 
sample point at which the oscilloscope will sample the bit value.

12 Press the Standard softkey; then, turn the Entry knob to select the LIN 
standard you are measuring (LIN 1.3 or LIN 2.X).

For LIN 1.2 signals, use the LIN 1.3 setting. The LIN 1.3 setting assumes 
the signal follows the "Table of Valid ID Values" as shown in section A.2 
of the LIN Specification dated December 12, 2002. If your signal does 
not comply with the table, use the LIN 2.X setting.

13 Press the Sync Break softkey and select the minimum number of clocks 
that define a sync break in your LIN signal.

LIN Triggering

To set up the oscilloscope to capture a LIN signal, see "Setup for LIN 
Signals" on page 397.

LIN triggering can trigger on the rising edge at the Sync Break exit of the 
LIN single- wire bus signal (that marks the beginning of the message 
frame), the Frame ID, or the Frame ID and Data.

A LIN signal message frame is shown below:

Back
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1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the CAN signal 
is being decoded.

3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger 
condition:

• Sync (Sync Break) — The oscilloscope triggers on the rising edge at 
the Sync Break exit of the LIN single- wire bus signal that marks the 
beginning the message frame.

• ID (Frame ID) — The oscilloscope triggers when a frame with an ID 
equal to the selected value is detected. Use the Entry knob to select 
the value for the Frame ID.

• ID & Data (Frame ID and Data) — The oscilloscope triggers when a 
frame with an ID and data equal to the selected values is detected. 
When triggering on a frame ID and data:

• To select the frame ID value, press the Frame ID softkey, and use 
the Entry knob.

Note that you can enter a "don't care" value for the frame ID and 
trigger on data values only.

• To set up the number of data bytes and enter their values (in 
hexadecimal or binary), press the Bits softkey to open the LIN Bits 
Menu.

• Parity Error — The oscilloscope triggers on parity errors.

• Checksum Error — The oscilloscope triggers on checksum errors.

Sync
Break

Identifier
Break

Sync Break Exit

Sync
Field

Checksum
Field

Data
Fields
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LIN Serial Decode

To set up the oscilloscope to capture LIN signals, see "Setup for LIN 
Signals" on page 397.

NOTE For details about using the LIN Bits Menu softkeys, press and hold the softkey in question 
to display the built-in help.

NOTE For LIN decode information see "LIN Serial Decode" on page 400.
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To set up LIN serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Choose whether to include the parity bits in the identifier field.

a If you want to mask the upper two parity bits, ensure that the box 
under the Show Parity softkey is not selected.

b If you want to include the parity bits in the identifier field, ensure 
that the box under the Show Parity softkey is selected.

3 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
decoded data.

See Also • "Interpreting LIN Decode" on page 402

• "Interpreting LIN Lister Data" on page 403

• "Searching for LIN Data in the Lister" on page 404

NOTE For LIN triggering setup see "LIN Triggering" on page 398.

NOTE If the setup does not produce a stable trigger, the LIN signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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Interpreting LIN Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid- level blue lines show an idle bus.

• The hexadecimal ID and parity bits (if enabled) appear in yellow. If a 
parity error is detected the hexadecimal ID and parity bits (if enabled) 
appear in red.

• Decoded hexadecimal data values appear in white.

• The checksum appears in blue if correct, or red if incorrect.

• Decoded text is truncated at the end of the associated frame when 
there is insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and 
run again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Unknown bus values (undefined or error conditions) are drawn in red.
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• If there is an error in the synch field, SYNC will appear in red.

• If the header exceeds the length specified in the standard, THM will 
appear red.

• If the total frame count exceeds the length specified in the standard, 
TFM will appear red (LIN 1.3 only).

• For LIN 1.3 a wakeup signal is indicated by WAKE in blue. If the 
wakeup signal is not followed by a valid wakeup delimiter a wakeup 
error is detected and displayed as WUP in red.

Interpreting LIN Lister Data

In addition to the standard Time column, the LIN Lister contains these 
columns:

• ID — frame ID.

• Data — data bytes.

• Checksum.
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• Errors — highlighted in red.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for LIN Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of LIN data in the Lister. You can use the [Navigate] key and 
controls to navigate through the marked rows.

1 With LIN selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the LIN signal is 
being decoded.

3 Press Search; then, select from these options:

• ID — Finds frames with the specified ID. Press the Frame ID softkey 
to select the ID.

• ID & Data — Finds frames with the specified ID and data. Press the 
Frame ID softkey to select the ID. Press the Bits softkey to enter the 
data value.

• Errors — Finds all errors.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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Setup for FlexRay Signals 405

FlexRay Triggering 406

FlexRay Serial Decode 409

FlexRay triggering and serial decode requires Option FLEX or the 
DSOX4FLEX upgrade.

Setup for FlexRay Signals

FlexRay signal setup consists of first connecting the oscilloscope to a 
differential FlexRay signal using a differential active probe (the Agilent 
N2792A is recommended), specifying the signal source, threshold voltage 
trigger level, baud rate, and bus type.

To set up the oscilloscope to capture FlexRay signals:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired serial 
bus (Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select FlexRay mode.

5 Press the Signals softkey to open the FlexRay Signals Menu.
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6 Press Source and select the analog channel that is probing the FlexRay 
signal.

7 Press Threshold; then, turn the Entry knob to set the threshold voltage 
level.

The threshold level should be set below the idle level.

The threshold voltage level is used in decoding and will become the 
trigger level when the trigger type is set to the selected serial decode 
bus.

8 Press Baud and select the baud rate of the FlexRay signal being probed.

9 Press Bus and select the bus type of the FlexRay signal being probed.

It is important to specify the correct bus because this setting affects 
CRC error detection.

10 Press Auto Setup to perform the following actions:

• Sets the selected source channel's impedance to 50 Ohms, assuming a 
differential active probe that requires a 50 ohm termination is being 
used .

• Sets the selected source channel's probe attenuation to 10:1.

• Sets the trigger level (on the selected source channel) to - 300 mV.

• Turns on trigger Noise Reject.

• Turns on Serial Decode.

• Sets the trigger type to FlexRay.

FlexRay Triggering

To set up the oscilloscope to capture a FlexRay signal, see "Setup for 
FlexRay Signals" on page 405.

After you have set up the oscilloscope to capture a FlexRay signal, you 
can then set up triggers on frames (see page 407), errors (see page 408), 
or events (see page 408).

NOTE To display FlexRay serial decode, see "FlexRay Serial Decode" on page 409.
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Triggering on FlexRay Frames

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay 
signals are being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Frame.

4 Press the Frames softkey to open the FlexRay Frame Trigger Menu.

5 Press the Frame ID softkey, and use the Entry knob to select the frame 
ID value from All or 1 to 2047.

6 Press the Frame Type softkey to select the frame type:

• All Frames

• Startup Frames

• NULL Frames

• Sync Frames

• Normal Frames

• NOT Startup Frames

• NOT NULL Frames

• NOT Sync Frames

7 Press the Cyc Ct Rep softkey, and use the Entry knob to select the cycle 
count repetition factor (2, 4, 8, 16, 32, or 64, or All).

8 Press the Cyc Ct Bas softkey, and use the Entry knob to select the cycle 
count base factor from 0 through the Cyc Ct Rep factor minus 1.

For example, with a base factor of 1 and a repetition factor of 16, the 
oscilloscope triggers on cycles 1, 17, 33, 49, and 65.
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To trigger on a particular cycle, set the Cycle Repetition factor to 64 
and use the cycle base factor to choose a cycle.

To trigger all (any) cycles, set the Cycle Repetition factor to All. The 
scope will trigger on any and all cycles.

Triggering on FlexRay Errors

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay 
signals are being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Error.

4 Press the Errors softkey; then, select the error type:

• All Errors

• Header CRC Error — cyclic redundancy check error in the header.

• Frame CRC Error — cyclic redundancy check error in the frame.

Triggering on FlexRay Events

1 Press [Trigger].

NOTE Because specific FlexRay frames may occur infrequently, it may be helpful to press the 
[Mode/Coupling] key, then press the Mode softkey to set the trigger mode from Auto to 
Normal. This prevents the oscilloscope from Auto triggering while waiting for a particular 
frame and cycle combination.

NOTE Because FlexRay errors occur infrequently it may be helpful to set the oscilloscope to press 
the [Mode/Coupling] key, then press the Mode softkey to set the trigger mode from Auto 
to Normal. This prevents the oscilloscope from Auto triggering while waiting for an error to 
occur. You may need to adjust trigger holdoff to see a particular error when multiple errors 
exist.
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2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay 
signals are being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select Event.

4 Press the Event softkey; then, select the event type:

• Wake-up

• TSS — Transmission Start Sequence.

• BSS — ByteStart Sequence.

• FES/DTS — Frame End or Dynamic Trailing Sequence.

5 Press Auto Setup for Event.

This automatically configures oscilloscope settings (as shown on the 
display) for the selected event trigger.

FlexRay Serial Decode

To set up the oscilloscope to capture FlexRay signals, see "Setup for 
FlexRay Signals" on page 405.

To set up FlexRay serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

NOTE For FlexRay triggering setup see "FlexRay Triggering" on page 406.
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3 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
acquired data.

See Also • "Interpreting FlexRay Decode" on page 410

• "FlexRay Totalizer" on page 411

• "Interpreting FlexRay Lister Data" on page 412

• "Searching for FlexRay Data in the Lister" on page 413

Interpreting FlexRay Decode

• Frame type (NORM, SYNC, SUP, NULL in blue).

• Frame ID (decimal digits in yellow).

• Payload- length (decimal number of words in green).



FlexRay Triggering and Serial Decode 24

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 411

 

• Header CRC (hex digits in blue plus red HCRC error message if 
invalid).

• Cycle number (decimal digits in yellow).

• Data bytes (HEX digits in white).

• Frame CRC (hex digits in blue plus red FCRC error message if invalid).

• Frame/coding errors (specific error symbol in red).

FlexRay Totalizer

The FlexRay totalizer consists of counters that provide a direct measure of 
bus quality and efficiency. The totalizer appears on screen whenever 
FlexRay Decode is ON in the Serial Decode Menu.

• The FRAMES counter gives a real- time count of all captured frames.

• The NULL counter gives the number and percentage of null frames.

• The SYNC counter gives the number and percentage of sync frames.

The totalizer runs, counting frames and calculating percentages, even when 
the oscilloscope is stopped (not acquiring data).

When an overflow condition occurs, the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset FlexRay Counters 
softkey.
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Interpreting FlexRay Lister Data

In addition to the standard Time column, the FlexRay Lister contains 
these columns:

• FID — frame ID.

• Len — payload length.

• HCRC — header CRC.

• CYC — cycle number.

• Data.

• FCRC — frame CRC.

• Frames with errors are highlighted in red.
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Searching for FlexRay Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of FlexRay data in the Lister. You can use the [Navigate] key and 
controls to navigate through the marked rows.

1 With FlexRay selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial bus (Serial 1 or Serial 2) on which the FlexRay 
signals are being decoded.

3 In the Search Menu, press Search for; then, select from these options:

• Frame ID — Finds frames with the specified ID. Press the Frame ID 
softkey to select the ID.

• Cycle number (+ Frame ID) — Finds frames with the specified cycle 
number and ID. Press the Frame ID softkey to select the ID. Press 
the Cycle # softkey to select the number.

• Data (+ Frame ID + Cycle number) — Finds frames with the specified data, 
cycle number, and frame ID. Press the Frame ID softkey to select the 
ID. Press the Cycle # softkey to select the number. Press the Data 
softkey to open a menu where you can enter the data value.

• Header CRC Error — Finds cyclic redundancy check errors in headers.

• Frame CRC Error — Finds cyclic redundancy check errors in frames.

• Errors — finds all errors.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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I2C Serial Decode 420
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SPI Triggering 428

SPI Serial Decode 430

I2C/SPI triggering and serial decode requires Option EMBD or the 
DSOX4EMBD upgrade.

Setup for I2C Signals

I2C (Inter- IC bus) signals setup consists of connecting the oscilloscope to 
the serial data (SDA) line and the serial clock (SCL) line and then 
specifying the input signal threshold voltage levels.

To set up the oscilloscope to capture I2C signals, use the Signals softkey 
which appears in the Serial Decode Menu:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

NOTE Only one SPI serial bus can be decoded at a time.
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4 Press the Mode softkey; then, select I2C trigger type.

5 Press the Signals softkey to open the I2C Signals Menu.

6 For both the SCL (serial clock) and SDA (serial data) signals:

a Connect an oscilloscope channel to the signal in the device under 
test.

b Press the SCL or SDA softkey; then, turn the Entry knob to select the 
channel for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob 
to select the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

Data must be stable during the whole high clock cycle or it will be 
interpreted as a start or stop condition (data transitioning while the 
clock is high).

The SCL and SDA labels for the source channels are automatically set.

I2C Triggering

To set up the oscilloscope to capture I2C signals, see "Setup for I2C 
Signals" on page 415.

After the oscilloscope has been set up to capture I2C signals, you can 
trigger on a stop/start condition, a restart, a missing acknowledge, an 
EEPROM data read, or on a read/write frame with a specific device 
address and data value.

1 Press [Trigger]; then, select the I2C trigger type.

2 Press [Trigger].
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3 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 

to select the serial slot (Serial 1 or Serial 2) on which the I2C signals 
are being decoded.

4 Press the Trigger: softkey; then, turn the Entry knob to select the trigger 
condition:

• Start Condition— The oscilloscope triggers when SDA data transitions 
from high to low while the SCL clock is high. For triggering purposes 
(including frame triggers), a restart is treated as a start condition.

• Stop Condition— The oscilloscope triggers when data (SDA) transitions 
from low to high while the clock (SCL) is high.

• Missing Acknowledge— The oscilloscope triggers when SDA data is high 
during any Ack SCL clock bit.

• Address with no Ack— The oscilloscope triggers when the acknowledge 
of the selected address field is false. The R/W bit is ignored.

• Restart— The oscilloscope triggers when another start condition occurs 
before a stop condition.

• EEPROM Data Read— The trigger looks for EEPROM control byte value 
1010xxx on the SDA line, followed by a Read bit and an Ack bit. It 
then looks for the data value and qualifier set by the Data softkey 
and the Data is softkey. When this event occurs, the oscilloscope will 
trigger on the clock edge for the Ack bit after the data byte. This 
data byte does not need to occur directly after the control byte.

SDA

SCL

Stop
Condition

R/Start
Condition

AckAck DataAddress
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• Frame (Start: Addr7: Read: Ack: Data) or Frame (Start: Addr7: Write: Ack: Data)— 
The oscilloscope triggers on a read or write frame in 7- bit addressing 
mode on the 17th clock edge if all bits in the pattern match. For 
triggering purposes, a restart is treated as a start condition.

• Frame (Start: Addr7: Read: Ack: Data: Ack: Data2) or Frame (Start: Addr7: Write: 
Ack: Data: Ack: Data2)— The oscilloscope triggers on a read or write 
frame in 7- bit addressing mode on the 26th clock edge if all bits in 
the pattern match. For triggering purposes, a restart is treated as a 
start condition.

• 10-bit Write — The oscilloscope triggers on a 10- bit write frame on the 
26th clock edge if all bits in the pattern match. The frame is in the 
format:

Frame (Start: Address byte 1: Write: Address byte 2: Ack: Data)

For triggering purposes, a restart is treated as a start condition.

SDA

SCL

Control
byte

Read

R/ Ack Data Ack
Trigger point

Start or
Restart

Condition

SDA

SCL

Stop 
Condition

Start or
Restart

Condition
Trigger point

17th clock edge

Address

Read Write

R/ Ack Data Ack

Read
Write

Start
Condition

Address R/W Ack Data Ack Data 2

Trigger point
26th clock edge

Ack Stop
Condition
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5 If you have set the oscilloscope to trigger on an EEPROM Data Read 
condition:

Press the Data is softkey to set the oscilloscope to trigger when data is 
= (equal to), ≠ (not equal to), < (less than), or > (greater than) the data 
value set in the Data softkey.

The oscilloscope will trigger on the clock edge for the Ack bit after the 
trigger event is found. This data byte does not need to occur directly 
after the control byte. The oscilloscope will trigger on any data byte 
that meets the criteria defined by the Data is and Data softkeys during a 
current address read or a random read or a sequential read cycle.

6 If you have set the oscilloscope to trigger on a 7- bit address read or 
write frame condition or a 10- bit write frame condition:

a Press the Address softkey and turn the Entry knob to select the 7- bit 
or 10- bit device address.

You can select from an address range of 0x00 to 0x7F (7- bit) or 
0x3FF (10- bit) hexadecimal. When triggering on a read/write frame, 
the oscilloscope will trigger after the start, address, read/write, 
acknowledge, and data events occur.

If don't care is selected (0xXX or 0xXXX) for the address, the 
address will be ignored. The trigger will always occur on the 17th 
clock for 7- bit addressing or 26th clock for 10- bit addressing.

b Press the Data value softkey and turn the Entry knob to select the 
8- bit data pattern on which to trigger.

You can select a data value in the range of 0x00 to 0xFF 
(hexadecimal). The oscilloscope will trigger after the start, address, 
read/write, acknowledge, and data events occur.

SCL

SDA

Stop
Condition

Start or
Restart

Condition
Trigger point

26th clock edge

Address
1st byte

R/ Ack1 AckAddress
2nd byte

Write

Ack2 Data
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If don't care (0xXX) is selected for data, the data will be ignored. 
The trigger will always occur on the 17th clock for 7- bit addressing 
or 26th clock for 10- bit addressing.

c If you have selected a three- byte trigger, press the Data2 value softkey 
and turn the Entry knob to select the 8- bit data pattern on which to 
trigger.

I2C Serial Decode

To set up the oscilloscope to capture I2C signals, see "Setup for I2C 
Signals" on page 415.

To set up I2C serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Choose 7- bit or 8- bit address size. Use 8- bit address size to include the 
R/W bit as part of the address value, or choose 7- bit address size to 
exclude the R/W bit from the address value.

3 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

NOTE To display I2C serial decode, see "I2C Serial Decode" on page 420.

NOTE For I2C triggering setup see "I2C Triggering" on page 416.
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You can use the horizontal Zoom window for easier navigation of the 
acquired data.

See Also • "Interpreting I2C Decode" on page 421

• "Interpreting I2C Lister Data" on page 423

• "Searching for I2C Data in the Lister" on page 423

Interpreting I2C Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid- level blue lines show an idle bus.

• In the decoded hexadecimal data:

NOTE If the setup does not produce a stable trigger, the I2C signals may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.



422 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

25 I2C/SPI Triggering and Serial Decode
 

• Address values appear at the start of a frame.

• Write addresses appear in light- blue along with the "W" character.

• Read addresses appear in yellow along with the "R" character.

• Restart addresses appear in green along with the "S" character.

• Data values appear in white.

• "a" indicates Ack (low), "~a" indicates No Ack (high).

• Decoded text is truncated at the end of the associated frame when 
there is insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and 
run again) to see decode.

• Red dots in the decode line indicate that more data can be displayed. 
Scroll or expand the horizontal scale to view the data.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red.
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Interpreting I2C Lister Data

In addition to the standard Time column, the I2C Lister contains these 
columns:

• Restart — indicated with an "X".

• Address — colored blue for writes, yellow for reads.

• Data — data bytes.

• Missing Ack — indicated by an "X", highlighted in red if an error.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for I2C Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of I2C data in the Lister. You can use the [Navigate] key and controls 
to navigate through the marked rows.
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1 With I2C selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the I2C signal is 
being decoded.

3 Press Search; then, select from these options:

• Missing Acknowledge — finds SDA data is high during any Ack SCL 
clock bit.

• Address with no Ack — finds when the acknowledge of the selected 
address field is false. The R/W bit is ignored.

• Restart — finds when another start condition occurs before a stop 
condition.

• EEPROM Data Read — finds EEPROM control byte value 1010xxx on the 
SDA line, followed by a Read bit and an Ack bit. It then looks for the 
data value and qualifier set by the Data is softkey and the Data 
softkeys.

• Frame(Start:Address7:Read:Ack:Data) — finds a read frame on the 17th 
clock edge if all bits in the pattern match.

• Frame(Start:Address7:Write:Ack:Data) — finds a write frame on the 17th 
clock edge if all bits in the pattern match.

• Frame(Start:Address7:Read:Ack:Data:Ack:Data2) — finds a read frame on 
the 26th clock edge if all bits in the pattern match.

• Frame(Start:Address7:Write:Ack:Data:Ack:Data2) — finds a write frame on 
the 26th clock edge if all bits in the pattern match.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.

Setup for SPI Signals

Serial Peripheral Interface (SPI) signals setup consists of connecting the 
oscilloscope to a clock, MOSI data, MISO data, and framing signal, then 
setting the threshold voltage level for each input channel, and finally 
specifying any other signal parameters.
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To set up the oscilloscope to capture SPI signals, use the Signals softkey 
which appears in the Serial Decode Menu:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select SPI trigger type.

5 Press the Signals softkey to open the SPI Signals Menu.

6 Press the Clock softkey to open the SPI Clock Menu.

In the SPI Clock Menu:

a Press the Clock softkey; then, turn the Entry knob to select the 
channel connected to the SPI serial clock line.

The CLK label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to select the 
clock signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

c Press the slope softkey ( ) to select rising edge or falling edge for 
the selected Clock source.

This determines which clock edge the oscilloscope will use to latch 
the serial data. When Display Info is enabled, the graphic changes to 
show the current state of the clock signal.

7 Press the MOSI softkey to open the SPI Master- Out Slave- In Menu.
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In the SPI Master- Out Slave- In Menu:

a Press the MOSI Data softkey; then, turn the Entry knob to select the 
channel that is connected to a SPI serial data line. (If the channel 
you selected is off, switch it on.)

The MOSI label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to select the 
MOSI signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

8 (Optional) Press the MISO softkey to open the SPI Master- In Slave- Out 
Menu.

In the SPI Master- In Slave- Out Menu:

a Press the MISO Data softkey; then, turn the Entry knob to select the 
channel that is connected to a second SPI serial data line. (If the 
channel you selected is off, switch it on.)

The MISO label for the source channel is automatically set.

b Press the Threshold softkey; then, turn the Entry knob to select the 
MISO signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

9 Press the CS softkey to open the SPI Chip Select Menu.
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In the SPI Chip Select Menu:

a Press the Frame by softkey to select a framing signal that the 
oscilloscope will use for determining which clock edge is the first 
clock edge in the serial stream.

You can set the oscilloscope to trigger during a high chip select (CS), 
a low chip select (~CS), or after a Timeout period during which the 
clock signal has been idle.

• If the framing signal is set to CS (or ~CS), the first clock edge as 
defined, rising or falling, seen after the CS (or ~CS) signal 
transitions from low to high (or high to low) is the first clock in 
the serial stream.

Chip Select — Press the CS or ~CS softkey; then, turn the Entry 
knob to select the channel that is connected to the SPI frame line. 
The label (~CS or CS) for the source channel is automatically set. 
The data pattern and the clock transition must occur during the 
time when the framing signal is valid. The framing signal must be 
valid for the entire data pattern.
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• If the framing signal is set to Timeout, the oscilloscope generates 
it's own internal framing signal after it sees inactivity on the serial 
clock line.

Clock Timeout — Select Clock Timeout in the Frame by softkey, then 
select the Timeout softkey and turn the Entry knob to set the 
minimum time that the Clock signal must be idle (not 
transitioning) before the oscilloscope will search for the Data 
pattern on which to trigger.

The Timeout value can be set anywhere from 100 ns to 10 s.

When you press the Frame by softkey, the Display Info graphic changes 
to show timeout selection or the current state of the chip select 
signal.

b Press the Threshold softkey; then, turn the Entry knob to select the 
chip select signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

When Display Info is enabled, information about the selected signal sources 
and their threshold voltage levels, as well as a waveform diagram, appears 
on the screen.

SPI Triggering

To set up the oscilloscope to capture SPI signals, see "Setup for SPI 
Signals" on page 424.

After the oscilloscope has been set up to capture SPI signals, you can then 
trigger on a data pattern that occurs at the start of a frame. The serial 
data string can be specified to be from 4 to 32 bits long.

When you select the SPI trigger type and Display Info is enabled, a graphic 
is displayed showing the current state of the frame signal, clock slope, 
number of data bits, and data bit values.

1 Press [Trigger].
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2 In the Trigger Menu, press the Trigger Type softkey; then, turn the Entry 
knob to select the serial slot (Serial 1 or Serial 2) on which the SPI 
signals are being decoded.

3 Press the second Trigger Type softkey; then, turn the Entry knob to select 
the trigger condition:

• Master-Out, Slave-In (MOSI) Data — for triggering on the MOSI data 
signal.

• Master-In, Slave-Out (MISO) Data — for triggering on the MISO data 
signal.

4 Press the #Bits softkey, and turn the Entry knob to set the number of 
bits (#Bits) in the serial data string.

The number of bits in the string can be set anywhere from 4 bits to 64 
bits. The data values for the serial string are displayed in the 
MOSI/MISO Data string in the waveform area.

5 Press the MOSI Data or MISO Data softkey and use the binary keypad 
dialog to enter bit values of 0 (low), 1 (high), or X (don't care).
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SPI Serial Decode

To set up the oscilloscope to capture SPI signals, see "Setup for SPI 
Signals" on page 424.

To set up SPI serial decode:

1 Press [Serial] to display the Serial Decode Menu.

NOTE For SPI decode information see "SPI Serial Decode" on page 430.

NOTE For SPI triggering setup see "SPI Triggering" on page 428.
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2 Press the Word Size softkey; then, turn the Entry knob to select the 
number of bits in a word.

3 Press the Bit Order softkey; then turn the Entry knob to select the bit 
order, most significant bit first (MSB) or least significant bit first (LSB), 
used when displaying data in the serial decode waveform and in the 
Lister.

4 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

5 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
acquired data.

See Also • "Interpreting SPI Decode" on page 432

• "Interpreting SPI Lister Data" on page 433

• "Searching for SPI Data in the Lister" on page 433

NOTE If the setup does not produce a stable trigger, the SPI signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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Interpreting SPI Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid- level blue lines show an idle bus.

• The number of clocks in a frame appears in light- blue above the frame, 
to the right.

• Decoded hexadecimal data values appear in white.

• Decoded text is truncated at the end of the associated frame when 
there is insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and 
run again) to see decode.

• Red dots in the decode line indicate that there is data that is not being 
displayed. Scroll or expand the horizontal scale to view the information.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red.



I2C/SPI Triggering and Serial Decode 25

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 433

 

Interpreting SPI Lister Data

In addition to the standard Time column, the SPI Lister contains these 
columns:

• Data — data bytes (MOSI and MISO).

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for SPI Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of SPI data in the Lister. You can use the [Navigate] key and controls 
to navigate through the marked rows.

1 With SPI selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the SPI signals 
are being decoded.
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3 Press Search; then, select from these options:

• Master-Out, Slave-In (MOSI) Data — for searching MOSI data.

• Master-In, Slave-Out (MISO) Data — for searching MISO data.

4 Press the Bits softkey to open the SPI Bits Search Menu.

5 In the SPI Bits Search Menu, use the Words softkey to specify the 
number of words in the data value; then, use the remaining softkeys to 
enter the hex digit values.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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I2S Triggering 438

I2S Serial Decode 441

I2S triggering and serial decode requires Option AUDIO or the 
DSOX4AUDIO upgrade.

Setup for I2S Signals

I2S (Inter- IC Sound or Integrated Interchip Sound) signals setup consists 
of connecting the oscilloscope to the serial clock, word select, and serial 
data lines and then specifying the input signal threshold voltage levels.

To set up the oscilloscope to capture I2S signals:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select I2S trigger type.

5 Press the Signals softkey to open the I2S Signals Menu.

NOTE Only one I2S serial bus can be decoded at a time.
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6 For the SCLK (serial clock), WS (word select), and SDATA (serial data) 
signals:

a Connect an oscilloscope channel to the signal in the device under 
test.

b Press the SCLK, WS, or SDATA softkey; then, turn the Entry knob to 
select the channel for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob 
to select the signal threshold voltage level.

Set the threshold levels for the SCLK, WS, and SDATA signals to the 
middle of the signals.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

The SCLK, WS, and SDATA labels for the source channels are 
automatically set.

7 Press the Back/Up key to return to the Serial Decode Menu.

8 Press the Bus Config softkey to open the I2S Bus Configuration Menu 
and display a diagram showing WS, SCLK, and SDATA signals for the 
currently specified bus configuration.

9 Press the Word Size softkey. Turn the Entry knob to match the 
transmitter word size of the device under test (from 4 to 32 bits).

10 Press the Receiver softkey. Turn the Entry knob to match the receiver 
word size of the device under test (from 4 to 32 bits).

11 Press the Alignment softkey; then, turn the Entry knob to select the 
desired alignment of the data signal (SDATA). The on- screen diagram 
changes with your selection.

Back
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Standard Alignment — MSB of data for each sample is sent first, LSB is 
sent last. The MSB appears on the SDATA line one bit clock after the 
edge of the WS transition.

Left-Justified — Data transmission (MSB first) begins at the edge of the 
WS transition (without the one- bit delay that Standard format employs).

Right-Justified — Data transmission (MSB first) is right- justified to the 
transition of WS.

12 Press the WS Low softkey; then, turn the Entry knob to select whether 
WS Low indicates Left or Right channel data. The on- screen diagram 
changes with your selection.

WS Low = Left Channel — Left- channel data corresponds to WS=low; 
right- channel data corresponds to WS=high. WS Low=Left is the 
oscilloscope's default WS setting.
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WS Low = Right Channel — Right- channel data corresponds to WS=low; 
left- channel data corresponds to WS=high.

13 Press the SCLK Slope softkey; then, turn the Entry knob to select the 
SCLK edge on which data is clocked in your device under test: either 
rising or falling. The on- screen diagram changes with your selection.

I2S Triggering

To set up the oscilloscope to capture I2S signals, see "Setup for I2S 
Signals" on page 435.

After you have set up the oscilloscope to capture I2S signals, you can then 
trigger on a data value.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the I2S signals 
are being decoded.
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3 Press the Trigger Setup softkey to open the I2S Trigger Setup Menu.

4 Press the Audio softkey; then, turn the Entry knob to choose to trigger 
on Left channel events, Right channel events, or events that occur on 
Either channel.

5 Press the Trigger softkey and choose a qualifier:

• Equal — triggers on the specified audio channel's data word when it 
equals the specified word.

• Not equal — triggers on any word other than the specified word.

• Less than — triggers when the channel's data word is less than the 
specified value.

• Greater than — triggers when the channel's data word is greater than 
the specified value.

• In Range — enter upper and lower values to specify the range in 
which to trigger.

• Out of Range — enter upper and lower values to specify range in which 
trigger will not occur.

• Increasing value — triggers when the data value is increasing over time 
and the specified value is met or exceeded. Set Trigger >= to the data 
value that must be reached. Set Armed <= to the value to which the 
data must fall before the trigger circuit is re- armed (ready to trigger 
again). These settings are made in the current menu when Base is 
Decimal or in the Bits submenu when the Base is Binary. The Armed 
control reduces triggers due to noise.

This trigger condition is best understood when the digital data 
transferred over the I2S bus is considered in terms of representing 
an analog waveform. The figure below shows a plot of sample data 
transmitted over an I2S bus for one channel. In this example, the 
oscilloscope will trigger at the 2 points shown since there are two 
instances in which the data increases from a value below (or at) the 
"Armed" value to a value greater than (or equal to) the specified 
"Trigger" value.
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If you select an "Armed" value that is equal to or greater than the 
"Trigger" value, the "Trigger" value will be increased so that it is 
always greater than the "Armed" value.

• Decreasing value — similar to the description above except the trigger 
occurs on a decreasing data word value, and the "Armed" value is 
the value to which the data must rise in order to re- arm the trigger.

6 Press the Base softkey and select a number base for entering data 
values:

• Binary (2's complement).

When Binary is selected, the Bits softkey appears. This softkey opens 
the I2S Bits Menu for entering data values.

When the trigger qualifier requires a pair of values (as with In 
Range, Out of Range, Increasing value, or Decreasing value), the first 
softkey in the I2S Bits Menu lets you select which value of the pair.

In the I2S Bits Menu, press the Bit softkey and rotate the Entry knob 
to select each bit; then, use the 0 1 X softkey to set each bit value to 
zero, one, or don't care. You can use the Set all Bits softkey to set all 
bits to the value chosen on the 0 1 X softkey. Don't care values are 
only allowed with Equal or Not Equal trigger qualifiers.

• Signed decimal.

When Decimal is selected, the softkey(s) to the right let you enter 
decimal values with the Entry knob. These softkeys can be Data, <, >, 
or Threshold depending on the selected trigger qualifier.
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I2S Serial Decode

To set up the oscilloscope to capture I2S signals, see "Setup for I2S 
Signals" on page 435.

To set up I2S serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press the Base softkey to select the number base in which to display 
decoded data.

3 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

NOTE If the setup does not produce a stable trigger, the I2S signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.

NOTE To display I2S serial decode, see "I2S Serial Decode" on page 441.

NOTE For I2S triggering setup see "I2S Triggering" on page 438.

NOTE If the setup does not produce a stable trigger, the I2S signal may be slow enough that the 
oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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You can use the horizontal Zoom window for easier navigation of the 
acquired data.

See Also • "Interpreting I2S Decode" on page 442

• "Interpreting I2S Lister Data" on page 443

• "Searching for I2S Data in the Lister" on page 444

Interpreting I2S Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid- level blue lines show an idle bus.

• In the decoded data:

• Right channel data values appear in green along with the "R:" 
characters.

• Left channel data values appear in white along with the "L:" 
characters.
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• Decoded text is truncated at the end of the associated frame when 
there is insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and 
run again) to see decode.

• Red dots in the decode line indicate that more data can be displayed. 
Scroll or expand the horizontal scale to view the data.

• Aliased bus values (undersampled or indeterminate) are drawn in pink.

• Unknown bus values (undefined or error conditions) are drawn in red.

Interpreting I2S Lister Data

NOTE When the receiver word size is greater than the transmit word size, the decoder fills the 
least significant bits with zeros and the decoded value does not match the trigger value.
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In addition to the standard Time column, the I2S Lister contains these 
columns:

• Left Channel — displays the left channel data.

• Right Channel — displays the right channel data.

• Errors — highlighted in red and marked with an "X".

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for I2S Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of I2S data in the Lister. You can use the [Navigate] key and controls 
to navigate through the marked rows.

1 With I2S selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the I2S signals 
are being decoded.

3 In the Search Menu, press Search; then, select from these options:

• = (Equal) — finds the specified audio channel's data word when it 
equals the specified word.

• != (Not Equal) — finds any word other than the specified word.

• < (Less than) — finds when the channel's data word is less than the 
specified value.

• > (Greater than) — finds when the channel's data word is greater than 
the specified value.

• >< (In Range) — enter upper and lower values to specify the range to 
find.

• <> (Out of Range) — enter upper and lower values to specify range not 
to find.

• Errors — finds all errors.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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Setup for ARINC 429 Signals 452

ARINC 429 Triggering 454

ARINC 429 Serial Decode 455

MIL- STD- 1553/ARINC 429 triggering and serial decode requires Option 
AERO or the DSOX4AERO upgrade.

The MIL- STD- 1553 triggering and decode solution supports bi- phase 
MIL- STD- 1553 signaling by using dual threshold triggering. The solution 
supports the standard 1553 Manchester II encoding, data rate of 1 Mb/s, 
and word length of 20 bits.

Setup for MIL-STD-1553 Signals

MIL- STD- 1553 signal setup consists of first connecting the oscilloscope to 
a serial MIL- STD- 1553 signal using a differential active probe (the Agilent 
N2791A is recommended), specifying the signal source, and specifying the 
high and low trigger threshold voltage levels.

To set up the oscilloscope to capture MIL- STD- 1553 signals:

1 Press [Label] to turn on labels.

2 Press [Serial].
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3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select MIL-STD-1553 decode mode.

5 Press the Signals softkey to open the MIL- STD- 1553 Signals Menu.

6 Press the Source softkey to select the channel connected to the 
MIL- STD- 1553 signal line.

The label for the MIL- STD- 1553 source channel is automatically set.

7 Press the Back/Up key to return to the Serial Decode Menu.

8 Press the Auto Setup softkey which performs these actions:

• Sets the probe attenuation factor of the input Source channel to 10:1.

• Sets upper and lower thresholds to a voltage value equal to ±1/3 
division based on the current V/div setting.

• Turns off trigger noise reject.

• Turns on Serial Decode.

• Sets the trigger type to MIL- 1553.

9 If the upper and lower thresholds are not set correctly by Auto Setup, 
press the Signals softkey to return to the MIL- STD- 1553 Signals Menu. 
Then:

• Press the High Threshold softkey; then, turn the Entry knob to set the 
high trigger threshold voltage level.

• Press the Low Threshold softkey; then, turn the Entry knob to set the 
low trigger threshold voltage level.

The threshold voltage levels are used in decoding and will become the 
trigger levels when the trigger type is set to the selected serial decode 
slot.

Back
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MIL-STD-1553 Triggering

To set up the oscilloscope to capture a MIL- STD- 1553 signal, see "Setup 
for MIL- STD- 1553 Signals" on page 445.

To set up a MIL- STD- 1553 trigger:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the 
MIL- STD- 1553 signal is being decoded.

3 Press the Trigger softkey; then, turn the Entry knob to select the trigger 
condition:

• Data Word Start — triggers on the start of a Data word (at the end of a 
valid Data Sync pulse).

• Data Word Stop — triggers on the end of a Data word.

• Command/Status Word Start — triggers on the start of Command/Status 
word (at the end of a valid C/S Sync pulse).

• Command/Status Word Stop — triggers on the end of a Command/Status 
word.

• Remote Terminal Address — triggers if the RTA of the Command/Status 
word matches the specified value.

When this option is selected, the RTA softkey becomes available and 
lets you select the hex Remote Terminal Address value to trigger on. 
If you select 0xXX (don't cares), the oscilloscope will trigger on any 
RTA.

• Remote Terminal Address + 11 Bits — triggers if the RTA and the 
remaining 11 bits match the specified criteria.

When this option is selected, these softkeys become available:

• The RTA softkey lets you select the hex Remote Terminal Address 
value.

• The Bit Time softkey lets you select the bit time position.
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• The 0 1 X softkey lets you set the bit time position value as a 1, 0, 
or X (don't care).

• Parity Error — triggers if the (odd) parity bit is incorrect for the data 
in the word.

• Sync Error — triggers if an invalid Sync pulse is found.

• Manchester Error — triggers if a Manchester encoding error is detected.

MIL-STD-1553 Serial Decode

To set up the oscilloscope to capture MIL- STD- 1553 signals, see "Setup for 
MIL- STD- 1553 Signals" on page 445.

To set up MIL- STD- 1553 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Use the Base softkey to select between hexadecimal and binary display 
of the decoded data.

The base setting is used for the display of the remote terminal address 
and the data, in both the decode line and in the Lister.

3 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

NOTE For MIL-STD-1553 decode information see "MIL-STD-1553 Serial Decode" on page 448.

NOTE For MIL-STD-1553 triggering setup see "MIL-STD-1553 Triggering" on page 447.
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You can use the horizontal Zoom window for easier navigation of the 
decoded data.

See Also • "Interpreting MIL- STD- 1553 Decode" on page 449

• "Interpreting MIL- STD- 1553 Lister Data" on page 450

• "Searching for MIL- STD- 1553 Data in the Lister" on page 451

Interpreting MIL-STD-1553 Decode

To display serial decode information, you must press [Run] or [Single] after 
switching on serial decode.

The MIL- STD- 1553 decode display is color coded as follows:

• Command and Status decoded data is colored green, with the Remote 
Terminal Address (5 bits of data) being displayed first, then the text 
"C/S:", followed by the value of the remaining 11 bits of a 
Command/Status word.

• Data word decoded data is colored white, preceded by the text "D:".
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• Command/Status or Data words with a Parity error have the decode 
text displayed in red instead of green or white.

• SYNC errors are displayed with the word "SYNC" within red angle 
brackets.

• Manchester encoding errors are displayed with the word "MANCH" 
within blue angle brackets (blue instead of red because a valid Sync 
pulse started the word).

Interpreting MIL-STD-1553 Lister Data

In addition to the standard Time column, the MIL- STD- 1553 Lister 
contains these columns:

• RTA — displays the Remote Terminal Address for Command/Status 
words, nothing for Data words.

• Word Type — "Cmd/Status" for Command/Status words, "Data" for Data 
words. For Command/Status words the background color is green to 
match the decode text color.
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• Data — the 11 bits after the RTA for Command/Status words, or the 16 
bits of a Data word.

• Errors — "Sync", "Parity", or "Manchester" errors as appropriate. The 
background color is red to indicate an error.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for MIL-STD-1553 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of MIL- STD- 1553 data in the Lister. You can use the [Navigate] key 
and controls to navigate through the marked rows.

1 With MIL- STD- 1553 selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the 
MIL- STD- 1553 signal is being decoded.

3 Press Search; then, select from these options:

• Data Word Start — finds the start of a Data word (at the end of a valid 
Data Sync pulse).

• Command/Status Word Start — finds the start of Command/Status word 
(at the end of a valid C/S Sync pulse).

• Remote Terminal Address — finds the Command/Status word whose RTA 
matches the specified value. The value is specified in hex.

When this option is selected, the RTA softkey becomes available and 
lets you select the hex Remote Terminal Address value to find.

• Remote Terminal Address + 11 Bits — finds the RTA and the remaining 11 
bits that match the specified criteria.

When this option is selected, these softkeys become available:

• The RTA softkey lets you select the hex Remote Terminal Address 
value.

• The Bit Time softkey lets you select the bit time position.

• The 0 1 X softkey lets you set the bit time position value as a 1, 0, 
or X (don't care).

• Parity Error — finds (odd) parity bits that are incorrect for the data in 
the word.
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• Sync Error — finds invalid Sync pulses.

• Manchester Error — finds Manchester encoding errors.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.

Setup for ARINC 429 Signals

Setup consists of first connecting the oscilloscope to a ARINC 429 signal 
using a differential active probe (the Agilent N2791A is recommended), 
then using the Signals Menu to specify the signal source, the high and low 
trigger threshold voltage levels, the signal speed, and the signal type.

To set up the oscilloscope to capture ARINC 429 signals:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select ARINC 429 decode mode.

5 Press the Signals softkey to open the ARINC 429 Signals Menu.

6 Press Source; then, select the channel for the ARINC 429 signal.

The label for the ARINC 429 source channel is automatically set.

7 Press the Speed softkey to open the ARINC 429 Speed Menu.

8 In the ARINC429 Speed Menu, press the Speed softkey and specify the 
speed of the ARINC 429 signal:
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• High — 100 kb/s.

• Low — 12.5 kb/s.

• User Defined — press the User Baud softkey and enter the user- defined 
speed value.

9 Press the Back/Up key to return to the ARINC 429 Signals Menu.

10 Press the Signal Type softkey and specify the signal type of the ARINC 
429 signal:

• Line A (non-inverted).

• Line B (inverted).

• Differential (A-B).

11 Press the Auto Setup softkey to automatically set these options for 
decoding and triggering on ARINC 429 signals:

• High Trigger Threshold: 3.0 V.

• Low Trigger Threshold: - 3.0 V.

• Noise Reject: Off.

• Probe Attenuation: 10.0.

• Vertical Scale: 4 V/div.

• Serial Decode: On.

• Base: Hex.

• Word Format: Label/SDI/Data/SSM.

• Trigger: currently active serial bus.

• Trigger Mode: Word Start.

12 If the high and low thresholds are not set correctly by Auto Setup:

• Press the High Threshold softkey; then, turn the Entry knob to set the 
high trigger threshold voltage level.

• Press the Low Threshold softkey; then, turn the Entry knob to set the 
low trigger threshold voltage level.

The threshold voltage levels are used in decoding and will become the 
trigger levels when the trigger type is set to the selected serial decode 
slot.

Back
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ARINC 429 Triggering

To set up the oscilloscope to capture a ARINC 429 signal, see "Setup for 
ARINC 429 Signals" on page 452.

After setting up the oscilloscope to capture a ARINC 429 signal:

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the ARINC 429 
signal is being decoded.

3 Press the Trigger: softkey; then, turn the Entry knob to select the trigger 
condition:

• Word Start — triggers on the start of a word.

• Word Stop — triggers at the end of a word.

• Label — triggers on the specified label value.

• Label + Bits — triggers on the label and the other word fields as 
specified.

• Label Range — triggers on a label following in a min/max range.

• Parity Error — triggers on words with a parity error.

• Word Error — triggers on an intra- word coding error.

• Gap Error — triggers on an inter- word gap error.

• Word or Gap Error — triggers on either a Word or Gap Error.

• All Errors — triggers on any of the above errors.

• All Bits (Eye) — triggers on any bit, which will therefore form an eye 
diagram.

• All 0 Bits — triggers on any bit with a value of zero.

• All 1 Bits — triggers on any bit with a value of one.

4 If you select the Label or Label + Bits condition, use the Label softkey to 
specify the label value.

Label values are always displayed in octal.
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5 If you select the Label + Bits condition, use the Bits softkey and submenu 
to specify the bit values:

Press the Data, SSM, and/or SSM softkeys and use the binary keypad 
dialog to enter the 0, 1, or X (don't care) values.

The SDI or SSM selections may not be available, depending on word 
format selection in the Serial Decode Menu.

6 If you select the Label Range condition, use the Label Min and Label Max 
softkeys to specify the ends of the range.

Again, label values are always displayed in octal.

You can use the Zoom mode for easier navigation of the decoded data.

ARINC 429 Serial Decode

To set up the oscilloscope to capture ARINC 429 signals, see "Setup for 
ARINC 429 Signals" on page 452.

To set up ARINC 429 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

NOTE To display ARINC 429 serial decode, see "ARINC 429 Serial Decode" on page 455.

NOTE For ARINC 429 triggering set up see "ARINC 429 Triggering" on page 454.
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2 In the submenu accessed by the Settings softkey, you can use the Base 
softkey to select between hexadecimal and binary display of the 
decoded data.

The base setting is used for data display in both the decode line and in 
the Lister.

Label values are always displayed in octal, and SSM and SDI values are 
always displayed in binary.

3 Press the Word Format softkey and specify the word decode format:

• Label/SDI/Data/SSM:

• Label -  8 bits.

• SDI -  2 bits.

• Data -  19 bits.

• SSM -  2 bits.

• Label/Data/SSM:

• Label -  8 bits.

• Data -  21 bits.

• SSM -  2 bits.

• Label/Data:

• Label -  8 bits.

• Data -  23 bits.

4 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

5 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
decoded data.

See Also • "Interpreting ARINC 429 Decode" on page 457

• "ARINC 429 Totalizer" on page 458

NOTE If the setup does not produce a stable trigger, the ARINC 429 signal may be slow enough 
that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the 
Mode softkey to set the trigger mode from Auto to Normal.
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• "Interpreting ARINC 429 Lister Data" on page 459

• "Searching for ARINC 429 Data in the Lister" on page 460

Interpreting ARINC 429 Decode

Depending on the selected word decode format, the ARINC 429 decode 
display is color coded as follows:

• When the decode format is Label/SDI/Data/SSM:

• Label (yellow) (8 bits) – displayed in octal.

• SDI (blue) (2 bits) – displayed in binary.

• Data (white, red if parity error) (19 bits) – displayed in the selected 
Base.

• SSM (green) (2 bits) – displayed in binary.

• When the decode format is Label/Data/SSM:

• Label (yellow) (8 bits) – displayed in octal.
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• Data (white, red if parity error) (21 bits) – displayed in the selected 
Base.

• SSM (green) (2 bits) – displayed in binary.

• When the decode format is Label/Data:

• Label (yellow) (8 bits) – displayed in octal.

• Data (white, red if parity error) (23 bits) – displayed in the selected 
Base.

The Label bits are displayed in the same order as they are received on the 
wire. For the Data, SSM, and SDI bits, the fields are displayed in the 
order received; however, the bits within those fields are displayed in 
reverse order. In other words, the non- Label fields are displayed in the 
ARINC 429 Word Format, while the bits for those fields have the opposite 
transfer order on the wire.

ARINC 429 Totalizer

The ARINC 429 totalizer measures the total ARINC 429 words and errors.

The totalizer is always running, counting words and errors, and is 
displayed whenever ARINC 429 decode is displayed. The totalizer counts 
even when the oscilloscope is stopped (not acquiring data).

Pressing the [Run/Stop] key does not affect the totalizer.

When an overflow condition occurs, the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset ARINC 429 Counters 
softkey (in the decode Settings menu).



MIL-STD-1553/ARINC 429 Triggering and Serial Decode 27

Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide 459

 

Interpreting ARINC 429 Lister Data

In addition to the standard Time column, the ARINC 429 Lister contains 
these columns:

• Label — the 5- bit label value in octal format.

• SDI — the bit values (if included in the word decode format).

• Data — the data value in binary or hex, depending on the base setting.

• SSM — the bit values (if included in the word decode format).

• Errors — highlighted in red. Errors can be Parity, Word, or Gap.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.
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Searching for ARINC 429 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of ARINC 429 data in the Lister. You can use the [Navigate] key and 
controls to navigate through the marked rows.

1 With ARINC 429 selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the ARINC 429 
signal is being decoded.

3 Press Search; then, select from these options:

• Label — finds the specified label value.

Label values are always displayed in octal.

• Label + Bits — finds the label and the other word fields as specified.

• Parity Error — finds words with a parity error.

• Word Error — finds an intra- word coding error.

• Gap Error — finds an inter- word gap error.

• Word or Gap Error — finds either a Word or Gap Error.

• All Errors — finds any of the above errors.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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Setup for UART/RS232 Signals 461

UART/RS232 Triggering 463

UART/RS232 Serial Decode 465

UART/RS232 triggering and serial decode requires Option COMP or the 
DSOX4COMP upgrade.

Setup for UART/RS232 Signals

To set up the oscilloscope to capture UART/RS232 signals:

1 Press [Label] to turn on labels.

2 Press [Serial].

3 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

4 Press the Mode softkey; then, select UART/RS232 trigger type.

5 Press the Signals softkey to open the UART/RS232 Signals Menu.
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6 For both the Rx and Tx signals:

a Connect an oscilloscope channel to the signal in the device under 
test.

b Press the Rx or Tx softkey; then, turn the Entry knob to select the 
channel for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob 
to select the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

The RX and TX labels for the source channels are automatically set.

7 Press the Back/Up key to return to the Serial Decode Menu.

8 Press the Bus Config softkey to open the UART/RS232 Bus Configuration 
Menu.

Set the following parameters.

a #Bits — Set the number of bits in the UART/RS232 words to match 
your device under test (selectable from 5- 9 bits).

b Parity — Choose odd, even, or none, based on your device under test.

c Baud — Press the Baud Rate softkey, then press the Baud softkey and 
select a baud rate to match the signal in your device under test. If 
the desired baud rate is not listed, select User Defined on the Baud 
softkey; then, select the desired baud rate using the User Baud softkey.

You can set the UART baud rate from 1.2 kb/s to 8.0000 Mb/s in 
increments of 100 b/s.

d Polarity — Select idle low or idle high to match your device under 
test's state when at idle. For RS232 select idle low.

e Bit Order — Select whether the most significant bit (MSB) or the least 
significant bit (LSB) is presented after the start bit in the signal 
from your device under test. For RS232 select LSB.

Back
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UART/RS232 Triggering

To set up the oscilloscope to capture UART/RS- 232 signals, see "Setup for 
UART/RS232 Signals" on page 461.

To trigger on a UART (Universal Asynchronous Receiver/Transmitter) 
signal connect the oscilloscope to the Rx and Tx lines and set up a trigger 
condition. RS232 (Recommended Standard 232) is one example of a UART 
protocol.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the UART/RS232 
signals are being decoded.

3 Press the Trigger Setup softkey to open the UART/RS232 Trigger Setup 
Menu.

4 Press the Base softkey to select Hex or ASCII as the base displayed on 
the Data softkey in the UART/RS232 Trigger Setup Menu.

Note that the setting of this softkey does not affect the selected base of 
the decode display.

5 Press the Trigger softkey and set up the desired trigger condition:

• Rx Start Bit — The oscilloscope triggers when a start bit occurs on Rx.

NOTE In the serial decode display, the most significant bit is always displayed on the left 
regardless of how Bit Order is set.
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• Rx Stop Bit — Triggers when a stop bit occurs on Rx. The trigger will 
occur on the first stop bit. This is done automatically whether the 
device under test uses 1, 1.5, or 2 stop bits. You do not need to 
specify the number of stop bits used by the device Under test.

• Rx Data — Triggers on a data byte that you specify. For use when the 
device under test data words are from 5 to 8 bits in length (no 9th 
(alert) bit).

• Rx 1:Data — For use when the device under test data words are 9 bits 
in length including the alert bit (the 9th bit). Triggers only when the 
9th (alert) bit is 1. The specified data byte applies to the least 
significant 8 bits (excludes the 9th (alert) bit).

• Rx 0:Data — For use when the device under test data words are 9 bits 
in length including the alert bit (the 9th bit). Triggers only when the 
9th (alert) bit is 0. The specified data byte applies to the least 
significant 8 bits (excludes the 9th (alert) bit).

• Rx X:Data — For use when the device under test data words are 9 bits 
in length including the alert bit (the 9th bit). Triggers on a data byte 
that you specify regardless of the value of the 9th (alert) bit. The 
specified data byte applies to the least significant 8 bits (excludes 
the 9th (alert) bit).

• Similar choices are available for Tx.

• Rx or Tx Parity Error — Triggers on a parity error based on the parity 
you have set in the Bus Configuration Menu.

6 If you choose a trigger condition that includes "Data" in its description 
(for example: Rx Data), then press the Data is softkey, and choose an 
equality qualifier. You can choose equal to, not equal to, less than, or 
greater than a specific data value.

7 Use the Data softkey to choose the data value for your trigger 
comparison. This works in conjunction with the Data is softkey.

8 Optional: The Burst softkey lets you trigger on the Nth frame (1- 4096) 
after an idle time you select. All trigger conditions must be met for the 
trigger to occur.

9 If Burst is selected, an idle time (1 µs to 10 s) can be specified so that 
the oscilloscope will look for a trigger condition only after the idle time 
has past. Press the Idle softkey and rotate the Entry knob to set an idle 
time.
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UART/RS232 Serial Decode

To set up the oscilloscope to capture UART/RS232 signals, see "Setup for 
UART/RS232 Signals" on page 461.

To set up UART/RS232 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press Settings.

3 In the UART/RS232 Settings Menu, press the Base softkey to select the 
base (hex, binary, or ASCII) in which decoded words are displayed.

• When displaying words in ASCII, the 7- bit ASCII format is used. 
Valid ASCII characters are between 0x00 and 0x7F. To display in 
ASCII you must select at least 7 bits in the Bus Configuration. If 
ASCII is selected and the data exceeds 0x7F, the data is displayed in 
hex.

NOTE If the setup does not produce a stable trigger, the UART/RS232 signals may be slow 
enough that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then 
press the Mode softkey to set the trigger mode from Auto to Normal.

NOTE To display UART/RS232 serial decode, see "UART/RS232 Serial Decode" on page 465.

NOTE For UART/RS232 triggering setup see "UART/RS232 Triggering" on page 463.
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• When #Bits is set to 9 in the UART/RS232 Bus Configuration Menu, 
the 9th (alert) bit is displayed directly to the left of the ASCII value 
(which is derived from the lower 8 bits).

4 Optional: Press the Framing softkey and select a value. In the decode 
display, the chosen value will be displayed in light blue. However, if a 
parity error occurs the data will be displayed in red.

5 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

6 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
acquired data.

See Also • "Interpreting UART/RS232 Decode" on page 467

• "UART/RS232 Totalizer" on page 468

• "Interpreting UART/RS232 Lister Data" on page 469

• "Searching for UART/RS232 Data in the Lister" on page 469

NOTE If the setup does not produce a stable trigger, the UART/RS232 signals may be slow 
enough that the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then 
press the Mode softkey to set the trigger mode from Auto to Normal.
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Interpreting UART/RS232 Decode

• Angled waveforms show an active bus (inside a packet/frame).

• Mid- level blue lines show an idle bus.

• When using 5- 8 bit formats, the decoded data is displayed in white (in 
binary, hex, or ASCII).

• When using the 9 bit format, all data words are displayed in green, 
including the 9th bit. The 9th bit is displayed on the left.

• When a data word value is selected for framing, it is displayed in light 
blue. When using 9- bit data words, the 9th bit will also be displayed in 
light blue.

• Decoded text is truncated at the end of the associated frame when 
there is insufficient space within frame boundaries.

• Pink vertical bars indicate you need to expand the horizontal scale (and 
run again) to see decode.
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• When the horizontal scale setting does not permit the display of all 
available decoded data, red dots will appear in the decoded bus to 
mark the location of hidden data. Expand the horizontal scale to allow 
the data to display.

• An unknown (undefined) bus is shown in red.

• A parity error will cause the associated data word to be shown in red, 
which includes the 5- 8 data bits and the optional 9th bit.

UART/RS232 Totalizer

The UART/RS232 totalizer consists of counters that provide a direct 
measure of bus quality and efficiency. The totalizer appears on screen 
whenever UART/RS232 Decode is ON in the Serial Decode Menu.

The totalizer is running, counting frames and calculating the percentage of 
error frames, even when the oscilloscope is stopped (not acquiring data).

The ERR (error) counter is a count of Rx and Tx frames with parity 
errors. The TX FRAMES and RX FRAMES counts include both normal 
frames and frames with parity errors. When an overflow condition occurs, 
the counter displays OVERFLOW.

The counters can be reset to zero by pressing the Reset UART Counters 
softkey in the UART/RS232 Settings Menu.
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Interpreting UART/RS232 Lister Data

In addition to the standard Time column, the UART/RS232 Lister contains 
these columns:

• Rx — receive data.

• Tx — transmit data.

• Errors — highlighted in red, Parity Error or Unknown Error.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.

Searching for UART/RS232 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of UART/RS232 data in the Lister. You can use the [Navigate] key 
and controls to navigate through the marked rows.

1 With UART/RS232 selected as the serial decode mode, press [Search].
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2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the UART/RS232 
signals are being decoded.

3 In the Search Menu, press Search; then, select from these options:

• Rx Data — Finds a data byte that you specify. For use when the DUT 
data words are from 5 to 8 bits in length (no 9th (alert) bit).

• Rx 1:Data — For use when the DUT data words are 9 bits in length 
including the alert bit (the 9th bit). Finds only when the 9th (alert) 
bit is 1. The specified data byte applies to the least significant 8 bits 
(excludes the 9th (alert) bit)

• Rx 0:Data — For use when the DUT data words are 9 bits in length 
including the alert bit (the 9th bit). Finds only when the 9th (alert) 
bit is 0. The specified data byte applies to the least significant 8 bits 
(excludes the 9th (alert) bit).

• Rx X:Data — For use when the DUT data words are 9 bits in length 
including the alert bit (the 9th bit). Finds a data byte that you 
specify regardless of the value of the 9th (alert) bit. The specified 
data byte applies to the least significant 8 bits (excludes the 9th 
(alert) bit).

• Similar choices are available for Tx.

• Rx or Tx Parity Error — Finds a parity error based on the parity you have 
set in the Bus Configuration Menu.

• Rx or Tx Any Error — Finds any error.

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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Setup for USB 2.0 Signals 471

USB 2.0 Triggering 473

USB 2.0 Serial Decode 475

USB 2.0 triggering and serial decode requires:

• Option USF or the DSOX4USBFL upgrade for full/low speed decode.

• Option U2H or the DSOX4USBH upgrade for high speed decode.

Setup for USB 2.0 Signals

To set up the oscilloscope to capture USB 2.0 signals:

1 Press [Serial].

2 Press the Serial softkey, turn the Entry knob to select the desired slot 
(Serial 1 or Serial 2), and press the softkey again to enable decode.

3 Press the Mode softkey; then, select USB trigger type.

4 Press the Speed softkey and specify the speed of the USB signal:

• Low (1.5 Mb/s) — requires two single- ended probes.

• Full (12 Mb/s) — requires two single- ended probes.

• High (480 Mb/s) — requires a differential probe.

Analog channels can be used for any of these speeds. Digital channels 
can be used for Low and Full speed only.

5 Press the Signals softkey to open the USB Signals Menu.
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6 For both the D+ and D-  signals (for low or full speed, similar steps for 
the single Source for high speed):

a Connect an oscilloscope channel to the signal in the device under 
test.

b Press the D+ Source or D- Source softkey; then, turn the Entry knob to 
select the channel for the signal.

c Press the corresponding Threshold softkey; then, turn the Entry knob 
to select the signal threshold voltage level.

The threshold voltage level is used in decoding, and it will become 
the trigger level when the trigger type is set to the selected serial 
decode slot.

7 Press Auto Setup to automatically set these options for decoding and 
triggering on USB signals:

• Low- speed:

• D+/-  Source thresholds: 1.4 V

• D+/-  Source vertical scale: 1.0 V/div

• D+/-  Source vertical offset: 0.0 V

• Horizontal scale: 5 µs/div

• Full- speed:

• D+/-  Source thresholds: 1.4 V

• D+/-  Source vertical scale: 1.0 V/div

• D+/-  Source vertical offset: 0.0 V

• Horizontal scale: 500 ns/div

• High- speed:

• D+/-  Source thresholds: 0.0 V

• D+/-  Source vertical scale: 200 mV/div

• D+/-  Source vertical offset: 0.0 V

• Horizontal scale: 20 ns/div

• Serial Decode: On

• Trigger Mode: currently active serial bus
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• USB Trigger Mode: Start of Packet

USB 2.0 Triggering

To set up the oscilloscope to capture USB 2.0 signals, see "Setup for USB 
2.0 Signals" on page 471.

To trigger on a USB 2.0 signal, connect the oscilloscope to the D+ and D-  
lines and set up a trigger condition.

1 Press [Trigger].

2 In the Trigger Menu, press the Trigger softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the USB 2.0 
signals are being decoded.

3 Press the Trigger softkey and use the  Entry knob to select the USB 
packet, error, or event to trigger on:

• SOP - Start of Packet — triggers on the sync bit at the beginning of the 
packet (low and full speed only).

• EOP - End of Packet — triggers at the end of the SE0 portion of the EOP 
(low and full speed only).

• Suspend — triggers when the bus is idle for > 3 ms (low and full 
speed only).

• Resume — triggers when exiting an idle state > 10 ms (low and full 
speed only).

• Reset — triggers when SE0 is > 10 ms (low and full speed only).

• Token Packet — triggers when a token packet with the specified 
content is detected.

• Data Packet — triggers when a data packet with the specified content 
is detected.

• Handshake Packet — triggers when a handshake packet with the 
specified content is detected.
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• Special Packet — triggers when a special packet with the specified 
content is detected.

• All Errors — triggers when any of the following errors are detected.

• PID Error — triggers when the packet type field does not match the 
check field.

• CRC5 Error — triggers when a 5 bit CRC error is detected.

• CRC16 Error — triggers when a 16 bit CRC error is detected.

• Glitch Error — triggers when two transitions occur in half a bit time.

• Bit Stuff Error — triggers when > 6 consecutive ones are detected (low 
and full speed only).

• SE1 Error — triggers if SE1 > 1 bit time (low and full speed only).

4 If you choose the Token Packet, Data Packet, Handshake Packet, or Special 
Packet trigger condition:

a Press the PID softkey to select the desired packet ID for the selected 
packet type.

b Press the Base softkey to select the Hex or Binary number base when 
displaying or entering USB packet trigger values.

Note that the setting of this softkey does not affect the selected base 
of the decode display.

c Press the Bits softkey.

d In the USB Bits Menu, press the Define softkey to select the trigger 
value to specify.

e Use the remaining softkeys to specify the value.

For details about using the USB Bits Menu softkeys, press and hold 
the softkey in question to display the built- in help.

NOTE If the setup does not produce a stable trigger, the USB 2.0 signals may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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USB 2.0 Serial Decode

To set up the oscilloscope to capture USB 2.0 signals, see "Setup for USB 
2.0 Signals" on page 471.

To set up USB 2.0 serial decode:

1 Press [Serial] to display the Serial Decode Menu.

2 Press the Base for Data softkey to select the base (hex, binary, ASCII, or 
decimal) in which decoded data is displayed.

3 If the decode line does not appear on the display, press the [Serial] key 
to turn it on.

4 If the oscilloscope is stopped, press the [Run/Stop] key to acquire and 
decode data.

You can use the horizontal Zoom window for easier navigation of the 
acquired data.

See Also • "Interpreting USB 2.0 Decode" on page 476

• "Interpreting USB 2.0 Lister Data" on page 478

NOTE To display USB 2.0 serial decode, see "USB 2.0 Serial Decode" on page 475.

NOTE For USB 2.0 triggering setup see "USB 2.0 Triggering" on page 473.

NOTE If the setup does not produce a stable trigger, the USB 2.0 signals may be slow enough that 
the oscilloscope is AutoTriggering. Press the [Mode/Coupling] key, then press the Mode 
softkey to set the trigger mode from Auto to Normal.
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• "Searching for USB 2.0 Data in the Lister" on page 479

Interpreting USB 2.0 Decode

The USB decode display is color coded as follows:

• For Token Packets (all but SOF):

• PID (yellow, "OUT", "IN", "SETUP", "PING")

• PID Check (yellow when valid, red when error detected)

• Address (blue)

• Endpoint (green)

• CRC (blue when valid, red when error detected)

• For Token Packets (SOF):

• PID (yellow, "SOF")

• PID Check (yellow when valid, red when error detected)

• Frame (green) – the frame number
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• CRC (blue when valid, red when error detected)

• For Data Packets:

• PID (yellow, "DATA0", "DATA1", "DATA2", "MDATA")

• PID Check (yellow when valid, red when error detected)

• Data (white)

• CRC (blue when valid, red when error detected)

• For Handshake Packets:

• PID (yellow, "ACK", "NAK", "STALL", "NYET", "PRE", "ERR")

• PID Check (yellow when valid, red when error detected)

• For Split Transaction Token Packets:

• PID (yellow, "SPLIT")

• PID Check (yellow when valid, red when error detected)

• Hub Addr (green)

• SC (blue)

• Port (green)

• S & E|U (blue)

• ET (green)

• CRC (blue when valid, red when error detected)

If the packet type is unknown because the PID is off screen, all bytes will 
be displayed in orange.



478 Agilent InfiniiVision 4000 X-Series Oscilloscopes User's Guide

29 USB 2.0 Triggering and Serial Decode
 

Interpreting USB 2.0 Lister Data

In addition to the standard Time column, the USB 2.0 Lister contains 
these columns:

• PID — PID is displayed as red text if the PID check value does not 
match.

• Addr — Address.

• Endp — Endpoint.

• Data — either the Data of a Data Packet, or the various fields of a 
SPLIT packet.

• Fr — Frame – frame number of a SOF packet.

• CRC.

• Errors — "PID", "CRC5", "CRC16", "Glitch", "Stuff" , or "SE1" errors as 
appropriate. The background color is red to indicate an error.

Aliased data is highlighted in pink. When this happens, decrease the 
horizontal time/div setting and run again.
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If the packet type is unknown because the PID is off screen, the Lister 
text will have an orange background.

Searching for USB 2.0 Data in the Lister

The oscilloscope's search capability lets you search for (and mark) certain 
types of USB 2.0 data in the Lister. You can use the [Navigate] key and 
controls to navigate through the marked rows.

1 With USB 2.0 selected as the serial decode mode, press [Search].

2 In the Search Menu, press the Search softkey; then, turn the Entry knob 
to select the serial slot (Serial 1 or Serial 2) on which the USB 2.0 
signals are being decoded.

3 In the Search Menu, press Search for; then, select from these options:

• Token Packet — finds token packets with the specified content.

• Data Packet — finds data packets with the specified content.

• Handshake Packet — finds handshake packets with the specified 
content.

• Special Packet — finds special packets with the specified content.

• All Errors — finds any of the following errors.

• PID Error — finds packet type fields that do not match the check field.

• CRC5 Error — finds 5 bit CRC errors.

• CRC16 Error — finds 16 bit CRC errors.

• Glitch Error — finds two transitions that occur in half a bit time.

• Bit Stuff Error — finds > 6 consecutive ones (low and full speed only).

• SE1 Error — finds when SE1 > 1 bit time (low and full speed only).

For more information on searching data, see "Searching Lister Data" on 
page 148.

For more information on using the [Navigate] key and controls, see 
"Navigating the Time Base" on page 77.
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Symbols
(-) Width measurement, 259
(+) Width measurement, 259

Numerics
1 M ohm input impedance, 85
10 MHz REF connector, 59, 339
50 ohm input impedance, 85

A
About Oscilloscope, 345
absolute value math function, 110
AC channel coupling, 84
AC RMS - Full Screen measurement, 254
AC RMS - N Cycles measurement, 254
accessories, 28, 370, 373, 374
accessory pouch, attaching, 30
acquire, 213, 223
Acquire key, 40
acquisition memory, 168
acquisition memory, saving, 314
acquisition mode, 219
acquisition mode, averaging, 223
acquisition mode, high resolution, 225
acquisition mode, normal, 220
acquisition mode, peak detect, 220
acquisition mode, preserve during 

AutoScale, 338
acquisition modes, 213
active serial bus, 393, 402, 421, 432, 442, 

467
activity indicator, 131
actual sample rate, 219
adding digital channels license, 376
addition math function, 94
address with no ack condition, I2C 

trigger, 417
AERO license, 375
Agilent IO Libraries Suite, 356

agx files, 333
aliasing, 215
aliasing, FFT, 105
alternating edge trigger, 171
AM (amplitude modulation), waveform 

generator output, 303
Amplitude measurement, 249
amplitude modulation (AM), waveform 

generator output, 303
analog channel inputs, 44
analog channel, probe attenuation, 88
analog channel, setup, 81
analog filters, adjusting, 100
Analyze key, 40
Analyze Segments, 228, 230, 270
annotation, adding, 164
arbitrary generated waveforms, 

editing, 291
arbitrary waveform generator output, 289
arbitrary waveforms, copying from other 

sources, 299
arbitrary waveforms, creating new, 293
arbitrary waveforms, editing existing, 294
Area - Full Screen measurement, 266
Area - N Cycles measurement, 266
ARINC 429 serial decode, 455
ARINC 429 totalizer, 458
ARINC 429 trigger, 454
ARINC 429 words/errors counter, 458
ARINC 429 decode, signal speed, 452
ARINC 429 decode, signal type, 453
ARINC 429 decode, word format, 456
ASCII file format, 310
ASCII XY data, 313
attenuation, probe, 88
attenuation, probe, external trigger, 211
attenuators, 89
AUDIO license, 375
Auto Increment, 318
AUTO Option, 375
Auto Scale key, 42
Auto Setup, FFT, 102

Auto trigger mode, 206
Auto? trigger indicator, 207
AutoIP, 331, 332
automatic measurements, 241, 244
automatic setup, 129
AutoProbe interface, 44, 85
AutoScale preferences, 337
AutoScale, digital channels, 129
AutoScale, undo, 36
Average - Full Screen measurement, 253
Average - N Cycles measurement, 253
average measurement trend, 116
averaged value math function, 114
averaging acquire mode, 219, 223
Ax + B math function, 108

B
Back Up key, 39
bandwidth, 345
bandwidth limit, 85
bandwidth required, oscilloscope, 218
bandwidth, oscilloscope, 216
bandwidth, realtime sampling, 227
base 10 exponential math function, 112
Base measurement, 251
BIN file format, 310
binary data (.bin), 377
binary data file examples, 381
binary data in MATLAB, 378
binary data, example program for 

reading, 381
binary mode cursors, 233
bits, SPI trigger, 429
Blackman Harris FFT window, 102
blanking, 73
BMP file format, 310
brick-wall frequency response, 216
brightness of waveforms, 39
Browser Web Control, 351, 352, 353, 

354, 355
Browser-Based Remote Front Panel, 354
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built-in help, 62
bursors, gated measurement window, 268
burst width measurements, 259
burst, capture signal bursts, 228
bus display mode, 134
buttons (keys), front panel, 38
BW Limit? in DVM display, 284

C
calibrate probe, 89
calibration, 342
calibration protect switch, 58, 59
calibration status, 361
CAN decode, source channels, 388
CAN frame counter, 394
CAN serial decode, 392
CAN symbolic data, 389
CAN totalizer, 394
CAN trigger, 390
capture signal bursts, 228
cardiac waveform generator output, 290
Center, FFT, 101
channel labels, 159
channel, analog, 81
channel, bandwidth limit, 85
channel, coupling, 84
channel, fine adjustment, 86
channel, invert, 86
channel, on/off keys, 44
channel, position, 83
channel, probe units, 87
channel, skew, 88
channel, vertical sensitivity, 83
characteristics, 367
chart logic bus state math function, 118
chart logic bus timing math function, 117
choosing values, 40
cleaning, 345
clear display, 155, 222
clear display, Quick Clear Display, 348
clear persistence, 154
clock, 338
CMOS threshold, 133
common logarithm math function, 110
COMP license, 375
compensate passive probes, 37, 44
Config softkey, 331, 332
connect probes, digital, 125

connection, to a PC, 332
connectors, rear panel, 58
control, remote, 329
controls, front panel, 38
copyright, 2
Counter measurement, 258
counter, ARINC 429 words/errors, 458
counter, CAN frame, 394
counter, FlexRay frame, 411
counter, UART/RS232 frame, 468
coupling, channel, 84
coupling, trigger, 208
crosstalk problems, 100
CSV data, 313
CSV file format, 310
CSV files, minimum and maximum 

values, 385
current probes, 373
cursor measurements, 231
cursor units, 234
Cursors key, 43
Cursors knob, 43
cursors, binary, 233
cursors, hex, 233
cursors, manual, 232
cursors, measure mode, 233
cursors, track waveform, 233

D
D*, 42, 134
d/dt math function, 97
damage, shipping, 27
data sheet, 367
DC channel coupling, 84
DC offset correction for integrate 

waveform, 99
DC RMS - Full Screen measurement, 253
DC RMS - N Cycles measurement, 254
DC signals, checking, 207
DC waveform generator output, 289
dead time (re-arm), 230
decaying average approximation, 114
decibels, FFT vertical units, 102
decimating samples, 219
decimation, for measurement record, 385
decimation, for screen, 385
default configuration, 35
default setup, 35, 322

Default Setup key, 41
defaults, waveform generator, 307
delay knob, 67
Delay measurement, 245, 260
delay time indicator, 76
delayed sweep, 73
delete file, 333
Demo 1 terminal, 44
Demo 2 terminal, 44
depth, AM modulation, 303
deviation, FM modulation, 305
DHCP, 331, 332
differential probes, 372
differentiate math function, 97
digital bus mode, 134
digital channel controls, 42
digital channel inputs, 60
digital channel menu, 132
digital channels, 132
digital channels, AutoScale, 129
digital channels, enabling, 376
digital channels, logic threshold, 133
digital channels, probing, 137
digital channels, size, 132
digital display, interpreting, 131
Digital key, 42
digital probes, 125, 137
digital probes, impedance, 137
digital voltmeter (DVM), 283
Display key, 40
display multiple acquisitions, 214
display, area, 61
display, clear, 155
display, interpreting, 60
display, persistence, 153
display, signal detail, 151
display, softkey labels, 62
display, status line, 61
displayed channels AutoScale, 338
distortion problems, 100
Divide math function, 95
DNS IP, 331
dots or vectors, waveform display, 156
dual channel tracking, waveform 

generator, 307
dual-channel (N2820A probe) 

measurements, 246
Duty cycle measurement, 259
duty cycle measurement trend, 116
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DVM (digital voltmeter, 283
DVM license, 375
Dynamic DNS, 331

E
ECL threshold, 133
edge speeds, 218
edge then edge triggering, 172
edge triggering, 170
EDK license, 375
EEPROM data read, I2C trigger, 417
either edge trigger, 171
e-mail setups, images, or data, 318
e-mail, Quick Email, 347
EMBD license, 375
energy of a pulse, 98
English user interface and Quick Help, 63
Entry knob, 40
Entry knob, push to select, 40
equivalent time sampling, 226
erase, secure, 322
event table, 146
expand about, 83, 335
expand about center, 336
expand about ground, 335
exponential fall waveform generator 

output, 290
exponential math function, 111
exponential rise waveform generator 

output, 290
exporting waveform, 309
EXT TRIG IN as Z-axis input, 73
EXT TRIG IN connector, 45
external memory device, 45
external trigger, 210
external trigger, input impedance, 211
external trigger, input signal range, 212
external trigger, probe attenuation, 211
external trigger, probe units, 211

F
factory default settings, 322
Fall time measurement, 260
fall time measurement trend, 116
falling edges count measurements, 265
fast debug AutoScale, 337
FFT aliasing, 105

FFT DC value, 105
FFT measurement hints, 104
FFT measurements, 100
FFT resolution, 104
FFT spectral leakage, 107
FFT units, 105
FFT vertical units, 102
FFT window, 102
file explorer, 333
file format, ASCII, 310
file format, BIN, 310
file format, BMP, 310
file format, CSV, 310
file format, PNG, 310
File keys, 43
file name, new, 317
file, save, recall, load, 333
filter math function, averaged value, 114
filter math function, high pass and low 

pass, 113
filters, math, 112
fine adjustment, channel, 86
fine adjustment, horizontal scale, 75
firmware updates, 377
firmware upgrade files, 361
firmware version information, 349
firmware versions, 361
flash drive, 45
Flat top FFT window, 102
FLEX license, 375
FlexRay frame counter, 411
FlexRay serial decode, 409
FlexRay totalizer, 411
FlexRay trigger, 406
FM (frequency modulation), waveform 

generator output, 304
folding frequency, 215
forcing a trigger, 169
frame trigger, I2C, 418
freeze display, 347
freeze display, Quick Freeze Display, 347
French front panel overlays, 46
French user interface and Quick Help, 63
frequency deviation, FM modulation, 305
Frequency measurement, 257
frequency measurement trend, 116
frequency modulation (FM), waveform 

generator output, 304
frequency requirements, power source, 32

frequency, Nyquist, 215
frequency-shift keying modulation (FSK), 

waveform generator output, 306
front panel controls and connectors, 38
front panel self test, 345
front panel, browser-based remote, 354
front panel, language overlay, 45
front panel, real scope remote, 352
front panel, simple remote, 353
FSK (frequency-shift keying modulation), 

waveform generator output, 306

G
gated by cursors measurement 

window, 268
gateway IP, 331
Gaussian frequency response, 216
Gaussian pulse waveform generator 

output, 290
Generic video trigger, 193
German front panel overlays, 46
German user interface and Quick Help, 63
glitch capture, 221
glitch trigger, 174
golden waveform test, 271
grabber, 127, 128
graphical user interface language, 63
graticule intensity, 155
graticule type, 155
grid intensity, 155
grid type, 155
ground level, 82
Ground terminal, 44

H
Hanning FFT window, 102
hardware self test, 344
Help key, 43
help, built-in, 62
hex bus trigger, 179
hex mode cursors, 233
HF Reject, 209
high pass filter math function, 113
high-frequency noise rejection, 209
high-resolution mode, 219, 225
holdoff, 210
hop frequency, FSK modulation, 306
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Horiz key, 41, 65, 70, 73, 223
Horizontal controls, 41, 69
horizontal Navigate key, 41
horizontal position control, 41
horizontal position knob, 67
horizontal scale fine adjustment, 75
horizontal Search key, 41
horizontal sweep speed control, 41
horizontal time/div control, 41
horizontal Zoom key, 41
host name, 331, 349
Host name softkey, 332

I
I/O interface settings, 329
I2C serial decode, 420
I2C trigger, 416
I2S serial decode, 441
I2S trigger, 438
identification function, web interface, 360
idle serial bus, 393, 402, 421, 432, 442, 

467
Imped softkey, 85
impedance, digital probes, 137
increment statistics, 270
indeterminate state, 233
infinite persistence, 154, 214, 221
information area, 62
input impedance, analog channel input, 85
installed licenses, 345
installed options, 361
instantaneous slope of a waveform, 97
Instrument Utilities web page, 360
Integrate math function, 98
intensity control, 151
Intensity key, 39
interpolate, arbitrary waveform 

option, 292
invert graticule colors, 312
invert waveform, 86
IP address, 331, 349
Italian front panel overlays, 46
Italian user interface and Quick Help, 63

J
Japanese front panel overlays, 46

Japanese user interface and Quick 
Help, 63

K
keys, front panel, 38
knobs, front panel, 38
Korean front panel overlays, 46
Korean user interface and Quick Help, 63

L
Label key, 44
label list, 163
label list, loading from text file, 162
labels, 159
labels, auto-increment, 162
labels, reset library, 163
LAN connection, 331
LAN interface, remote control, 329
LAN port, 60
LAN Settings softkey, 331, 332
landscape mode, 326
language, user interface and Quick 

Help, 63
length control, 314
length softkey, 313
level, trigger, 169
LF Reject, 208
library, labels, 161
licenses, 375, 376
LIN serial decode, 400
LIN trigger, 398
line voltage, 32
Lister, 146
load file, 333
Load from, 317
localized front panel overlay, 45
Location, 317
Location, File Explorer softkey label, 334
logic presets, waveform generator, 300
logic threshold, 133
low pass filter math function, 113
low-frequency noise rejection, 208

M
magnify math function, 114
mask files, recall, 320

MASK license, 375
mask statistics, quick reset, 347
mask test, trigger output, 275, 339
mask testing, 271
mask, TRIG OUT signal, 339
math filters, 112
math functions, cascaded, 92
Math key, 42
math operators, 94
math transforms, 96
math visualizations, 114
math, 1*2, 95
math, 1/2, 95
math, addition, 94
math, differentiate, 97
math, divide, 95
math, FFT, 100
math, functions, 91
math, integrate, 98
math, multiply, 95
math, offset, 93
math, scale, 93
math, subtract, 94
math, units, 93
math, using waveform math, 91
MATLAB binary data, 378
Maximum measurement, 249
maximum sample rate, 219
Meas key, 43, 241
Measure controls, 43
measure mode cursors, 233
measure statistics, quick reset, 347
measure, Quick Measure All, 347
measurement category, definitions, 368
measurement definitions, 244
measurement record, 314
measurement statistics, 268
measurement thresholds, 266
measurement trend math function, 115
measurement window, 268
measurements, 244
measurements, automatic, 241
measurements, delay, 245
measurements, overshoot, 245
measurements, phase, 245
measurements, preshoot, 245
measurements, time, 256
measurements, voltage, 248
MegaZoom IV, 4
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mem4M, 375
memory depth and sample rate, 219
memory, segmented, 228
menu line, 62
message, CAN symbolic, 391
MIL-STD-1553 serial decode, 448
MIL-STD-1553 trigger, 447
Minimum measurement, 249
missing acknowledge condition, I2C 

trigger, 417
Mode/Coupling key, trigger, 205
model number, 345, 349
Modify softkey, 332
modulation, waveform generator 

output, 302
module installed, 345
MSO, 4
MSO feature upgrade, 376
MSO license, 376
Multicast DNS, 331
multiplexed position knob, 42
multiplexed scale knob, 42
Multiply math function, 95

N
N2820A high-sensitivity current 

probe, 246
N8900A InfiniiView oscilloscope analysis 

software, 310
natural logarithm math function, 111
navigate files, 333
Navigate key, 41
navigating the time base, 77
negative pulse width measurement 

trend, 116
network configuration parameters, 349
network printer connection, 325
network, connecting to, 331
new label, 161
noise rejection, 209
noise waveform generator output, 289
noise, adding to waveform generator 

output, 301
noise, high-frequency, 209
noise, low-frequency, 208
noisy signals, 205
non-volatile memory, secure erase, 322
normal acquire mode, 220

normal mode, 219, 220
Normal trigger mode, 206
notices, 2
Nth edge burst trigger, 184
Nth edge burst triggering, 184
number of negative pulses 

measurements, 264
number of positive pulses 

measurements, 264
Nyquist frequency, 106
Nyquist sampling theory, 215

O
offset (DC) correction for integrate 

waveform, 99
operators, math, 94
options, print, 326
OR trigger, 180
oscilloscope bandwidth, 216
oscilloscope bandwidth required, 218
oscilloscope rise time, 217
oscilloscope sample rate, 217
output load expected, waveform 

generator, 300
output, trigger, 339
overlay, localized, 45
Overshoot measurement, 245, 251
overvoltage category, 369

P
palette, 312
pan and zoom, 67
parts, replacement, 142
passive probes, 371
passive probes, compensating, 37
password (network), reset, 365
password (network), setting, 363
pattern trigger, 177
pattern, SPI trigger, 429
PC connection, 332
peak detect mode, 219, 220, 221
Peak-peak measurement, 249
Period measurement, 257
period measurement trend, 116
persistence, 153
persistence, clearing, 154
persistence, infinite, 214

Phase measurement, 245, 261
phase X cursor units, 234
PNG file format, 310
point-to-point connection, 332
pollution degree, 369
pollution degree, definitions, 370
Portuguese front panel overlays, 46
Portuguese user interface and Quick 

Help, 63
position digital channels, 133
position knob, 133
position, analog, 83
positive pulse width measurement 

trend, 116
post-processing, 242
post-trigger information, 68
pouch (accessory), attaching, 30
Power App measurements, 246
power consumption, 32
power cord connector, 59
power requirements, 32
power supply, 59
power switch, 33, 39
power-on, 32
predefined labels, 160
Preshoot measurement, 245, 252
Press to go, 317
Press to go, File Explorer softkey label, 334
pre-trigger information, 68
print, 347
Print key, 43
print options, 326
print screen, 323
print, landscape, 326
print, Quick Print, 347
printer, USB, 45, 323
printing the display, 323
probe attenuation, 88
probe attenuation, external trigger, 211
probe compensation, 44
probe head, 89
probe units, 87
probe, AutoProbe interface, 44
probe, calibrate, 89
probes, 370, 373, 374
probes, connecting to oscilloscope, 33
probes, current, 373
probes, differential, 372
probes, digital, 125
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probes, passive, 371
probes, passive, compensating, 37
probes, single-ended active, 371
programmer's guide, 357
pulse polarity, 175
pulse waveform generator output, 289
pulse width trigger, 174
PWR license, 376

Q
qualifier, pulse width, 176
Quick Action key, 43, 347
Quick Clear Display, 348
Quick Email, 347
Quick Freeze Display, 347
Quick Help, 62
Quick Help language, 63
Quick Mask Statistics Reset, 347
Quick Measure All, 347
Quick Measure Statistics Reset, 347
Quick Print, 347
Quick Recall, 347
Quick Save, 347
Quick Trigger Mode, 347

R
ramp waveform generator output, 289
random noise, 205
range, external trigger input, 212
ratio measurement, 256
ratio measurement trend, 116
ratio X cursor units, 234
ratio Y cursor units, 234
raw acquisition record, 314
Real Scope Remote Front Panel, 352
realtime sampling and oscilloscope 

bandwidth, 227
realtime sampling option, 226
rear panel connectors, 58
re-arm time, 230
recall, 347
recall files via web interface, 358
recall mask files, 320
recall setups, 320
recall, Quick Recall, 347
Rectangular FFT window, 102
Ref key, 42, 121

reference point, waveform, 335
reference signal mode, 339
reference waveforms, 121
remote control, 329
Remote Front Panel, 355
remote programming, Agilent IO 

Libraries, 356
remote programming, web interface, 355
replacement parts, 142
required oscilloscope bandwidth, 218
reset label library, 163
reset network password, 365
restart condition, I2C trigger, 417
return instrument for service, 346
Rise time measurement, 260
rise time measurement trend, 116
rise time, oscilloscope, 217
rise time, signal, 218
rise/fall time triggering, 182
rising edge count measurements, 265
RMS - AC measurement trend, 116
roll mode, 70
RS232 trigger, 463
Run Control keys, 41
runt pulses, 257
runt triggering, 185
Russian front panel overlays, 46
Russian user interface and Quick Help, 63

S
safety warning, 34
sample rate, 3
sample rate and memory depth, 219
sample rate, current rate displayed, 66
sample rate, oscilloscope, 216, 217
sampling theory, 215
sampling, overview, 215
save, 347
save file, 333
save files via web interface, 357
save segment, 313
save setup files, 311
save times, data, 315
Save to, 317
save, Quick Save, 347
save/recall from web interface, 357
Save/Recall key, 43
saver, screen, 336

saving data, 309
SCL, I2C trigger, 416
SCLK, I2S trigger, 436
SCPI Commands window, 355
screen image via web interface, 359
screen saver, 336
SDA, 415
SDA, I2C trigger, 416
Search key, 41
secure erase, 322
segmented memory, 228
segmented memory, re-arm time, 230
segmented memory, saving segments, 313
segmented memory, statistical data, 230
select digital channels, 133
select knob, 133
Selected, File Explorer softkey label, 334
selecting, values, 40
self test, front panel, 345
self test, hardware, 344
serial clock, I2C trigger, 416
serial clock, I2S trigger, 436
serial data, 415
serial data, I2C trigger, 416
serial decode controls, 42
Serial key, 42
serial number, 345, 349
service functions, 342
setup and hold triggering, 187
setup files, saving, 311
setup, automatic, 129
setup, default, 35
setups, recall, 320
shipping damage, 27
shipping precautions, 346
Sigma, minimum, 274
signal, CAN symbolic, 391
Simple Remote Front Panel, 353
Simplified Chinese front panel overlays, 46
Simplified Chinese user interface and Quick 

Help, 63
sinc waveform generator output, 289
sine waveform generator output, 289
single acquisition, 41
Single key, 213
single-ended active probes, 371
single-shot acquisitions, 207
single-shot events, 214
size, 132
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skew, analog channel, 88
slope trigger, 170
Snapshot All measurements, 247
snapshot all, quick action, 347
softkey labels, 62
softkeys, 7, 39
software updates, 377
software version, 345
Span, FFT, 101
Spanish front panel overlays, 46
Spanish user interface and Quick Help, 63
specifications, 367
spectral leakage, FFT, 107
SPI serial decode, 430
SPI trigger, 428
square math function, 109
square root, 108
square waveform generator output, 289
square waves, 216
stand-alone connection, 332
start acquisition, 41
start condition, I2C, 417
state logic bus chart, 118
statistics, increment, 270
statistics, mask test, 276
statistics, measurement, 268
statistics, using segmented memory, 230
status line, 61
status, User Cal, 345
Std Deviation measurement, 254
stop acquisition, 41
stop condition, I2C, 417
storage locations, navigate, 317
subnet mask, 331
subtract math function, 94
symbolic data, CAN, 389
sync pulse, waveform generator, 299

T
template, front panel, 45
test, mask, 271
theory, sampling, 215
threshold, analog channel 

measurements, 266
threshold, digital channels, 133
thumb drive, 45
tilt for viewing, 31
time measurements, 256

time reference indicator, 76
time, re-arm, 230
timebase, 69
times for saving data, 315
timing logic bus chart, 117
Tools keys, 43
Top measurement, 250
totalizer, ARINC 429, 458
totalizer, CAN, 394
totalizer, FlexRay, 411
totalizer, UART/rs232, 468
Touch key, 40, 47
tracking cursors, 233
trademarks, 2
Traditional Chinese front panel overlays, 46
Traditional Chinese user interface and Quick 

Help, 63
transforms, math, 96
transient withstand capability, 369
Transparent backgrounds, 336
TRIG OUT connector, 59, 339
TRIG OUT signal and zone qualified 

trigger, 204
Trig'd trigger indicator, 207
Trig'd? trigger indicator, 207
Trigger controls, 40
trigger coupling, 208
trigger indicator, Auto?, 207
trigger indicator, Trig'd, 207
trigger indicator, Trig'd?, 207
trigger level, 169
trigger mode, auto or normal, 206
trigger mode, Quick Trigger Mode, 347
trigger output, 339
trigger output, mask test, 275, 339
trigger type, ARINC 429, 454
trigger type, CAN, 390
trigger type, edge, 170
trigger type, edge then edge, 172
trigger type, FlexRay, 406
trigger type, glitch, 174
trigger type, hex bus, 179
trigger type, I2C, 416
trigger type, I2S, 438
trigger type, LIN, 398
trigger type, MIL-STD-1553, 447
trigger type, Nth edge burst, 184
trigger type, OR, 180
trigger type, pattern, 177

trigger type, pulse width, 174
trigger type, rise/fall time, 182
trigger type, RS232, 463
trigger type, runt, 185
trigger type, setup and hold, 187
trigger type, slope, 170
trigger type, SPI, 428
trigger type, UART, 463
trigger type, USB 2.0, 473
trigger type, video, 188
trigger types, 167
trigger, definition, 168
trigger, external, 210
trigger, forcing a, 169
trigger, general information, 168
trigger, holdoff, 210
trigger, mode/coupling, 205
trigger, source, 170
trigger, zone qualified, 202
triggers, TRIG OUT signal, 339
TTL threshold, 133
turn channel on, 44

U
U2H license, 376
UART totalizer, 468
UART trigger, 463
UART/RS232 frame counter, 468
UART/RS232 license, 375
UART/RS232 serial decode, 465
under-sampled signals, 215
units, cursor, 234
units, external trigger probe, 211
units, math, 93
units, probe, 87
updating software and firmware, 377
upgrade files, 361
upgrade options, 375
upgrading the oscilloscope, 376
upload new firmware, 349
usb, 335
USB 2.0 serial decode, 475
USB 2.0 trigger, 473
USB decode, signal speed, 471
USB device port, 60
USB device port, remote control, 329
USB host port, 60, 323
USB host ports, 45
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USB printer, 323
USB printers, supported, 323
USB storage device, 45
USB, CD device, 335
USB, eject device, 45
USB, storage device numbering, 335
usb2, 335
USBSQ license, 376
user cal, 342
user calibration, 342
user interface language, 63
User-defined threshold, 133
USF license, 376
utilities, 329
Utility key, 43

V
V RMS, FFT vertical units, 102
values, choosing, 40
variable persistence, 154
vectors or dots, waveform display, 156
ventilation requirements, 32
Vertical controls, 44
vertical expansion, 83
vertical offset, 83
vertical position, 83
vertical position knobs, 44
vertical scale knobs, 44
vertical sensitivity, 44, 83
Vertical Units, FFT, 102
VGA video output, 60
VID license, 376
video trigger, 188
video trigger, custom Generic, 193
viewing, tilt the instrument, 31
VISA connect string, 349
visualizations, math, 114
voltage measurements, 248

W
warranted specifications, 367
warranty, 346
Wave Gen1/2 keys, 43, 45
waveform generator, 287
waveform generator defaults, 

restoring, 307

waveform generator dual channel 
tracking, 307

waveform generator expected output 
load, 300

waveform generator logic presets, 300
waveform generator sync pulse, 299
waveform generator sync pulse, TRIG OUT 

signal, 339
waveform generator, arbitrary 

waveforms, 291
waveform generator, waveform type, 287
Waveform keys, 40
waveform type, waveform generator, 287
waveform, cursor tracking, 233
waveform, intensity, 151
waveform, printing, 323
waveform, reference point, 335
waveform, saving/exporting, 309
WAVEGEN license, 376
web interface, 349
web interface, accessing, 350
white noise, adding to waveform generator 

output, 301
Width - measurement, 259
Width + measurement, 259
Window, FFT, 102

X
X at Max Y measurement, 263
X at Max Y on FFT, 246
X at Min Y measurement, 263
X at Min Y on FFT, 246
XY mode, 69, 70

Z
Z-axis blanking, 73
zone qualified trigger, 202
zoom and pan, 67
zoom display measurement window, 268
Zoom key, 41
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